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Lawmaker help

ℹ  Documentation overview

🕑 Recently updated

Here are the recently updated pages.

Auto-application of amendments: known limitations and planned improvements
30 Sept 2024 • contributed by Edward Griffiths

What's new in v.17.1?
25 Sept 2024 • contributed by Matt Lynch

References
24 Sept 2024 • contributed by Matt Lynch

Tips for SI & SSI drafters working with processing teams
24 Sept 2024 • contributed by Matt Lynch

Lords Running List
20 Sept 2024 • contributed by Edward Griffiths

 

 

 

 

Online user manual and help for the Lawmaker application. Use the search box to find help on a particular issue or click on the topic links 

below.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/355729410/Auto-application+of+amendments+known+limitations+and+planned+improvements
https://lawmaker.atlassian.net/wiki/people/712020:d6011eca-688b-444a-8c18-5060e6543453?ref=confluence
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/548962305/What+s+new+in+v.17.1
https://lawmaker.atlassian.net/wiki/people/557058:27c28f03-fb90-4531-a098-ffcec3b404ad?ref=confluence
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522/References
https://lawmaker.atlassian.net/wiki/people/557058:27c28f03-fb90-4531-a098-ffcec3b404ad?ref=confluence
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/213483521/Tips+for+SI+SSI+drafters+working+with+processing+teams
https://lawmaker.atlassian.net/wiki/people/557058:27c28f03-fb90-4531-a098-ffcec3b404ad?ref=confluence
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/300417025/Lords+Running+List
https://lawmaker.atlassian.net/wiki/people/712020:d6011eca-688b-444a-8c18-5060e6543453?ref=confluence
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Projects and documents

 

Introduction

Two important concepts in Lawmaker are the Project and the Document. This section explains a bit about both and how you can interact 

with them.

What is a Project?

We use “project” as a generic name for the thing you’re working on in Lawmaker. Each Bill or statutory instrument you work on in Lawmaker 

will be represented by a separate project which is essentially a collection of documents relating to that Bill or instrument. For example, a Bill 

project will contain all the different versions of the Bill and all the amendments and amendment lists relating to that Bill.

Users in different organisations can work on the same project but can only see documents created by users in their own organisation or 

documents that have been shared with them.

When you log in, all the projects you can access are visible on the dashboard (see Finding projects on the Dashboard ). A project’s 

name is determined by the title of the Bill or SI it relates to. (Each project also has a unique ID number like SP000123 or SI007534.)

This section covers how to create and manage projects and the documents within them, including how to use the Dashboard and the 

Project Tab, generating PDFs. sharing documents and managing permissions.

If you’re the first person to work on a particular Bill or statutory instrument then you will need to create a project for it first. See Cr

eating a new project   for instructions on how to do that.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688758
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688758
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
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Documents

Everything in Lawmaker is based on documents. As mentioned above, projects are collections of documents and, when you are using the 

Editor, you are editing a document. 

Lawmaker handles a range of different document types. The most common are Bills, statutory instruments and amendment lists but others 

are covered too. The kind of documents that a project can contain is controlled by the type of project you create, e.g. a Scottish Public Bill 

project will contain Scottish Bill documents and Scottish amendment list documents.

There are different types of document versions - working, significant and snapshot.

Finding projects on the Dashboard

Creating a new project

Deleting a project

Documents and folders on the Project Tab

Generating and viewing a PDF

Managing document permissions

Sharing a document with another organisation

Publishing a Bill document version

Finalising a document

 

See Documents and folders on the Project Tab  for more on the different types of document and how to work with them in 

Lawmaker.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688758/Finding+projects+on+the+Dashboard
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709/Creating+a+new+project
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688701/Deleting+a+project
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786/Documents+and+folders+on+the+Project+Tab
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197/Generating+and+viewing+a+PDF
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286/Managing+document+permissions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688436/Sharing+a+document+with+another+organisation
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688381/Publishing+a+Bill+document+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/61046815/Finalising+a+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
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Finding projects on the Dashboard

The Dashboard is the screen you will see when you login.

The Dashboard gives you access to all the projects that are available to you. You can filter what is shown in different ways and switch 

between two different views, the Tile view and the List view.

You can get back to it any time by pressing on the home icon in the top left of the screen.

How to switch between Tile view and List view on the Dashboard

You can choose whether you would prefer to see your dashboard in tile format or in list format.  

If you are on the Tile view and want to view projects in a list, click on the List view button in the top left, next to the search field.

If you are on the List view and want to view projects as tiles, click on the Tile view button in the top left, next to the search field.

Sorting the projects displayed on the Dashboard

The Tile view is sorted alphabetically by project title. You can’t change the sort order.

By default, the List view is sorted alphabetically by project title but you can change the sort order by clicking on the relevant column heading.

A project becomes visible on the dashboard when there is at least one document in it that you have access to (either read and write 

or read only).  If you do not have access to any document in a project, you will not see the project on your dashboard.

The details about a project (e.g. title, number etc.) shown on the dashboard are updated when a user saves changes to a document 

within the project: 

When a bill contains a published document, the project data will only be updated when a subsequent bill within it has been published or 

submitted to the National Archive’s publishing tool as enacted legislation

When a SI contains a document that has been submitted to the National Archive’s publishing tool either as a Draft or Made document 

version
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How to filter the projects shown on the Dashboard

You can use the controls across the top of the Dashboard to filter what projects are shown. Lawmaker will remember your filter settings 

when you next return to the Dashboard, even if you’ve logged out in between.

There are four ways you can filter the projects shown:

by project title

by favourites 

by session e.g. "58/1" for UK Bills or "6" for SP Bills

by project type (UK Bills/Acts, SP Bills/Acts, or Statutory Instruments)

You can combine different filters together (the effect is cumulative).

Project title

Enter a word or words into the “Filter by project title…” search field. The Dashboard will update as you type.

To remove the search filter, clear any text out of the search field.

Favourites

You can select a project to be a 'favourite' which is useful tool for controlling the view of your dashboard so that only 'favourites' are 

displayed.  

To mark a project as a favourite, click on the pin icon on the top right of the project tile (in Tile view) or to the left of the project title (if in List 

view). To unmark a project as a favourite, do the same.

Click on the Favourites button to show only projects marked as favourite. The button will be highlighted orange when the dashboard is 

being filtered by favourite projects only.

How to open a project

You can access the documents in a project by clicking on a project from the Dashboard. 

To open a project:

In Tile view, click on the project title or the ‘Open’ link at the bottom of the project tile.

In List view, click on the project title or the open folder button  to the right of the project row.

The system will open the project and take you to the Project Tab, displaying all versions of the document that you have access to.

Whenever you create a new project, it will automatically be marked as a favourite.
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Creating a new project

To draft a new Bill or SI/SSI, you will first need to create a new project from the dashboard.  When you create a new project, an empty 

document on the appropriate template is automatically created within the project.

How to create a project
1. From the dashboard, click on the + New button in the top right above the project tiles/list

2. The system will ask you to provide the following information:

a. Type (mandatory)

b. Sub-type (only applicable to a subset of 'Type' options - mandatory)

c. Title (mandatory)

d. Procedure (only applicable to SI/SSIs - mandatory)

3. You can also adjust the default permissions before the project is created - see Managing document permissions  .

4. When you have added the necessary details, click on the Create button

5. The system will take you to the Editor, with the appropriate bill/SI/SSI template loaded and pre-populated with known text.

 

Hints and tips

By default, any user in the same organisation as the document creator will have read/write access to it.

When you create a new project, it will automatically be set as a 'favourite' on the dashboard

The 'Type' and 'Sub-type' drop down menus are 'sticky' which means your last selection will be remembered when you create a new project

In Bill projects, a bill document template will consist of the Preface and Body.  The pre-populated text will be affected by your choice of type 

and subtype. You can manually insert the front cover, table of contents and back cover depending on when/whether you need them.

In SI/SSI projects, a SI/SSI document template will consist of the Preface, Preamble and Body.  The Procedure you select will determine 

whether the document is created on a Made or Draft document template.  You can change the procedure later if it changes after you start 

drafting the document. You can manually insert the Table of contents, Signature block, Explanatory Notes, Commencement history table and 

other preface-related elements depending on when/whether you need them

See also

Creating an empty document in a project  

Deleting a project  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688841
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688841
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688701
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688701
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Deleting a project

You can delete a project and the documents within it from the Dashboard.

How to delete a project
1. If you have the Tile view of the Dashboard, click on the delete icon on the bottom of the tile for the project you want to delete.

2. If you have the List view of the Dashboard, click on the delete icon at the right of the row for the project you want to delete.

3. The system will present a message to check before deleting.

4. Click Delete  to delete the project.

The project will no longer be visible on the dashboard and all documents it contained will be deleted.

You can’t delete a project  if it contains a significant version (i.e. a document that has been shared with another organisation, published or 

submitted to TNA.)

You can’t delete a project if another user currently has a lock on a document within it.

There is no way to undo the deletion of a project from within Lawmaker.

See also Deleting a document  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688725
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688725
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Documents and folders on the Project Tab

What do we mean by “working version”, “snapshot” and “significant version”?

Working versions and snapshot versions

Significant versions

The Project Tab is the first page you will see when you open any project. It shows you all the different versions of the Bill, Statutory 

Instrument, Church Measure etc. that you have access to within the project.

There are different kinds of versions shown on the Project Tab: working versions, snapshots and significant versions. Working versions are 

organised within folders.

This page explains more about the different versions and how you can organise them and rename them.

A working version is an unpublished document that you can view and edit. Working versions are only ever visible to users in one 

organisation: the organisation of the user that created the document. But access to a particular working version may be restricted 

further.

For each working version, Lawmaker also stores a series of related snapshot versions. A snapshot version is a read-only, point-in-time 

snapshot of the working version. Snapshots are created automatically when certain actions are carried or when the user requests that a 

snapshot be created.

Snapshots are created when you:

generate a PDF (the snapshot will be called: 'PDF generated')

Download a zip file (the snapshot will be called: 'Downloaded')

Duplicate a document (the snapshot will be called: 'Duplicated')

Share a document (the snapshot will be called: 'Shared externally')

Publish a document (the snapshot will be called: 'Published')

Submit a document to TNA (the snapshot will be called: 'Submitted to TNA')

Lawmaker also stores the auto-saved version of any document you are working on as a snapshot.

Each time you save a working version, Lawmaker creates a backup snapshot (overwriting the existing backup) so if the master 

document gets corrupted in the save process, the backup can be used to restore the document.

A significant version is a document that has been published, marked as signed, submitted to TNA or shared with another organisation. 

These versions are read only which means that the document content cannot be changed. This maintains the data integrity of these 

versions.

1. Published significant versions (bills only) are visible to all users in the system.

2. Shared significant versions are visible to users in the organisation that shared the version and the organisation with which it was shared.

3. Signed and submitted versions (SI/SSIs only) can only be viewed by users in the organisation that created the document.

4. You can view the (read-only) Significant version in the Editor together with its (read-only) document information; generate/view a pdf; download a 

bill bundle or make a duplicate version to continue drafting if necessary.
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Working with the Project Tab

Layout

All working versions are shown on the left of the screen. They are divided up into one or more folders. The folders are arranged 

alphabetically.

Clicking on the black triangle next to the folder name will expand the folder to show all the working versions it contains. Clicking it again will 

collapse the folder so only the folder name is visible.

Each green tile within a folder is a working version. The working versions are also arranged alphabetically.

Clicking on the black triangle next to the working version description will expand the view to show all snapshot versions relating to that 

working version. Clicking it again will collapse the view so only the working version is visible.

All significant versions are shown on the right of the screen.

You can use the chevron icons above the working versions and significant versions to show or hide one type of version.

 

How to rename a folder

1. Click on the folder name.

2. Add a new name for the folder.

3. Click on the save icon that appears.

If you specify the same folder name as another folder in the project, then the two folders will be merged.

How to rename a working version

1. Click on the working version name.

2. Add a new name for the version.

3. Click on the save icon that appears.
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Other pages in this section

Deleting a document

Downloading a plain text version of a document

Updating document information from project tab

Comparing documents

Downloading a ZIP file of a document

Create a new document by uploading an XML file

Duplicating a document version

Creating an empty document in a project

Copying a document to another project

 

The version description must be unique within the project.

How to move a working version to another folder

1. Select Move version from the Actions menu on the tile of the working version you want to move.

2. The system will ask you to specify a folder.

3. When you have provided a folder, click Move.

The system will then move the document to the specified folder.

You can create a new folder to move the working version to by specifying a folder name that doesn’t yet exist.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688725/Deleting+a+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688711/Downloading+a+plain+text+version+of+a+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60915747/Updating+document+information+from+project+tab
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688686/Comparing+documents
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688696/Downloading+a+ZIP+file+of+a+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688419/Create+a+new+document+by+uploading+an+XML+file
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688280/Duplicating+a+document+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688841/Creating+an+empty+document+in+a+project
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688665/Copying+a+document+to+another+project
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Deleting a document

You can delete working versions, snapshot versions and some significant versions. It is not possible to delete published significant versions.

How to delete a document
1. On the Project tab, select Delete document from the Actions menu next to the working version, snapshot or significant version you want to delete.

2. A warning message will be shown. Make sure you have selected the right document version to delete.

3. Click Delete.

The selected version will be deleted. If it was a working version then all associated snapshot versions will also be deleted.

Only users in the same organisation as the user who created the document version can delete it.

You cannot delete the last document in the project. You will need to separately delete the project if you wanted to get rid of the last document 

in it - see Deleting a project .

If you delete the only shared significant version in a project, users from the other organisation may no longer be able to see the project in 

their dashboard if that was the only document in the project they had access to.  If they had created a working version of the significant 

version before it was deleted, they will still be able to see the project.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688701
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688701
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Downloading a plain text version of a document

A plain text version of a document can be downloaded as a backup or for other purposes.

How to download a text file
1. On the Project tab, select Download text file from the Actions menu next to the document version that you want to download a text file for.

 A text file will be created and saved  in the Downloads folder on your computer.

 

This feature currently only works for Bills.

The text in the text file download can be copied and pasted into another flat editor e.g. Word/email etc. should you wish to share the 

document in an editable format with another person who did not have access to Lawmaker but the text will not be formatted.
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Updating document information from project tab

For Bills and Acts, you can update document information (metadata) like the title, number, session and related members from the Project 

tab. For larger documents, this will be quicker than updating it in the Editor.

How to update document information
1. From the Project tab, find the working version that you want to update.

2. Select Actions > Update Document Information. 

3. A dialogue box will appear with fields for you to update. The fields that are visible will depend on the document type.

4. Update the fields in the dialogue box.

5. Click Update.

Lawmaker will update the document without you needing to open the document.

You cannot update the Document Information from the Project tab if another user is currently updating it or you have the document open in 

the Editor already and have a lock on it.

If the document has a back cover, you will need to reinsert it to make sure all the changes made here are visible on the cover. See Insert

ing UK Bill and Act front and back covers  and Inserting Scottish Bill and Act front and back covers  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
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Comparing documents

You can compare two document versions in a project to create a new version showing the differences as tracked changes.

How to compare documents
1. On the Project tab, find the document version that contains the most recent changes and select "Compare version" from the Actions menu next to it.

2. In the 'Compare document versions' dialogue box, select the significant, working or snapshot document version you want to compare it to.

3. You can provide a name for this new compared document or one will be assigned automatically.

4. Click Compare.

A new document version will be created, in the folder “Compare” containing the comparison between the two documents.

You can use the Compare function as an alternative to working with Tracked Changes turned on.

Note that if you have generated a PDF with line numbering for one or both of the versions you are comparing, you will see erroneous tracked 

changes in the resulting comparison document. This is due to the way that line numbering information is stored within the XML of document 

versions in Lawmaker. To create a comparison between versions where line numbering info has been added, use the Duplicate version 

action from the Actions menu next to each version, and ensure the option to ‘Strip out page/line numbers’ is ticked. The resulting duplicate 

versions can then be compared, and the comparison will not contain any erroneous tracked changes.

The logic works best if you select 'Compare version' on the newer document version and then select the older version to compare it with in 

the dialogue box.

You can compare documents that are significant versions, working versions or snapshot versions or a mixture.

This feature works best if the changes between the documents aren't too significant as there are some known limitations which will be 

refined for a later release:

If you insert or delete a quoted structure, the text before it will also be marked up in an insert/delete tracked change due to the way the 

XML is constructed.  We will refine this logic in future so that only the quoted structure is marked as inserted/deleted.

Moving provisions around the document can create more tracked changes than expected due to the changes occurring behind-the-

scenes in the XML.  We have caught the main provisions but there are some that are likely to need further refinement.  One example of 

this limitation is moving definitions around in a list: this tends to result in lots of tracked changes appearing within the list of definitions 

and we will be working on refining this in future.  If you spot anything similar when moving different provisions around your document, 

please report it to us.

It's possible to accept/reject changes using the 'Review' right-hand panel in your compare document version if required.

You can move 'compare' documents into other folders.
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Downloading a ZIP file of a document

You can download a zip file containing the XML of a document version together with any related images and the PDF if there was one 

stored with the document version. 

 

How to download a document bundle
1. On the Project tab, select Download ZIP file from the Actions menu next to the document version you want to generate a ZIP file from.

2. If you are downloading the XML to send on to a third party (e.g. TNA), leave “Resolve dates in XML” ticked.

3. If you are downloading the XML to be uploaded back into Lawmaker in future then uncheck “Resolve dates in XML”.

4. Click Download.

A zip file containing the XML file, any images and a PDF (if there is a PDF saved against the chosen document version) will be saved to 

your local download folder.

This function can be used to create a zip file which can then be uploaded to The National Archive’s publishing system. To ensure there is a 

PDF included, select Download Zip file from the Actions menu next to a PDF snapshot, a Published snapshot or a Submitted to TNA 

snapshot.

It can also be used as a way of keeping a local backup of important documents. You can use the downloaded XML to create a new working 

version:  see Create a new document by uploading an XML file .

If you download a ZIP file from a working version, a snapshot version will be created, labelled “Downloaded” which will allow you to access 

the document version in future should you need to return to that exact version of the XML.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688419
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688419
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Create a new document by uploading an XML file

You can upload an XML document into Lawmaker to create a new working version. The XML document must have originally been 

downloaded from Lawmaker.

 

How to upload an XML file
1. On the Project tab, click on the Upload document button.

2. Select a folder and enter a version description for your new document.

3. Click Choose file and select the XML file from your computer that you wish to upload.

4. Click on the Upload button

Lawmaker will validate the file to check that it is a Lawmaker file and that it is the correct type for the project you are uploading to. If it is, a 

new working version will be created on the Project tab.

You may need to extract the XML document from the compressed zip file that was downloaded using  Downloading a ZIP file of a docum

ent  before you can upload it.

Any images associated with the XML file will not be uploaded. 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688696
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688696
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688696


25

Duplicating a document version

You can create a new working version of a document within a project by duplicating an existing version. Working versions, snapshots and 

significant versions can all be duplicated. 

 

How to duplicate a document version
1. On the Project Tab, select Duplicate version from the Actions menu next to the version you want to duplicate.

2. Specify a Folder that the duplicate will be placed in. This can be an existing folder selected from the menu or you can type in the name of a new 

folder and it will be created at the same time.

3. Enter a name for the duplicate version in the Version description field.

4. Leave the “Strip out page/line numbers” option checked. (If you deselect it, any existing page and line number information will remain in the XML and 

this can cause issues with styling in the Editor view.  A future update to Lawmaker may enable the Editor to make use of the information.)

5. Leave “Convert to Act”/”Convert to Made” option unchecked.

6. Click Create.

A duplicate version of the document will be created as a working version on the Project Tab in the folder you specified.

When you duplicate a document version from a snapshot version or a working version, it will create a snapshot version called “Copied” 

under the source working version.

If a document has been shared with you, the only way it can be further edited is by making a duplicate version because the shared 

significant version is read-only.
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When creating a duplicate version, the duplicated version will have the same permissions as the original version. See Managing docume

nt permissions .

To create an Act version of a Bill or to create a made version of a draft SI see Converting a UK Bill into an Act , Converting a Scottish 

Bill into an Act  and Converting a Draft SI/SSI into a Made version - old old UNDEFINED .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688792
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688792
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688792
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Converting%20a%20Draft%20SI%2FSSI%20into%20a%20Made%20version%20-%20old%20old&linkCreation=true&fromPageId=688280
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Converting%20a%20Draft%20SI%2FSSI%20into%20a%20Made%20version%20-%20old%20old&linkCreation=true&fromPageId=688280
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Converting%20a%20Draft%20SI%2FSSI%20into%20a%20Made%20version%20-%20old%20old&linkCreation=true&fromPageId=688280
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Converting%20a%20Draft%20SI%2FSSI%20into%20a%20Made%20version%20-%20old%20old&linkCreation=true&fromPageId=688280
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Creating an empty document in a project

You can create a new draft document on the appropriate template at any time within an existing project. There is no limit to the number of 

documents in a particular project.

How to create an empty document 
1. From the Project Tab of a particular project, click on the Document Actions menu in the top right and select Create new working version.

2. The system will ask you to provide the following information:

Folder - you can select an existing folder or add a new folder;

Version description- this is a name for the document and must be unique across the whole project.

3. When you have added the necessary details, click Create.

4. The system will create a new working version and display it as a green tile in the appropriate folder on the left of the Project Tab.

 

Hints and tips

By default, any user in the same organisation as the document creator will have read/write access to it. See Managing document permis

sions  if you want something different.

See also Create a new document by uploading an XML file  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688419
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688419
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Copying a document to another project

You can copy a document to another existing project.  Both working versions and significant versions can be copied. A new working version 

will be created in the project the document is copied to.

 

How to copy a document to another project
1. On the Project Tab, select Copy to another project from the Actions menu next to the document version you want to copy

2. Select the Project you want to copy the document to. As you start typing in the Project field, a list of matching projects will be shown.

3. Enter a  version description in the Version description field. This must be different from any existing version description in the project you’re moving it 

to.

4. Leave “Strip out page/line number” ticked.

5. Click Copy.

A copy the document will be created in the specified project in a folder with the same name as the original’s folder.

The permissions on the newly created document will be the default permissions, regardless of the permissions set on the document you are 

copying.  If you want to restrict its access, you will need to update the permissions on the newly created document as soon as you have 

copied it. See Managing document permissions .

The short title of the document you copy will inherit the same title as the project that you're moving it to.

If you copied a significant version (the grey versions on the right hand side) it will create a working version (green version on the left hand 

side) and the folder will be named "Significant version"

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
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Generating and viewing a PDF

PDFs can be generated at any time for all documents in Lawmaker. You can generate them from the Editor or from a document on the 

Project Tab, Amendment Workspace Tab or the Official Lists Tab.

When you generate or view a PDF it will open in a separate tab or window in your browser.

 

If the PDF isn’t appearing in a new tab or window, check that you have pop-ups enabled for Lawmaker (clicking on the padlock to 

the left of the URL in the browser address bar will give you quick access to adjust these settings).

How to generate a PDF

First bring up the Generate PDF dialogue bx:

If you are in the Editor, select Document menu> Generate PDF from the upper tool bar. 

If you are on the Project Tab, Amendment Workspace or Official Lists tab, select Actions menu> Generate PDF on the document working version or 

snapshot you want to generate a PDF from. 

Once you have selected your preferred settings, click Generate.

The PDF generated from the Editor will be based on the document as it is including any changes you have made but not saved.

A PDF generated from a working version will be based on the last saved version of the document.

PDF generation settings

There are a number of different setting you can select to control what is generated. Some options are only available for certain document 

types.

Pages/provisions to include

By default all provisions in a document (or all amendments in an amendment list) are included in the PDF.

But you can select a subset using this dropdown. You can select any combination of provisions/amendments. They don’t need to be next to 

one another or of the same type. For example you can select a Part of a Bill (which will include all the sections in a Part) and some 

individual sections elsewhere in the Bill.

Tracked changes

These settings relate to if and how tracked changes in the document are rendered in the PDF.

Show tracked changes: all tracked changes will be visible in the PDF.

Show changes applied: in this case the PDF will show as if all the changes had been accepted.

Include side-lining: if this option is selected, side-lining will be included in the margin to indicate where changes have been made to the text.

Print and publishing artefacts

The options that appear here depend on the document type:

Include line numbering

If selected, the PDF will show line numbering in the margin of each page. Every 5th line is numbered.

This feature is only available for Bills. Line numbering shows on the left for Scottish Bills and on the right for UK Bills.
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Footers

If selected, the PDF will include appropriate footers drawn from the document metadata, e.g. the Session and Bill number.

Page numbers

Includes page numbers (List of Draft Amendments only). Other documents like Bills, Acts and SIs have page numbers by default.

Generate as House Bill

If  selected, the PDF will be generated as a House Bill with the appropriate covers. See  Preparing a House Bill .

Footer note

Use this option to include a custom note in the footer of each page. The note can be up to 2 lines of text.

Insert draft watermark

Use this option to place a watermark on every page of the PDF. This will result in the word “Draft” being placed in light grey diagonally 

across the page behind the main content.

 

Large print

Use this option to produce a PDF in large print format. The document will be generated in 20pt Arial font. Some adjustment of margins, 

indentation and spacing will take place to avoid overlapping text.

Extras

These extra features can only be included in the PDF if line numbering is turned off. The options that appear here depend on the document 

type.

Show J-numbers in margin (Bills and SI/SSIs only)

Select this if you want the J-numbers to be visible in the PDF (in addition to the section/schedule numbers). See Managing J-refs .

Show Jrefs in cross-references

Select this if you want the J-numbers of target provisions to be included in cross-references in the PDF - see References  .

Show D-Numbers

Select this to display the unique D-number assigned to each amendment (e.g. HoC1) in the PDF (in addition to any official number assigned 

to the amendment).

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63406081
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63406081
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
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Show amendment D-numbers against inline amendments

Select this if you want the the D-number of each inline amendment to be shown in the PDF of the inline list of draft amendments.

Show review comments

Select this to include any comments that have been added to the document in the Editor. Each comment will be shown in italics and 

surrounded by square brackets within the text. The comment will be placed at the end of the text to which it refers. Any replies to the 

comment will also be included. The username of the user who made the comment or reply is shown at the beginning of each 

comment/reply.

 

Show origin information

Select this option if you’re working on a consolidation and want the origin notes to be visible in the PDF.

Save a snapshot of the document

When you generate a PDF from a working version or an existing snapshot, the option Record snapshot version enables you to save a 

snapshot version containing the PDF you generated and the corresponding XML document. 

You can provide a name for the snapshot in the Version description box or leave the box empty and it will be saved with the default name 

“PDF”.

This option can be useful so you can:

 view the same PDF again at a later date without regenerating it,

generate another PDF of the same document but with different settings,

generate a new working version from PDF version to edit further,

publish the document (only PDF snapshots can be published - see Publishing a Bill document version )

 

How to view a PDF

If you’ve created a snapshot or significant version that includes a PDF, you can view the PDF again without regenerating it.

On the Project Tab, Amendment Workspace Tab or Official Lists Tab, select Actions>View PDF on the document you want to view.

The stored PDF will be presented in another browser tab.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688381
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688381
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Managing document permissions

By default, all documents created in a project (e.g. Bills, SIs, draft amendments, official amendment lists) are visible to and editable by all 

users in the same organisation as the user who created the document. When you create a project, the first document that is automatically 

created in that project will, in the same way, be visible to all users in your organisation.

Projects do not have separate permissions of their own. Instead, who can see and access a project (on the Dashboard) is determined by the 

documents inside the project. If there is at least one document in the project that a user has access to then the user will be able to see the 

project on their dashboard. 

You can restrict access to documents on the Project Tab (e.g. Bills, SIs, Finance Bill resolution documents) so that only specific users in 

your organisation can view or edit them. At the moment you can’t restrict access to draft amendments or official amendment lists. 

 

How to restrict permissions when creating a new project

You can restrict access to the first document in a new project (and therefore access to the project itself) at the time of creating the project:

1. Click on the +New button on the dashboard.

2. Fill in the mandatory new project information.

3. Click on the Manage Permissions button.

4. Select Only specific users in my organisation to over-ride the default permissions.

5. Select users from your organisation that you want to restrict the document to.

6. Click on the Update button.

7. When you click on Create a project will be created but only the selected users will be able to see it on the dashboard and access the document in it.

How to restrict permissions when creating a new document within a project
1. Click on the +New button on the 'Project' tab

2. Fill in the mandatory new document information

3. Click on the Manage Permissions button

4. Select Only specific users in my organisation to over-ride the default permissions.

5. Select users from your organisation that you want to restrict the document to.

6. Click on the Update button.

7. Click on the Create button.
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How to restrict permissions when uploading a document within a project
1. Click on the +Upload Document button on the dashboard

2. Fill in the mandatory new document information

3. Click on the Manage Permissions button

4. Select Only specific users in my organisation to over-ride the default permissions.

5. Select users from your organisation that you want to restrict the document to.

6. Click on the Update button.

7. Click on the Upload button.

How to change permissions on an existing document
1. On the Project Tab, select Actions > Manage permissions on the document you want to update.

2. Select the appropriate radio button or add/remove user names as required.

3. Click on the Update button.

Duplicating a document and copying a document to another project will  retain the existing document permissions. 

If you share a document with another organisation, all users in that organisation will be able to view the read-only significant version that is 

created.  Additionally, all users in your organisation will be able to view the significant version, even if the original working version had 

restricted access.

If you update the permissions to a document this may affect who can see and access the project.

A Document Administrator in an organisation can view all documents created by users in their organisation.  However they will not be able to 

edit documents with restricted permissions unless they are named as an editor of that document.
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Sharing a document with another organisation

You can share a document with another organisation. When you share a document, Lawmaker creates a read-only significant version which 

can be seen by users in the organisation it was shared with and users in your organisation. Users in the other organisation will not get 

access to your working version or to changes you make after the document is shared.

Sharing a document can be useful for:

review purposes,

handing over ownership of a document, e.g. for introduction in Parliament or handing over an SI for processing by the departmental Parly Clerks.  

How to share a document
1. On the Project Tab, select Actions > Share version on the document version you would like to share.

2. Select the organisation you want to share it with and then click on Share.

The system will create a Significant Version which will appear on the right-hand side of the ‘Project’ tab with read only access to users from 

the other organisation

 

Hints and tips

The Significant Version becomes read only to all users with access to it to maintain the integrity of the version that was shared.

Users from the organisation will only be able to see the Significant Version of the document – they will not be able to see the working version 

or any of its snapshot versions.

When you share a document, a snapshot version is created in the same series as the working version that you shared, only visible to users 

with access to the working version.

The default organisation in the drop-down list will be set to the last organisation that you shared a document with.
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Publishing a Bill document version

Publishing a Bill on Lawmaker does several things:

It makes a copy of the Bill (XML and PDF) available via the API so that other systems, e.g. a Parliament’s website publishing system, can pick it up 

and use it.

It marks the particular version of the Bill as one that can be used in Lawmaker for an amending stage.

It creates a significant version of the Bill that is available on the Project Tab to users in all organisations

Before a Bill can be published, you need to generate a PDF snapshot of the Bill - see Generating and viewing a PDF  .

How to publish a Bill
1. If you haven’t already, generate a PDF of the Bill you want to publish.

2. From the Project Tab, click on the toggle next to the working version that you wish to publish to expand the view to show the  snapshot versions 

underneath

3. Find the PDF snapshot that will be used for publishing and select Publish version from the drop-down menu

4. The system will present a warning message, making sure you have selected the right PDF to mark as having been published

5. Select Publish button to publish the chosen bill version associated to the PDF

The system will:

create a significant version with the label “Published”. The significant version will be visible to all users in the system and will contain both the PDF 

and XML version of the the bill.

create a snapshot version in the relevant working document’s version series.

 

There is currently no direct link from publishing a Bill in Lawmaker to publishing a Bill on the Scottish Parliament’s website. See 

Publishing a Scottish Bill    for more information on the current process. 

See  Publishing bills  for more information on publishing a UK Bill.

Hints and tips

All other users of the system can view the significant version produced. 

Other users will be able to open the bill version in the Editor (in read-only format), view the PDF, generate their own PDF (if they wanted to 

select different presentation options), download a zip file containing the PDF and bill XML or generate a duplicate version.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688371
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688371
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688371
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
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Finalising a document

You can carry out a number of operations on a document in one go using the Finalise document feature.  Especially for larger document, it 

will be faster and more convenient that doing each of the operations separately in the Editor. 

 

How to finalise a document
1. On the Project Tab, click on Actions>Finalise document on the working version you want to finalise.

2. Select the actions you want to perform on the document.

3. Click Update and wait for the success message when the operation is completed.

The selected operations are run in the order they appear in the dialogue box (Renumber, update x-refs, insert front and back covers).

In terms of the specific operations:

Renumber will renumber all provisions in the document, including  provisions in quoted structures.

Update x-refs will check all existing cross references in the document and update them accordingly - including those within quoted structures.

Insert Front Cover includes inserting the table of contents. Any existing cover will be replaced.

Insert Table of Contents only will overwrite existing any table of contents if there is one but will leave other parts of the front cover as they are.

You can’t finalise a document if it or any provisions within it are locked.

If any of the individual operations fail, an error will be displayed. However, all changes up to that point will be saved.

See also: 

Renumbering provisions  

Cross-references (x-refs) ARCHIVED  

Inserting UK Bill and Act front and back covers  

Inserting Scottish Bill and Act front and back covers  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/l/cp/JzXZWN5Y
https://lawmaker.atlassian.net/l/cp/JzXZWN5Y
https://lawmaker.atlassian.net/l/cp/JzXZWN5Y
https://lawmaker.atlassian.net/l/cp/JzXZWN5Y
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349


37

Drafting and editing

In this section

Opening a document in the Editor

Opening and editing a portion of document

Working with the Editor

Inserting, modifying and deleting provisions

Moving provisions, tables and amendments within a document

Numbering

References

Quoted structures

Quoted Text

Saving your document

Using cut, copy and paste

Smart paste

Document checks - validating your document

Managing document information

Inserting and managing tables

Inserting table of contents

Inserting front and back covers

Inserting and managing math formulae

Images

Inserting symbols and special characters

Inserting page breaks

Adding formatting to text (bold, italic, superscript etc.)

Copying provisions between documents - push/pull

Managing footnotes

Managing J-refs

Using tracked changes

Managing origin information

Multi-user editing and locks

Import legislation from www.legislation.gov.uk

How to draft and edit documents using the XML editor built into Lawmaker.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688387/Opening+a+document+in+the+Editor
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223/Opening+and+editing+a+portion+of+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371669/Working+with+the+Editor
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688768/Inserting+modifying+and+deleting+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339163/Moving+provisions+tables+and+amendments+within+a+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688838/Numbering
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522/References
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075/Quoted+structures
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522059778/Quoted+Text
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659/Saving+your+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267/Using+cut+copy+and+paste
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339283/Smart+paste
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339341/Document+checks+-+validating+your+document
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688308/Managing+document+information
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057/Inserting+and+managing+tables
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317/Inserting+table+of+contents
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/61276169/Inserting+front+and+back+covers
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339049/Inserting+and+managing+math+formulae
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339041/Images
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339085/Inserting+symbols+and+special+characters
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60948495/Inserting+page+breaks
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339259/Adding+formatting+to+text+bold+italic+superscript+etc.
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338989/Copying+provisions+between+documents+-+push+pull
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339113/Managing+footnotes
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123/Managing+J-refs
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339333/Using+tracked+changes
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339131/Managing+origin+information
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/8945675/Multi-user+editing+and+locks
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/186941441/Import+legislation+from+www.legislation.gov.uk
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Opening a document in the Editor

Introduction

To open a document in the Editor, you will need to be on the Project Tab.

When you open a document it will open in a new tab or window.  Working versions are opened in read/write mode; if you open a snapshot 

version or a significant version, it will open read-only.

How to open a document in the Editor
1. On the project tab, click on the Open icon on the version you want to open. The icon depends on whether you can edit the document or just view it. 

See below.

2. The system will load the Editor and display the selected document version in read only or editable format depending on the document-level 

permissions:

 

 

As well as opening the whole document, you can edit smaller portions of the document which will be faster - see Opening and ed

iting a portion of document  .

Open the document read-only

Open the document with read/write access for editing

You can switch back to the Project Tab when you have a document open without losing what you are working on because it will be in a 

different tab.

The bill is presented in a similar format to printed bills but without any page-related furniture (e.g. page numbers, running headers) or print 

layout (page width and page breaks)

You can open more than one document at the same time; each will be in a separate tab.

You can open the same document in more than one tab but you will only be able to edit the document in the first tab. Subsequent versions 

will be opened in read only format to avoid confusion when editing  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
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Opening and editing a portion of document

Sometimes you might only need to update a single provision or a subset of provisions in a document.  Or sometimes you might be working 

with other drafters in the same bill and only want to update the provisions that you are responsible for.  Or sometimes the bill might be so 

large, that opening up the whole document creates performance issues.  To address these various needs, we have made it possible to edit 

a portion of the document without needing to open the whole document

You can open one or more of the following types of provisions:

1. Parts

2. Chapters

3. Cross-headings

4. Sections/clauses

5. Regulations/articles/rules

6. Schedules

7. Schedule Parts

8. Schedule Chapters

9. Schedule cross-headings

How to edit a portion of a document

Schedules created before version 17 was released (August 2024) are not automatically fragmented to the grouping level - you will 

only be able to edit the whole schedule as a portion. However, as soon as the document containing the schedule is saved again, all 

schedules in the document will be fragmented at the grouping level and you will be able to edit individual Parts etc. of a schedule.

1. From the Project Tab, click on the Actions menu for the working version you want to edit.

2. Select Edit portion of document.

3. In the dialogue box, select the provisions you wish to edit. 

4. Click on the Edit button to open the selected provisions in the Editor.
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Selecting provisions to open

The dialogue box will show a list of all provisions in the document, e.g. Parts, Chapters, sections, articles, schedules etc.

You can select one or more provisions and they don’t need to be next to each other. All selected provisions must be at the same level so, for 

example, you can select a number of different sections dotted around a Bill, or you could select a couple of different Parts of an SI but you 

can’t select a cross-heading group and an individual section in a Bill.

If you’ve previously edited a portion of the document then provisions you edited will be selected by default.

Working in the Editor with a portion of a document

When you open a portion of the document in the Editor, the highest level provisions e.g. sections, regulations or Parts, will have their 

numbers locked so that when you renumber the document, they do not get automatically updated.  You can manually change these 

numbers if necessary but you will need to renumber the whole document if provisions not in your portion are going to be affected by these 

number changes.

The renumber feature will only renumber provisions in the portion, even if “whole document” is selected.

The Tag x-refs and Update x-refs features will only tag/update references within the portion of the document but will search the whole 

document for the target provisions, not just the portion - see References  .

If you still you already have locks on provisions in the document you are selecting, you will be forced to open these provisions so 

that you can save any detected unsaved changes from a previous editing session.  As soon as the locks are released (upon Save) 

you can go back and open a smaller portion if desired.

See Opening a document in the Editor  for more about opening the whole document rather than a portion.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688387
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688387
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Working with the Editor

This section covers the basic functionality of the Editor including the structure view.

Pages in this section

Folding provisions

Viewing tags

Using find and replace

Using spellchecker

Using the structure view

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339033/Folding+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339349/Viewing+tags
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339275/Using+find+and+replace
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339295/Using+spellchecker
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303/Using+the+structure+view
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Folding provisions

You can collapse and expand provisions in the Editor which can make it easier to work on specific provisions without being distracted by 

others and can help with performance.  In Lawmaker this is called “folding”.

When you first open a document, all provisions will be unfolded but you can quickly fold all provisions if you want.

Provisions than can be folded are shown in the Editor with a small triangle to their left. The provisions that can be folded are:

In Bills, sections and schedule paragraphs. When these are folded, you’ll still be able to see the section number and heading but not any of the 

content.

In SIs, regulations/articles/rules and schedule paragraphs. When these are folded, you’ll still be able to see the regulation etc. heading and number 

but not any of the content.

In amendment lists, any quoted structure within an amendment . When these are folded, you’ll just see (folded) instead of the quoted structure 

content

How to fold all provisions or expand all provisions

You can use the buttons in the toolbar to quickly collapse all provisions or expand them all.

 

The highlighted button on the left expands all provisions

The highlighted button on the right folds/collapses all provisions (other than the provision containing your cursor)

How to fold or expand particular provisions

Click on the small triangle to the left of the provision to fold or expand the provision depending on its current state, e.g.
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Viewing tags

You can control whether XML tags are visible in the Editor and, if so, how they are displayed.

Showing block tags can be useful if you want to do some paste or insert operations where the location of your cursor is important, e.g., 

when pasting or inserting a provision before the first provision in the series.

How to change the XML tag mode.

Select Document>Preferences… from the upper tool bar to bring up the preferences dialogue box.

You can then select how you want the XML tags to be displayed using the Tags display mode drop down menu. The options are:

No Tags: displays no tags in the Editor leaving it as close to a word-processor view as possible.

Partial Tags: displays simple tags without names for inline elements, while block elements are not displayed. 

Inline Tags: to display full tag names for inline elements, while block elements are not displayed.

Block Tags: to display full tag names for block elements and simple tags without names for inline elements

Full Tags: to display full tag names without attributes for both block and inline elements

Full Tags with Attributes: to display full tag names with attributes for both block and inline elements

 

 

The distinction between “inline” and “block” elements hasn’t been fully configured in Lawmaker so you may not see tags on all the 

elements you are expecting when using the following modes: Partial Tags, Inline Tags and Block Tags.
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Using find and replace

The Editor includes a find & replace function which allows you to find and replace content in the current document. 

 

How to find or replace text in your document
1. Click on Edit>Find in the upper toolbar or use the Ctrl + F keyboard shortcut to bring up the Find and Replace dialogue box.

2. Type the text that you want to find into the Search for field.

3. If you want to replace the found text, then enter the replacement text in the Replace with field.

The number of results that are found in the document are shown on the right side in this field and each match is also highlighted in the 

editor. The highlights for the results in the editor are persistent while the Find/Replace window is open. When you close the window, the 

highlights disappear. 

To replace text one occurrence at a time, Use the Find Next or Find Previous buttons (the up and down arrows) to go to the occurrence you 

want (you can also use the down arrow and up arrow on your keyboard) and click Replace.

To replace all text in one go, click Replace All. 

Selecting the Match case option will result in the find operation only finding results that match the search text and have the same letter 

case. 

Selecting the Whole words option will result in the find operation only finding results which are whole words and match the search text. 

 

 

Hints and tips

The ‘Find/Replace’ pop-up window can be moved by clicking on the grey banner at the top and moving it to your desired location.  It is also 

resizable by clicking on the bottom-right corner and resizing it according to your preferred view. 

If you select text in the editor and then open the Find/Replace dialogue box, the Search for field will automatically be populated with the 

selected text. 

The Match case and Whole words options are persistent in your current editing session, so will be remembered if you close the 

Find/Replace dialogue box and reopen it later.
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Using spellchecker

The Editor includes an as-you-type spell checking feature as well as a manual spell checking action to open a Spelling dialogue box.

How to manually spellcheck your document

Click on F7 to open the Spelling dialogue box.

 

The first identified misspelled word will be displayed with a suggested word to replace it with.

You can leave the suggestion or select a different one from the list of Suggestions under the 'Replace with' word.

You can:

Replace this word by clicking on the Replace button,

Replace all occurrences of the word in the document (starting from the cursor's position to the end of the document) using the Replace All button,

Ignore the first occurrence of the unrecognised word by clicking on the Ignore button, and

Ignore all instances of the unrecognised word in the document by clicking on the Ignore All button.

 

Hints and tips

You can change the size of the Spelling dialogue box by clicking on the bottom right corner of the box and dragging it to your 

preferred size.

The Ignore and Ignore all options will only work whilst you have the document open.  If you close the document and reopen, the 

ignored words will appear again in the spelling dialogue box again,(similar to the behaviour in Microsoft Word).  
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Using the structure view

The structure view provides an outline of the provisions or amendments in your document.  Within provisions or amendments, you can drill-

down to lower level provisions including provisions within quoted structures.

The structure view also shows the lock status of individual provisions and amendments.

By clicking or right-clicking on an item in the structure view you can perform a variety of actions.

Controlling what you can see in the structure view

A - Toggle between limited and full-depth structure view

Click on this to toggle between the two views:

Single arrow - limited depth where only individual sections/regulations/articles etc. are shown together with grouping levels such as Parts and 

Chapters. Schedules and the grouping levels within them are also shown.

Double arrow - full depth where every provision can be viewed including subsections and paragraphs and provisions within quoted structures.

B - Turn the structure view on and off

Clicking on this switch will turn off the structure view entirely (it can be turned back on any time). Switching off the structure should improve 

performance of the Editor when working with large documents.

C - Reset structure view

Click on the reset button at the top of the structure view to reset the levels that are shown.

For a Bill or SI, this means the structure view will show the same levels that are visible in the table of contents, e.g. Parts, Chapters, cross-headings, 

sections/regulations, schedules.

For an amendment list, it will show an entry for each amendment.

D - Toggle provision

Click on the arrow to the left of any provision to show or hide the child provisions within that provision, e..g to show the subsections within a 

section. What is visible will depend on whether the limited or full-depth structure view is showing.
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E - Change width of structure view

You can drag this handle to increase or reduce the width of the structure view.

Clicking on the handle will minimise the structure view (not that minimising it doesn’t switch it off). Clicking on it again will expand it to its 

default width.

Using the structure view to navigate around your document

Clicking on any provision in the structure view will make the Editor jump to that provision and select it.

If you select a higher-level provision it will automatically select all its descendants

 

The provision containing your cursor in the Editor will be highlighted with black text

Selecting more than one provision

To select one or more provisions using the structure view hold down the Ctrl key while clicking on the provisions you want to select one by 

one.

The selected provisions will be highlighted in the structure view to show that they have been selected. 

You can only select provisions which are next to one another and of the same kind.

Locking and the structure view

The structure view shows information about the lock status of individual provisions and amendments

If another user is editing the same document as you, a black padlock will appear against the provision(s) they are working on, signalling that the 

provisions are locked and you cannot edit them. Hovering the mouse  over the padlock icons will reveal a tool tip explaining who has the lock and 

since when.

If you are editing the document,  a pencil icon will appear against the provision(s) you have edited to indicate that you are editing them and have a 

lock on them.

When you insert a new provision such as a section or regulation, an asterisk appears against it.

Right-click actions from the structure view

You can right click on a provision in the structure view to:
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Copy an x-ref - see References   

Wrap the provision (or provisions) - see Wrapping and unwrapping provisions  

Cut or copy the provision - see Using cut, copy and paste  

Convert it to a schedule or vice versa - see Converting provisions to a schedule and vice versa  

Tag or update cross-references - see References  

Show or hide j-refs - see Managing J-refs  

Renumber provisions - see Renumbering provisions  

Mark a provision as a money provision - see Marking 'money provisions'  

Moving provisions or amendments using the structure view

 see Moving provisions, tables and amendments within a document  

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338981
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338981
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339139
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339139
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339163
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339163
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Inserting, modifying and deleting provisions

This section covers the features of the Editor you use to create and modify provisions within your document.

Pages in this section

Inserting provisions and other elements

Deleting provisions and other elements

Wrapping and unwrapping provisions

Promoting and demoting provisions

Splitting and merging provisions

Converting provisions to a schedule and vice versa

 

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065/Inserting+provisions+and+other+elements
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339025/Deleting+provisions+and+other+elements
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357/Wrapping+and+unwrapping+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171/Promoting+and+demoting+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339235/Splitting+and+merging+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338981/Converting+provisions+to+a+schedule+and+vice+versa
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Inserting provisions and other elements

The Editor uses the Content Completion Assistant (CCA) to help you insert provisions and other elements into your document. It ensures 

that what you insert is valid in terms of document structure and the underlying XML.

The CCA offers a list of provisions and other elements that are valid at your cursor’s location and will insert your selected provision in the 

next correct place in the document.

How to insert a provision using the Content Completion Assistant (CCA)

To insert a provision:

1. Press Enter to activate the CCA.

2. Select the provision you wish to insert. You can use the up and down arrow keys or your mouse or you can start typing the name of the provision you 

want.

3. Press Enter again.

The selected provision/element will be inserted in the next correct place, e.g. if your cursor is within a paragraph of a Regulation and you 

select “Regulation” from the CCA then a new Regulation will be inserted after the current Regulation.

When you insert a provision, default child elements within the provision like the number and heading are also inserted.

Your cursor will move into the provision that is inserted.

(You can also bring up the CCA by using the Insert element… option in the right-click context menu or in the toolbar, Insert menu>Insert 

element….)

How to insert next default provision

You can quickly insert the next default provision for the context your cursor is in by pressing Ctrl+Enter.

The provision that will be inserted in the provision that would appear at the top of the CCA had you pressed Enter. This will generally be the 

same provision as the one your cursor is in with the exception of when your cursor is a heading, opening words or closing words.

How to insert an additional text paragraph within a provision

You can insert an additional paragraph of text within a provision by using the keyboard shortcut Shift+Enter.

Note on the ordering and contents of the CCA

The CCA will show all the valid sibling elements and valid child elements that you can insert.

A sibling element is an element that will be inserted after the current element your cursor is in. For example, if your cursor is in a subsection 

then a sibling would be another subsection. Or if your cursor was in the opening words of a paragraph then a sibling would be a sub-

paragraph.

Heading of grouping element (e.g. Part, Chapter, cross-heading) Section if in a Bill; regulation/article etc. if in an SI/SSI

Heading of a section in a Bill Subsection

Schedule heading Cross-heading

Any other provision (e.g. subsection, paragraph etc.) The same provision

When your cursor is in This provision will be inserted
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A child element is an element that will be inserted within the current element your cursor is in. For example, if your cursor is in a subsection 

then a child would be a paragraph, definition or step.

The CCA shows options in the following order:

First, the valid siblings of the immediate provision your cursor is in.

Then the valid children of the provision your cursor is in.

Last, the valid siblings of each ancestor above the provision your cursor is in.

So, for example, if your cursor is in a subsection within a Bill, the CCA might look like:

In this case:

The valid sibling of the provision your cursor is in is Subsection (1).

The valid children are: Paragraph (a), Definition, Step, Heading, Unnumbered Paragraph.

The valid siblings of ancestors of the provision are: Section, Cross heading, Part.

Numbering of inserted provisions

See Numbering  for more on how provisions are numbered when they are inserted.

Inserting elements in the preface

If you need to insert an element in the preface (e.g. to insert a ‘note’ at the top of a Bill e.g. for Money bill rubrics), the simplest way is as 

follows:

1. Open the Preferences by selecting  Document>Preferences… in the upper toolbar menu.

2. Turn on block tags mode by selecting Block tags in the Tags display mode dropdown menu.  This will present XML tags in the Editor.

3. Place your cursor within the Preface tags but not within any child elements inside the preface. 

4. Press Enter and select the element you want to insert (e.g. Note).

5. Return the display mode to normal by selecting No Tags in the Preferences… dialogue box.

Automatic conversions and insertions

In some cases, when you insert a particular element, Lawmaker will automatically convert an existing element or insert an extra element to 

ensure the document remains correctly structured and formatted.

In particular:

When you insert a subsection into a section in a Bill (that isn’t currently divided), the existing content of the section will be converted into the first 

subsection of the section.

When you insert a paragraph into a Regulation or Article etc. into an SI/SSI (that isn’t currently divided), the existing content of the regulation etc. will 

be converted into the first paragraph.

When you insert a schedule subparagraph into a schedule paragraph (that isn’t currently divided), the existing content of the schedule paragraph will 

be converted into the first schedule subparagraph.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688838
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688838
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When you insert a second schedule into a UK Bill or an SI/SSI, a ‘SCHEDULES’ heading will be inserted before the first schedule.

 

Screencasts

 

 

Hints and tips

When you insert a section into a Bill, it will contain a subsection by default. If you want an undivided section, you can use the promote 

function to remove the subsection - see Promoting and demoting provisions

When you insert an article, regulation, or rule into an SI/SSI, it will be undivided by default. You can insert paragraphs and sub-paragraphs 

using the CCA. 

To insert a provision before the first provision in the series, it is sometimes useful to ‘view block tags’ (from Document>Preferences… in the 

toolbar menu) and place the cursor before the starting tag of the first provision in the series. From here you can use the CCA to insert the 

provision at the beginning of the series.

The combined numbering format used by SI/SSIs will happen automatically when you insert a child provision into the parent, e.g. inserting a 

sub-paragraph (i) into the first paragraph (a) – will become: (a)  (i)  sub-paragraph text here.

It is possible to insert a bulleted list into your documents (bills & SIs). If you right-click on the bullet point and select ‘Update List Style’ you 

can change the bullet point to an em-dash list or no bullet point.

Creating an SI SSI and drafting provisions

Created by Legislation Drafting Amending and Publishing Project • Updated on 25 M…

This screencast covers: - Creating a new SI/SSI - Inserting provisions (including definitions and
combined numbering) - Deleting provisions - Copy/cut & paste - Promote/demote -
Wrap/unwrap - Drag & drop

YouTube Open preview

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://www.youtube.com/watch?v=JWBAOaGSXUE
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Deleting provisions and other elements

You can delete whole provisions and other elements like tables if they are no longer required.

How to delete a provision

Select the provision (e.g. a paragraph) that you want to delete by:

Clicking on the provision in the breadcrumb, or

Clicking on the provision(s) in the structure view (multi-select provisions from the structure view using Ctrl+mouse click to select more than one 

provisions).

You can also select provisions by dragging  the mouse over the provision(s) that you want to select but this method can be unreliable and 

you need to be careful to select the whole provision including any number or heading if using this method.

Once selected, press the Backspace key to delete the provision. The selected provision (and any descendent provisions) will be deleted, 

e.g., if you delete a subsection then any paragraphs within the subsection will also be deleted.

When you click on the provision either in the structure view or from the breadcrumb, it will highlight the provision in the Editor, including any 

descendent provisions, so that you can see exactly what will be removed before you press Backspace.

How to delete a table

Delete tables using the breadcrumb method only.  Select the table element (to the left of the foreign element) in the breadcrumb and press 

Backspace to completely remove the table.

 

 

Hints and tips

You can undo and redo a delete by using the undo button or keyboard shortcut Ctrl+z and Ctrl+y respectively.

You can delete individual elements within a provision, e.g. a num or heading element, by clicking on the individual element in the 

breadcrumb (first place your cursor in the element in the Editor) and pressing Backspace.  This will delete only the selected 

element but leave behind the rest of the provision. However, the exception to this rule are num elements in subsections and 

schedule sub-paragraphs.  Lawmaker prevents the deletion of those.
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Wrapping and unwrapping provisions

To insert a Part, Chapter or other “grouping” level around existing provisions like sections, you need to use the wrap function.

To remove a Part, Chapter or other “grouping” level without removing the provisions within the Part etc., you use the unwrap function.

How to wrap a provision

To wrap one or more provisions:

1. Select the provisions you want to wrap

2. Either:

right-click within the selected provisions in the structure view or the Editor and select Wrap element…,

from the toolbar select Tools>Wrap element… or

use the keyboard shortcut Alt+w.

3. Select from the menu that appears the element (e.g. Part) that you want to wrap the provisions with.

Selecting provisions to wrap

To select the provisions you want you can either:

Select the provisions in the structure view - see Using the structure view . 

Highlight the provisions in the Editor by dragging your cursor from the beginning to the end of them (or vice versa).

How to unwrap provisions

To unwrap provisions do one of the following:

Right-click on the grouping level provision you want to remove in the Structure view and select Unwrap element.

Right-click on the provisions in the Editor and select Unwrap element.

Use the keyboard shortcut Alt+e.

This will remove the grouping level provision but not the content within it, e.g. if you unwrap a Part then the Part will be deleted, but not any 

sections within the Part.

When you unwrap a provision, Lawmaker will move the existing contents of that provision into another sibling provision if it exists so as to 

maintain a valid document structure:

If the unwrapped provision was the first of its kind, its contents will be moved to the next provision of the same kind, e.g. if you unwrap the first Part in 

a document, then the contents of that Part will be moved to the beginning of what was the second Part.

if the unwrapped provision was the second or later one of its kind, its contents will be moved into the previous provision of the same kind, e.g. if you 

unwrap the last Chapter within a Part then the contents of that Chapter will be moved to the end of the previous Chapter.

Lawmaker will only show the elements that you can validly wrap the selection in. This will depend on the document type and the provisions 

you have selected but can also depend on the parent provisions, e.g. you can only wrap provisions in a Chapter if they are already within a 

Part. You can’t wrap provisions in an element they are already wrapped with, e.g. provisions already within a cross-heading cannot be 

wrapped in a cross-heading.

To wrap provisions, Lawmaker will take a lock on the parent of those provisions. If it can’t get a lock (because someone else is editing the 

parent) then you won’t be able to complete the wrap operation.

It is possible sometimes by unwrapping a specific provision to create an invalid document structure, e.g. in some cases by 

unwrapping a Part that contains Chapters. You will see a warning about this in the Document Checks panel. To fix the issue, you 

may need to unwrap further provisions.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
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Wrap options

The following tables summarise the wrap options dependent on your selection.

Bills and Acts

SIs and SSIs

Provisions that can be unwrapped

You can unwrap the following provisions:

Group of Parts

Part

Chapter

Section (SI/SSIs only)

Sub-section (SI/SSIs only)

Cross-heading

Part Group of Parts

Chapter Part

Cross heading Part, Chapter

Section Part, Chapter, Cross heading

Schedule 

paragraph

Part, Chapter, Cross heading

Selected 

provision(s)

Wrap option (depending on context)

Part Group of parts

Chapter Part

Section Part, Chapter

Sub-section Part, Chapter, Section

Cross heading Part, Chapter, Section, Sub-section

Regulation (or 

article etc.)

Part, Chapter, Section. Sub-section, Cross-heading

Schedule 

paragraph

Part, Chapter, Section, Sub-section, Cross-heading

Selected 

provisions(s)

Wrap option (depending on context)
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Promoting and demoting provisions

You can change a provision into another type of provision using promote and demote. If you want to change it into the next logical provision 

up a level, you promote it, e.g. changing a subsection into a section; if you want to move it down a level, you demote it e.g. changing a 

paragraph into a sub-paragraph.  This is designed to be a quick way of changing a provision into a new type if required - the function is only 

available for certain provisions.

How to promote a provision

How to demote a provision

Place your cursor anywhere in the provision you wish to promote (e.g. in the num, heading or text element) and do one of the following:

use keyboard shortcut, press Alt+[ ,

from the right-click context menu in the Editor or Structure view, select Promote element, or

from the upper toolbar, select Tools>Promote element.

The selected provision will be promoted into the next valid provision.

When you promote a provision that has child elements (e.g. a paragraph containing sub-paragraphs), the child elements will also be 

promoted if it would be logical to do so (definitions and steps will stay the same).

Promoting the last in a list of paragraphs, sub-paragraphs or sub-sub-paragraphs will convert the provision into closing words as the first 

step, and then into the next provision up in the hierarchy as the second step.

Promoting the only subsection in a section or only paragraph in a Regulation or Article etc. (i.e. a provision with the number format (1)) is a 

quick way of removing the subsection/paragraph so you have an undivided section/regulation etc.

Provision types that can be promoted are: Bill subsections, SI paragraphs, paragraphs, sub-paragraphs, sub-sub-paragraphs, definitions 

and steps, and schedule sub-paragraphs. 

Place your cursor anywhere in the provision you wish to demote and;

using keyboard shortcut, click Alt+] ,

from the right-click context menu, select Demote element,

from upper toolbar, select Tools>Demote element.

The selected provision will be demoted into the next valid provision. Lawmaker uses the context of the provision to work out whether it can 

be promoted and what to - that means that the feature can’t be used at the moment on the first provision in a quoted structure because 

there is no context.

When you demote a provision that has child elements (e.g. a paragraph containing sub-paragraphs), the child elements will also be 

demoted if it would be logical to do so (definitions and steps will stay the same).

Demote works for subsections, schedule sub-paragraphs, paragraphs and sub-paragraphs as long as there is another element of the same 

kind before it to ‘adopt’ the demoted provision as its child.

You can demote section/regulation text (into subsection/paragraph (1)), paragraphs, sub-paragraphs, definitions and steps, schedule 

paragraph text and schedule sub-paragraphs

The right-click context menu will show spelling suggestions as a priority if you right-click on a word which isn’t recognised (with red 

wavy underscore).  In this instance, select Other actions in the menu to continue navigating to promote or demote element

Only valid provisions/elements can be demoted or promoted.  If you select a provision/element that isn’t valid, the Editor will present 

an error message
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See Promotion rules  and Demotion rules    for promotion and demotion rules which are dependent on the context/ancestry 

of the provision

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526917
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526917
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559090
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559090
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Demotion rules

These are the detailed rules that govern how the demote function works in Bills, Acts and SI/SSIs. See Promoting and demoting provisio

ns  for general help.

Bills and Acts

SI/SSIs

Subsection or

Schedule subparagraph

Definition

Step

There is a sibling of the 

same kind immediately 

before the provision and

Contains no sub-sub-

paragraph child elements

Provision will be ‘demoted’ into a paragraph, 

copying over any text

If the provision had child elements, they will 

remain child elements with the following 

additional change:

Sub-paragraphs will be converted ‘down’ a 

single level

Paragraph Provision will be ‘demoted’ into a sub-

paragraph, copying over any text

If the paragraph had any child elements, these 

will remain child elements with the exception 

that a sub-paragraph would be converted to a 

sub-sub-paragraph

Sub-paragraph Provision will be ‘demoted’ into a sub-sub-

paragraph, copying over any text

Closing words Provision will be ‘demoted’ into a sibling of the 

provision immediately before the closing words, 

copying over any text.

Provision Conditions Rule

Paragraphs with 

numbering 

format (1) or

Schedule 

subparagraph

Definition

Step

There is a sibling of the 

same kind immediately 

before the provision and

Contains no paragraph child 

elements with number 

format (aa)

Provision will be ‘demoted’ into a paragraph with the numbering format (a), copying over any 

text

If the provision had child elements, they will remain child elements with the following additional 

change:

Lower level paragraphs with numbering format (i) will be converted ‘down’ a single level 

unless they are children of a child definition or step

Paragraphs with 

the numbering 

format (a)

Provision will be ‘demoted’ into a paragraph with the numbering format (ii), copying over any 

text

If the paragraph had any child elements, these will remain child elements with the exception 

that a paragraph with the numbering format (i) would be converted to a paragraph with the 

numbering format (aa) unless they are children of a child definition or step 

Paragraphs with 

the numbering 

Provision will be ‘demoted’ into a paragraph with numbering format (aa), copying over any text

Provision Conditions Rule

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
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format (i)

Closing words Provision will be ‘demoted’ into a sibling of the provision immediately before the closing words, 

copying over any text.

Bullet lists there is a sibling of the same 

kind immediately before the 

bullet list being demoted

The bullet list item and all its child bullet list items will be demoted to become a bullet list at the 

level down

Paragraph lists 

in Explanatory 

notes and 

Preamble

there is a sibling of the same 

kind immediately before the 

provision and

Contains no paragraph child 

elements with number 

format (aa)

The paragraph list item and all its child paragraph list items will be demoted to become a 

paragraph list at the level below – converting the numbering e.g. from (a) to (i) and (i) to (aa)
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Promotion rules

These are the detailed rules that govern how the promote function works in Bills, Acts and SI/SSIs. See Promoting and demoting provisi

ons  for general help.

Bills and Acts

Paragraph

Sub-paragraph

Sub-sub-

paragraph

Definition or 

Step

where there is only one of 

its kind; and

the parent isn’t a section 

or a schedule paragraph 

or step

Provision will be ‘promoted’ into a sibling of its parent provision, copying over any text

If the provision had child elements, they will remain child elements with the following additional 

change:

Sub-paragraphs and sub-sub-paragraphs will be converted ‘up’ a single level unless they are 

children of a child definition

Paragraph

Sub-paragraph

Sub-sub-

paragraph

Definition or 

Step

where the provision is not 

the last child of its kind

Provision will be ‘promoted’ into a sibling of the parent provision, copying over any text.

Any sibling provisions to the ‘promoted’ provision will now become child provisions to the newly 

‘promoted’ provision

Paragraph

Sub-paragraph

Sub-sub-

paragraph

Definition or 

Step

where it is the last child of 

its parent; and

there is more than one of 

its kind

Provision will be ‘promoted’ into the closing words of the parent provision, copying over any text.

If the provision had child elements, it will be promoted into a sibling of its parent provision, copying 

over any text and keeping the child elements with the following additional change:

Sub-paragraphs and sub-sub-paragraphs will be converted ‘up’ a single level unless they are 

children of a child definition or step

Closing words The provision’s parent 

isn’t section or schedule 

paragraph

Closing words will be ‘promoted’ into a sibling of the parent provision, copying over any text

Schedule 

subparagraph

where there is only one of 

its kind

Schedule subparagraph will become the schedule paragraph’s content, copying over any text

If the schedule sub-paragraph had child elements, they will remain child elements with no change 

in element type.

Subsection where there is only one of 

its kind

The subsection will become the section’s content, copying over any text

If the subsection had child elements, they will remain child elements with no change in element 

type.

Subsection where the provision is not 

the first or last child of its 

kind

A section will be created with a subsection.  The subsection will contain the promoted subsection’s 

content and the heading of the section will be left blank

If the subsection had child elements, they will remain child elements with no change in element 

type.

Provision Conditions Rule

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
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SI/SSIs

Schedule sub-

paragraph

where the provision is not 

the first or last child of its 

kind

Schedule subparagraph will be ‘promoted’ into a sibling of the parent schedule paragraph, copying 

over any text

Any sibling schedule sub-paragraphs to the ‘promoted’ provision will now become child schedule 

sub-paragraphs to the newly ‘promoted’ provision

Paragraphs with 

numbering format 

(a), (i) or (aa)

Definition or 

Step

where there is only one of 

its kind; and

the parent isn’t a regulation 

(or article etc.) or a 

schedule paragraph

Provision will be ‘promoted’ into a sibling of its parent provision, copying over any text

If the provision had child elements, they will remain child elements with the following 

additional change:

Lower level paragraphs with numbering format (i) and/or (aa) will be converted ‘up’ a 

single level unless they are children of a child definition or step

Paragraphs with 

numbering format 

(a), (i) or (aa)

Definition or 

Step

where the provision is not 

the last child of its kind

Provision will be ‘promoted’ into a sibling of its parent provision, copying over any text.

Any sibling provisions to the ‘promoted’ provision will now become child provisions to the 

newly ‘promoted’ provision

Paragraphs with 

numbering format 

(a), (i) or (aa)

Definition or 

Step

where it is the last child of 

its parent; and

there is more than one of its 

kind

Provision will be ‘promoted’ into the closing words of its parent provision, copying over any 

text.

If the provision had child elements, it will be promoted into a sibling of its parent provision, 

copying over any text and keeping the child elements with the following additional change:

Lower level paragraphs with numbering format (i) and/or (aa) will be converted ‘up’ a 

single level unless they are children of a child definition or step

Closing words The provision’s parent isn’t 

section or schedule 

paragraph

Closing words will be ‘promoted’ into a sibling of its parent provision, copying over any text

Schedule 

subparagraph

where there is only one of 

its kind

Schedule subparagraph will become the schedule paragraph’s content, copying over any 

text

If the schedule sub-paragraph had child elements, they will remain child elements with no 

change in element type.

Paragraph with the 

numbering format 

(1)

where there is only one of 

its kind

A regulation (or article etc.) will be created with a paragraph.  The promoted paragraph’s 

content will become the new paragraph’s content and the heading of the regulation (or 

article etc.) will be left blank

If the paragraph had child elements, they will remain child elements with no change in 

element type.

Schedule 

subparagraph

where the provision is not 

the first or last child of its 

kind

Schedule subparagraph will be ‘promoted’ into a sibling of the parent schedule paragraph, 

copying over any text

Any sibling schedule sub-paragraphs to the ‘promoted’ provision will now become child 

schedule sub-paragraphs to the newly ‘promoted’ provision

Paragraph with the 

numbering format 

(1)

where the provision is not 

the first or last child of its 

kind

A regulation (or article etc.) will be created with a paragraph.  The promoted paragraph’s 

content will become the new paragraph’s content and the heading of the regulation (or 

article etc.) will be left blank

If the paragraph had child elements, these will be copied to the newly created paragraph 

without any change to their element types.

Provision Conditions Rule
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Schedule 

subparagraph

where it is the last child of 

its parent; and

there is more than one of its 

kind

Schedule subparagraph will be ‘promoted’ into a sibling of the parent schedule paragraph, 

copying over the text into a newly inserted schedule sub-paragraph of the newly created 

schedule paragraph

If the schedule sub-paragraph had child elements, these will be copied to the newly created 

schedule sub-paragraph without any change to their element types.

Siblings to the schedule sub-paragraph being promoted will also remain as siblings to the 

newly created schedule sub-paragraph

Paragraph with the 

numbering format 

(1)

where it is the last child of 

its parent; and

there is more than one of its 

kind

A regulation (or article etc.) will be created with a paragraph.  The promoted paragraph’s 

content will become the new paragraph’s content and the heading of the regulation (or 

article etc.) will be left blank

If the paragraph had child elements, these will be copied to the newly created paragraph 

without any change to their element types.

Any sibling paragraphs to the ‘promoted’ paragraph will be copied over to become siblings 

to the newly inserted paragraph in the newly inserted regulation (or article etc.).

Bullet lists The bullet list item and all its child bullet list items will be promoted to become a bullet list at 

the level above

If the selected item is at the highest level and doesn’t have any child elements, the bullet list 

item will be promoted into a paragraph of text (without a bullet)

If the selected item is at the highest level and contains child bullet list items, it’s not possible 

to ‘promote’ this bullet list further

Paragraph lists in 

Explanatory notes 

and Preamble

The paragraph list item and all its child paragraph list items will be promoted to become a 

paragraph list at the level above – converting the numbering e.g. from (aa) to (i) and (i) to 

(a)

If the selected paragraph is at the highest level (i.e. number format (a)) and doesn’t have 

any child elements, the paragraph list item will be promoted into a paragraph of text (without 

a number)

If the selected paragraph item is at the highest level and contains child paragraph list items, 

it’s not possible to ‘promote’ this paragraph further
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Splitting and merging provisions

You can split a single provision into two siblings of the same type. It is also possible to merge two or more provisions of the same type into 

one. 

How to split a provision

To split a provision, use one of the following methods:

Place your cursor in the provision at the point in the text where you want to split it and press the keyboard shortcut, ALT+s,

Right-click in the provision at the point in the text where you want to split it and select Split element from the context menu.

The selected provision will be split at the cursor point and a new sibling element inserted immediately after it containing the rest of the text 

after the cursor point.

How to merge provisions

To merge two or more provisions:

1. Highlight the provisions that you want to merge.

2. Right-click and select Merge elements from the context menu.

The selected elements will be merged into one element - the existing text in the two provisions will appear in the merged provision 

separated by a whitespace.

Most provisions in all document types containing text can be split. However:

It is not possible to split provisions that have headings, i.e. Parts, Chapters, cross headings, sections, regulations, articles etc.

You cannot split table cells or text in cells.

You cannot split a provision if it has child elements, e.g. you cannot a subsection that contains paragraphs.

Most provisions can be merged. However:

You cannot use this function to merge table cells. See Inserting and managing tables  for how to do that.

You cannot merge provisions that contain complex objects within them, e.g. tables, formulas or images.

You can only merge provisions which contain child elements if the child elements are in the last provision being merged.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057
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Converting provisions to a schedule and vice versa

Lawmaker can convert sections in a Bill, or regulations etc. in an SI, to a schedule and vice versa.  

You can also copy and paste lower-level provisions like subsections into a schedule and they will be converted automatically, and vice 

versa.

How to convert provisions into a schedule

To create a new schedule from existing provisions:

1. Using the Editor or the structure view, select one or more contiguous sections in a Bill or regulations etc. in an SI.

2. Right-click and select Convert to/from schedule.

The selected provisions will be converted to a schedule at the end of the document. The schedule will contain a cross heading and a 

schedule paragraph for each converted provision.

How to convert a schedule into provisions in the main body of the document

To convert a schedule into provisions in the main body of the document:

1. Select one schedule in the Editor (using the breadcrumb) or structure view.

2. Right-click and select Convert to/from schedule.

The selected schedule will be converted into sections if you are in a Bill, or regulations etc. if you are in an SI.

Each cross heading and following schedule paragraph within the schedule will become a separate section or regulation. If a schedule 

paragraph hasn't got a cross heading before it, it will appear under an empty section/regulation/article heading.

The new provisions will be inserted at the end of the main body of the document, i.e. before any existing schedules and within the last 

grouping element such as a Part if there is one.

Converting provisions or schedules within a quoted structure

You can convert sections/regulations and schedule inside quoted structures in the same way but the converted provisions will remain within 

the quoted structure. If you are converting a schedule in a quoted structure which is document type SI/SSI - Lawmaker will always convert 

them to regulations as it doesn't have enough context information to work out whether they should be articles or rules instead.

Converting provisions when you paste

You can use copy (Ctrl+C) and paste (Ctrl+V) to move certain provisions between the main body of a document and a schedule. Lawmaker 

will automatically convert them into the appropriate provision type when you paste.

Converting schedule paragraphs

If you copy one or more schedule paragraphs and paste them:

into a section of a Bill, they will be converted into subsections,

into a regulation, article or rule in an SI/SSI, they will be converted into SI paragraphs,

into a Finance Bill resolution, they will be converted into subsection-like elements.

To select more than one provision in the structure view, you will need to select bottom-up rather than top-down as there is currently 

a bug which otherwise prevents 'Convert to/from schedule' from appearing in the right-click context menu.
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Converting subsections in Bills and paragraphs in SIs

If you copy one or more subsections, SI paragraphs, or subsection-like elements from a Finance Bill resolution and paste them into a 

schedule paragraph then they will be converted into schedule sub-paragraphs.

This automatic conversion works in quoted structures as well.
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Moving provisions, tables and amendments within a document

To move things like provisions, tables, amendments or interstitial headings around a document, you can either:

use cut and paste, or

use drag and drop in the structure view

Moving using cut and paste
1. Select the thing you want to move (using the breadcrumbs or structure view).

2. Cut it using Ctrl+x.

3. Place your cursor in the provision or amendment before where you want to move cut one to.

4. Paste in the cut provision or amendment using Ctrl+v.

See Using cut, copy and paste .

Moving using the structure view
1. Collapse the structure level down to the level of the element you are planning to move.

2. Locate the provision (including table)/amendment/interstitial heading you wish to move and press and hold the left button on your mouse.

3. Drag the provision/amendment/interstitial heading to the target location.

4. When the structure view shows a green tick, drop the selected provision into its new location. (Invalid drop locations will be indicated by red text and 

a cross symbol.)

See Using the structure view .

 

You can only move one provision/amendment etc. at a time using drag and drop.

Hints and tips

If you move the penultimate subsection out of a section, the remaining subsection will auto-convert into a section/content element

You cannot move a subsection into a section that isn’t divided into subsections.  You will need to convert the section’s content into a 

subsection by inserting a subsection into the section first.  This can be later deleted if not required.

Drag and drop is more reliable when neighbouring provisions have been collapsed to the level of the thing you are trying to move, e..g if you 

are moving a section make sure the structure view is only showing down to the section level around the area you want to move to.

You can move provisions out of quoted structures and into the main body of the document and vice versa.

Paragraphs, sub-paragraphs and sub-sub-paragraphs i.e. those using the numbering format (a), (i) and (A)/(aa) can be moved from 

sections/subsections to schedule paragraphs/sub-paragraphs.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
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Numbering

Most legislative provisions have numbers. Lawmaker generally assigns a number to a provision as soon as you insert it. It does the same 

when you paste provisions or move them around in the Structure View.

Lawmaker has two different numbering modes which you can switch between. We call these “auto-assign” mode and “auto-renumber” 

mode.

You can toggle between the two modes using Tools menu>Turn on/off Automatic renumbering. The mode selected will apply to all 

documents you work on until you change it again.

You can edit the number of any provision if you want it to have a different number from the one automatically assigned. (See Locking an

d unlocking numbers  for how to stop Lawmaker overwriting your manually applied number when it renumbers.)

Auto-assign mode

In this mode, Lawmaker will assign a number to newly inserted (and pasted) provisions to give them unique numbers without changing any 

existing number. For example, a subsection inserted between subsections (2) and (3) will be given the number (1A). For more on the logic 

applied see Rules used to "auto-assign" numbers to provisions .

Auto-renumber mode

In this mode all lower level provisions are automatically renumbered whenever you insert (including paste) or delete (including cut) a 

provision.

Lower level provisions are provisions below the level of:

a section/clause in a Bill, e.g. subsections, paragraphs, sub-paragraphs;

a regulation/article/rule in an SI/SSI, e.g. paragraphs, sub-paragraphs;

a schedule in any document, e.g. schedule paragraphs, schedule sub-paragraphs. 

 

 

 

Whenever you open a document in the Editor, a green pop-up message will appear in the top right-hand corner of the screen letting 

you know what numbering mode Lawmaker is in.

See Renumbering provisions  for how to renumber a selection of provisions or the whole document.

This includes when you drag and drop a provision in the structure view, i.e. when you drag and drop a provision in a new position it 

will be assigned a new number as if it had been newly inserted at the new location.

When this numbering mode is active, dragging and dropping provisions in the Structure View that are not automatically renumbered, 

like sections or regulations, will result in those provisions retaining their existing numbers (unlike what happens in auto-assign 

mode).

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526921
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526921
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
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Renumbering provisions

You can trigger a renumbering of a single provision, the whole document or a selection of provisions within the document.

How to renumber

To trigger a renumber, do one of the following:

Click on the Renumber icon in the toolbar,

Right-click in the Editor or Structure View and select Renumber,

Press keyboard short-cut Alt+n.

If you’ve selected some provisions before triggering renumber then those provisions will be renumbered. Otherwise, you’ll be given a choice 

of whether to renumber the current provision (i.e. the section, regulation etc. or schedule containing your cursor) or the whole document.

If your cursor is within a quoted structure then you’ll be given a choice between the current provision and the whole quoted structure 

instead.

Lawmaker will renumber the provisions sequentially including all their descendants. It won’t renumber any locked numbers and those 

numbers will influence subsequent numbers - see Locking and unlocking numbers .

Renumbering and quoted structures

The renumber function will not renumber provisions in quoted structures except where your cursor is within a quoted structure before you 

trigger the operation.

If you want to renumber a quoted structure, place your cursor within it and then trigger the renumber operation selecting “whole quoted 

Structure” as the scope of the operation. This will renumber that quoted structure. It won’t renumber any other quoted structures, including 

any adjacent quoted structures.

See Quoted structures  for more on quoted structures generally.

 

Renumbering the whole document will require locks to be taken on all provisions so can’t be done if anyone else is editing the same 

document at the time.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
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Renumbering and locking numbers

Renumbering and locking numbersRenumbering and locking numbers

https://youtu.be/31sD5Pj6RZg
https://www.youtube.com/watch?v=31sD5Pj6RZg
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Locking and unlocking numbers

You can lock and unlock numbers to prevent Lawmaker from automatically updating them when renumbering. 

How to lock/unlock a number

Place cursor in the number that you want to lock/unlock and either:

Use keyboard short-cut Alt + l,

Right-click and select ‘Lock/Unlock Number’ from the context menu, or

From the upper tool bar, select ‘Tools > Lock/Unlock Number

Lawmaker will lock/unlock the selected num element

Locked numbers will not be changes, and subsequent numbers will be updated from the last locked number

Unlocked numbers will be updated depending on the predecessor

 

Screencasts

SI/SSI Numbering screencast

General Numbering/Locking numbers screencast

Hints and tips

Locking is particularly useful for the first numbered provision within textual amendments (quoted structures) which often starts with a 

number which isn’t the starting number of a sequence

You can tell if a number has been locked as there will be a dotted line surrounding the number

Examples of when locking numbers will be useful;

when you are quoting previously amended legislation where a non-sequential number format needs to be maintained

if the auto-assign number rule inserts or renumbers a numbered provision with the wrong number (this would only be applicable for edge 

cases as most auto-assign rules have been incorporated)

You must be within a num element to be able to turn on/off number lock

If a number has been locked, the renumber function will ignore it and move onto the next provision in the sequence.  Any provisions 

following a locked number will be renumbered based on the locked number e.g. if the locked number was 3A, the next unlocked 

sibling provision will be 3B and so on.  If you don’t want the next provision to follow the format of the preceding locked num, you will 

need to lock the next provision’s number as well.. 

https://youtu.be/1EnqGp16pwM
https://youtu.be/31sD5Pj6RZg
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Legal Numbering

By “legal numbering” we mean numbers that consist of two or more numeric components separated by a full stop, e.g. 1.2, 3.5, 13.2A. 

We’ve called it legal numbering because it is a style of numbering commonly used in legal documents. In legislation, legal numbering is 

most commonly used in court rules but also sometimes appears in EU legislation.

Lawmaker supports the legal numbering style for SI regulations and articles and schedule paragraphs. It can   also be used for Bill sections.

The numbering for these provisions by default continues to be the standard style (e.g. 1., 2., 3. etc. or 1, 2, 3 etc.) but you can manually 

change the numbering to the legal numbering style and Lawmaker will respect that when renumbering or adding new provisions.

How to use legal numbering in a document
1. Change the first rule/regulation/section number from “1.” or “1” to the legal number format, e.g. “1.1.”

2. Right-click on the number and select Lock/Unlock Number. This will stop the number being changed when you renumber the document. (See L

ocking and unlocking numbers .)

3. If you insert new provisions after the first provision they will automatically be numbered in sequence, e..g “1.2.”, “1.3.” etc.

4. If you renumber all the provisions in your document, they will be be renumbered following the legal number format.

5. If your document has divisions such as Parts and you want the numbers in each Part to correspond to the Part number then you should manually set 

the number of the first provision and lock it as described in step 2 above. For example, in Part 2, change the first provision number to “2.1.” and lock 

the number. If you do that, inserting new provisions and renumbering will work correctly.

 

You can tag and update cross-references to provisions with legal number format as you can with other number formats - see 

References .

Note that the smart paste feature doesn’t currently fully support legal number format. If, therefore, you copy for example court rules 

from another source, eg: Word or legislation.gov.uk,  Lawmaker will insert any characters in the number after the first full stop as text 

into the paragraph.  You can work around this by simply deleting the additional characters and adjusting the number as necessary.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
http://legislation.gov.uk/
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Rules used to "auto-assign" numbers to provisions

The table below sets out how Lawmaker works out the correct number to assign to a new provision when it is inserted, pasted, or moved. 

This applies to all provisions when auto-renumber is switched off.

Inserting the first provision in a series/ 

renumbering the first provision in a 

series

1. Assign the starting ‘normal/regular’ number for the element type

NB: if the first element inserted in a quoted structure is a num element, the user will have to specify a 

value in the num element and this num element will automatically be locked. Users might lock 

additional numbers in a quoted structure e.g. if the numbered element is section-level or above (group 

of parts, part, chapter or section)

Inserting at the beginning of a series 

(before existing numbers)

1. scenario 1

a. If the first element’s number is a ‘normal/regular’ arabic, alphabetical or roman format:

b. Take the first element’s number and add an “A” or “a” before it (dependent on case of the first 

element’s num)

2. scenario 2

a. If the element's first number is a ‘normal/regular’ non-arabic format:

b. Take the first element’s number and add a “Z” or “z” before it (dependent on case of the first 

element’s num)

Inserting at the end of the 

series/ renumbering sibling elements 

after a locked element.

1. scenario 1

a. If the value of the last element’s num in the series (or the locked element) is 'normal/regular', 

assign the inserted element with the next number in the sequence

2. scenario 2

a. If the value of the last element’s num in the series (or the locked element) is 'irregular/auto-

assigned':

b. if the last (set of) characters are arabic: duplicate the 'irregular/auto assigned' value but replace 

the arabic number(s) with the next number in the sequence

c. if the last character is alphabetical: duplicate the 'irregular/auto assigned' value but replace 

the last character with the next letter of the alphabet.

3. scenario 3

a. If the last character is “Z” or “z”: duplicate the value in the last element's num (or the locked 

element) and add "1" at the end

4. scenario 4

a. If the value of the last element's num in the series (or the locked element) is 'Schedule':

b. Renumber the last element's num (if it is unlocked) to 'Schedule 1'; and

c. Assign the inserted element with 'Schedule 2'.

Inserting between two numbers in a 

series

1. scenario 1

a. If both the nums are 'normal/regular' OR if both element nums are 'irregular/auto assigned' with 

an equal number of characters:

b. Take the leading element’s number and add an “A” or “a” after it (dependent on the case of the 

leading element’s num

2. scenario 2

a. If the leading num element is 'normal/regular' arabic format and the trailing element 

is 'irregular/auto assigned' and ends with a non-arabic character:

b. Take the trailing element’s number and add a “Z” or “z” immediately before it’s last 

letter (dependent on the case of the leading element’s num)

3. scenario 3

Position of inserted element in a series Rule
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a. If the trailing element’s num is a 'normal/regular' arabic format and the leading num element 

is 'irregular/auto assigned' and ends with an alphabetical character:  

b. Take the leading element’s number and increment the (last) letter to the next letter of the 

alphabet

c. If the last letter is “Z” or “z”, duplicate the value in the leading element's num and add "1" at the 

end

4. scenario 4

a. If both the nums are 'irregular/auto assigned' and the leading element’s num 

has more characters than the trailing element’s num:

b. take the leading element’s number and increment the (last) letter to the next letter of the 

alphabet with the following exception:

c. Miss out “O” in the alphabetical sequence

d. If the last letter is “Z” or “z”, duplicate the value in the leading element's num and add "1" at the 

end

5. scenario 5

a. If both the nums are 'irregular/auto assigned' and the leading element’s num 

has less characters than the trailing element’s num:

b. take the second element’s number and add a “Z” or “z” immediately before the last 

letter (dependent on the case of the trailing element’s num)
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References

What are references in Lawmaker?

Legislative provisions will often refer to other legislative provisions or legislative documents. Lawmaker can mark up these references in the 

document XML so that it can provide additional functionality to help while drafting and editing legislation but also to help downstream users 

when the legislation is published.

References are sometimes referred to as cross-references, or x-refs for short.

Two types of references can be marked up in Lawmaker:

1. Internal references - these are references to other provisions in the same document, e.g. “section 3(2)(a)” or “paragraph (3)”.

2. External references - these are references to provisions in other legislative documents or to the whole document, e.g. “section 5 of the Human 

Rights Act 1998”. In practice, external reference often appear as a provision reference only (e.g. “section 25”) and a wider reading of the context is 

required to determine that it is an external reference.

References are identified visually in the Editor using different formatting:

Valid internal references will show as purple , e.g. “section 3(2)(a)” 

External references will show as blue, e.g. “section 7 of the Housing (Scotland) Act 2000”

References that are invalid or have been manually altered are shown with different formatting which is described below in relation to specific 

features (the formatting is summarised below: under Table describing formatting of different references). The formatting in the editor is not 

replicated in the PDF version of the document but references will become hyperlinks in the PDF that can be used to jump to the target of the 

reference.

Creating references

References can be created in two ways, using the Tag references feature (which tags both internal and external references) or by copying 

a reference to a provision via the structure view or the right-click context menu and pasting it into your document (for internal references 

only).

Working with references

Once created, references can be manipulated and modified using the right-click context menu, the toolbar menus or by the floating toolbar.

Note that the text within reference tags cannot be directly edited. This is to reduce the risk of the metadata associated with the reference 

going out-of-sync with the text displayed.

For internal references, you can:

Update them, so that the text of the reference contains the up-to-date number of the provision which it refers

Remove the reference mark-up (but leave the text behind),

Mark a reference to be ignored which has previously incorrectly been marked up as a reference.

Make the Editor jump to the location of the target provision.

Show or hide j-refs within references.

Modify the displayed text and the underlying metadata via the Edit Reference dialog box.

For external references, you can:

Remove the reference mark-up or mark it to be ignored (as you can with internal references)

Open a new tab in the browser containing the provision referred to as it appears on www.legislation.gov.uk.

For SI/SSIs only, add an automatically-generated legislative history footnote, derived from data on www.legislation.gov.uk.

Modify the displayed text and the underlying metadata via the Edit Reference dialog box.
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How to “tag” references

Lawmaker can analyse text you have drafted and automatically add reference mark-up to the internal and external references it identifies.

You can trigger the Tag references feature in a number of ways:

Click on the Tag references icon in the toolbar,

Select Tools menu>Tag references,

Right-click in the Editor or Structure view and select Tag references, or

Use the keyboard short cut Alt+t.

When the tag operation finishes, you will see all the references Lawmaker has identified highlighted in the Editor according to the table 

below:  Formatting of reference types. Internal and external references are, in particular, distinguishable from one another by their colour.

What gets tagged?

By default, when you trigger the Tag references feature, Lawmaker will analyse the text in the provision (i.e. the section, regulation etc.) your 

cursor is in. If, however you have selected some provisions before triggering the feature, then all of those provisions will be analysed.

Internal references within  Quoted structures  will not be marked up because there may not be enough context within the quoted 

structure to reliably identify the target of the reference. Lawmaker will try and identify external references wherever they appear.

More on external references

To identify external references, Lawmaker relies on data about enacted legislation from www.legislation.gov.uk. Lawmaker can’t therefore 

identify references to legislation that has not yet been enacted or made. This also means that, if for some reason www.legislation.gov.uk is 

not available for a period of time, then Lawmaker will not be able to properly identify external references during that time but the Tag 

reference function will otherwise work as expected for internal references.

Lawmaker identifies and marks up both references to external provisions and to the documents containing those provisions. While 

sometimes references consist of both together, e.g. “section 12 of the Scotland Act 1998”, Lawmaker is also able to identify references to 

external provisions where the context determines that they relate to an enacted document rather than the document containing them. In 

particular, it will do this:

where an earlier provision sets the context, e.g. where a section begins “(1) The Human Rights Act 1998 is amended as follows.”,

where the opening words set the context, e.g. “In The Human Rights Act 1998-”,

where the reference refers back to a previously mentioned enactment, e.g. “section 7 of that Act”

Lawmaker will also identify external references that use an alias instead of the full title of the legislative document, e.g. references to “the 

2007 Act” or “the 1998 Regulations”. It does this by searching for definitions of the alias elsewhere within the document, either of the form of 

a full definition like “the 2007 Act” means the Criminal Justice Act 2007” or a parenthetical definition like “…the Criminal Justice Act 

2007(“the 2007 Act”)”.

Tagging provisions that already contain references

When you trigger the Tag reference feature on a provision that already contains some marked-up references, existing references are 

checked and re-tagged as necessary. References that have been marked as manually edited or to be ignored will not be touched when re-

tagging. 

Any existing internal references will be updated as an initial step of the re-tagging operation to ensure that the text of the references is up-to-

date before it is re-tagged.

Where however Lawmaker detects that the target of an existing reference has changed (e.g. because the context in which that reference 

sits has changed), the reference will be changed accordingly but it will be marked as requiring checking. Such references will appear brown 

in the Editor (e.g. “regulation 52”) and each one will also be highlighted with a document check error. From the document check panel, you 

can confirm that the reference remains valid or you can remove the reference mark-up if you think it is no longer appropriate.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
http://www.legislation.gov.uk/
http://www.legislation.gov.uk/
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How to create a reference using the Structure View or the right-click context menu

Internal references can be created using the Structure View or via the context menu that is available when you right-click on text within your 

document. Using this method you first copy a reference to a particular provision and then you use the normal paste function to paste the 

reference where you want it in your document.

This method is the only way to create internal references within a quoted structure.

To insert a reference to a provision using this method:

1. Either:

a. Right-click on the provision in the Structure view you want to refer to (you may want to turn on full-depth mode to see all provisions - see Usin

g the structure view ), and select Select reference to copy from the menu that appears , or

b. Right-click within the provision in the main Editor window and select Select reference to copy from the context menu.

2. Select the reference in the form you want from the different options that are presented. Lawmaker will present all the possible options for referring to 

the provision so you can select whether or not you want the provision name (e.g. “section”) to be included and whether any ancestor provisions 

should be included in the reference.

3. If using the option via the right-click context menu in the Editor, click Copy in the dialog box.

4. The selected cross-reference will be put in the clipboard.

5. Place your cursor in the Editor where you would like the cross reference to be inserted and press Ctrl+v to paste in the reference.

Floating toolbar for references

To stop the accidental modification of the text of references (without the underlying metadata being updated if necessary), references are 

not directly editable in the editor (although you can delete a whole reference).

However, double-clicking on a reference will bring up a handy toolbar to access a range of reference-related features. All of these features 

(with the exception of Goto ref) are also available via the right-click context menu or from the main toolbar.

The tag reference functionality relies on sophisticated pattern recognition and the data in www.legislation.gov.uk. Despite that, there 

may be some references that it doesn’t recognise. There is also a small possibility that Lawmaker will tag something as a reference 

when it isn’t.  We’re constantly refining this feature so please provide feedback to Lawmaker Support if you come across any issues. 

In SI/SSIs, Lawmaker will determine whether a provision should be referred to in the reference as a “sub-paragraph” or “paragraph” 

depending on the provision’s context.

You can’t currently create references to EU provisions using this method.

Turning on the full-depth mode to see all provisions in the Structure View - especially in big documents - might have an impact on 

the Editor performance, slowing it down. Using the right-click context menu in the Editor will be faster and perform better.            

You can also paste over an existing cross reference.  Pasting will strip out the old cross reference mark-up before inserting the new 

cross reference and its mark-up.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
http://www.legislation.gov.uk/
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How to view the target of a reference

The Goto Ref button on the reference toolbar provides a quick way to navigate to and view the provision or document that a reference 

relates to.

For internal references, clicking on Goto Ref will move the focus of the editor window up or down until the provision that is targeted is 

visible.

For external references, clicking on Goto Ref will open a new tab in the browser and will navigate to the target provision or document in 

www.legislation.gov.uk. 

How to update internal references to reflect renumbering of provisions

The Update references feature enables you to update the number component within internal references to match the current number of the 

target provision. For example, if there is a reference to “section 5” but what was section 5 has been renumbered to section 7 then updating 

the reference will result in the reference changing to “section 7”.

You can update internal references that have previously been marked up in a number of ways:

Click on the Update references icon in the main toolbar,

Select Tools menu>Update references from the main toolbar,

Right-click in Structure view or Editor view and select Update references,

Click on the Update ref button on the references toolbar, or

Use the keyboard short cut Alt+u.

If nothing has been selected before you trigger the update then you’ll be given the option of updating references in the current provision (i.e. 

the current section, article, regulation etc.) or the whole document. Otherwise, Lawmaker will update all references in your selection.

Lawmaker will try and update both valid and invalid internal references but not references that have been marked as “manual” due to the 

metadata being edited. If Lawmaker can no longer find the target of a valid reference in the current document then it will change the 

reference’s status to invalid. Equally, if Lawmaker finds the target of an invalid reference then it will change the reference’s status to valid.

Tagging and updating references when editing a portion of the document

If you have a portion of a document open in the Editor (see Opening and editing a portion of document ) and you use the Tag reference 

or Update reference feature, Lawmaker will detect when references in the portion do not point to other provisions within the portion and give 

you option to search the whole document rather than just the portion.

This will take longer than just searching the portion but will mean that references to other parts of the document are tagged and updated 

correctly instead of being marked as invalid references.

How to edit references

Although references cannot be directly modified in the editor, you can click on the Edit ref button on the reference toolbar, or select Edit 

reference from the right-click context menu, to bring up a dialog box allowing you to edit the text of the reference and its underlying 

metadata.

This can be useful if you need to make a minor change the reference text, e.g. to adjust the capitalisation of the word “section”. However, 

any more significant changes to the text or other metadata fields should be done with care by expert users or in consultation with the 

Lawmaker support team.

If you change any text field other than Reference text then the Status will automatically change to “Manual”. This means your 

changes will be preserved during any re-tagging operation but will also stop the Update references feature from operating on the 

reference. Changes to the the Reference text field will not impact on the Status and so will not stop Update references from 

working.

http://www.legislation.gov.uk/
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
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How to ‘ignore’ references that have been tagged

If something has been erroneously marked up as a reference or misidentified as an external reference when it is an internal reference or 

vice versa,  you can tell Lawmaker to ignore it in future. This will stop it trying to update the reference when you use the Update references 

feature or to re-tag it when you use the Tag references feature. 

To ignore a reference, right-click within the reference and select Ignore reference.

(You can also get this feature from the upper toolbar by selecting Tools menu>Ignore reference or using the Ignore ref button on the 

reference toolbar. )

How to remove (unwrap) tagged references

You can remove the reference mark-up that Lawmaker adds to a reference without deleting the text of the reference. You may want to do 

this, for example, if you want to update the text of the reference and then re-tag it.  You may also want to remove existing reference tags 

because the text tagged isn’t a reference.

To do this, right-click within the cross-reference and select Remove reference tag.

(You can also do this from the upper toolbar, select Tools menu>Remove reference tag or with the Remove tag button on the reference 

toolbar.)

Any ignored reference will show up in the Editor as grey text with a dotted underline.

When a document is published on Lawmaker for external systems to access, the mark-up for ignored x-refs is removed.
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If you choose to remove the reference tags from one part of a compound reference (e.g. “sections 5 to 7 of the Police Act 2007”), Lawmaker 

will automatically remove the mark-up from all other parts at the same time.

Only the reference mark-up will be removed - the text will be left alone.

Showing j-refs as part of references

You can make the Editor and any PDF generated show the j-ref of target provisions within cross-references. See Managing J-refs  for 

more about this.

Inserting and updating references between documents within Lawmaker

You can use the Structure View or context menu method to create a reference to a provision in another document in Lawmaker. That 

reference can be inserted into the document you are working on. This can be useful if you are working on a Bill or SI which has been split 

into a number of different documents or if you are drafting an amendment which contains references to provisions in the published Bill.

To create such a reference, open the other document, follow the steps above to copy the reference and then return to the document you are 

working on and press Ctrl+v to paste in the reference. 

The reference will show up as valid when you first paste it in. However, when you update the cross-references in text, any reference to 

another document will show up as Invalid (grey highlighted text) and the reference won’t be updated. If at a future point the target provision 

is copied into the same document (or, in the case of an amendment, it is applied to the Bill), then the reference should return to being valid 

when you update the cross-references again.

Table describing formatting of different references

This table lists the different formatting possibilities of references and what that means.  Invalid references and references that require 

checking are also highlighted in the Document Checks panel.

Purple text Valid internal 

reference

The target provision has been identified and the citation 

should update correctly when you update x-refs.

Blue text Valid external 

reference

 

Grey text with a light grey 

highlight

Invalid reference An internal reference, the target of which cannot be found in 

the document (it may, however, exist in another document) or 

an external reference, the target document of which couldn’t 

be located on www.legislation.gov.uk.

Brown text Reference requiring 

checking

A reference that has been modified as part of the Tag 

references operation that needs to be checked by the user to 

ensure it remains correct.

Double underlining Manually edited 

reference

A reference the properties of which have been manually 

edited by the user and which will not be modified by any 

subsequent Tag references operation.

Black text with orange highlight Internal reference 

which can’t be 

resolved

Lawmaker can find the target provision but is unable to 

update the reference text automatically. This is usually 

because the target provision has changed in some way, e.g. 

it has be promoted or demoted.

To fix this, it is generally best to remove the existing 

reference and either re-tag the reference if it remains correct 

or insert a new reference.

Format of reference Description Notes

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339123
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Grey text with dotted grey 

underline

Ignored reference The reference text of this cross-reference will not be updated 

as part of an Update references operation.
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Quoted structures

A quoted structure is the element you insert in Lawmaker to contain inserted or substituted provisions  when you are creating a textual 

amendment in a Bill or SI, or creating a parliamentary amendment.

A quoted structure can contain any kind of provision and will normally appeared indented on the page and surrounded by quote marks. In 

the Editor a quoted structure will be shown with a dotted line around it to distinguish from other provisions.

(They’re called “quoted structures” because  element used in Akoma Ntoso to hold structured content that is being quoted in some way from 

another document. They are similar to what, in the existing SI template, were called “long quotes”.)

How to insert a quoted structure
1. Use any of the following methods:

right-click in the Editor and select Insert quoted structure

from the Insert menu in the toolbar, select Insert quoted structure

use keyboard shortcut CTRL+q

2. Select a starting element and adjust any other settings in the dialogue box.

3. Click Insert.

Lawmaker will insert a quoted structure containing the selected starting element on a new line below the provision your cursor is in,.

If the starting element has a number, then the number will be left empty (but parentheses will still be present if the element number would 

normally have them) and it will be locked (see Locking and unlocking numbers ). You can manually add a number to the first element 

and subsequent elements will be numbered accordingly.

Setting the properties of a quoted structure

When you insert a quoted structure you can set various properties of the the quoted structure. Some of these can be updated after the 

quoted structure is inserted by right-clicking within the quoted structure and selecting Update quoted structure properties (You can also 

do the same using the Insert menu in the toolbar.)

If you are creating a textual amendment in a Bill or SI that only inserts or substitutes a single word or a phrase then you should use 

a quoted text element instead - see Quoted Text .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522059778
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522059778
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Document type

(Can’t be changed after quoted structure is inserted.)

Selecting the document type determines how the contents of the quoted structure will be formatted and what starting elements are available.

By default, the document type will be the Act type that corresponds to the document you are editing (e.g. an Act of the Scottish Parliament if 

you are editing a Scottish Bill, or a UKPGA if you are editing an amendment list for the Commons or the Lords)..

The possible types are:

Act of the Scottish Parliament (asp)

United Kingdom Public General Act (ukpga)

UK Statutory Instrument

Scottish Statutory Instrument

EU Regulation, EU Directive or EU Decision

Starting element

(Can’t be changed after quoted structure is inserted.)

The list of possible starting elements is determined by the document type. The list include all possible elements in the main body and in 

schedules - there are separate options for grouping elements in the body and schedule (e.g. “Part” and “Sch Part”).

Indent level

All provisions in a quoted structure are, by default, indented compared to how they would be if they appeared directly in the document.

The Indent level option allows you to alter that indent.

Indent level -1 removes the normal indent that is applied to provisions within a quoted structure.

Indent levels 1 and above add additional indent beyond the deafult indent.

If you select a  different document type, the PDF will render the elements in the appropriate styles for the target document, except in 

relation to font style an size which will match the main document.

That means if you include an asp quoted structure in a UK Bill, or a ukpga quoted structure in a Scottish Bill,  there may be some 

presentational differences in the content of the quoted structure when you generate a PDF. If you want the contents of the quoted 

structure to look exactly like other provisions in the Bill then set the document type to the Act type that corresponds to the Bill.
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See Cases where you may need to adjust the indent level of a quoted structure or use adjacent quoted structures  for more on when and 

how to use this feature.

Start quote and end quote

If a quoted structure is to be surrounded by quote marks, you should select them here. 

By default, a quoted structure will be set to have double inverted commas “ and “ except in the case of a Scottish Parliament amendment 

which uses < and >.

Following text

Enter here any text that you want to appear directly after the closing quote mark. This will usually be punctuation and/or a conjunction, e.g. 

“;” or “, and”.

Inserting a quoted structure immediately after another quoted structure

To insert a quoted structure immediately after another quoted structure either:

right-click in the Editor within the existing quoted structure and select Insert adjacent quoted structure, or

From the Insert menu on the toolbar, select Insert adjacent quoted structure.

See Cases where you may need to adjust the indent level of a quoted structure or use adjacent quoted structures  for more on when and 

how to use this feature.

Nested quoted structures

It is possible to insert a quoted structure within an existing quoted structure. Just place your cursor within the existing quoted structure and 

follow the instructions above to insert a new quoted structure. 

Tables in quoted structures

You can insert a table as a starting element by selecting “table” as the starting element.  This will take you to the “Insert table” dialogue box 

allowing you to specify the type of table/table row that you want to insert. If you just want to insert a single row of a table then insert a table 

with only 1 row and no table number, caption or header - see Inserting and managing tables .

Moving existing provisions in and out of quoted structures

See Moving elements in or out of Quoted Structures  for help with this.

 

In the Editor, the quote marks will be shown outside the box around the quoted structure content but in the PDF they will be 

displayed correctly.

Avoid setting the quote marks to none and then inserting the quote marks directly within the content of the quoted structure. That 

can cause problems with numbering and formatting elsewhere.

It is easier to enter it here rather than trying to add this text in the Editor. Doing so will also guarantee that the text is placed in the 

correct element will display correctly in the PDF. 

 More notes on quoted structures
You can copy or cut a quoted structure by placing your cursor in the quoted structure, selecting “quoted structure” from the breadcrumb and 

then pressing CTRL+c or CTRL+c as appropriate. To paste it, place your cursor in the provision/amendment you want your quoted structure 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526905/Default+indent+for+starting+provisions+in+a+quoted+structure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526905/Default+indent+for+starting+provisions+in+a+quoted+structure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526905/Default+indent+for+starting+provisions+in+a+quoted+structure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526905/Default+indent+for+starting+provisions+in+a+quoted+structure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/218497025
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/218497025
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to appear after and use the keyboard short cut CTRL+v.

You can’t use the Tag x-refs features when the cursor is in a quoted structure because there won’t be enough context to resolve any 

references found. But you can create manual x-refs to and from provisions in a quoted structure - see To create cross references

UNDEFINED . (You can’t currently create manual cross-references to provisions within a quoted structure that is marked as relating a EU 

document type.

The training video on Managing footnotes, textual amendments and references in SI/SSIs includes how to insert quoted structures.

https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=To%20create%20cross%20references&linkCreation=true&fromPageId=9339075
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=To%20create%20cross%20references&linkCreation=true&fromPageId=9339075
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=To%20create%20cross%20references&linkCreation=true&fromPageId=9339075
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=To%20create%20cross%20references&linkCreation=true&fromPageId=9339075
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=To%20create%20cross%20references&linkCreation=true&fromPageId=9339075
https://www.youtube.com/watch?v=SHW-GSOaulg
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Cases where you may need to adjust the indent level of a quoted structure or 
use adjacent quoted structures

This page provides more detail on how to use the quoted structure features in certain particular cases. For general help with quoted 

structures, see Quoted structures .

Inserting wide tables or images into a quoted structure

Using the Indent level dropdown menu in the quoted structure dialogue box, you can select Indent level -1 which will present the contents 

of the quoted structure set to full page width, i.e. exactly as they would normally appear and without any global additional indent.

This can be useful if your quoted structure is to contain something like a wide table and you need the full page width to display it.

Inserting a schedule which consists of a quoted structure and nothing else

Indent level -1 can also be used when you want to create a schedule that consists solely of inserted content, e.g. if you want to create an SI 

with a schedule which contains an annex to some European legislation. In that case, the normal indention is superfluous so you may want to 

present schedule content without any indentation. 

Inserting a quoted structure when the context being amended is itself within a textual amendment

Where the provision being amended is itself within a textual amendment in a Bill or SI (i.e. within a quoted structure) then you will need to 

use Indent level 1 to reflect the additional indentation that will be required. This will result in everything in the quoted structure being 

indented by twice as much as a normal quoted structure. Were the provision being amended within a nested quoted structure then you 

would use Indent level 2.

Inserting paragraphs and other provisions that have relative indent in a context where the 
paragraph etc. is not in its default position

Most provisions (e.g. sections, subsections, regulations) have a fixed indent when they appear in a document outside a quoted structure. 

However, some provisions have an indent relative to their parent provision because they can appear in a number of different contexts.

The provisions that have a relative indent are:

paragraph (a)

sub-paragraph (i)

sub-sub-paragraph (A)/(aa)

definition

step

closing words

When one of these provisions is selected as the starting provision in a quoted structure, its indentation will be based on its default position, 

i.e. as if it were being inserted as a child of a section in a Bill or a regulation/article/rule in an SI.

However, if the provision is actually to be inserted as a child of another provision then you can use the Indent level of a quoted structure to 

ensure the provision is correctly presented.

For example:

If you were inserting a paragraph as a child of a definition or a step then you would use Indent level 1 (because it is one level further down the 

hierarchy than the default, e.g. section>definition>paragraph rather than section>paragraph).

If you were inserting closing words of a sub-sub-paragraph then you would use Indent level 3 (because it is three levels further down the hierarchy).

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
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Inserting a quoted structure where the first provision is lower in the hierarchy than subsequent 
provisions

Sometimes textual amendments and parliamentary amendments begin with a provision which is lower in the hierarchy (e.g. a paragraph) 

and then continue with provisions which are higher in the hierarchy (e.g. subsections). For example:

In Lawmaker, a single quoted structure must start with the highest level provision in that structure. So, to achieve a structure like the one 

above, you need to use two quoted structures back-to-back.

Lawmaker provides a feature to help with this - with your cursor in the first quoted structure, right-click and select Insert adjacent quoted 

structure. - that will enable you to create a quoted structure after the existing one rather than inside it. The quoted structure dialogue box 

will be shown where you can select the higher level provision to insert. The document type field isn’t enabled because the type must be the 

same as the previous quoted structure. And any following text of the original quoted structure is moved across to the new one. 

In most cases you’ll need to use the quoted structure dialogue box to adjust the quote marks in both the first and second quoted structures 

so that the first only has an opening quote mark and the second only has a closing quote mark.

Note that any cumulative effect of nested quoted structures and provisions will relative indents can be achieved by adding up the 

indent levels that would otherwise be selected. For example, if you are inserting a paragraph as a child of a definition within a 

quoted structure then you would use Indent level 2, since each would otherwise result in a level of 1.
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Moving elements in or out of Quoted Structures

This page explains how to move existing provisions and other elements (eg: paragraphs, definitions, tables etc):

into a Quoted Structure when the provision is currently within the main body of a Bill or SI/SSI, or

out of a Quoted structure so the provision becomes the main body of the Bill or SI/SSI.

About quoted structures

Quoted structures are used whenever you are making a textual amendment to another enactment to insert new provisions into that 

enactment. See Quoted structures .

In Lawmaker, elements are organised hierarchically so a provision (e.g. a paragraph) making an amendment will contain the quoted 

structure and the quoted structure will contain the provisions being inserted.   Therefore, you can not simply add a quoted structure to an 

existing provision or delete the existing one, but instead need to move the provision either into or out of the quoted structure.

Moving Provisions into a Quoted Structure

To move existing provisions into a quoted structure:

1. Ensure the Structure View is expanded so it is showing all levels.  Click on the icon so it shows a double down arrow:

2. In the main Editor window, click on the provision where you want the quoted structure and press Ctrl+Q to insert a quoted structure.   For the starting 

element, select the provision type that is the same as the provisions you want to move. For further help see Quoted structures  

3. In the structure view, expand  both the provisions that contain the provisions to be moved AND the provision containing the newly created quoted 

structure.

4. Drag and drop the provision into the new quoted structure.

5. Finally, delete the (empty) starting element of quoted structure that was inserted when you first created the quoted structure:

a. Click on the empty provision in the Structure view.  It may look something like this

b. Press Delete on your keyboard

Moving existing provisions out of a Quoted Structure
1. Ensure the Structure View is expanded so it is showing all levels.  Click on the icon so it shows a double down arrow:

2. Expand the provision containing the quoted structure.  Continue expanding the quoted structure until you can see the contents of the quoted 

structure.  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
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3. If required, expand the provision where you want move the provisions in the quoted structure to.

4. In the structure view, drag and drop the provision from the quoted structure to the provision where you want it.

5. If you moved a numbered provision out of a quoted structure, it may have been locked so you will need to unlock it so that it will be properly 

renumbered in future. See Locking and unlocking numbers .

6. If your quoted structure is now empty, you should delete it. See Deleting provisions and other elements  .

 

 

 

When dragging and dropping things in the structure view, other elements in the structure view will turn red if they are an invalid 

place in the document to move the thing to, and green if it is valid.

For more information see Moving provisions, tables and amendments within a document  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339093
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339025
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339025
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339163
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339163
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Quoted Text

When drafting a textual amendment within a Bill or SI that only involves a word or a phrase (i.e. does not involve inserting or substituting a 

whole provision), you should use the Quoted Text element in Lawmaker to represent the text that is being left out, inserted or substituted, 

rather than simply surrounding the text with quote marks. 

(If you are inserting whole provisions or other structured content then you should use a quoted structure instead - see Quoted structure

s .) 

For instance, quoted text should be used for the highlighted portions in the following examples:

for “£50,000” substitute “£60,000”

In subsection (1), after “police,” insert “tri-service serious crime unit,”

In section 2, insert at the end “or to a limited liability partnership”

A quoted text element should also be used for a textual amendment that starts with a word, phrase or punctuation but then continues with 

structure, e.g. in the following case:

In section 3(2) of the 2008 Act, at the end of paragraph (b) insert “or,

   “(ba) the Scottish Ministers.”

 

How to insert quoted text

A ‘Quoted Text’ element can be inserted from the Content Completion Assistant by pressing Enter in the Editor and selecting Quoted text. 

This will create an empty ‘Quoted text’ placeholder with opening and closing quote marks.

Changing quote marks

When you insert a quoted text, by default double inverted commas (“ and “) are automatically inserted as quote marks. These quote marks 

can be removed or altered if necessary, by right-clicking within the quoted text and selecting Update quoted text properties.

Setting the quote marks to ‘none’ can be particularly useful when the quoted text needs to be followed by a quoted structure.

Inserting a quoted structure immediately after a quoted text

To insert a quoted structure immediately after a quoted text either:

right-click in the Editor and select Insert Quoted Structure  

use the CTRL+Q keyboard shortcut, or

From the Insert menu on the toolbar, select Insert Quoted Structure.

Using the Quoted Text element rather than just manually typing quote marks around the text improves data quality which helps 

ensure the documents can be published successfully on legislation.gov.uk and helps other Lawmaker functions like the Tag 

Reference feature operate correctly.

Note: at present Quoted Text elements should not be used in an amendment instruction when drafting parliamentary amendments 

(but can be used within provisions being inserted in amendment, i.e. within a quoted structure within an amendment, as they would 

be within a Bill).

It is currently not possible to paste text into a Quoted Text element.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
http://legislation.gov.uk/
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Saving your document

This page explains how to save your document in the Editor and what happens when you do. 

Lawmaker also auto-saves your documents every 2 minutes. And you can save a snapshot of your document at any time.

How to save a document

To save changes in your document, do one of the following:

In the toolbar, click on the Save button.

In the toolbar menus, click Document>Save.

 Use keyboard shortcut Ctrl+s.

What happens when you save a document

Lawmaker will save the changes you made so that the copy on the server is the same as the one in the Editor. To do this, it only saves the 

fragments of the document that you have locks on (see Multi-user editing and locks ) because a lock will have been established as soon 

as you made a change to a particular fragment.

In addition, as a backup in case there is a problem with saving the fragments or the document gets corrupted, a full snapshot of the 

document is also saved (called “AUTO-BACKUP”). Each time you save, the existing auto-backup version is replaced.

Once the save action is completed, any locks you had on the document will be released, and the Editor will be updated with any changes 

that other users have made to the document.

Saving amendment lists

When you save an amendment list, some additional things happen:

Lawmaker will assign each amendment a unique reference, known as a D-number or Dnum.  The amendment will keep this reference for its lifetime 

and will be useful to refer to before they are assigned their official number as part of the parliamentary process. The D-numbers are based on the 

organisation that creates the amendment.

The instruction text of each amendment is parsed  to extract key information about the amendment that is used to correctly filter and sort the 

amendment in official lists. You can see the result of the parsing in the Amendment Information panel in the Editor.

Auto-save

Lawmaker will auto-save the document in the Editor every 2 minutes.

The auto-save version appears as a snapshot called “auto-save” on the Project Tab (see Documents and folders on the Project Tab ). 

Only you can see the auto-save snapshot.

When you manually save your changes, any auto-saved snapshot version will be discarded.

When you open a working version, Lawmaker will check whether you have any previous unsaved changes relating to the document version 

(i.e. whether an auto-save snapshot exists).  If there are, you can either:

Continue working on your changes, which will use the auto-save snapshot to restore the last auto-saved version, or

Discard your changes, which will open the last manually saved version of the document (and discard the auto-saved version).

Saving snapshots of your document

You can save a snapshot of the document you are editing at any time. This  will create a copy of the document in its current state and save it 

as a snapshot in the document’s version history without affecting the main version of the document (i.e. the one that is saved when you 

press the Save button).

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/8945675
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/8945675
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
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To save a snapshot:

1. In the upper toolbar, select Document>Take snapshot.

2. Edit the snapshot name in the Version Label field (it is set to “Saved” by default)

3. Click OK.

Hints and tips
The system will not allow you to navigate away from the project or open a new document version in the Editor if you have a document open 

with unsaved changes.

See Documents and folders on the Project Tab  for more about document versions (working, significant and snapshot).

See Multi-user editing and locks  for more about fragments and locking.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/8945675
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/8945675
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Using cut, copy and paste

You can use cut, copy and paste to edit content and move provisions, amendments and interstitial headings around a document or between 

documents. 

How to use cut/copy and paste with whole provisions, amendments and interstitial headings

Select the provision/amendment/interstitial heading, from the breadcrumb or Structure view, you would like to cut/copy using:

keyboard short cuts Ctrl + C (for copy) or Ctrl + X (for cut);

right-click context menu > Copy or > Cut (when mouse cursor is in Editor view and Structure view)

from the upper toolbar, select Edit > Copy  or > Cut

Navigate to the part in the document that you would like to paste the cut/copied provision/amendment/interstitial heading and place the 

mouse cursor at the end of the provision you would like the cut/copied provision/amendment/interstitial heading pasted after

Use the keyboard short cut (Ctrl + V) to paste the provision/amendment/interstitial heading

Before your provision/amendment is pasted, a message will appear to let you know exactly what will happen (e.g. will a duplicate be created 

or will a new version be created) allowing you to continue with the paste or cancel

The system will attempt to paste the cut/copied provision/amendment/interstitial heading into the next valid location after the 

provision/amendment/interstitial heading the mouse cursor is placed in.

Always use the keyboard shortcut Ctrl+V to paste. Ignore any menu or toolbar option for pasting as that will trigger Oxygen’s “paste 

special” feature which isn’t used in Lawmaker.

Hints and tips

Pasted provisions will be numbered according to the selected numbering mode:

Automatically Renumber Provisions will mean that subsections/schedule paragraphs and SI paragraphs and below will be automatically 

renumbered and all subsequent elements renumbered also.

Auto-assign mode means that the pasted elements will be numbered using the auto-assign rule e.g. 1A, A1 etc.

You can copy, cut and paste quoted structures by placing your cursor in the quoted structure and selecting “quoted structure” from 

the breadcrumb. To paste it, place your cursor in the provision you want your quoted structure to appear after and use the keyboard 

short cut Ctrl + v.

This works for amendments as well

To paste a provision before the first provision in a sequence, it can help to view block tags (see ‘Viewing tags’ to find out how).  With 

tags visible, place your cursor before the starting tag of the first provision in the document and paste

The system will only let you cut or paste a provision if it can acquire a lock on the parent provision

You can select more than one provision in a cut/copy and paste operation.  To do this, use multi-select in the Structure view (Ctrl + 

mouse click)

Multi-selecting provisions to cut/copy will only work for contiguous, sibling provisions e.g. sections 1-5 

If you want to cut/copy more than one provision that do not appear back-to-back, you will need to do these as separate operations

The system will attempt to find the next valid location to paste a cut/copied provision after the provision the mouse cursor is placed 

in

It is possible to copy/cut provisions from one document and paste them into the same document or even another document from the 

same project or a document from a different project.
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You can highlight the ‘body’ from the breadcrumb and copy all provisions in a document and paste them into the empty ‘body’ of 

another document

The system will check for duplicate references when it pastes so that means that

Cut provisions will maintain their unique references so that any cross references to the cut provision are maintained (assuming they 

are pasted back into the same document)

Copied provisions will be assigned new unique references to ensure any cross references to the copied provision(s) are not broken.

Amendments only

When pasting amendments into a document, the system will check what bill version the target document is associated with so that 

the amendment is pointing to the correct bill version.  If the bill version was different, a new version of the amendment is created 

upon paste.

When pasting amendments into a document, the system will be checking for duplicate amendments with the same unique 

reference.  If a duplicate exists, (e.g. if you copied an amendment from a list and pasted the copied amendment into the same list) 

the system will treat it as a new amendment
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Smart paste

Smart paste is used for copying text from outside Lawmaker into the Editor. Here is a screen cast giving a quick introduction to using this 

feature:

Using Smart Paste

Using Smart PasteUsing Smart Paste

https://youtu.be/551CN2-UtjQ
https://www.youtube.com/watch?v=551CN2-UtjQ
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How to use smart paste

Select the text you wish to copy from your source document and copy O (Ctrl C)

Open the Editor with the document you want to insert the text into and place your cursor in the appropriate location

Use the keyboard shortcut Ctrl + V to paste your copied text

How to workaround any smart paste limitations

Open up notepad or Word and paste the content into it

Check that there are line breaks at the end of each provision and then copy again (Ctrl C)

Hints an tips

Important: to be successful, the start of your pasted block should contain the highest level provision in your copied block of text e.g. 

if you have copied a section, followed by a cross heading: smart paste will not paste the following cross heading.  

To get around the issue, you either need to make sure the start of your copied block of text includes the highest level provision i.e. 

Cross heading, followed by a section, followed by a cross heading.

If you are copying data in chunks due to other smart paste limitations, consider manually adding the higher levels in later e.g. 

pasting only section level and using "Wrap element" to later insert the higher grouping level elements such as part, chapter and 

cross headings etc. 

Smart paste has been designed to work for the following scenarios:

Copying the body of a Bill/Act (including schedules)

Copying the body of an SI.  Note: smart paste cannot handle signatures yet, so to copy an existing SI/SSI, it is best to copy the body 

first and the schedules as a separate copy & paste operation.

Copying schedules

Copying quoted structures/amending text (nested quoted structures are also handled)

Copying portions of a document e.g. a part containing multiple sections, a list of subsections etc.

Copying individual amendment instructions (including any quoted structures) 

Scenarios not currently handled:

Signatures in SI/SSIs

Tables and images

Explanatory Statements in UK amendments

Proposer/Supporters in amendments

Multiple definitions on the same line e.g. “condition A”, “condition B”, “condition C”, “condition D” or “condition E” means that 

condition as set out in section 3;"

Front and Back covers & the preface (Enacting words etc.)

Footnotes in SIs (need to insert them manually into the Editor but at least you can copy and paste the text for each footnote from the 

source.  Sometimes they can trip up smart paste as they render as the same number format as paragraphs.  If paste is tripping up 

over the footnotes, the best thing is to paste the text into a Word document or notepad and remove the footnote references) 

“Schedules” heading (appears before Schedules in UK bills and SIs in certain circumstances)
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Known limitations:

If copying text from a website, be aware that websites can handle line breaks/carriage returns in inconsistent ways which can 

confuse smart paste.  For example, we've noticed that legislation.gov can sometimes miss carriage returns, particularly before 

closing words which will result in the closing words being added as text to the end of the provision before it or after definitions in 

SIs.  This is why it's really important to check what you have pasted into the Editor whenever you use smart paste.  

If copying from a PDF, there can often be carriage returns added to the end of lines in the copied text which will confuse smart 

paste.  

When copying from Legislation.gov.uk:

SI definitions: for some reason, there is no line break after a definition copied from legislation.gov (even though you can see one in 

the webpage rendering) so the easiest way around this is to paste a chunk of definitions (e.g. the Paragraph they sit within) into a 

Word document or notepad and manually insert line breaks (carriage return) after each definition.  Copy from the notepad and paste 

into Lawmaker in the appropriate location in your document.

Schedules when copied from Legislation.gov.uk: 

In a UK bill the reference note appears before the schedule num which confuses smart paste.  The easiest way around this issue is 

to paste the content of the schedule into a Word document or notepad and move the reference note from the start, to after the 

schedule number e.g.

Schedule 1 Section 2

Terrorism prevention and investigation measures

 

 

 

In Scottish bills, the reference note appears after the schedule heading.  The easiest way around this issue is to paste the content of 

the schedule into a Word document or notepad and move the reference note from after the schedule heading, to before the 

schedule heading so that it appears correctly between the schedule number and the heading e.g.

SCHEDULE 1

(introduced by section 1)

The Scottish Pubs Code

Other tips when a paste doesn't go to plan:

If using a PDF, it can sometimes help to export the PDF into a Word Document (File > Export to > Microsoft Word) and copy from 

the Word document

If text from a provision has been included in the preceding provision, this can be usually be corrected in Lawmaker by using the 

'Split' function and, if needed, 'Promote Element' or 'Demote Element' to convert the sibling provision into the appropriate provision.

If smart paste cannot work out a structure, it will paste the text as plain text, sometimes in the last provision it could recognise.  If 

this happens to you and 'split' is not going to work or will take too long to sort out the block of text, then it might be easier to select a 

smaller chunk of text to copy and paste as separate actions.  

Smart paste is as good as the data that it using to convert from.  Therefore it may be necessary to tweak the text in the source 

document e.g. to make sure you remove additional carriage returns or to ensure numbered provisions do actually have a number in 

the correct format

Check that the document you are copying doesn’t include line numbers as that will confuse smart paste

Smart paste can be further improved and the best way to ensure this is to let us know where a paste hasn’t worked as expected.  

Send the source document to the support email address (if you are allowed) so that we can investigate where the issue lies and 

http://legislation.gov/
http://legislation.gov.uk/
http://legislation.gov/
http://legislation.gov.uk/
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how we might be able to improve smart paste to handle that particular scenario.  
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Document checks - validating your document

As you draft your document, there are a set of validation rules being applied to check the document is correct in terms of legitimate Akomo 

Ntoso XML as well as some more general drafting practices.

How to review the validity of your document

Expand the right-hand panel by clicking on the grey left-facing arrow halfway down the right-hand side of the Editor window

Click on the ‘Document Checks’ panel

To see what rules have been broken select one or more ‘Phases’ from the drop-down filter

Any validation rules that have been broken will be presented

Using quick fixes

To automatically fix a broken validation rule:

From the right-hand Validation panel: find the validation rule tile which has a blue underscore ‘quick fix’ option and click on it;

From the tooltip in the Editor (see hints and tips): click on the blue underscore ‘quick fix’ option

The system will update the document which will remove the validation error.

 

 

Hints and tips

Work is ongoing with validations.  We will be doing a lot more work in future releases to capture more document checks for both bills 

and SI/SSIs. 

Click on the validation rule tile in the right-hand panel to see where in the document the specific rule has been broken, with an arrow 

pointing to it in the Editor

Click on the red underscore in the Editor which represents a broken validation rule to see where the rule is in the Validation right-

hand panel

Hover your mouse cursor over the red underscore in the Editor to see a tooltip explaining the validation rule that has been broken

Some validation rules have associated ‘quick fix’ options which will correct the structure of the document and consequently remove 

the validation error e.g. deleting the ‘text’ element out of provision’s content element.
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Managing document information

Some data appearing in the document can only be updated from the right-hand ‘Document information’ panel.  This includes information 

such as the title and document numbers.

How to update document information
1. Access the Document Information panel either by:

Clicking on the blue highlighted text in the Editor view which will automatically open the ‘Document information’ right-hand panel with the cursor 

point positioned in the corresponding field, or

Clicking on the ‘Document Information’ in the right-hand panel

2. Make changes to any of the fields

3. The system will update the fields in the document with the changes
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Hints and tips

You can also update the Document Information panel from the ‘Project’ tab which is a faster way of updating document information 

for larger bills. See Updating document information from project tab  

The right-hand panel will be minimised by default when you first open the Editor. 

To expand it, click on the grey left-facing arrow which will show the right-hand panel menu options. 

To close it again, click on the grey right-facing arrow.

Text in the editor that is highlighted blue represent data that can only be updated in the Document Information panel

You will need to ‘Save’ the document to save changes made in the document information right-hand panel.

In SI/SSIs

Some of the blue highlighted text is updatable from a pop-up modal rather than the document information right-hand panel to make it easier 

to manage certain bits of data i.e. document dates and subject information

Changing the procedure will update some of the metadata in the preface and preamble and a message will be displayed to warn you

In bills

You can provide your own version rubric by selecting ‘other’ and typing into the input field in the Document Information panel;

You can change the display of a Member’s name by clicking on the “Manage members” button at the bottom of the panel.  This will open a 

new dialogue box allowing you to update presenters and supporters as required, including using drag & drop to change the order of 

supporters.

In amendment lists

Some lists contain editable fields in the Document Information panel 

UK Bills only

Members names will be filtered according to the “Printed by” House that is selected.

If the Member in the House of Commons has a Laying name e.g. The Prime Minster, this will be displayed by default in the name 

field and presented in the Bill’s back cover

Scottish Bills only

If you change the version rubric to one that contains the phrase “as amended”, the accompanying document rubric will be removed 

and replaced with the usual ‘Amendment’ rubric

Changing the version rubric to ‘As Passed’ will not change the rubric displayed at the top of the page

https://lawmaker.atlassian.net/l/cp/Zrhzg0LJ
https://lawmaker.atlassian.net/l/cp/Zrhzg0LJ
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Inserting and managing tables

You can insert a range of per-formatted tables into your document.

How to insert a table

Place your cursor in the provision that you would like to insert your table after

Select to insert a table by:

Right-click menu “Insert table”

From the upper tool bar, select Insert > Insert table

Specify your table requirements in the dialogue box that appears:

Number of rows and columns

Whether you want to specify column widths (%)

Styles and formatting (for table number, caption, row header and all cells under the header row)

Page set up (repeating headers, table width and alignment), and

Border options (there are 5 pre-set formats)

Click ‘Insert’ when you’ve selected your criteria

Lawmaker will insert the table on the line below the text in your provision

How to update table properties

With your cursor in the table, select to update table properties by

Right-click menu select Table > Update table

From the upper tool bar, select Insert > Update table

Specify your changes in the dialogue box that appears

Specify column widths (in %) 

Styles and formatting (for table number, caption, row header and all cells under the header row)

Page set up (repeating headers, table width and alignment), and

Border options

Click ‘Update’ when you’ve specified your criteria

Lawmaker will update your table

How to insert additional rows or columns

With your cursor in the appropriate cell, select to insert a row or column by

Right-click menu select Table > Insert row before/Insert row after/Insert column to the left and insert column to the right

From the upper toolbar, select Insert > Insert row before/Insert row after/Insert column to the left and insert column to the right

The system will insert the appropriate row/column to your table based on your cursor location

How to delete a row or a column

With your cursor in a cell in the selected column/row, specify you would like to delete the column or row by

Right-click menu select Table > delete row/column
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From the upper toolbar, select Insert > delete row/column

The system will delete the selected row/column based on the cursor location

How to delete a table

Place cursor in the table that you want to delete

Click on ‘Tbl block'’ in the breadcrumb or select ‘table’ from the structure view

 

Press delete or backspace on your keyboard

The system will remove the table completely from your document

How to merge cells

Highlight the cells you wish to merge (vertically or horizontally)

Right-click and select Table > Merge cells

How to unmerge cells

Highlight the cell you wish to unmerge (vertically or horizontally or both)

Right-click and select Table > Unmerge cells

 

Hints and tips

You can create back-to-back tables by:

placing your cursor at the outer right-hand edge of the table so that the breadcrumb is ….> Content > Tbl block > foreign > table

using the right facing arrow key, move forwards 3 presses so that cursor is now inside the ‘content’ element and breadcrumb reads …> 

Content

now insert a table as usual using the ‘How to insert a table’ instructions above

the new table will be inserted after the existing table

to change the order, you can use the structure view to drag and drop the tables into a new order.  

It is possible to insert tables directly into Parts, Schedules and other non-text provisions

The row count includes the header row.  If you uncheck header in the styles and formatting, the row count will decrease by 1

If you delete the last column or row, you will delete the entire table

If you place your cursor in the header row, you can insert another row that is a header by selecting ‘insert row above’ or ‘insert row 

below’

It is possible to insert structured text in the table cells e.g. numbered lists including quoted structures

If the text looks squashed in the PDF it could be because the column width you specified is too narrow.  You will need to adjust the 

column width to correct the text formatting.

The PDF line counting will count each line of text within a row, including repeating headers

You cannot merge the first row of your table with the header row (vertical merge).  If you want to merge two cells in the header, you 

will need to insert another header row by placing your cursor in the header row and inserting another row before/after which will 

insert another row classed as a header row.
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When specifying the width of columns, you need to be accurate to 2 decimal places e.g a 2 column width might be 33.33 and 66.66.
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Inserting table of contents

A table of contents can be inserted into your document at any time.

How to insert a table of contents

From the upper tool bar, select ‘Insert > Insert table of contents’

If a table of contents doesn’t exist already, the system will insert a table of contents based on the current structure of your document

If a table of contents already exists, the system will replace the existing table of contents with a new one – including any changes that may have been 

made since the last one was inserted.

 

 

Hints and tips

To update the table of contents as the structure of the document changes, you will need to reinsert the table of contents

To delete the table of contents, you should select it either from the breadcrumb or using the structure view and click ‘backspace’ as 

you would delete a normal provision in the document.Bills only

The table of contents will include schedule chapters.  If you don’t want them included in your table of contents, select the entries in 

the table of contents and delete them using the breadcrumb and save.

SI/SSIs only

If your document contains regulations (or Articles etc.) without any headings, you will need to manually update the Table of contents 

to present it as required

For SIs and SSIs – it is not possible to add page numbers to your table of contents currently.

Finance Resolutions only

If you have marked resolutions in the document as s.5 PCTA resolutions, then an s.5 PCTA statement is inserted before the table of 

contents, listing all resolutions that have been marked.

UK Bills only

You can insert a table of contents without a Front Cover
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Inserting front and back covers
See:

Inserting UK Bill and Act front and back covers  

Inserting Scottish Bill and Act front and back covers  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
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Inserting and managing math formulae

The editor allows you to insert a mathematical formula into your document.

How to insert a math formulae

Place your cursor in the provision that you would like to insert formula after

Select to insert an formula by:

Right-click menu in the Editor View “Insert Math Formula”

From the upper tool bar, select Insert > Insert Math Formula

The system will present a "MathType" dialogue box

Either create the formula using the buttons or free text editor entry, or

Use the freehand option to draw the formula

Click OK

Lawmaker will insert the formula on the line below the text in your provision, followed by the "where—" statement

How to delete a math formulae

Click on the formula in the Editor

Select ‘tblock-formula’ from the breadcrumb and click ‘backspace’ or 'delete'

The formula will be removed from the document but the "Where—" statement will remain

To remove with "Where—" statement, click on it and select "Text" and click ‘backspace’ or 'delete'

How to update a math formulae

Double-click on the formula

Make any changes in the "MathType" dialogue box and click on OK.

Hints and tips

You can only adjust the font size and font in the "MathType" dialogue box if required 

You can view a third-party demonstration here - MathType demo - Equations editor (wiris.com)

https://demo.wiris.com/mathtype/en/index.php
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Images

The editor allows you to insert an image into your document.

How to insert an image

Place your cursor on the provision where you would like to insert the image, then either:

Right-click menu in the Editor View “Insert image”

From the upper tool bar, select Insert > Insert image

The system will present the Insert Image dialogue box where you can upload a new image or select from images that you’ve already 

inserted elsewhere in the document.

To insert a new image click Upload, navigate to the folder where your image is saved,  select it and click Open.

To insert an existing image, select it from the File list.

You must add Alternate text for all images. This is text which describes the image to assist visually-impaired users.

You can optionally add an Image caption and adjust the Width, Height and Image alignment. You can only adjust the height or the width 

as the system will maintain the image aspect ratio.

The system will warn you when the image quality is less than the recommended resolution of 300 dpi which required for print publishing.

The image selected must be in either jpeg or tiff format.

Insert Image Dialogue
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How to delete an image

Click on the image in the Editor

Select ‘img block’ from the breadcrumb and press delete or backspace

The image will be removed from the document without affecting the element it was inserted in

How to update image information

Click on the edit button next to the image in the document 

 

Make changes to any of the fields in the “Manage Image Properties” dialogue box and click Update button.

The system will update the image in the document with the changes.

 

 

Click on Img block

Hints and tips

The system will calculate the size of the image based on its properties and will display the image at a relative size alongside the text 

in the Editor.   The PDF will show its true size based on the mm height and width assigned.

The system will save the image files against the document version so that only users with permission to see the document will view 

the images.

When you duplicate a document version which contains images, these image files will be mapped to the duplicated version.

When you delete an image from the document, the image will not be removed from list of images available in the document version 

so can be reinserted if required.

See also:

How to create high resolution images of forms etc. from Word to insert into Lawmaker  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/73662474
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/73662474
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Inserting symbols and special characters

You can insert symbols and other special characters using the character map.

How to insert a special character

To insert a special character:

Click on the Insert special character icon on the toolbar,

Select Insert menu>Insert special character… from the toolbar, or

Right-click and select Insert special character.

 

The character map will present your most commonly used symbols but you can search for more by selecting More symbols… from that 

menu.

The selected symbol will be inserted at your cursor position in the Editor.

You can search for a symbol by name or by categories or hex code

You can select more than one symbol to insert when searching by name or category and these will appear in the ‘selected character’ field.

There is a keyboard shortcut for inserting em-dashes. Type in ‘- -‘ (dash dash) and it will be replaced by an em-dash.
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Inserting page breaks
Sometimes you need to over-ride the automatic pagination rules applied when generating a PDF to keep certain elements or groups of 

elements together on a page.  Examples include tables or groups of amendments. 

You can do this by inserting a page break marker in the document which will cause the content of the document after the marker to appear 

at the start of a new page.

How to insert a page break
1. Place the cursor in the text or object where you want the page break to appear after.

2. Right-click and select Insert page break.

The page break will be inserted at the end of text or object. It is not possible to insert a page break within a table, image or formula.

How to remove a page break
1. Place the cursor in the page break you want to remove.

2. Click on Page Break in the breadcrumb:

3. Press Backspace to remove it.
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Adding formatting to text (bold, italic, superscript etc.)

You can apply styling to text within your document. In most cases, if a whole element requires to be styled in a particular way, Lawmaker will 

style it automatically (e.g. headings to sections in a Bill will appear in bold). But sometimes you need to format a particular word or phrase 

with a particular style.

The styles that you can apply manually are:

Bold

Italic

Underline

Superscript

Subscript

How to apply formatting

In the Editor, highlight the text to be formatted and use the Format menu to select a style. The text selected must be within the same 

paragraph  – you cannot cross element boundaries.

You can also use the following keyboard shortcuts:

Ctrl+B - Bold

Ctrl+U - Underline

Ctrl+I - Italic

Ctrl+Shift++ - Superscript

Ctril+Shift+- - Subscript

 

You can can apply more than one style to the same text.
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Copying provisions between documents - push/pull

It is possible to take provisions from one document and either push them into another document; or pull them into the document you are 

currently editing.

How to push provisions into another document

Open the document containing the provisions that you want to 'push'

From the upper tool bar, select 'Tools > Copy provisions between documents....'

Select 'Push - Copy from this document to target document' using the radio buttons at the top

Select the document version that you want to 'push' your provisions to (the "Target document")

In the left-hand panel, under "This document", select the provisions you want to 'push'

Select whether you want to:

renumber the document after the copy

update x-refs in target document after copy

add a comment (enter comment text if you select this option)

Select 'Copy provisions' to push the provisions to your selected target document

How to pull provisions from another document

Open the document that you want to 'pull' provisions into

From the upper tool bar, select 'Tools > Copy provisions between documents....'

Select 'Pull - Copy from target document to this document' using the radio buttons at the top

Select the document version that you want to 'pull' provisions from (the 'Target document')

In the right-hand panel, under "Target document", select the provisions you want to 'pull'

Select whether you want to:

renumber the document after the copy

update x-refs in target document after copy

add a comment (enter comment text if you select this option)

Select 'Copy provisions' to pull the selected provisions into your document ("This document")

 Hints and tips

If the provision already exists, it will be replaced by the selected provision. 

If it doesn't exist but the sibling provision before the selected provision exists in the target document, Lawmaker will insert it after the 

sibling.

If Lawmaker couldn't find an 'anchor' provision, the copied provisions will be inserted at the end of the document. 

Push

You cannot push provisions to a document if that document is locked for editing by another user (this maybe a future improvement)

If you are pushing provisions around the same time as another user, your lock on the target document should be relatively short as 

the lock will be released as soon as the push operation has completed.
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Pull

The locking rules are a little less strict for pull: you can only pull provisions from another document if the selected provisions aren't 

locked AND if the parent node you are pulling them into isn't locked. In other words, another user can be editing a section in the 

document that you are pulling from; and another user can be editing a section in the document you are pulling the section into and 

both these locks won't stop you, however if another user has a lock on the section you want to 'pull' or if another user is editing the 

part that you are trying to 'pull' a section into, you will not be able to perform the pull operation until they have released their locks.
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Copying provisions from multiple documents

You can ‘pull’ provisions from multiple documents into a single document.  Combined with the feature allowing you to copy documents from 

other projects, this could be useful when merging different bill projects into a single bill or when compiling a single Finance Resolution 

Document from lots of separate Finance Resolution documents.

How to copy provisions from multiple documents
1. Open the document you want to pull provisions from multiple documents into

2. From the upper tool bar, select 'Tools > Copy provision from multiple documents...'

3. Select the documents you want to copy from using the check boxes

4. Select whether you want to:

a. renumber the document after the copy

b. update x-refs in target document after copy

c. add a comment (enter comment text if you select this option)

5. Select 'Copy provisions' to pull the provisions into your document

 

Hints and tips

If a provision already exists, it will be replaced by the selected provision. 

If it doesn't exist but the sibling provision before the selected provision exists in the target document, Lawmaker will insert it after the 

sibling.

If Lawmaker couldn't find an 'anchor' provision, the copied provisions will be inserted at the end of the document. 

You can only pull provisions from another document if the document doesn't contain locks to other users

You can only pull in provisions from documents of the same type.  This is particularly relevant to Finance Bill projects containing 

Finance Resolutions: it's not possible to pull finance resolutions into finance bills.  You will need to use copy & paste to handle that.
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Managing footnotes

You can insert footnotes in any document type, although it’s only used for SI/SSIs.

How to insert a footnote

Place the cursor where you would like to insert a footnote and insert one by:

Selecting ‘Insert > Insert footnote’ from the upper toolbar, or

Right-click and select ‘Insert footnote’

Keyboard short-cut Alt + f

The system will insert a footnote where your cursor is

To add text to the footnote, click on the footnote marker (an asterisk in the Editor, but will convert to a letter in the PDF rendition)

To hide the footnote, click on the footnote marker again

How to delete a footnote

Place your cursor in the expanded footnote and select “Footnote” from the breadcrumb and click on ‘backspace’

 

 

Screencast

Inserting footnotes

Hints and tips

You can add an additional paragraph to your footnote by using the keyboard shortcut ‘Shift + Enter’

When your document is printed, the footnote markers will convert to (a), (b) etc. restarting their numbering on each new page.

https://youtu.be/SHW-GSOaulg
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Managing J-refs

You can assign unique references to the main provisions in your Bill or SI to help you track them and to give you something more stable to 

use in correspondence. We call these references “J-refs” for continuity with existing terminology used by OPC and PCO.

You can view these j-refs in the Editor next to each provision. You can also choose to make them visible within cross-references and in a 

PDF you generate.

How to insert or update a J-ref

In the Editor, right click in the provision you want to assign a j-ref to and select Insert/Update J-ref from the context menu.

(You can also do this by right-clicking on the provision in the Structure View or selecting Insert menu>Insert/Update J-ref from the toolbar. 

Or use the keyboard shortcut: Alt+J)

The existing j-ref will be shown if there is one. If there a j-ref in the previous provision then Lawmaker will suggest a new j-ref, e.g. if the 

previous j-ref was “j100” then Lawmaker will suggest “j101”.

Add or update the j-ref and then click Save to record your changes. The j-ref you enter must be unique within the document and can be up 

to 10 characters long.

 

Once you save the change, the J-ref will be displayed:

in the Editor: in the left-hand margin against your selected provision

 in the Structure View: after the provision number but before the heading text.

How to delete all J-refs

Before publishing a Bill or sharing it with another organisation you may wish to remove all the j-refs from your document.

To do this, select Insert menu>Delete all J-refs from the toolbar.

The provisions you can assign a j-ref:

sections/clauses in Bills,

regulations, articles, rules in SIs,

schedules in both Bills and SIs.
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How to delete an individual J-ref

If you need to delete a j-ref assigned to a specific provision, follow these steps:

1. Place your cursor in the J-ref that you want to delete.

2. Expand the right-hand panel.

3. Click on the Attributes panel.  

 

4. Click on the value labelled ukl:jref.

5. Click on the delete icon (a bin) to remove the J-ref. 

 

How to show J-refs in cross references in the Editor

You can make the Editor show the j-refs within cross-references. This means that where the target provision of a cross-reference has a j-ref, 

it will show up in the cross-reference.

To do this, select Tools menu>Show/hide J-refs in cross references.

Repeat the action to stop showing them.

How to view J-refs in cross references in PDFs

You can choose to show j-refs within cross-references in the PDF you generate of your document. See Generating and viewing a PDF  .

 

 

 

if you add a J-ref after creating a cross reference to that provision, you will need to run 'update x-refs' for the J-ref to be visible in the 

cross reference. See References  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
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Using tracked changes

The Editor includes track changes feature which allows you to manage changes that you or another user has made, including accepting and 

rejecting them

How to activate change tracking

Click the “Toggle change tracking” button  on the tool bar (it will be highlighted grey when it’s enabled)

How to accept/reject tracked changes

Accepting tracked changes

From the right-hand panel > Review view: click on the black tick “Accept” button which will accept the whole change

From the right-hand panel > Review view: click on the  double green tick “Accept all changes” button which will accept all tracked changes in your 

document

From the right-click context menu: right-click on the change and select “Accept Change(s)” which will accept the whole change

From the hover-over/tooltip: hover your cursor on the change for a second and a tooltip will appear and select the green tick “Accept” to accept the 

whole change

Rejecting tracked changes

From the right-hand panel > Review view: click on the black tick “Reject” button which will reject the whole change

From the right-hand panel > Review view: click on the  double red cross “Reject all changes” button which will reject all tracked changes in your 

document

From the right-click context menu: right-click on the change and select “Reject Change(s)” which will reject the whole change

From the hover-over/tooltip: hover your cursor on the change for a second and a tooltip will appear and select the red cross “Reject” to reject the 

whole change

How to reply to changes

From the right-hand panel > Review view: click on the  black tick “Reply” button which will open a dialogue box with an input field to capture 

your reply

From the right-click context menu: right-click on the change and select “Reply” which will open a dialogue box with an input field to capture 

your reply

From the hover-over/tooltip: hover your cursor on the change for a second and a tooltip will appear and select the reply button which will 

open a dialogue box with an input field to capture your reply

How to change the view of tracked changes

From the ‘Review’ drop down menu in the upper tool bar:

Select “View All Changes/Comments” to have all tracked changes and comments represented in the Editor.  This is the default viewing 

mode.

Select “View Final” to preview the document as if all tracked changes (both inserted and deleted) were accepted.

Select “View Original” to preview the document as if all tracked changes (both inserted and deleted) were rejected.
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Hints and tips

Modifications made when tracked changes are enabled are highlighted as blue, underlined text for newly inserted text and red, 

strikeout text for deleted text

The right-hand panel > Review is useful for managing tracked changes and comments.  In this view the edits are presented in a 

compact form, in the order they appear in the document and each edit is marked with a type-specific icon. 

You can use this view to quickly navigate through changes, accept or reject them, or to add and manage comments for the changes.

You can also search for specific changes and it includes some filtering options (for example, you can filter it to only show certain 

types of changes or to only show changes for a particular author).

Click on the under the Review heading for further help on explicit filters for a more fine-grained control.

If you attempt to edit the document when the “View Original” mode has been selected, the view mode will switch automatically to “View all 

Changes/Comments”

If you use “View Final” or “View Original” mode, the callouts are not displayed for comments or changes

If you copy content from the Editor that contains tracked changes, the changes will automatically be accepted prior to the content 

being copied to the clipboard. This filtering is performed only if the selection is not entirely inside a tracked change.

Some operations are not marked with tracked changes because of the extra ‘behind the scenes’ work that is involved in their 

implementation.  These include things like deleting quoted structures or deleting the penultimate subsection/paragraph in a 

section/regulation.  These are known limitations and we will be stopping this disabling of tracked changes for these operations 

based on feedback from live users.
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Managing origin information

You can can record Origin information against provision in bills which can be used later to generate the Table of Origins.

How to insert/update Origin information

Place the cursor in the provision that you would like to insert origin information against and:

select ‘Insert > Insert/Update Origin information’ from the upper toolbar

select “Insert/Update Origin information” from the right-click menu in the Editor.

The system will present a modal allowing you to specify the Origin information in the appropriate format.

Click on the Save button.

How to delete Origin information against a provision

Right-click on the starting element of the provision that contains the origin information and select Delete Origin Information.

 

Hints and tips

You can optionally view origin information in the Editor by selecting Tools menu>Show/Hide Origin information in the toolbar.

You can also show origin information in the PDF - see Generating and viewing a PDF .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
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Multi-user editing and locks
Lawmaker allows more than one user to edit a document at the same time. To do that it operates a locking system where individual 

provisions or groups of provisions can be locked by different users. These pages provide help on managing locks and multi-user editing.

Locking document fragments/multi-user editing

Releasing Locks

Refreshing a document

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526913/Locking+document+fragments+multi-user+editing
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339194/Releasing+Locks
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339179/Refreshing+a+document
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Locking document fragments/multi-user editing

Lawmaker supports multi-user editing by locking fragments of the document to a specific user preventing other users making changes to the 

same fragment.   If no one else has a lock when you begin editing a fragment inside a document, Lawmaker will lock the fragment to you, 

noting the date/time that the lock was acquired so that other drafters in the document can see through the tooltip in the Structure View.  

For bill/SI/SSI provisions

To insert a new provision, the system will need to acquire a lock on the parent element.    

If you are editing an existing section, regulation, article or rule, the lock will only occur at the section/regulation etc level.  allowing many 

drafters to edit separate provisions at the same time in the same document. If you are editing a schedule, the same applies but the lock will 

occur at the schedule level or, if the schedule is divided into Parts, Chapters, or cross-headings, at that level.

For amendments

The lock will be at the amendment level or the amendment list level if you are editing a List of Draft Amendments (LoDA), Daily List, 

Marshalled List (including manuscript amendments and scripted marshalled list etc) and Grouping List.  

To insert a new amendment in a LoDA you will need a lock on the entire document.  

To edit an amendment, you only need a lock on the amendment thereby allowing other users to edit other amendments in the same list.  

Interstitial headings are treated as part of the document (e.g. LoDA, Daily List etc) so if you have inserted a new amendment (only possible 

in a LoDA) – all interstitial headings will be locked as well but this won’t interfere with other users in the same document editing existing 

amendments.

Once you save your changes, the lock is released.

Locks are shown in the structure view using padlocks, pencils and asterisks.  

Asterisk - represent newly inserted provisions/amendments/interstitial headings which haven’t been manually saved yet and are only 

visible to the user who created them until they save their changes.

pencil - this indicates to the user editing the fragment that it has been locked to them

padlock - this is what other users see when you have a fragment locked.   

Hovering your mouse pointer over the lock icons will display a message informing you who has the lock and when this lock was acquired.

Additionally, you will be able to see if another user has a lock on the document as the text in the Editor will also be highlighted grey.

It is not possible to insert provisions if the parent element is locked.  You will need to ask the other user save their changes (which 

will release all their locks) so that you can insert and save your new provision.  Saving after the insertion will allow you to continue 

editing your newly inserted provision without stopping another user from inserting or updating another provision with the same 

parent. 

Schedules created before version 17 was released (August 2024) will not be fragmented to the grouping level - they will remain as 

single fragments that can only be edited and locked at that level. However, as soon as the document containing the schedules is 

saved again, all schedules in the document will be fragmented at the grouping level.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339194
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Releasing Locks

You can force Lawmaker to release locks on a particular Bill or SI. (Locks are normally released whenever a user saves the document.)

How to release locks

If you are unable to contact the user(s) who have active locks on a document, in the upper toolbar, select Document > Release All Locks.

When Lawmaker releases the locks, it will create snapshot versions of all users’ unsaved changes so that their changes can be recovered if 

necessary. All users in the same organisation will be able to view the snapshot version.

 

Releasing locks should only be used as a last resort, e.g. when the user with active locks on a document is uncontactable and you 

cannot wait for them to release the locks themselves.
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Refreshing a document

When there is more than one drafter editing a document at the same time, it can be useful to refresh your document to see what changes 

others have made.

How to refresh a document

To refresh your document when another user has saved changes to it whilst you have it open:

Click on the Refresh icon in the upper tool bar

Select Document menu>Refresh Document in the toolbar, or

Use keyboard shortcut Alt+r.

The system will update the version of the document in the Editor with any changes saved by other users since you last saved.

If you refresh your document using the browser refresh button (or F5) then this will load the last auto-save version you have saved 

without the recent changes saved by other users.  If you have no auto-save version, it will load the last saved version on the server 

so at most you will lose is 2 minutes editing. If you attempted to edit a portion of the document recently updated (and saved) by 

another user, Lawmaker will let you know that you are about to edit an out of date version and will offer you the chance to refresh 

the document version to bring it up to date with the last saved changes.  

Hints and tips

The refresh button is only enabled when another user has saved changes to the document since you last saved it.

You do not need to have made any changes to the document for the ‘refresh’ button to work.

If you did make unsaved changes to the document, clicking on ‘refresh’ will not lose any changes you have made so you can 

continue editing after the refresh.
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Import legislation from www.legislation.gov.uk
You can import existing legislation into Lawmaker to create a new working version which you can edit further or copy into other documents. 

You can import a whole document or part of it (e.g. a specific section of an Act). 

The legislation is imported from www.legislation.gov.uk and you’ll need the URL (the web address) of the legislation you want to import.

How to import a document from legislation.gov.uk 
1. First, go to www.legislation.gov.uk and navigate to the legislation you want to import.

2. Copy the URL from the browser, e.g.

3. On the Project tab, click on the Document actions drop down menu.

4. Select Import from legislation.gov.uk.

5. Paste the legislation.gov.uk URL of the document (or part of the document) you wish to import in the URL field.

6. Select a folder and enter a version description for your new document.

7. Click Import.

Lawmaker will validate the URL to check that it points to a piece of legislation on  legislation.gov.uk URL. If it is valid, a new working version 

will be created on the Project tab containing the imported document.

What legislation can you import? (valid URLs/documents)

You can  import any primary, secondary, draft or EU legislation that is available on  www.legislation.gov.uk. That includes:

United Kingdom Public General Acts

Acts of the Scottish Parliament

Statutory Instruments (Regulations, Orders etc.)

Scottish Statutory Instruments

EU Regulations, Directives and Decisions

The import feature is still in beta as there are a number of edge cases that may need further refinement in future and some of the 

infrastructure used to support this feature is temporary while we await some important updates to Legislation.gov.uk  . 

Subsequent versions of Lawmaker will update this feature and make it more robust.

http://www.legislation.gov.uk/
http://www.legislation.gov.uk/
http://www.legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
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You should provide the URL of the document or provision in the document that you want to import. However, if you copy the URL for a 

document’s contents page, for instance https://www.legislation.gov.uk/asp/2022/3/contents , then Lawmaker will import the whole document 

(rather than the actual contents page).

If the URL contains a keyword for a specific portion, for instance https://www.legislation.gov.uk/asp/2022/3/section/2 , then only the 

specified portion will be imported

You can import different versions of a piece of legislation: original (as enacted), latest available (revised), or a point in time version. To do 

this, use the options on legislation.gov.uk to view a particular version and then copy the full URL from the browser (e.g. 

https://www.legislation.gov.uk/ukpga/1998/46/2017-05-18)

Converting the imported document to match the format of your project

By default, when you import a document, Lawmaker will convert it to match the format of the project you are importing it into. For example,  

importing a EU regulation into a SI project will convert the unique EU provisions into SI provisions. There is more information below about 

what is converted as part of this process.

If you untick the Convert document to match the format of this document option then the original elements from the imported document 

will be preserved (e.g.: importing a EU regulation into a SI project will import the document retaining its EU elements). This may be useful for 

citing/referencing purposes, e.g. when you plan to put the imported content within a quoted structure in your Bill or SI.

When importing a document of the same type of your project, it doesn’t matter whether Convert document to match the format of this 

project is ticked or unticked. 

What isn’t imported into Lawmaker?

Lawmaker only imports the main body of a document (including the schedules, annexes and appendices) and, in the case of an SI, the 

conclusions of the document (containing the explanatory note).

Some specific elements and information are removed when importing any document type:

any signature block

Editorial notes and markup about amendments to the imported provisions

Formatting information about tables (e.g. column widths, border formatting, landscape orientation)

The following are also removed when importing EU    documents:

the preamble

any attachment

Elements not yet supported

There are a few things that Lawmaker cannot import so copying URLs to these won’t work:

Associated documents

EU Treaties

Impact Assessments

PDF versions of documents

The import feature is currently beta. This means that there are a few elements that are not yet supported and, therefore, are not 

currently imported or are imported incorrectly. These are:

Images

Table notes

Hyperlinks

https://www.legislation.gov.uk/asp/2022/3/contents
https://www.legislation.gov.uk/asp/2022/3/contents
https://www.legislation.gov.uk/asp/2022/3/section/2
https://www.legislation.gov.uk/asp/2022/3/section/2
http://legislation.gov.uk/
https://www.legislation.gov.uk/ukpga/1998/46/2017-05-18


129

What happens when you import EU legislation into a Bill or SI
Each EU articles becomes a section in the Bill  or a regulation, rule or article in the SI (depending on subtype)

EU article paragraphs become subsections in the Bill (and stay as paragraphs within SIs).

Paragraph numbering style changes to match  Bill or SI style as appropriate.

EU annexes and appendices become separate schedules and all the schedules are numbered sequentially. The original number of the annex or 

appendix is retained and inserted as part of the schedule heading. For instance, 

Appendix II

Continuing Airworthiness Arrangement

might become:

Schedule 3

Appendix II - Continuing Airworthiness Arrangement

Within Annexes and appendices, Lawmaker will try and convert the content into a series of schedule paragraphs. Where there are extra headings 

that don’t fit neatly into the structure of a schedule, Lawmaker will put these headings into empty schedule paragraphs so you can delete them or 

modify the document further.

What happens when you import an Act into an SI or vice versa

When you import an Act into an SI, Lawmaker does the following:

Act sections become regulations, rules or articles (depending on SI subtype).

Act subsections become paragraphs within those regulations etc.

The numbering style of sections is adjusted (adding the full stop after the number).

When you import an SI into Act, the reverse is done.
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Amendments and amendment lists

In this section

Amendment Workspace Tab - working with draft amendments

Drafting and editing amendments

Inline amendments

Amendment Manager Tab - viewing and managing individual amendments

Creating, managing and updating official amendment lists

Applying Amendments

How to create and manage draft amendments using the Amendment Workspace and Amendment Manager tabs; and how to generate and 

manage amendment lists using the Official Lists tab.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/29917185/Amendment+Workspace+Tab+-+working+with+draft+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/30244878/Drafting+and+editing+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688621/Inline+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/30015489/Amendment+Manager+Tab+-+viewing+and+managing+individual+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/30212099/Creating+managing+and+updating+official+amendment+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526373/Applying+Amendments
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Amendment Workspace Tab - working with draft amendments

In Lawmaker, amendments are always worked on within a list. A list can contain one or more amendments.

The Amendment Workspace tab allows you to create and manage a type of list called a List of Draft Amendments (or “LoDA” for short). 

These lists are used to create and edit draft amendments before they are submitted but can also be used to collect together an ad hoc 

collection of amendments to work on (e.g. to review or to update statuses). 

An empty LoDA can be created on the Amendment Workspace tab or you can create a new LoDA from a temporary list (see Saving a te

mporary/ephemeral list as a new amendment list ).

Creating new amendments on a List of Draft Amendments (LoDA)

Managing amendment permissions

Duplicating amendment lists

Editing a document's version description/list name

Viewing Lists of Draft Amendments (LoDAs)

Moving a list of amendments to a different stage or Bill version

Deleting a List of Draft Amendments (LoDA)

Uploading amendment lists to create new amendments

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978541
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978541
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978541
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526389/Creating+new+amendments+on+a+List+of+Draft+Amendments+LoDA
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/170229761/Managing+amendment+permissions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526440/Duplicating+amendment+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688251/Editing+a+document+s+version+description+list+name
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526732/Viewing+Lists+of+Draft+Amendments+LoDAs
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60719105/Moving+a+list+of+amendments+to+a+different+stage+or+Bill+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/4030465/Deleting+a+List+of+Draft+Amendments+LoDA
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/525795329/Uploading+amendment+lists+to+create+new+amendments
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Creating new amendments on a List of Draft Amendments (LoDA)
Introduction

To create new traditional amendments, first navigate to the bill project to create your new amendments.

How to create a LoDA

From the 'Amendment Workspace' tab, click on the + New button in the top right

Select either to create:

Traditional amendments (to type in the instruction) or

In-line amendments (to edit the published version of the Bill to be amendmend)

The system will ask you to provide the following information:

Bill version

House (UK Amendments only)

Stage

List name

Proposer

When you have added the necessary details, click on the Create button

Lawmaker will take you to the Editor, with the List of Draft Amendments template loaded and pre-populated with the affected bill short title.

 

Hints and tips

When you save your amendment list, your locks will be released.  At the same time, the "Amendment Information" panel will be 

updated with any changes to the instruction resulting in different 'location' information e.g. if you changed a page or line number etc.

Selecting a proposer when you first create the list is optional.  It will mean that your first amendment is already populated with a 

proposer making it quicker to get started drafting the content of your amendment

The default permissions set will be that any user in the same organisation as you will have read/write access to your document 

including the ability to submit one or more amendments within it.

The bill version will default to the latest published bill version in the selected project.

If there have been no published bills yet, the default bill version will be “As Introduced” thereby allowing you to draft amendments in 

advance of the amending stages

The LoDA’ preface contains placeholder elements for stage information and a subtitle.  These can be deleted if not required

When you save your List of Draft Amendments, any new amendment will be automatically assigned a unique number constructed 

from the abbreviated form of the organisation you belong to, followed by a number e.g. HoC1 which will stay with the amendment 

throughout its lifetime and can provide a handy reference for the amendment before the official number is assigned

UK Amendments

The list of Members available in the "Proposer" drop down will update according to the selected House

If there are no published bill versions in the Project, the default House will be "House of Commons" but this can be changed

Lords: the Clause or Schedule number should be included in the text of the amendment instruction rather than inserting a separate 

interstitial heading.  Whenever a PDF is generated, the system will automatically create interstitial headings containing the clause or 
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schedule number.  

Ping Pong motions and amendments

See Creating ping pong motions and amendments on Lists of Draft Amendments (LoDAs)

https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=UM&title=Creating%20ping%20pong%20motions%20and%20amendments%20on%20Lists%20of%20Draft%20Amendments%20%28LoDAs%29
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Managing amendment permissions

By default, all documents created in a project (e.g. Bills, SIs, draft amendments, official amendment lists) are visible to and editable by all 

users in the same organisation as the user who created the document. 

On the Amendment Workspace, you can restrict access to specific lists of draft amendments (and the amendments within the list) so that 

only specific users in your organisation can view or edit them. At the moment you can’t restrict access to official amendment lists.

Restricting permissions on a list of draft amendments affects both the list and the amendments within the list. That means:

Only the specified users will be able to see the list and edit it on the Amendment Workspace tab.

Only the specified users will be able to see the amendments in the list on the Amendment Manager tab and interact with them.

When you add new amendments to an existing list, they will adopt the same permissions as the list, i.e., they will be restricted to the same 

users that have access to the list as a whole.

 

 

How to restrict permissions when creating a new list of draft amendments (LoDA)

You can restrict access to amendments and the list containing them at the time you create the list of draft amendments.

1. Click on the +New button on Amendment Workspace Tab.

2. Fill in the mandatory information for the list.

3. Click on the Manage Permissions button.

4. Select Only specific users in my organisation to over-ride the default permissions.

5. Select users from your organisation that you want to restrict the amendments to.

6. Click on the Update button.

7. When you click on Create a new list of draft amendments will be created but only the selected users will be able to see it on the Amendment 

Workspace tab and only they will be able to see the individual amendments in the Amendment Manager tab.

How to change permissions on an existing list of draft amendments
1. On the Amendment Workspace Tab, select Actions > Manage permissions on the list you want to update permissions on.

2. Select the appropriate radio button or add/remove user names as required.

3. Click on the Update button.

Bill and SI documents can also be restricted - see Managing document permissions  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
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When you submit amendments, the amendments will revert to being accessible (on a read-only basis) to all users in the submitting 

organisation (unless the amendments were submitted by a parliamentary user in which case the amendments will become editable 

by all users in the relevant parliamentary organisation).

A Document Administrator in an organisation can view all amendment lists created by users in their organisation.  However they will 

not be able to edit lists with restricted permissions unless they are named as an editor of that document.
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Duplicating amendment lists
It is possible to duplicate amendment lists which can have a number of benefits including the creation of scripted marshalled lists. 

How to duplicate an amendment list
1. From the Official Lists tab, select Duplicate version from the Actions menu next to the list you want to duplicate.

2. The system will present the Create duplicate version dialogue box.

3. Provide a unique list name and click on Create.

4. The system will create a duplicate version of the list. 

 

Duplicating a list does not duplicate the amendments within the list. Instead, the amendments in the duplicated list will be new 

instances of the amendments in the original list and so if you make changes to an amendment on one list, it will be changed in the 

other list too.

To duplicate the amendments themselves, use the copy amendments feature. See Moving a list of amendments to a different sta

ge or Bill version  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60719105
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60719105
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60719105
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Editing a document's version description/list name
Introduction

Each document version and List of Draft Amendments (LoDA) has a version description assigned which can be updated when the 

document is editable.  

How to edit a document’s version description

(For Bills and SI/SSIs) When on the ‘Project’ tab, click on the version description above the last modified date/time

(For LoDAs) When on the ‘Draft Amendments’ tab, click on the version description

Add your new version description and click on the save button when finished

The system will update the version description

Hints and tips

 

 

Hints and tips

(Bills and SI/SSIs) The version description must be unique within the project

(LoDAs) The version description must be unique within the bill version that the amendments have been assigned
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Viewing Lists of Draft Amendments (LoDAs)
Introduction

You can view all lists of draft amendments for a bill by clicking on the particular bill project from the dashboard. 

How to view lists of draft amendments

Select the project you wish to open

In tile view: click on the ‘Open’ link  on the bottom of the tile or the project title

In list view: click on the open folder button  to the right of the project row or the project title

The system will open the project and present the ‘Project’ tab displaying all versions of the document that you have access to.

Click on the ‘Amendment Workspace' tab to view all lists of draft amendments that you have access to

 

Hints and tips

Use the ‘search’ box at the top of the ‘Amendment Workspace’ tab to locate a particular LoDA if the list of LoDAs gets 

unmanageable.

The banner at the top of the page will display the project title (which is derived from the document's title) so it's clear which project 

you are viewing

To return to the dashboard, click on the home icon in the top left on the banner

You can filter the list of LoDAs by bill version using the bill version drop-down menu in the top left of the screen. 

It will default to the most recently published bill version for ease of use

The document tiles are coloured green if you have edit rights and grey when you only have read-only access.

Working versions are editable (subject to document permissions)

Clicking on the black triangle on a working version will expand the view of any snapshot versions related to this document version 

series; or hide the snapshot versions

Snapshot versions appear under the working version they relate to.  By default, they are not shown but clicking on the black 

triangle next to the working version description will show a list of snapshot versions sorted in chronological order. They are most 

commonly generated automatically when users generate a pdf or download a document bundle to capture the XML at that point in 

time.   But they can also be generated manually from the editor (see “Save a snapshot version”). 
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Moving a list of amendments to a different stage or Bill version
See Moving or copying amendments to a different stage (including ping pong motions)  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
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Deleting a List of Draft Amendments (LoDA)
You can delete a List of Draft Amendments if it is no longer required.

How to delete a list of draft amendments (LoDA)

On the Amendment Workspace Tab,  select Delete document from the Actions menu on the LoDA you want to delete.

Deleting a LoDA does not delete any amendments on the list. They will still be visible on the Amendment Manager Tab.
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Uploading amendment lists to create new amendments
You can create amendments in a project by uploading the XML of an amendment list that has previously been downloaded. Both the 

uploading and downloading can be done from the Amendment Workspace tab - official lists can also be downloaded from the Official Lists 

tab.

This can be useful for testing purposes or as a backup strategy.

How to download an amendment list

To download the XML of an amendment list, go to the Amendment Workspace or Official Lists tab in a bill project and click the Actions 

menu next to a working version of an amendment list; then select Download ZIP File:

 

A ZIP file will be downloaded to your Downloads folder. Right click on it and extract the contents to a new folder. It should contain an XML 

file.

How to upload an amendment list

Navigate to the other bill project where you would like to upload the new amendments from the list, and go to the Amendment Workspace 

tab. Click the Upload button in the top-right.

Screenshot showing a list on the Amendment Workspace with the ‘Download ZIP File’ action highlighted

Screenshot showing a list on the Official Lists tab with the ‘Download ZIP File’ action highlighted
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In the modal, select the bill version you want to create the new amendments against, the amending stage (and if uploading UK Bill 

amendments, the House), and give the List a name. The click ‘Choose File’ and navigate to the folder containing the XML of the amendment 

list you wish to upload.

 

Click Upload. A green toastie notification will appear onscreen while the amendments are processed and new draft amendments created. A 

new list should then appear on the Amendment Workspace tab containing the amendments from the uploaded list.

Screenshot of the upload button

Screenshot showing the ‘Upload Draft Amendment List’ modal

New amendments created using this method will be created in a Draft state, irrespective of the status assigned to them in the downloaded 

list. Their lifecycle history will be reset.

Proposer and Supporter information will be preserved.

New amendments Dnums will be assigned to all the amendments in the list.

You can’t upload amendments of the wrong type to a bill versions. For example, you won’t be able to upload House of Lords amendments to 

House of Commons or Scottish bill version.
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Drafting and editing amendments
When working with the content of amendments, Lawmaker uses the same editor experience as for drafting and editing Bills. However, there 

are some particular features of the editor that only apply to amendments.

Inserting/deleting amendments or interstitial headings

Managing proposers and supporters

Bulk update of proposers and supporters

Inserting an amendment note

Managing cross references to other amendments

Managing amendment information

Renumbering amendments

Turn on/off line number on amendments (including ping pong motions)

Updating the status of amendments within the Editor

Undoing an amendment status/managing lifecycle events

For general help on editing documents, see Drafting and editing  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526493/Inserting+deleting+amendments+or+interstitial+headings
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526541/Managing+proposers+and+supporters
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115277837/Bulk+update+of+proposers+and+supporters
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526485/Inserting+an+amendment+note
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526533/Managing+cross+references+to+other+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526517/Managing+amendment+information
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526629/Renumbering+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526682/Turn+on+off+line+number+on+amendments+including+ping+pong+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60817409/Updating+the+status+of+amendments+within+the+Editor
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526690/Undoing+an+amendment+status+managing+lifecycle+events
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
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Inserting/deleting amendments or interstitial headings

Introduction

The editor uses a Content Completion Assistant (CCA) to help you insert valid XML content.  It offers a list of elements that are valid at your 

cursor’s location and will insert your selected element in the next correct place in the document.

How to insert an amendment/interstitial heading

Place cursor in the amendment/interstitial heading that you want to insert your new element after and click Enter

The system will present the CCA

Select the element you wish to insert next, using the down/up arrows or mouse and click Enter again

The selected element will be inserted in the next correct place.

How to insert an amendment using the keyboard shortcut

Place cursor in the amendment/interstitial heading that you want to insert your new element after and click Ctrl + Enter

The system will insert an amendment in the next correct place.

How to insert an amendment/interstitial heading using right-click menu in the Editor

Place cursor in the amendment/interstitial heading that you want to insert your new element after and right click on your mouse

The system will present a context menu

Select “Insert element…”

The system will present the CCA

How to insert an amendment/interstitial heading using the upper toolbar

Place cursor in the amendment/interstitial heading that you want to insert your new element after

Select Insert > Insert Element… from the dropdown menu in the upper toolbar

The system will present the CCA

How to delete an amendment/interstitial heading

Either select the appropriate amendment/interstitial heading using any of the following methods:

highlight the amendment and/or interstitial heading in the Editor

select the amendment/interstitial heading(s) from the structure view

Click on 'Amendment' or 'Interstitial heading' from the breadcrumb

Click 'delete' or 'backspace' key

The system will remove the selected amendments or interstitial headings from the list

 

Hints and tips

Amendments are not numbered when they are first inserted. 
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Unique references are assigned once you first save a new amendment e.g. HoC1

To insert an amendment or interstitial heading before the first element in the list place your cursor in the first element in the list e.g. 

Proposer’s name.  Use your left arrow to move the cursor through the different elements so that the breadcrumb shows “Draft List > 

List body”.  Now you can click Enter to select the element you want to insert before the first element in the list.

You can only insert new amendments in Lists of Draft Amendments (LoDAs), and they will default to status “Draft”

Quoted structures (amending text) can be added to amendments in the same way they are inserted into bills – see “Inserting textual 

amendments (quoted structures)”

If you are deleting the only instance of a draft amendment from a list, it will be removed completely.  It is possible for the same 

amendment to appear on multiple Lists of Draft Amendments (LoDAs) - in which case, deleting one of these LoDAs will not remove 

that amendment from the system.  

Where appropriate, amendments will include placeholders for pertinent information e.g. Section/Clause number or Page/Line 

numbers.  You can use tab to move into the next placeholder which can be useful particularly for 'page-line' type amendments.  As 

soon as you type into a placeholder, it disappears and is replaced by text.
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Managing proposers and supporters
Proposers and supporters for amendments and ping pong motions can be updated through a dialogue box giving you the option to select 

from the list of current Members from the relevant parliament or house.

How to add/update proposer and/or supporters

1. Either:

Click on the proposer's name (or placeholder element if no name has been specified yet), or

Right-click on the proposer (or supporter names) and select “Update Proposers/Supporters”,

2. In the Manage proposers and supporters dialogue box you can add, update, re-order or delete Members' names as required.

3. When you finished, click Update button

How to paste a supporter block into an amendment that doesn't already have supporters
Copy the supporter block from an amendment

1. Place your cursor in any of the supporter names in the selected amendment

2. Select Supporter block from the breadcrumb which will highlight all the supporters

3. Copy the supporters (ctrl + c or right-click and select 'copy')

Paste the supporters into your selected amendment

1. Place your cursor in the num element of the amendment you want to paste your supporters into (that doesn't already have supporters)

2. Click on your left arrow key 5 times to move your cursor through the hidden XML tags until it ends up in the Proposer Block element

3. 

4. Use keyboard short cut Ctrl + V to paste the supporter block into your amendment

How to delete all supporters
1. If you want to get rid of all supporters on an amendment, place your cursor in any of the supporter names in the selected amendment

2. Click on Supporters block in the breadcrumb

3. 

4. The system will highlight all the supporters in the Editor

5. Click on backspace to remove all supporters from the amendment

breadcrumb

breadcrumb
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How to change the order of supporters 
1. Open the Manage proposers and supporters dialogue box by clicking on the blue proposer name in the amendment list

2. Use the left-click on your mouse and hold it down as you drag the supporter to the new position

3. Release the left-click and the supporter will be moved to its new position

How to add proposers to a ping pong amendment that doesn’t already have one
Ping pong amendments (that sit within the ping pong motion) do not automatically have a proposer.  Sometimes, particularly in the 

Commons, different sponsors need to be recorded against different ping pong amendments within a ping pong motion.  

1. Place cursor in the ping pong amendment you wish to add sponsors to

2. Right-click and select Update Manage proposers and supporters 

3. The Manage proposers and supporters dialogue box will open allowing you to add a proposers and any supporters to that ping pong amendment

 

 

When you are in a List of Draft Amendments (LoDA) and you have inserted a new amendment after an existing amendment which had a 

proposer specified – the newly inserted amendment will only copy the proposer from the previous amendment.  It will not copy the 

supporters if the previous amendment had supporters as well.

For Commons: see also Adding [R] to Members with Registered Interests  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526357
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Bulk update of proposers and supporters
You can update the proposers and supporters in multiple amendments at the same time. You can:

Update the amendments so they all have the same proposer, or

Add, remove or replace supporters on selected amendments.

How to update members in more than one amendment
1. Open the amendments in the Editor - you can open an existing list, e.g. a LoDA or a marshalled list, or you can create a Temporary list.

2. From the Tools menu, select Update Members…

3. In the dialog box that appears, first select the amendments you want to update. By default, all amendments in the list will be updated but you can 

select specific amendments using the Amendments to update dropdown menu.

4. Select which action you want to perform. You can replace the proposer with a new proposer, remove specific supporters, add specific supporters or 

replace the existing supporters with new supporters.

5. Enter the member or members to be added or removed in the Member(s)  box.

6. Click Update.

The selected amendments will be updated and you can then save you changes if you’re happy with the update.
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This feature will also work with ping pong motions but it will only change the proposer and supporters of the motion, not any 

amendments within the motion.
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Inserting an amendment note
Introduction

Lords and Scottish Parliament amendments can sometimes have notes added to them in italics, appearing between the proposer/supporter 

names and the instruction text e.g. In substitution amendment in Scottish Parliament or substantively updated Lords amendments.

How to insert amendment notes

1. With your cursor in the selected amendment,

Right-click and select Insert Amendment Note, or

From the upper tool bar, select Insert > Insert Amendment Note

2. Lawmaker will insert a note element allowing you to add the text of your amendment note
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Managing cross references to other amendments
Cross references can be created to other amendments inside Explanatory Statements.  The system will create a link to the target 

amendment so that when it is assigned a number, the cross reference e.g. Lawmaker will detect these changes and update the displayed 

number following an ‘update’ operation.

See References  for more information on cross-references generally.

How to create a cross references to an amendment

Manually paste cross references

To manually create a cross-reference to another amendment in an explanatory statement, browse to the target amendment you want to 

cross refer to using the Structure View

Right-click on the amendment and hover the mouse cursor over the ‘select x-ref to copy’ menu, selecting the amendment cross reference 

text from the second context menu presented by the system

Return to the Editor view and click with your mouse cursor in the place in your explanatory statement that you would like the cross reference 

to be inserted

Use the ‘paste’ keyboard shortcut Ctrl + V to insert your cross reference into your specified location.  Manually created cross references will 

always appear in purple text when they are first inserted, to indicate they are valid.

See the table at the end of References   for more details about the formatting of references in the Editor.

How to update cross references to amendments

Either:

Highlight some text or the whole explanatory statement (by selecting it in the structure view or selecting 'explanatory statement' from the 

breadcrumb); or

Leave your cursor in the amendment list

Specify you would like to check for existing cross references by

Clicking the Update references icon in the upper tool bar

From the upper tool bar, select Tools > Update x-refs

Right-click in Structure view or Editor view and select  Update references, or

Use the keyboard short cut Alt + u

If you didn’t highlight a provision, the system will check whether you want to update the current provision that your cursor is in, or whether 

you want to update the whole quoted structure/amendment list (depending on cursor placement).

Specify your preferred range

The system will attempt to acquire a lock on the appropriate document fragment if it hasn’t got one already and will then update any existing 

cross references and present any that it finds according to the table below.

How to remove (unwrap) cross references to amendments

See the section on removing references in References   for help with removing references.

 

Hints and Tips

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
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The House of Lords and the House of Commons have agreed for amendment cross references to be inserted as capital 

"Amendment X" 

The system will present the unique number if the amendment hasn't been assigned a number yet e.g. HoC1.  When the amendment 

has been assigned a number, running 'Update x-ref' will resolve the cross reference so that it uses the number instead of the unique 

number.

Don’t use ‘Paste’ from the right-click menus or upper toolbar as this uses a specific “paste special’ method that hasn’t been properly 

configured to work in our version of the application yet.
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Managing amendment information
Introduction

Metadata relating to the amendment is displayed in the right-hand panel called Amendment Information.   In most cases, the amendment 

information is automatically generated by parsing the amendment instruction/ping pong motion heading to work out the clause/page/line etc. 

information.  This information is used by Lawmaker when sorting amendments or motions in lists.  In some cases, namely amendments to 

amendments in the House of Lords and House of Commons, the instruction doesn't contain enough context for sorting so the Amendment 

Information can be manually updated to allow more fine-tuned sorting to take place.

How to view amendment information

In the Editor, click on the Amendment Information panel 

How to update amendment information (e.g. adding a sort code)

1. In the Editor, click on the Amendment Information panel 

2. Click on the cell for the relevant attribute you want to update

3. Make changes and wait for the document to update with the changes

The whole right-hand panel can be minimised/expanded by clicking on the grey arrow on the side of the panel

If you select a different amendment in the Editor, the Amendment Information panel will update to reflect the information associated to the 

newly selected amendment

The Sort Code is an optional field which can be updated to allow fine tuning sorting where necessary e.g. 2 x amendments inserting new 

sections in the same location

The Location information is updated after an amendment has been saved (including changes to the amendment).  

For ‘normal’ amendments, the system will parse the instruction text and work out the various location information which is used by the 

system for sorting amendments in official lists.



155

For ‘ping pong’ motions, the system will parse the motion heading e.g. COMMONS AMENDMENT 1 in order to link the motion to the 

target amendment

Appropriate text to manually insert:

Location: "before" or "after" (used in Lords and SP for new clauses and new amendments e.g. "After Schedule 2"

Provision: "sec_7" or "sch_2" or "amnd_3" (amnd_3 = the target amendment)

Page: the appropriate page number e.g "4"

Line: the appropriate line number e.g. "20"

Sort code: this is uses numeric or alphanumeric sort so it's up to you how you would like to use this function in your jurisdiction

See also [Commons and Lords] Amendments to amendments  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60653569
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60653569
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Renumbering amendments

Introduction

You can number your amendments using the 'Renumber Amendments' function in the Tools upper tool bar menu.  It is only possible to 

renumber amendments in the List of Draft Amendments (LoDA), the temporary list opened when you Edit a selection of amendments in the 

Editor; or the Consolidated List of Amendments.

How to renumber amendments

From the Upper tool bar select "Tools > Renumber Amendments" 

Specify a starting number and click on 'OK'

The system will update the numbers of all amendments in the document

 

Hints and tips

You can use this function to assign temporary numbers to your amendments as you draft them

The system will not be checking for uniqueness, so if you are using this for official numbering, it will be up to you to ensure the 

numbers assigned to amendments are unique

This function will overwrite officially assigned numbers so make sure you use this function with caution

This function will help when preparing Consolidated List of Amendments
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Turn on/off line number on amendments (including ping pong motions)

Introduction

It’s possible to manually turn on/off line numbering on amendments, including ping pong motions in the UK, if you want line numbers to 

appear when there isn't an amendment to an amendment targeting the amendment/motion.

How to turn on/off line numbering

With your cursor in the selected amendment, right-click and select “Update line number status”

The system will present the “Update line number status” dialogue box

Select whether you want to turn on or turn off line numbering and click ‘Update’

The system will update the amendment/motion accordingly

 

 

Hints and tips

You can set line numbering against a ping pong message, ping pong amendment and ping pong motion - as well as normal 

amendments.

Line numbers are generated as part of the PDF generation process which means you won't see the line numbers against your 

selected amendment/motion until you view your generated PDF

Line numbers appear as they do in bills - every 5 lines.

Line numbers will continue to appear by default according to the existing logic applied to amendments to amendments: if the target 

amendment appears before the amendment to amendment, it will be line numbered by default.  This cannot be turned off using this 

feature.
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Updating the status of amendments within the Editor

The status amendments can be updated individually or in bulk in the Editor. This feature is only available to parliamentary users.

All amendments start with a status of “draft”. Their status can then be updated to reflect the lifecycle of the amendments, e.g., to show that 

the amendment has been submitted to parliament or to record the outcome of a parliamentary vote on the amendment.

How to update the status of a single amendment
1. Place your cursor within the text of the amendment you want to update.

2. Click on the Amendment Status panel on the right hand side of the Editor.

3. The current status will be shown next to the Status label. Below that will be a series of buttons showing the possible transitions from the current 

status. For example, if the status is “Submitted” then buttons for Tabled and Rejected will be shown.

4. To select a new status, click on the appropriate button. The button will change colour to indicate that it has been selected. You can click on it again to 

deselect it, leaving the current status unchanged.

When you save the list containing the amendment, the new status will be committed and the Amendment Status panel will be updated to 

show the current status.

How to update the status of a number of amendments at the same time

You can update the status of all the amendments in a list, or a subset of the amendment, using the Bulk update statuses button on the 

Amendment Status panel.

If you want to revert the status of an amendment back to an earlier status or to change the status to something other than one of the 

normally-allowed transitions, you can directly manage the lifecycle events stored in the XML by clicking on Manage lifecycle 

events - see Undoing an amendment status/managing lifecycle events  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526690
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526690
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By default, the status of all amendments will be updated. To select a subset, click on the Amendments to update dropdown  and use the 

checkboxes next to each amendment to select or deselect the desired amendments.

Use the Status transition dropdown menu to select the status update you want to make. The menu will show all the possible transitions for 

amendments of the type in the document (e.g. Scottish amendments, Commons amendments or Lords amendments).
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Click Update once you have selected the amendments and the status transition.

The update will only apply to amendments that have the status first mentioned in the transition. For example, if you select “Submitted to 

Tabled” then the update will apply to all selected amendments that currently have a status of “Submitted”; it will ignore any amendments that 

have different statuses but a message will pop up informing you that some amendments were not updated.
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Undoing an amendment status/managing lifecycle events

Introduction

It’s possible to manually update events that have happened to an amendment.  An event includes submitted, tabled, published.  If you 

accidentally tabled an amendment that shouldn’t be, you can use this filter to undo that state change by removing the event from the 

amendment.

How to update an amendment status

1. Open the amendment in a temporary list by selecting  Amendment Actions > Open temporary list from the drop-down menu in the top right of the 

page

2. Place your cursor in the first amendment in the list and click on the Amendment Status panel in the right-hand panel in the Editor

3. Click on the Manage lifecycle event blue, underlined hyperlink

4. The system will present a dialogue box listing all the recorded ‘events’ or statuses linked to the amendment. 

5. You can add, delete or update any of these events

6. When you have finished making the changes, click on the Update button

7. When you return to the Editor View, click on the Save button in the upper tool bar

 

If an amendment has been published on a list, there will be a link available to click on which will open that list so that you can view the 

amendment on it – there may be more than one list that an amendment is published on e.g. Daily List, another Daily List (if an amendment 

to it was lodged), 1st Marshalled List, 2nd Marshalled List and associated Grouping Lists.
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Inline amendments

Lawmaker enables you create parliamentary amendments by editing the existing version of the Bill instead of drafting them as “traditional” 

amendments. In Lawmaker, this is called “inline amending”.

The process is similar to make changes to document in tracked changes mode.

Lawmaker can then automatically generate versions of the amendments in the traditional form which can be submitted and managed in the 

same way as amendments that were drafted from the outset in the traditional form.

In this Section

Creating an inline amendment

Removing an inline amendment

Viewing traditional amendments

Removing a warning marker from an inline amendment

Managing proposers and supporters on inline amendments

Working with inline amendments

When creating your inline amendment document, you will be able to specify a proposer which will be applied to all inline amendments in that 

document.  You can update the proposer and supporter information in an inline document which will update all amendments in that 

document.  Alternatively you can choose to update individual amendment's proposers and/or supporters when viewing the traditional form of 

the inline amendments.

Using the "Inline Amendments" summary panel, you can navigate between the inline amendments, choosing to view or remove 

amendments from that document.  

For larger bills, it is also possible to open portions of the inline document, allowing you to create inline amendments against specific 

provisions which will help with performance issues. 

Types of amendments currently handled

For the first iteration of inline amendments, we've focused on the 3 main types of amendment:

Insert (including inserting new clauses/sections and schedules)

Leave out, and

Substitute (e.g. leave out X and insert Y).

Converting inline amendments to traditional amendments

As soon as an inline amendment has been saved, it can be viewed in traditional form and is available on the 'Amendment Manager' tab. 

 The traditional amendments that are generated will include proposer and supporter info, Dnumbers and any other relevant metadata (e.g. 

Ids and location attributes) equivalent to what the amendment would have if drafted as a traditional amendment.  Inline-derived 

amendments can be edited in traditional form.  This will set a warning marker against the equivalent inline amendment which lets you know 

that the traditional form of the inline amendment has been updated and prevents you from editing it.  Markers can be manually removed 

from the inline amendment if you did want to overwrite the changes made to the traditionally formatted amendment.  

Managing traditional amendments generated from inline amendments

Amendments generated from an inline document can be handled in exactly the same way as a traditionally generated amendment once 

they appear on the 'Amendment Manager' tab.  They can be submitted, tabled, set to 'On hold' etc.;  and they will be included in the official 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526797/Creating+an+inline+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526821/Removing+an+inline+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526829/Viewing+traditional+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526813/Removing+a+warning+marker+from+an+inline+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526805/Managing+proposers+and+supporters+on+inline+amendments
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lists as part of the list generation process.

What is planned for future iterations

The inline amending (and auto-application of amendments) features will be extended to cover the following types of amendments in future 

iterations:

Amendments to content within tables

Amendments to divide and move/transpose provisions

Amendments to the preamble and long title in UK Bills

Some less common forms of wording in traditional amendments, such as amendments that include the phrase "to end of clause" or "to end 

of subsection". haven't been catered for yet and will be tackled in future versions.

We will also continue to refine how inline amendments behave to make the process more robust while keeping it flexible. Feedback on edge 

cases that aren't correctly handled at the moment  will be essential to refine future iterations and should be directed to the Lawmaker 

support email address.
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Creating an inline amendment

Introduction

Lawmaker can create traditionally formatted amendments from changes made to the text of the bill.   This can make drafting amendments 

easier and often a quicker process.  The traditional amendments that are generated can be submitted to the relevant Parliament for 

tabling/lodging.  

How to get started
1. From the Amendment Workspace tab, click on the + New button in the top right

2. Select 'Inline' and fill in the usual information in the dialog box

3. A new tab will open with a copy of the bill in the Editor ready to start amending

How to create inline amendments

You can create ‘insert’, ‘leave out’ and ‘substitute’ amendments using the inline feature.  It is not possible to create ‘divide’, ‘transpose/move’ 

or amendments to amendments.  

Once you have created an inline amendment a card appears in the Inline Amendments right-hand panel showing what type of amendment it is and 

the name of the member.  

When you save your inline amendments, each amendment will be assigned a unique number (DNumber) which appears on the card in the right-hand 

panel, but also after the inline amendment in your document.

Only when you have saved your inline amendments can you view them in traditional format.

You can only submit amendments from the traditional view

How to create 'Insert' type amendments

Insert text amendments e.g. a word or sentence in an existing provision

1. Place your cursor where you want to insert the new text

2. Press Enter to bring up the insert menu and select Insert text

3. A new ‘text’ placeholder element will appear, surrounded in square brackets allowing you to type in the new text

Inserting new provisions e.g. new subsection(s)

1. Place your cursor where you want to insert the new provision

2. Press Enter to bring up the insert menu and select the appropriate provision

3. An empty provision will be inserted in the next valid place after the cursor location, surrounded in square brackets, allowing you to type in the new 

text

How to create 'Leave out' type amendments

1. Highlight the text or provision(s) that you want to leave out (use the structure view or breadcrumb to help you select whole provisions)

2. You can either:

a. From the floating tool bar, select Leave out, or (if the floating tool bar doesn’t appear - and it won’t if you select using the structure view or 

breadcrumb)

If you are amending a large bill, the recommended approach is to edit a portion of the document at a time.  To do this, create the 

inline document following the steps above for How to get started and close the document once it has finished loading in the new 

Editor tab.  Back on the Amendment Workspace tab, select Actions > Edit portion of document and this will only open the 

selected portion of your document, improving performance when drafting amendments inline.
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b. From Inline Amendment Tools in the right-hand panel, select Leave out

3. The text/structure you selected will be highlighted in red and struck out with a start and end square bracket denoting the extent of the leave out 

amendment

How to create 'Substitute' type amendments

1. Highlight the text or provision(s) that you want to leave out (use the structure view or breadcrumb to help you select whole provisions)

2. You can either:

a. From the floating tool bar, select Substitute, or (if the floating tool bar doesn’t appear - and it won’t if you select using the structure view or 

breadcrumb)

b. From Inline Amendment Tools in the right-hand panel, select Substitute

3. The text/structure you selected will be highlighted in red and struck out with a start and end square bracket denoting the extent of the leave out part 

of the substitute amendment.  Additionally an empty element will be inserted allowing you to insert text/provision depending on what you leave out:

if you left out a whole provision, the same provision will be automatically inserted for you after the left out provision (i.e. a direct substitution)

if you left out some text, a 'Text' placeholder will appear after the text that you left out, ready for you to add substitution text.  You can continue 

adding further provisions after the text if required

if you left out a combination of text and provisions: 

if the selection to be left out starts with text followed by provisions then a 'Text' placeholder will be inserted after the last left out provision.  You 

can continue adding further provisions after the text if required.

if the selection to be left out starts with provisions followed by text, then the same kind of provision that is being left out will be inserted after 

the end of the leave out selection, and the trailing text in the last provision will be moved into that newly inserted provision after the 'Text' 

placeholder.

How to view your inline document in traditional amendment format
1. Once you have saved all changes in your inline document, from Inline Amendment Tools in the right-hand panel, select View Traditional 

Amendments

2. A new tab will open with a LoDA showing all your inline amendments in traditional format.

How to update Member information from inline documents
1. From the Inline Amendment Tools in the right-hand panel, select Manage Members

2. You can add or remove proposers and supporters and this will update all amendments in the inline document

The recommendation is to update Members when the amendments are in traditional format using existing Member editing tools as this will 

be a more efficient tool.

 

Warning markers

These will appear on the cards that appear in the Inline Amendments right-hand panel to inform you that changes have been made to 

the traditional form of the amendment because changes do not sync back to the inline rendition of the amendment.  

This includes adding explanatory statements (UK amendments only)

The marker will prevent you accidentally making changes to the updated traditional form of the amendment whilst in the inline 

document.  

If you wanted to override the changes you made to the traditional amendment, you can click on the warning marker in the Inline 

amendments right-hand panel to remove it.  This will allow you to make changes to the inline amendment and overwrite the traditional 

amendment 

You cannot edit inline amendments after they have been submitted.  If you have edit rights to a submitted amendment, you will have to make 

changes to the traditional format of the amendment from this point onwards (by opening a temporary list from the Amendment Manager 

tab)

You can manage Members globally for all amendments in your inline document (e.g. the Member in charge of the amendments changes).  

Otherwise you can change them using the bulk Member update when you view them in their traditional format.
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Removing an inline amendment

Introduction

It is possible to remove an inline amendment if one was created by mistake in an inline document.  You can also use the same feature for 

removing an inline amendment when it has been applied to a bill version before accepting it.  

How to remove an inline amendment

1. From the Inline Amendments right-hand panel, find the inline amendment you with to remove

2. Click on the X button to remove the amendment

3. The card will be removed from the right-hand panel and the inline amendment will be cleanly removed from your document

 

 

You can use undo to bring back the removed amendment if you haven't yet saved the changes

Inline amendments will appear on the Inline Amendment right-hand panel before they have been saved which allows you to remove them 

cleanly before saving the changes
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Viewing traditional amendments

Introduction

Once you have created and saved an inline amendment, it is possible to preview the traditional amendment created.

How to view traditionally formatted amendments

1. From the Inline Amendment Tools right-hand panel, click on View Traditional Amendments button

2. A new tab will open listing all inline amendments converted to traditionally formatted amendments

 

 

The new tab that opens with the traditional amendments will be editable allowing you to further polish each amendment in this format if 

required

You can update the text or proposer/supporter information of an inline-derived amendment in traditional form (including adding explanatory 

statements for UK amendments).  As traditional amendments are not backwards synchronised to their inline equivalent a warning marker is 

set against the inline amendment whenever you save changes to its traditional form.  This mark prevents users from saving changes to the 

inline amendment and unwittingly overwriting any changes made to the traditional form.  This warning marker can be manually removed if 

desired, which will allow you to save changes to the inline amendment. 

DO NOT insert new amendments into the traditional document derived from the inline document.  You will need to create a separate 

traditional List of Draft Amendments (LoDA) to create additional amendments.



169

Removing a warning marker from an inline amendment

Introduction

Warning markers appear against inline amendments when they have been updated in traditional format e.g. to change the 

proposer/supporter information, update the instruction or quoted structure or add an explanatory statement.  Because the traditional 

amendment is not backwards synchronised with the inline amendment, a warning marker is set against the inline amendment in the inline 

document to prevent you or others from unwittingly overwriting the changes made to the traditional amendment.  It is possible to manually 

remove a warning marker from an inline amendment if you did want to overwrite the changes in the traditional format.

How to remove a marker from an inline amendment

1. Open up the Inline Amendments right-hand panel

2. Find the amendment with the warning and click on the warning marker

3. Confirm the warning message that pops up

 

Inline amendments will be read-only if they have a warning marker set against them

Warning markers are set against amendments whenever they have been updated in traditional form

Changing the status of an amendment e.g. from 'Draft' to 'On hold' or from 'Draft' to 'Submitted' will not set a warning marker, but it is still not 

possible to update an amendment that isn't in 'Draft' state.  
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Managing proposers and supporters on inline amendments

Introduction

You can specify a proposer when you first create a new inline document.  And when you are in the inline document, you will be able to 

update the proposer and any supporters which will update ALL inline amendments in the document.

How to manage members on inline amendments

1. Open the Inline Amendment Tools right-hand panel

2. Click on the Manage Members button

3. Update the proposer and/or supporters and click on Update button

4. The changes to proposer and/or supporters will be assigned to all inline amendments

 

Updating the Member information in an inline LoDA will update proposers and supporters for all inline amendments in that document

Do not use Manage Members when there are warning markers set against any of the inline amendments (warning markers let you know 

that the traditional form of the amendment has been edited and because they are not synchronised backwards, the warning marker prevents 

you unwittingly making changes to the traditional amendment when in inline form)

If you want to update the members on individual amendments, you will need to do this in the traditional view of the amendments

In future we will implement 'manage members' for individual inline amendments on the inline document
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Amendment Manager Tab - viewing and managing individual amendments
The  Amendment Manager Tab displays in tabular form all the individual amendments that you have permission to view.

It is filtered by Bill version, i.e., it only shows the amendments corresponding to a particular Bill version, but can be filtered further on a 

number of criteria.

From the Amendment Manager Tab you can flag and add comments to individual amendments, create temporary and official amendment 

lists and put amendments on hold.

Filtering amendments

Sorting amendments on the Amendment Manager Tab

Preview and comment on amendments

Submitting amendments

Creating an Order of Consideration

Set 'Draft' amendments to 'On hold' (and vice versa)

Flagging amendments

Moving or copying amendments to a different stage (including ping pong motions)

Opening amendments in the Editor (creating temporary lists)

Saving a temporary list as a new amendment list

Viewing amendments (incl. ping pong motions)

Recording outcomes (including ping pong)

Publishing individual amendments

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526453/Filtering+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/524550160/Sorting+amendments+on+the+Amendment+Manager+Tab
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115343371/Preview+and+comment+on+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666/Submitting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526399/Creating+an+Order+of+Consideration
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526650/Set+Draft+amendments+to+On+hold+and+vice+versa
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526461/Flagging+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551/Moving+or+copying+amendments+to+a+different+stage+including+ping+pong+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526559/Opening+amendments+in+the+Editor+creating+temporary+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526637/Saving+a+temporary+list+as+a+new+amendment+list
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526706/Viewing+amendments+incl.+ping+pong+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526621/Recording+outcomes+including+ping+pong
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526600/Publishing+individual+amendments
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Filtering amendments
Amendments can be filtered by a number of different criteria on the Amendment Manager tab.

The filter can be used as part of workflow for amendments: for example, filtering by status “submitted” will give you a quick way of seeing all 

amendments that are ready for tabling/lodging.  Alternatively, selecting a particular location will provide a quick way of checking whether any 

other amendment already exists for the same amendment that you are potentially about to draft. 

How to filter amendments

Click on Filter above the table of amendments.

You can filter using any one or more of the options below. Only amendments matching the filter will be shown in the table of amendments.

Amendment Number or unique reference (Dnum)

List of Draft Amendments (LoDA) name -  this will offer a drop-down menu containing any existing LoDAs that you have permission to 

view.  If there are no LoDAs this drop-down will be disabled. You can select one or more.

Location

(section/clause, schedule, target amendment being amended, long title or appropriate place amendments) 

Status

Filters by the status of the amendment. You can select more than one status.

Member

Searches for any amendment where the selected Member appears as a proposer or a supporter.

Comment

Searches for a word or phrase in the amendment comment.

 

The list of amendments is already filtered by bill version so filtering the list of amendments, will only return matching amendments for that bill 

version

The filter only works on amendments that you have privileges to see

Whenever you navigate away from the ‘Amendment Manager’ tab and return to it, your filter preference will be retained

If you type "Amendment", all amendments to amendments will be returned (SP & UK amendments)

For Commons amendments, if you type "new clause" or "new clauses" in the 'Location' field, all new Clause amendments will be returned.  

The same applies for new schedule amendments

If you type "All Agreed" in the 'current status' field, the system will return all "Agreed to" and "Agreed to on division" amendments

Quick Filters

Lawmaker also has Quick Filters available from the drop down menu next to the Filter button. You can select one of the following to quickly 

filter the amendments by status:

Draft

Submitted

Tabled

Ready For Publishing
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These filters are sticky which means if you navigate away from this screen, they will still be applied when you get back.  If you change a 

bunch of Amendments from Draft to Submitted but leave the Quick Filter set to 'Draft', you will end up with an empty screen!
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Sorting amendments on the Amendment Manager Tab
You can sort the amendments shown on the Amendment Manager tab by the values in any of the columns.

You can also sort amendments according to the marshalled order (taking account of any order of consideration if there is one).

Sorting by a column heading

The table on the Amendment Manager tab shows the following information about each amendments recorded against the selected bill 

version:

Number

DNum

Location

Sort code

Proposer

Last updated

Preview and Comment

Status

Click once on any of the headings in the table to sort the amendments in ascending order of the values in that column. Click again to 

change the sort to descending order.

In the screenshot below, the amendments have been sorted by Last updated date/time, in descending order. This means the amendments 

which were most recently edited will appear at the top of the table:

 

Sorting by marshalled order

Click the ‘Sort by marshalled order’ button in the top-right of the page to sort the amendments according to the same logic which determines 

the order they will appear in a Marshalled List.

 

The sorting takes into account the target location of the amendments, the user-assigned Sort code, and any Order of Consideration 

assigned for that bill version. (See Creating an Order of Consideration  for information on how to define the Order of Consideration as a 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526399
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526399
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parliamentary user.)

To revert to sorting by the values in a specific column, click a column heading.

 

Amendments which insert new clauses or new schedules are marshalled slightly differently at Committee and Report stage in the 

House of Commons. The ‘Sort by Marshalled Order’ button uses the Committee Stage sorting logic. 
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Preview and comment on amendments
 

You can quickly preview any amendment from the Amendment Manager tab. While previewing the amendment, you can add a comment or 

update the existing comment. You can also add a quick comment.

 

If the amendment has changed since you opened the preview, you can refresh the preview by clicking Refresh preview and comment.

How to preview an amendment

To preview an amendment click on the eye icon in the Comment column of the amendment manager Tab:

This will display a dialog box like the one above showing you a preview of the amendment and giving you access to a number of other 

features.

The amendment is shown as it would be in the Editor. The only difference is that any Dnum is shown separately at the top of the dialog box.

The preview function currently doesn’t support formulas or images. To view those you will have to look at the amendment in the 

Editor or in a PDF version of a list.
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Comments

You can add a comment against the amendment you are previewing by adding text in the Comment box. This comment will only be visible 

to users in the same organisation as you. You can also edit any existing comment.

Any changes you make to the comment will be saved when you navigate away from the amendment (by clicking Next, Previous or Save 

and Close) unless you press Cancel.

Click Clear text if you want to remove the comment.

When you close the preview, the first 20 or so characters of the comment will be visible in the Comment column of the Amendment Manager 

tab but you can hover over the comment to see the rest.

Quick comments

It can sometimes be useful to add the same comment to each amendment when you preview it (e.g. you might want to add your initials to 

confirm you’ve checked it.)

You can use the Quick comment box for this. When you click Quick Comment, the text in the box next to it will be added to the end of the 

existing comment. Once you’ve added text to the box, Lawmaker will remember it whenever you preview another amendment so you only 

need click Quick Comment again to insert the same comment.

Editing the amendment

You edit the amendment you are previewing by clicking Edit amendment.

This will open up a temporary list containing the single amendment in the Editor in a separate tab.

The amendment preview will remain open. If you make any changes and save the amendment, click Refresh preview and comment to 

see those changes reflected in the preview.

Navigating in the preview

You can use keyboard shortcuts to quickly navigate around the preview feature.

The shortcuts are:

If the comment is changed by another user while you are previewing an amendment, Lawmaker will prevent you from saving your 

changes to the comment so that the other user’s changes aren’t inadvertently overwritten. You can click Refresh amendment and 

comment to see their changes and then update it further as needed (copy any changes you’ve made to the clipboard before 

clicking the button if you want to retain them).

You can use the Filter options on the Amendment Manager to filter amendments based on the content of the amendment 

comments.

N Next amendment

P Previous amendment

Q Add quick comment

E Edit amendment

Shortcut Key Action
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S Save and close

The keyboard shortcuts won’t work while your cursor is in the comment box or the quick comment box.
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Submitting amendments

Once you have finished drafting your amendment(s), you can submit them for tabling/lodging at the appropriate Parliament.

When an amendment is submitted by a user who is not  a parliament user, the permissions on it are changed so that the appropriate 

parliament users can now view, edit and manage the submitted amendments while the original user retains read-only access.

How to submit amendments from the Amendment Manager Tab
1. Click on the ‘Amendment Manager’ tab

2. Using the check boxes on the left-hand side of each amendment, select the one(s) you wish to submit

3. Click on the 'Amendment Action' dropdown menu in the top right of the screen and select "Submit Amendments"

4. The selected elements will be updated to status “Submitted” and visible to the appropriate Parliaments’ users.

How to submit amendments from the Editor (non-parliamentary users)

You can submit all the amendments in a list of draft amendments (LoDA) directly from the Editor.

1. Open the list in the Editor.

2. Click on the 'Document Information' right-hand panel.

3. Click Submit List.

All the amendments in the list will be updated to status “Submitted” and become visible to the appropriate parliament. In addition, a copy of 

the whole list will be created that is visible to the appropriate parliament which parliament users can use to help check and manage the 

submitted amendments in one place.

How to 'bulk' submit amendments from the Editor (Parliament users)

Parliament users can update the status of amendments to submitted from within the Editor using the Bulk update statutes feature.

1. Click on the 'Amendment Status' right-hand panel in the Editor

2. Click the Bulk update statuses button. From the pop up select the amendment you wish to update. Select ‘Draft to Submitted’.

3. Click on the Update button

4. Save your changes and all amendments in the list that are set to 'Draft' will be updated to 'Submitted'

You can only submit amendments in this way if:

the associated bill version has been published by the appropriate Parliament,

the status of all amendments is “Draft”,

there are no active locks on any amendments, and

no amendment has a flag set against them 

You can only submit amendments in this way if:

the associated Bill version has been published by the appropriate Parliament,

the status of all the amendments is “Draft”, and

there are no active locks on any amendments.

If an amendment contains tracked changes or comments (in the Editor) then a warning will be displayed when you select to submit 

them.  You can choose to cancel and remove them or submit them anyway.
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Hints and tips

The system knows which Parliament to share the amendments to:

If the bill project is a Scottish bill, they will always be sent to Scottish Parliament.

If the bill project is a UK bill, they will be sent to the Parliament who published the latest version of the bill

If you are not a user in the appropriate Parliament that the amendments were submitted to, then you will only have read-only rights to the 

submitted amendments

You will continue to view an up-to-date version of the amendments so that if the Parliament made some changes to your 

amendment or the status was to update – you would be able to see these changes if you opened the amendments in the Editor
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Creating an Order of Consideration
The order of consideration for a particular stage can be specified on the Amendment Manager tab. This will influence the ordering of 

amendments when an amendment list is generated. Only parliament users can modify the order of consideration.

In Lawmaker, an Order of Consideration consists of a list of entries specifying the order in which clauses/sections or amendments are to be 

considered. Each entry can be one of a certain kind, depending on the parliament/house and may include a range, e.g. “section 3 to 5”.

The list always contains some entries (e.g. Long Title) at the end that cannot be modified.

There is only one Order of Consideration saved against each Bill version, but it can be updated as many times as needed.  Updating an 

Order of Consideration will only affect new lists, it will not retrospectively change the sort order of existing lists, unless they are subsequently 

re-generated.

How to create or modify an Order of Consideration
1. On the Amendment Manager tab, click Order of Consideration. It is only possible to add an Order of Consideration once there is a published 

version of the Bill.

2. In the dialog box, select the provision from the drop-down to start creating the order and fill in the “from” and “to” fields as required

3. To add more entries, click on the + button.

4. To remove a entry, click on the x button.

5. Click on Save when you have finished adding or modifying the Order of Consideration.

6. Alternatively, click Clear if you no longer require an Order of Consideration.

Scottish Parliament Order of Consideration

When you generate a Marshalled list, the Order of Consideration will be used to populate the Order at the beginning of the list.

The only available entries in the Order of Consideration are “Section(s)” and “Schedule(s)”.

House of Commons Order of Consideration

Entries in the Order of Consideration can specify:

Clause(s) x to y - all amendments relating to those clauses

Schedule(s) x to y - all amendments relating to those schedules

New Clause(s) NCx to NCy - amendments to insert new clauses numbered NCx to NCy (if NCx and NCy are left blank then all new clause 

amendments will be included)

New Schedules(s) NSx to NSy - amendments to insert new schedules numbered NSx to NSy (if NSx and NSy are left blank then all new schedule 

amendments will be included)

Group heading - this enables you to add a heading that will be inserted at the appropriate place in any marshalled list or proceedings that is 

generated using this Order of Consideration.

If there is only 1 schedule in the bill, you do not need to populate the ‘from’ and ‘to’ fields

If you are only including one section in a level, you will need to populate both "from" and "to" fields with the same number e.g. Clause(s) 1 to 

1

If the Order of Consideration is not comprehensive, i.e. if some amendments do not fall within any of the entries, then the sorting of 

any generated amendment list may be erratic.
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House of Lords Order of Consideration

The dialogue box include a date option which will be used to pre-populate the date on the Marshalled List when one is generated.

The only available entries in the Order of Consideration are “Clause(s)” and “Schedule(s)”.
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Set 'Draft' amendments to 'On hold' (and vice versa)
Introduction

You can move 'Draft' amendments to 'On hold' if they are not actively being worked on, but they must not be deleted.  

How to set 'Draft' amendments to 'On hold'

How to set 'On hold' amendments back to 'Draft'

 

 

From the 'Amendment Manager' tab, select the draft amendments you want to put 'On hold'

Click on the 'Amendment Action' drop-down menu at the top-right of the screen and select Set 'Draft' to 'On hold'

Amendments will be updated to 'On hold'

From the 'Amendment Manager' tab, select the 'On hold' amendments you want to set back to 'Draft'

Click on the 'Amendment Action' drop-down menu at the top-right of the screen and select Set 'On hold' to 'Draft'

Amendments will be updated to 'Draft'

Hints and tips

You can use the filters to filter by 'On hold'

You can use the 'quick filter' option to see 'Draft' Amendments which will filter out the 'On hold' amendments

You can also set amendments to 'On hold' using the 'Manage Lifecycle events' link on the 'Amendment Status' tab (Parliament users 

only)

You cannot submit 'On hold' amendments



184

Flagging amendments
You can flag an amendment on the Amendment Manager tab which will highlight it in the list of amendments. 

Amendments with any status can be flagged. While a draft amendment is flagged, it can’t be submitted. While a tabled amendment is 

flagged, you can’t publish a list of amendments containing it.

Flags are only visible within the organisation of the user who set the flag so different organisations can set different flags.

How to flag amendments

1. Go to the Amendment Manager tab

2. Click on a  flag icon on the left-hand side of an amendment to flag it.

The selected amendment will be highlighted yellow in the list when the flag is on. To remove the flag, simply click on the flag icon again.

 



185

Moving or copying amendments to a different stage (including ping pong 
motions)

It is possible to move or copy amendments to a different stage (and to be associated with a different Bill version). Moving amendments can 

be done from the Amendment Manager or to all amendments in a list on the Amendment Workspace; copying amendments can only be 

done from the Amendment Manager.

How to move amendments or motions from the Amendment Manager
1. On the Amendment Manager tab, select one or more amendments using the check boxes to the left of the amendments (or ping pong motions).

2. Select Amendment Actions>Move/copy to a different stage.

3. Select Move amendments to a different stage.

4. Select the stage to move the amendments to using the Stage dropdown menu.

5. The Bill version will default to the most recently published version but can be adjusted using the Bill version dropdown menu if necessary.

6. Click Confirm.

How to move all amendments or motions on a LoDA
1. On the Amendment Workspace Tab, select Actions>Move to a different stage on the List of Draft Amendments (LoDA) containing the 

amendment(s) that you want to move.

2. Select the stage to move the amendments to using the Stage dropdown menu.

3. The Bill version will default to the most recently published version but can be adjusted using the Bill version dropdown menu if necessary.

4. Click Confirm.

The LoDA and all amendments in the list will be updated with the new stage/bill version.

How to copy amendments or motions to another stage
1. On the Amendment Manager tab, select one or more amendments or motions using the check boxes to the left of the amendments.

2. Select Amendment Actions>Move/copy to a different stage.

You cannot move an amendment if it is locked to another user for editing or if you don’t have edit rights to update the amendment.

You can move an amendment to another stage regardless of its status (e.g. Draft, Submitted, Tabled etc.). 
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3. Select Copy amendments to a different stage.

4. Select the stage to move the amendments to using the Stage dropdown menu.

5. The Bill version will default to the most recently published version but can be adjusted using the Bill version dropdown menu if necessary.

6. Click Confirm.

The selected amendments will be copied to the new stage (and Bill version) and you will be able to see them on the Amendment Manager 

tab.

The new amendments will be the same as the original amendments except they will:

have new D-numbers assigned to them,

have empty num elements,

have no supporters,

have a status of “Draft” (and have no other lifecycle information recorded against them), and

have any existing decision block deleted (Commons amendments only).

If you copy UK amendments to the “Ping pong” stage, any Commons amendments that are copied will be converted into Lords 

amendments.

Copied amendments do not appear on any LoDA by default. If you want to create a LoDA containing the copied amendments, first 

create a temporary list containing them and then use the Save As feature to create a LoDA. See Saving a temporary list as a ne

w amendment list .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526637
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526637
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526637
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Opening amendments in the Editor (creating temporary lists)
Introduction

It is possible to select one or more amendments to open in the Editor to allow you to view or edit amendments depending on your 

permissions. 

How to open selected amendment in the Editor

Select one or more amendments using the check boxes to the left of the amendments on the ‘Amendment Manager’ tab

Click on the 'Amendment Actions' dropdown menu in the top-right of the screen and select "Create temporary List"

Make changes to the amendments that appear in the Editor (subject to your access privileges)

Save changes and Click on Close Editor above the structure view panel

 

Hints and tips

Opening the editor to edit selected amendments will create a temporary document that only you will be able to view.

If you do not close the Editor down properly, by clicking on the “X” button above the structure view, then a warning will appear at the 

top of the ‘Amendment Manager’ tab allowing you to reopen the document and close it down properly.

Only you will be able to see this warning.

You can only have one temporary document open at one time

If you do not have edit rights to an amendment e.g. if you are a Counsel drafter and viewing ‘Submitted’ amendments in the Editor, 

the amendment  to it, your filter preference will be retained
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Saving a temporary list as a new amendment list

Introduction

The 'Edit' function on the 'Amendment Manager' tab allows users to make changes/updates to selected amendments, but it does not keep 

these amendments in a formal list.  This function allows you to save a temporary list which will allow you to come back to it again later. 

How to save a temporary list as an ad hoc list

Select one or more amendments using the check boxes to the left of the amendments on the ‘Amendment Manager’ tab

Click on the Edit button

Save the amendment list as a new list by:

Right-clicking and selecting 'Save as', or

selecting 'Document > Save as' from the upper tool bar

Provide a unique name for the new list and click 'Create'

A new list will be created and available on the 'Amendment Workspace' tab

 

 

Hints and tips

Creating a new list will not create new versions of amendments.  Amendments that were selected will now appear on more than one 

list such that saving changes on one list will update the same amendment appearing on another list.

If you wanted to create a new version of an amendment: copy it and paste it back into the same List of Draft Amendments (LoDA).  

The system will work out when pasting the amendment that another amendment exists in the same list with duplicate unique IDs 

and will therefore assign new IDs such that the amendment becomes a new amendment with a new unique reference when saved.
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Viewing amendments (incl. ping pong motions)

Introduction

You can view a list of all individual amendments (and ping pong motions) that you have permission to see for a bill by clicking on the bill 

project from the dashboard. 

How to view amendments

Select the project you wish to open

The system will open the project and present the ‘Project’ tab displaying all versions of the document that you have access to.

Click on the ‘Amendment Manager’ tab to view a list of all individual amendments that you have access to

 

Hints and tips

The banner at the top of the page will display the project title (which is derived from the document's title) so it's clear which project 

you are viewing

To return to the dashboard, click on the home icon in the top left on the banner

You can filter the list of LoDAs by bill version using the bill version drop-down menu in the top left of the screen. 

It will default to the most recently published bill version for ease of use

The columns on the “Amendment Manager” tab are all sortable if you click on them

You can sort amendments on the 'Amendment Manager' tab by the order of consideration if one has been set for the bill version by 

clicking on the "OoC" button on the 'Location' column.  If there was no special order of consideration on the selected bill version, 

clicking on this button will sort the amendments in the order they appear in the published version of the bill

If you have sorted your amendments on the 'Amendment Manager' tab, when you open a temporary list the amendments will be 

sorted in the same way

UK ping pong motions only

If you have ping pong motions in the table, the 'Location' will display the amendment they are referring to.  In some cases this will 

just be one amendment, in other cases a ping pong motion can refer to more than one amendment and if that is the case, all the 

amendment numbers will be displayed in the Location column.

Commons amendments and ping pong motions only

It is possible to 'fold' the supporter block in Commons amendment lists if the supporter block is particular large and difficult to 

navigate the list as a result.  By default, the toggle will be set to 'open' but if you click on the triangle toggle to the left of the 

supporter block, this will 'fold' the supporter block so that it is no longer visible.
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Recording outcomes (including ping pong)
Introduction

If you are a Parliament user, you will have access to the “Amendment status” panel in the right-hand panel of the Editor where you can 

update an amendment’s status e.g. tabling (lodging) or recording an debate outcome e.g. “Agreed to” or a pre-debate outcome e.g. 

“Withdrawn before debate” 

Recording outcomes against amendments

Select one or more amendments that you would like to update and click on the Amendment Action drop-down menu in the top right of the 

‘Amendment Manager’ tab and select 'Create temporary List' (alternatively, select a working version of a Marshalled List to open)

Place your cursor in the first amendment in the list and click on the “Amendment Status” panel in the right-hand panel in the Editor

Select the status you would like to change your amendment to e.g. “Withdrawn”

Move to the next amendment using:

The Next >  or < Previous button at the top of the “Amendment Status” panel

Or using keyboard short cuts

Alt + k to move to “Next” amendment, or

Alt + h to move to  “Previous” amendment

When you have finished making changes, click on the Save button

Recording outcomes against ping pong motions

1. Select one or more ping pong motions that you would like to update and click on the Amendment Action drop-down menu in the top right of the 

‘Amendment Manager’ tab and select 'Create temporary List'  (alternatively, select a working version of a Marshalled List to open)

2. Follow the steps list above to record the outcome.

How to record outcomes against ping pong amendments (Commons only)

If you want to record outcomes against ping pong amendments but not against the parent motion:

Place your cursor in the ping pong amendment, and click on the “Amendment Status” panel in the right-hand panel in the Editor

Record the about come using the steps above

If you want to record outcomes against the ping pong motion as well as the ping pong amendments within it you will need to record the 

outcome against the motion first, then move to the amendment and record the outcome against it next.  Then save.

Hints and tips

You can update the status of amendments in official lists such as Marshalled Lists or Grouping Lists which might make it easier to 

record outcomes after debate

The changes to amendment statuses will only be applied when you click ‘Save’

To undo a selection, click on the button again to de-select it.

You can manage outcomes from the 'Lifecycle Manager' accessibly by clicking on 'Manage Lifecycle Events' on the 'Amendment 

Status' right-hand panel.
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Scottish Amendments

When you set an amendment to “Withdrawn before debate” the italicised text “Withdrawn” will appear above the amendment’s 

instruction.  There’s no need to delete the instruction from the Editor as when the Daily List PDF is generated, the instruction will not 

appear – only the italicised “Withdrawn”

House of Commons Amendments

When you set an amendment to "Withdrawn before debate" the amendment will no longer appear in the next Marshalled List/Daily 

and will need manually adding to the end of the document in the "Withdrawn Amendments" section

You can use the same process to record outcomes against motions and resolutions

When you record an outcome against an amendment, motion or resolution a 'decision outcome' field will appear in the 'Amendment 

Status' panel.  This is the text that is displayed to the left of the amendment number.  You can change the display of the outcome 

text in this field.  However, do not use this field to change the outcome of the amendment - you need to select the appropriate button 

outcome.  This text is to give more flexibility in the text that is displayed on the Proceedings.  This works the same way for ping pong 

motions.

When you record the outcome against a resolution, it will automatically update the presentation of the resolution so that it is ready 

for the proceedings.  It will strip the start and end paragraph from the resolution and insert a separate proposer element at the top of 

the resolution.  If you selected an outcome by mistake, you will need to use 'undo' to revert the resolution back to it's pre-outcome 

appearance

House of Lords Amendments

When you set an amendment to “Withdrawn before debate” the italicised text “[Withdrawn]” will appear above the amendment’s 

instruction.  There’s no need to delete the instruction from the Editor as when the Marshalled List PDF is generated, the instruction 

will not appear – only the italicised “[Withdrawn]”



192

Publishing individual amendments

Introduction

'Publishing’ in this context will make the amendment list available on the PDR (Published Document Repository) which will be available to 

down-stream applications who have access to our published data (e.g. Parliament websites).  This option is only available to users in 

Parliament.

How to publish an amendment

From the 'Amendment Manager' tab: select one or more amendments that you want to publish

Select "Publish Amendments" from the 'Amendment Actions' drop down

Confirm the warning message to publish your selected amendments

 

 

Hints and tips

You can publish an amendment at any stage using this method

Amendments are automatically published when you publish a list that they appear on

Publishing amendments will make them visible to all users in the system



193

Creating, managing and updating official amendment lists
The Official Lists Tab shows all the official lists (e.g. marshalled lists) that you have the permission to view. Like the project tab, it shows 

editable working versions on the left and read-only significant versions on the right.

Only parliament users can create and edit official lists.

Opening lists in the Editor

Inserting/removing an Amendment Star

Viewing lists

Sharing an amendment list from the Official Lists tab

Updating/populating a list with amendments

Managing amendment list document information

Downloading a ZIP file (Amendment list)

Generating an Amendment List (including Proceedings, ping pong lists and reason documents)

Publishing an amendment list

Recording amendment outcomes

For more on the different types of versions see Documents and folders on the Project Tab  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526574/Opening+lists+in+the+Editor
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526509/Inserting+removing+an+Amendment+Star
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526724/Viewing+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526658/Sharing+an+amendment+list+from+the+Official+Lists+tab
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526698/Updating+populating+a+list+with+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526525/Managing+amendment+list+document+information
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526427/Downloading+a+ZIP+file+Amendment+list
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526477/Generating+an+Amendment+List+including+Proceedings+ping+pong+lists+and+reason+documents
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526587/Publishing+an+amendment+list
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60948519/Recording+amendment+outcomes
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
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Opening lists in the Editor
Introduction

It is possible to select a list to open in the Editor to allow you to view or edit amendments depending on your permissions. 

How to open an amendment list in the Editor

From the ‘Official Lists’ tab, select the list you want to open and Select  Open document in Editor from the drop-down menu

The system will load the Editor and display the selected list

 

 

Hints and tips

The list will open in read only or editable format depending on either the document-level permissions or if the document is a 

snapshot version or has been published

The amendment list is presented in a similar format to printed amendment lists but without any page-related furniture (e.g. page 

numbers, running headers) or print layout (page width and page breaks)

You can open more than one document at any time as they open in separate tabs

You can only have one document version open in editable format at one time, if you open the same document version more than 

once, subsequent versions will be opened in read only format to avoid confusion when editing  
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Inserting/removing an Amendment Star
Introduction

You can manually add/remove stars to amendments e.g. if they have been substantively updated.

How to insert amendment stars

With your cursor in the selected amendment, right-click and select “Update star status”

The system will present the “Update amendment star” dialogue box

Select which star you want and click ‘Update’

The system will update the amendment accordingly

 

 

Hints and tips

Amendments appearing on a Marshalled List for the first time, that haven’t been published on another list before will automatically 

be assigned an amendment star

Amendment stars are associated to the list which means you do not need to manually remove stars for subsequently generated lists
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Viewing lists
Introduction

All official amendment lists will be displayed on the ‘Official lists’ tab.

How to view a list

Click on the ‘Official lists’ tab

The system will present all versions of the official lists that you have access to.

 

Hints and tips

If you are a user in the same organisation as the user who generated an official list, then you will have full read/write access to it 

until it has been published

When an official list has been published, it will be available in read-only format for all users in the system

The document tiles are coloured green if you have edit rights and grey when you only have read-only access.

Working versions are editable (subject to your access privileges)

Click on the black triangle on a working version to expand the view of any snapshot versions related to this document version series; 

or hide the snapshot versions

Snapshot versions appear under the working version they relate to.  By default, they are not shown but click on the black triangle 

next to the working version description to show a list of snapshot versions sorted in chronological order. They are most commonly 

generated automatically when users generate a pdf.   But they can also be generated manually from the editor (see “Save a 

snapshot version”).

UK Parliament

Consolidated Lists of Amendments will always be visible on the 'Official Lists' tab, regardless of the bill version filter that has been 

applied to the page.

https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Saving%20a%20snapshot%20version&linkCreation=true&fromPageId=25526724
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Saving%20a%20snapshot%20version&linkCreation=true&fromPageId=25526724
https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=USERMANUAL&title=Saving%20a%20snapshot%20version&linkCreation=true&fromPageId=25526724
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Sharing an amendment list from the Official Lists tab

You can choose to share an amendment list from the Official Lists tab with another organisation which can be used for review purposes.  

How to share a document
1. When on the Official Lists tab: select Actions > Share version from the drop-down menu on the document version you would like to share

2. The system will present a message explaining that you are about to share your document version with another organisation and ask you to specify 

your chosen organisation

3. Select the organisation you want to share it with and then click on Share

4. The system will create a Significant Version on the right-hand side

 

The Significant Version is read only to all users in your organisation and the organisation that it was shared with to maintain the integrity of 

the version that was shared

Users from the organisation that the document was shared with will only be able to see the Significant Version of the document – they will 

not be able to see the working version or any of its snapshot versions

When you share a document, a snapshot version is created in the same series as the working version that you shared so that you can see 

which list was shared and at which moment in time it was shared

The default organisation in the drop-down list will be set to the last organisation that you shared a document with
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Updating/populating a list with amendments

Introduction

Some lists will allow you to update the list of amendments e.g. if you have made any changes to the amendments that will affect their sort 

order, or if you want to refresh a rolling list with amendments following the current day's activities. 

How to update your amendment list

With your list in the Editor:

Right-click and select Update List, or

From the upper tool bar, select Tools > Update List or for Scottish Lists, Tools > Populate List

The system will:

select which amendments qualify for the list you are updating which can potentially result in new amendments appearing and/or amendments being 

removed from the list (but not deleted!)

sort the amendments in the list

insert interstitial headings (depending on the list being updated)

number the amendments (depending on the list being updated)

add stars (depending on the list being updated)

For Scottish Groupings Lists only:

validate the amendment numbers you have listed in the “Groupings of Amendments” section:

Orange text = amendment numbers that exist for that bill version

Grey highlight = amendment numbers that do not exist for that bill version.

populate the Grouping List under the heading “Amendments in Debate Order” with the valid amendments listed under each Group heading in the 

order specified in the list.

 

SP Grouping Lists: you do not need to publish your corresponding Marshalled List before generating the Grouping List, but if there are any 

new amendments on the Marshalled List – they will appear in grey highlight as it’s not until you publish a list that the amendment appear on 

that their amendment number becomes set in stone. 

Lords: if you added a number to an unpublished amendment and run Update List then the number will get overwritten as amendment 

numbers do not get set in stone until an amendment has been published.  It’s the same when manually adding or removing stars.  These will 

get refreshed when Update List is run so you may lose stars you’ve manually added or see stars reappear if you’ve manually 

removed/changed them.
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Managing amendment list document information
Introduction

Some amendment lists display data in the footer relating to the list and/or the bill version that the amendments are amending and this data 

can be managed in the ‘Document Information’ panel.

How to update document information

Access the Document Information panel either by clicking on the ‘Document Information’ in the right-hand panel

Make changes to any of the fields

The system will update the fields in the document with the changes

SP Marshalled Lists

Lords Daily Sheets, Marshalled Lists and Running Lists

 

The information in the ‘Document Information’ right-hand panel is used by the PDF generator to populate the footers. 

The display of session and bill year will automatically be formatted correctly by the PDF generator using the information you provide in 

this panel e.g. Session 5 (2020)

The ‘Version’ input field is used for the text displayed in brackets e.g. “(Supplement)” or “(Revised)” etc.

The information in the ‘Document Information’ right-hand panel is used by the PDF generator to populate the footers. 

The display of session and year will automatically be formatted correctly by the PDF generator using the information you provide in this 

panel e.g. 58/1 

The ‘Version’ input field is used for the text displayed in brackets e.g. “(Rev)” etc.

You should include the full bill number and list number in the list number field
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Downloading a ZIP file (Amendment list)
Introduction

You can download a zip file containing the amendment list XML as well as PDF, if there was one stored with the amendment list.  The main 

purpose of this facility is to allow users to provide technical teams with the amendment’s data (this functionality is also available via an API)

How to create the ZIP file:

Select Download ZIP file from the drop-down menu on the document version you want to generate the ZIP file from

On the pop-up box, leave the checkbox “Resolve dates in XML” ticked if the download is destined for an external system and click 

Download button

The system will generate a ZIP file containing the amendment list’s XML and a PDF (if there is a PDF saved against the chosen 

amendment list) and save it in your local download folder.

 

Hints and tips

If you download a ZIP file from a working amendment list version, a snapshot version will be created, labelled “Downloaded” which 

will allow you to access the document version in future should you need to return to that exact version of the XML.

If your document contained an image, the image will be included in the ZIP file

To ensure there is a PDF included, click on the download ZIP file button on a PDF snapshot version. 
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Generating an Amendment List (including Proceedings, ping pong lists and 
reason documents)

You can generate an official Amendment List from the Amendment Manager or Official Lists tab. The list will open in the Editor and, 

depending on list type, may be automatically populated with amendments.

How to generate an Amendment List

You can generate a list in two ways:

From the Amendment Manager tab, from the Amendments Actions dropdown menu, select Create official list.

On the Official Lists tab, click Create List.

To create the list:

1. From the Amendment list drop-down menu in the Create amendment list dialog box, select the type of list you want to generate. 

2. Select the correct stage - Committee, Report and Ping Pong all have their own individual formats and rubrics.

3. Fill in the subsequent information in the dialog box according to your selected list type.

4. Click Create 

The system will generate a list document and open it in the Editor. 

The list will be accessible from the Official Lists tab (to all users in the same organisation as you).

with the appropriate amendments, and loaded in the Editor sorted and numbered as required.  With Ping Pong Proceedings, the motions 

and amendments appear in the order of the amendments they refer back to from the Consolidated List of Amendments.

How to generate Manuscript Amendment Lists (Scottish Parliament & Lords only)

To create a manuscript list, you need to select the amendments you want to include in the list before generating it.

1. From the Amendment Manager tab, select the amendment(s) that you want to include in the list using the checkboxes on the left. You can use the 

filter to help locate the amendments you want (see Filtering amendments ).

2. From the Amendments Actions dropdown menu select Create official list.

3. Select the manuscript list type. 

4. Fill in the other fields in the dialog box.

5. Click Create.

The system will generate a list containing the selected amendments, sorted and numbered according to Marshalled List rules.

Scottish Parliament amendment lists

See Scottish Amendment Lists   for more information on the different types of lists and the rules used to generate them

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526453
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526453
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526872
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526872


202

House of Commons and House of Lords amendment lists

See also:

Managing Commons amendments and amendment papers  

Managing Lords  amendments and amendment papers  

Ping pong  

If you generated a Commons Marshalled List, the list will be empty when you first create it.  You will need to run 'Update List' to 

populate it with amendments.  

You can start adding motions or resolutions (Programme Motions) directly into Commons Marshalled List and Commons 

Proceedings as required.

If you are creating a Marshalled List for ping pong motions, make sure you select "stage = Ping Pong" for the rubric at the top of the 

list to be correct

To create a Reasons document you will need Reason motions set to 'Ready for Publishing' as with all Commons lists, you will need 

to generate the empty list first, then run "Tools > Update List" to populate it with motions.  

Generating a House of Lords Daily List is fairly straightforward, as is the Running List.  Generating a Marshalled List is a little more complex.

The Stage/Committee drop-down menu on the 'Create List' dialogue box is the text that will appear in the list title (hence "on" or "in").  If you 

wanted to create a new stage/committee then you will need to include the appropriate preposition as required.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22347777
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22347777
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22446081
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22446081
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25166191
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25166191
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Publishing an amendment list

Introduction

'Publishing’ in this context will make the amendment list available on the PDR (Published Document Repository) which will be available to 

down-stream applications who have access to our published data (e.g. Parliament websites).  You will need to have generated a PDF that 

you are happy with before you can mark the amendment list as having been published.

How to publish an amendment list

From the ‘Official Lists’ tab: expand the working version that you wish to publish to view the snapshot versions underneath

Find the PDF snapshot that will be used for publishing on Parliament’ website and select Publish version from the drop-down list

The system will present a warning message, making sure you have selected the right PDF to mark as having been published

Select Publish button to publish the chosen amendment list version associated to the PDF

The system will:

create a significant version marked as “Published”, visible to all users in the system containing the PDF and the amendment list version that 

produced it

create a snapshot version in the working document snapshot series containing the PDF and version of the amendment list that was published

make this version of the document available on the PDR (Published Document Repository)

 

Hints and tips

All other users of the system can view the significant version produced. 

Other users will be able to open the amendment list in the Editor (in read-only format), view the PDF or generate their own PDF (if 

they wanted to select different presentation options).

You will still need to send the actual PDF (Scottish Parliament users) to the web/publishing team according to existing processes to 

publish the amendment list on the website.  Please make sure it is the same PDF that you marked as having been ‘published’ in the 

system to ensure data integrity between Lawmaker and the website whilst there is no electronic interface as yet.

Once an amendment list has been published, all amendments on that list will be visible to all users in the system in their 

'Amendments' tab but in read-only format.  Only the parliament that published the version of the bill being amended will have 

read/write access to the submitted amendments.

UK Parliament only

When you publish a Consolidated List of Amendments, the amendments within the document will become editable to all users in the 

same organisation as you. 
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Recording amendment outcomes
Introduction

After debate, the outcomes need to be recorded against each amendment.  It’s possible to do this via a temporary list or by editing the latest 

Marshalled List.  The process for recording the outcomes against each amendment is the same for both approaches.  

How to record outcomes
1. Open the amendments in the Editor (either by opening latest Marshalled List or selecting the amendments from the Amendment Manager tab and 

editing in a temporary list)

2. Place cursor in the first amendment in the list

3. Open the ‘Amendment Status’ right-hand panel

4. Record the outcome by clicking on the relevant outcome button e.g. Agreed

5. Wait for it to update then move to the next amendment 

6. When all outcomes have been updated, save your changes

 

Hints and tips
Use keyboard shortcut Alt + K to move down or Alt + H to move back up the list of amendments

Use the filters on the Amendment Manager tab to help you find the amendments that need updating
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Applying Amendments
To create an as-amended version of a Bill you can do either of the following (or a combination of both):

use the auto-apply feature to automatically apply amendments to a new Bill version, or

manually apply amendments to a new Bill version,

Auto-applying amendments

Users can generate a copy of a Bill with any amendments they choose applied to it (regardless of the status of the amendment or whether 

the amendment is an inline amendment or traditionally drafted amendment).   All successfully applied amendments will appear marked up in 

the bill version with a corresponding 'inline amendment card' in the "Inline Amendments" right-hand panel in the Editor. In the document 

itself, the applied amendments will show up as tracked changes. In the event that an amendment cannot be applied e.g. the page/line 

information is incorrect or it overlaps with another applied amendment, it will be listed separately on the "Review" right-hand panel in the 

Editor with a brief description explaining why.  Handling amendments in this way means that you will know exactly which amendments out of 

a batch were applied and which were not.  

For the first iteration of auto-apply amendment functionality, we focused on the 3 main types of amendment:

Insert (including inserting new clauses/sections and schedules)

Leave out, and

Substitute (e.g. leave out X and insert Y).

See Auto-application of amendments to a Bill version  for more detail.

Accepting auto-applied amendments

Once amendments have been applied to a bill using the 'Apply Amendments' feature, a clean version of the Bill can be created using the 

'Accept All' button on the "Inline Amendments" right-hand panel in the Editor. 

An 'as amended' version of the bill can be constructed from both automatically and manually applied amendments and you can make 'silent' 

printing changes as required around these applied amendments as you currently do.

See Accepting all applied amendments in a bill version .

Manually applying amendments

You can also continue to apply amendments manually, for example any amendment that couldn't be applied using the auto-application 

feature, and these can be accepted using the usual 'accept'/'reject' buttons on the 'Review' right-hand panel, if applied in tracked change 

mode.

See Manually applying amendments  for more help.

Cross-references in applied amendments

If an amendment contains a cross reference to a provision in another amendment, or to a provision in the bill being amended, then the 

system should be able to resolve this cross reference when you paste in the amendment content.

If a cross reference didn't update as expected, check that the target provision exists in the document where the amendment content was 

pasted and try running Update x-refs again - see Cross-references (x-refs) | Updating existing cross references ARCHIVED    

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526854
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526854
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526862
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526862
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/55803905
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/55803905
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776/Cross-references+x-refs#Updating-existing-cross-references
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776/Cross-references+x-refs#Updating-existing-cross-references
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776/Cross-references+x-refs#Updating-existing-cross-references
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776/Cross-references+x-refs#Updating-existing-cross-references
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Auto-application of amendments to a Bill version
Lawmaker will allow any user to select one or more amendment to apply to a copy of the bill.  You can either create a new bill version or 

apply amendments to an existing working version.  The amendments do not have to be derived either traditional or inline documents.  

How to apply amendments to a bill version
1. On the Amendment Manager tab, select one or more amendments you wish to apply using the check boxes down the left-hand side.

2. From the Amendment Actions drop-down menu in the top right of the screen, select Apply Amendments.

3. You can select to apply the amendments to a new Bill version or to an existing Bill version.

4. Enter or select the details of the Bill version.

5. Click Create.

When the operation is complete, you will be taken to the project tab so you can access the Bill version that has been created or updated 

with the amendments.

A message will pop up indicating how many amendments were successfully applied.

Viewing the applied amendments in the Editor

Amendments successfully applied

When you open the Bill in the Editor, all successfully applied amendments will be listed on the Inline Amendments right-hand panel.

Clicking on a card on the Inline Amendments panel will jump to the location in the Bill where that amendment appears.

You can use the 'X' button the inline amendment's card to remove the amendment from the Bill if you no longer want it applied.

Accepting all the amendments

If you want to apply the amendments (i.e. to remove the tracked changes) then you should click on the Accept All button at the top of the 

Inline Amendments right-hand panel.

Amendments that should be reviewed

The Review right-hand panel will automatically generated comments on amendments that were successfully applied but where users are 

advised to check their insert location or for the need to make printing/silent changes.  This occurs in particular where there are two or more 

amendments being inserted in the same location e.g. two or more amendments inserting some paragraphs to the same provision.

In some cases, you might need to add some printing/silent changes (non-substantive changes to the text) in and around the 

amendments.  You can do this using tracked changes.  Make sure you turn off tracked change mode before using the Accept All 

button in the Inline Amendments panel, otherwise the results will look very strange.  If you had used tracked changes for the 

printing point changes, using Accept All will not change these so you can share this 'clean' version of the document with Counsel if 

you like and they can verify the printing changes easily.
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Amendments that weren’t applied

Any amendments that couldn't be applied will also be listed on the Review right-hand panel.  Reasons for not applying an amendment 

include:

the location information (clause/schedule, page or line) was invalid or incorrect, 

the amendment overlapped with the location of another amendment, or

the amendment's instruction wasn't in a form that was recognised.

 

Get in touch with the service team if you think an amendment should have been applied but wasn’t. Auto-application of amendments 

is still a beta feature and all feedback will help us refine it in future.
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Accepting all applied amendments in a bill version
You can accept all amendments applied to a bill version using the 'Apply Amendments' feature to create a clean version of the Bill. 

How to accept all amendments to a bill version
1. Open the bill version which you amended using the "Apply Amendments" feature from the 'Amendment Manager' tab

2. Open the 'Inline Amendments' right-hand panel

3. Select 'Accept All' button at the top of the list of applied amendments

All tracked changes will be removed and the amendments will be applied to the bill version

 

 

Hints and tips

The tracked change mode used in the Editor is different from the tracked changes created through inline and auto-apply of 

amendments.  This means that "Accept All" will not do anything to tracked changes made using the Editor's tracked change feature.  

This means you can using tracked change mode in the Editor to capture any printing point changes required in and around the 

amendments once they have been applied and once you use 'Accept All', the printing point changes will remain so that you can 

share that version with Counsel for review.  The tracked changes in the Editor can be easily dealt with using the 'Accept' and 'Reject' 

options in the 'Review' right-hand panel.

Pencil icons will appear in the structure view in the provisions that were updated when you used 'Accept All' so this will help steer 

you to the provisions being updated if you wanted to check the application.
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Manually applying amendments
A Bill can be updated manually to reflect agreed-to amendments.  You can do this by editing the Bill version (e.g. by deleting a provision) 

and by using copy and paste to transfer content from the amendments to the Bill (e.g. to reflect the insertion of some new subsections).

How to copy the whole content of a quoted structure

To apply an insertion or substitution amendment, you will need to copy all of the content to be inserted from the amendment. This content 

will be in the quoted structure within the amendment. Lawmaker has a special feature to make it easier to copy.

To copy the quoted structure content from an amendment into a Bill:

1. Open the list containing the amendment in the Editor (this can either be an existing list or a temporary list).

2. Right click somewhere within the quoted structure in the amendment and select Copy Content of Quoted Structure from the context menu.

3. Open the Bill in the Editor (you don’t have to close the amendment list before doing this).

4. Place your cursor where the inserted text should appear.

5. Paste the copied content by pressing Ctrl+v.

The system will paste the content of the quoted structure after your cursor location at the first valid insertion point.

Numbering of provisions when applying amendments

When amendments are applied to a Bill by pasting in their content, any provision in the amendments with an empty number will be assigned 

an appropriate number (e.g. 2A) as part of the paste operation as long as your bill is not in auto-renumbering mode.

To toggle the renumbering mode, use Tools>Turn on/off Auto-Renumbering in the upper tool bar.)

See also:

Using cut, copy and paste  

Quoted structures  

See also Numbering  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339267
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688838
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688838
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SIs and SSIs

Pages within this section

Introductory training videos for SIs and SSIs

Selecting the procedure applying to an SI/SSI

Managing Subject, Extent and Subsubject

Managing Dates

Inserting pre-populated rubrics

Citation footnotes (legislative history footnote)

Managing Signatures

Inserting Explanatory Notes

Marking a document as 'Submitted'

Inserting Commencement Tables

Confirming which SI/SSI document version should be published

Converting a Draft SI/SSI into a Made version

Marking a document as 'Signed'

Submitting an SI or SSI to TNA

Processing and submitting SI/SSIs overview

Tips for SI & SSI drafters working with processing teams

Specific help for drafting and managing statutory instruments, e.g. handling subjects and signatures, submitting SIs to TNA.

For general assistance with SI/SSI projects and documents see:

Projects and documents  

Drafting and editing  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688753/Introductory+training+videos+for+SIs+and+SSIs
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115277992/Selecting+the+procedure+applying+to+an+SI+SSI
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121966/Managing+Subject+Extent+and+Subsubject
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121950/Managing+Dates
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121926/Inserting+pre-populated+rubrics
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/521404417/Citation+footnotes+legislative+history+footnote
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121958/Managing+Signatures
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121942/Inserting+Explanatory+Notes
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121982/Marking+a+document+as+Submitted
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121934/Inserting+Commencement+Tables
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/207126529/Confirming+which+SI+SSI+document+version+should+be+published
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121889/Converting+a+Draft+SI+SSI+into+a+Made+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121974/Marking+a+document+as+Signed
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448577/Submitting+an+SI+or+SSI+to+TNA
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/194936833/Processing+and+submitting+SI+SSIs+overview
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/213483521/Tips+for+SI+SSI+drafters+working+with+processing+teams
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688727
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688727
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
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Introductory training videos for SIs and SSIs
This page contains a series of introductory videos about using Lawmaker to draft SIs and SSIs.

Getting started - SI/SSIs in Lawmaker

Summary

Logging on to Lawmaker 

Viewing projects on the dashboard 

Opening a project and viewing all document versions

Opening and closing document in the Editor

Getting started: SI/SSIs in Lawmaker

Getting started: SI/SSIs in LawmakerGetting started: SI/SSIs in Lawmaker

https://www.youtube.com/watch?v=_V65MiLKIEs
https://www.youtube.com/watch?v=_V65MiLKIEs
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Script of video 

This screencast covers: 

1. Logging on to Lawmaker 

2. Viewing projects on the dashboard 

3. Opening a project and viewing all document versions 

4. Opening and closing document in the Editor 

Logging on 

1. To log on to Lawmaker, you will need your username and password.   

2. The first time you log on, you will need to reset your password and set up Multi-factor Authentication (MFA).  To do this you will need to install an 

authenticator app on your mobile phone.   

3. Once you have set yourself up to use Lawmaker, whenever you log on in future, you will only need to supply your username and password and 

a code from your authentication app 

4. Contact your Lawmaker User Champion if you are struggling to log in. 

Dashboard 

1. When you log into Lawmaker or when you click on the Home button, you will be taken to the dashboard.  This is where all the different projects 

that you have permission to view are displayed. 

2. You can toggle between list view or tile view 

3. You can search for a project by typing into the ‘Search’ input field.  You can search by any word that appears in the project title. The project title 

is based on the title of the documents in the project. 

4. There is an option to view ‘Favourites’ which are projects you have ‘pinned’.  Projects that you create will have a pin in them by default so that 

they are always identified as a favourite.  You can add/remove pins on projects by clicking on the drawing pin on the project tile, or to the left of 

the project in list view and when you select to view ‘favourites’ these projects will always appear. 

5. To open a project and view the document versions within it, click on the ‘Open’ button or on the project title. 

Projects tab 

1. When you open a project, you will be taken to the ‘Projects’ tab and this is where all document versions that you have permission to view will be 

displayed 

2. Documents can appear in different folders which can be expanded or collapsed as you please. 

3. The green tiles on the left hand side are working document versions and can be edited. 

4. The grey tiles on the right hand side are significant versions which are read only.   

5. Significant versions are created whenever a document is shared with another organisation, you mark a document as submitted to the national 

archives,  and when you mark a document as having been signed. 

6. Working versions might have some snapshot versions linked to them which you can view by toggling the triangle button on the left hand side.   

7. These represent versions of the working version from a particular point in time and are either created automatically, for example when you 

generate a PDF; or 

8. are manually created if you decide to save a snapshot when in the Editor.   

9. Snapshots are read only when opened in the Editor, but it is possible to copy a provision within them to paste into your working document if you 

want to revert back to a previous version of a provision for example. 

10. To open a document in the Editor, either to continue editing, or to view the document as a read-only document, click on the button to the left of 

the Actions’ drop down 

11. If the document is editable (green tile), the button will be a pen and paper icon 

12. If the document is read only (grey tile), the button will be a document icon 

Editor 

1. The Editor will open in a new tab and load your selected document 

2. I will come onto using the Editor in a separate screencast.   

3. To ensure you close the document properly, always use the ‘Close document’ button that appears above this left hand structure view.  If the 

Structure view is collapsed, the button changes into a blue cross. 
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Drafting SI/SSI provisions

Summary

Creating a new SI/SSI

Inserting provisions (including definitions and combined numbering)

Deleting provisions

Copy/cut & paste

Promote/demote

Wrap/Unwrap

Drag & drop

Creating an SI SSI and drafting provisions

Creating an SI SSI and drafting provisionsCreating an SI SSI and drafting provisions

https://www.youtube.com/watch?v=JWBAOaGSXUE&feature=youtu.be
https://www.youtube.com/watch?v=JWBAOaGSXUE
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Script of video

This screencast includes: 

1. Creating a new SI/SSI 

2. Inserting provisions (including definitions and combined numbering) 

3. Deleting provisions  

4. Copy/cut & paste 

5. Promote/demote 

6. Wrap/Unwrap 

7. Drag & drop  

Creating a new SI/SSI  

1. To create a new SI/SSI project, click on the +New button at the top of your dashboard 

2. Select the Type of document you want to produce and the Sub-type 

3. Supply a title for your SI and the type of procedure it will be subject to.   

4. Both of these can be updated later if anything changes 

5. Click on ‘Create’ when ready 

6. The Editor will open in a separate browser tab, containing the document template for the SI/SSI you have chose to create 

7. This document will be available in read/write format to all other users in the same organisation as you 

8. In my example, I selected a draft SI Regulations so I have the draft procedural rubric in the header of the document and ‘DRAFT’ appears in the 

banner. 

9. The Editor is made up of  

10. A Structure view on the left hand side which shows you the structure of your document as you build it up, which you can expand or collapse 

11. The Editor view which is where you type and insert provisions 

12. The right-hand panel which contains various tools which we will come to later 

13. The upper tool bar which displays various menus containing editing functions which we will look at later, and finally 

14. The breadcrumb which tells you the full context of an element where your cursor is placed.  

15. Editing the preface will be handled in a separate screencast.  This screencast will focus on drafting the provisions in your SI/SSI 

Inserting provisions 

1. To insert provisions into your document, place your cursor in the ‘body’ element and click ‘Enter’ to bring up the insert menu. 

2. The insert menu will display all the elements you can insert into your document at this location.  

3. I’m going to insert a regulation. 

4. The cursor is ready for me to start typing into the heading element of the regulation 

5. If you look at the Structure View, you will see the inserted regulation 

6. If you look at the breadcrumb, you will see the full context of the element my cursor is in 

7. To continue adding content to the regulation I can tab or click with my mouse button to move the cursor into the ‘text’ element ready for me to 

start typing. 

8. I can continue to add further provisions into my SI/SSI, by clicking ‘Enter’ and selecting the next appropriate element.   

9. Here I will insert a paragraph.   

10. I can continue by adding sub-paragraphs. 

11. To insert a paragraph with combined numbering, I must insert another paragraph into my empty paragraph which will automatically combine the 

numbering for me. 

12. I can insert definitions which contain an inline element placeholder for the defined term.  To add text before or after the defined term, I will use 

the arrow keys to move my cursor into the correct location before typing.   

Deleting provisions 

1. The key to successfully deleting provisions is to use the breadcrumb or the structure view to select the provision before deleting.   

2. To delete this regulation, I can either click on ‘regulation’ in the breadcrumb 

3. Or click on the regulation in the structure view  
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4. The provision will be highlighted in the Editor so that you can make sure you have selected the correct provision 

5. Use the ‘delete’ key or backspace to delete the selected provision.  

Copy/cut & paste 

1. The breadcrumb and structure view also comes in handy when you need to copy or cut a provision and paste it into the same document or 

another one.   

2. First select the provision you want to copy or cut using the breadcrumb or structure view 

3. Then use right-click and select ‘copy element’ or ‘cut provision’ or use the universal keyboard short cut Ctrl + C or Ctrl + X.   

4. Finally, place your cursor at the location you want to paste the provision and use the keyboard shortcut ctrl + v. 

Promote/demote 

1. Sometimes it might be necessary to convert a sub-paragraph into a paragraph or vice versa and we call this promote and demote. 

2. First I will demonstrate ‘promote’ 

3. Place your cursor in the provision you want to promote, and right-click and select ‘promote element’ 

4. In this example the provision is promoted first to being closing words for the list of paragraphs, and when I promoted it again, it became a 

paragraph higher up 

5. Now I will demonstrate a ‘demote’ using the same provision 

6. As my cursor is already in the provision I want to promote, I will right-click and this time select ‘demote element’ 

Wrap/unwrap 

1. As the SI/SSI begins to build up, you might decide some grouping elements are required. 

2. Grouping elements are things like parts, chapters, sections and sub-sections.   

3. We use the term ‘wrap’ when inserting them as in XML terms they are wrapping around the provisions that they contain.  

4. With that in mind, the first step will be to highlight the provisions you want to wrap in a grouping element.   

5. The best way to select multiple sibling provisions is to use Ctrl + left click on the mouse in the Structure View to select more than one provision 

at a time.   

6. Here I have selected 3 regulations that I want to wrap inside a Part. 

7. In the Editor, right-click on the selected provisions and select “wrap element”.   

8. Here are the grouping levels that you can use.  I will select “Part” 

9. The part is inserted and displayed in the Editor here. 

10. I can see that it has been successfully inserted as the structure view shows the regulations are now inside the part 

11. And the breadcrumb shows part in the hierarchy. 

12. You can continue adding grouping levels inside Parts using the same method, for example to further wrap the provisions inside Chapters or 

Sections or Sub-sections. 

13. Conversely, if you have a grouping element that you no longer need, you need to remove them by ‘unwrapping’ them.  

14. To unwrap a grouping element, place your cursor in the selected grouping element in the Editor and right-click and select “Unwrap element”.   

15. This will remove the grouping element the correct way from your document.   A common mistake when users first use Lawmaker is to delete the 

grouping element.  This will not correctly remove the element and will be highlighted as a validation error in the right-hand panel.  More on that in 

another screencast. 

16. You can insert and remove grouping elements inside schedules in exactly the same way. 

Moving provisions around using the Structure view 

1. It’s possible to move provisions around the document using the Structure View 

2. You can move whole grouping levels, individual regulations or individual lower-level paragraphs.   

3. First select the provision you wish to move.  If it has child elements you need to make sure the provision is collapsed in the structure view before 

you use drag & drop.   

4. Next press and hold the left mouse button and then move it to the desired location.   

5. The green provisions indicate where you are allowed to move the provision to.   
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Managing footnotes, textual amendments and references in your SI/SSI

Summary

Inserting and managing footnotes

Inserting textual amendments (quoted structures)

Inserting and managing cross references

Inserting and managing J-refs

Managing footnotes, textual amendments and references in SI/SSIs

Managing footnotes, textual amendments andManaging footnotes, textual amendments and……

https://www.youtube.com/watch?v=SHW-GSOaulg
https://www.youtube.com/watch?v=SHW-GSOaulg
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Script of video

This screencast includes:

1. Inserting and managing footnotes

2. Inserting textual amendments (quoted structures)

3. Inserting and managing cross references

4. Inserting and managing J-refs

 Inserting and managing footnotes

1. To insert a footnote, place your cursor where you want the footnote inserted and right-click and select “Insert footnotes”.  Alternatively use the 

keyboard shortcut Alt+F

2. This will insert an asterisk surrounded by brackets and highlighted in yellow.

3. Click on the asterisk to add text to the footnote

4. Although the asterisk appears inline in the Editor, when a PDF is generated it will automatically be rendered at the bottom of the page that the 

footnote marker appears on, with the correct numbering using letters.

5. Place your cursor in the ‘text’ element and start typing. 

6. To close the footnote up so that it’s no longer visible, click on the asterisk again.

7. If you no longer want a footnote, place your cursor in the footnote, and select ‘footnote from the breadcrumb and delete it using ‘backspace’ or 

‘delete’ button.

8. To move a footnote elsewhere, select the footnote using the breadcrumb and select ‘cut’ from the right-click menu or keyboard short cut and 

place your cursor in the new location and use Ctrl+v to paste it.

Inserting textual amendments (quoted structures)

1. To insert a textual amendment, place your cursor in the provision it should be inserted into and right-click and select ‘Insert quoted structure’ or 

use the keyboard short cut “Ctrl+Q”

2. The document type will default to the type of document you are editing.  You can change this which helps get the correct style and formatting of 

the provisions you are inserting into the quoted structure.

3. Select the starting element from the list in the drop-down.

4. The Indent level is set to ‘none’ which is the default indent applied to textual amendments in the PDF.  If you have a particularly wide table for 

instance, you might want to overwrite the indent level to -1 which essentially sets the quoted structure indent to the width of the page.  Most of 

the time though, you can leave it at ‘none’

5. The start and end quote default to the usual style but you have the option of changing it or removing them if they are not required.

6. And finally, the following text is the punctuation that appears after the end quotation.  Usually a full stop, but you can put whatever you like in 

there.

7. When you are ready, you can click on ‘Insert’

8. A quoted structure is inserted into your document, it is presented with a dotted line around it to make it obvious what it is.

9. Add text to your starting element and continue adding structure to the quoted structure using the same method of clicking ‘Enter’ and selecting 

the next appropriate Element from the insert menu.

10. To move the cursor outside of the quoted structure, to continue drafting the SI/SSI, either use tab to move the cursor out of the quoted structure 

and from there you can click ‘Enter’ and it will give you the appropriate element options outside of your quoted structure

11. It’s possible to cut and paste a quoted structure from one provision to another by selecting ‘quoted structure’ from the breadcrumb and placing 

your cursor in the desired provision and clicking on ctrl+v to paste it in its new location

12. Like provisions in the rest of the document, you can use drag & drop in the structure view to change the order they appear

Inserting and managing cross references

1. There are two ways to create cross references in your document

a. The first is using the ‘tag x-ref’ function, and

b. The second is to manually create an x-ref using the structure view

2. To use the ‘tag x-ref’ function, you should first type the cross reference, and then run ‘tag x-ref’ to automatically mark it up as a cross reference. 

3. Right-click and select ‘tag x-ref’, click on the ‘tag x-ref’ button in the upper tool bar or the keyboard shortcut Alt+t
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Numbering, renumbering and num locks

4. Tag x-ref works by pattern recognition.  If Lawmaker thinks it has identified a cross reference, it will attempt to search for the corresponding 

provision inside the document. 

a. If it is successful, it will mark up the cross reference and it will be presented in orange text.

b. If it cannot find the corresponding provision, it will highlight the cross reference grey.

5. However, it’s not perfect and sometimes it mis-identifies cross references, particularly when they are cross references to enacted legislation.  

The best thing to do in this case is to ‘ignore x-ref’ by placing your cursor in the x-ref, right-clicking and selecting “Ignore x-ref”.  This means that 

everytime you run tag x-ref or update x-ref, it will always be ignored.

6. The other way to create cross references is using the structure view.

7. Navigate to the target provision in the structure view by using the toggle to expand the levels visible if necessary.

8. Right click on the appropriate x-ref, click on Select ‘X-ref to copy’ and select the appropriate format of the x-ref from the sub-menu

9. Next, place your cursor in the Editor where you would like the cross reference to appear and use keyboard short cut Ctrl + V to paste the cross 

reference.  The cross reference will appear in orange text to let you know that it is a valid x-ref

10. You will need to use manual x-refs using the structure view for provisions appearing in textual amendments, those provisions within quoted 

structures.

11. As provision move around the document, the cross references will need updating. This is an automatic process that is triggered when you select 

‘Update x-ref’ from the upper tool bar or using right-click in the Editor

12. Either highlight the text containing the x-ref you want to update, or you can place your cursor in a provision and run ‘Update x-ref’.

13. If you have not highlighted your text, the system will check whether you want to run update x-ref on the current provision (which is the regulation 

or schedule that your cursor is within) or the whole document.  

14. As well as checking for valid and invalid x-refs again, it will also identify where it thinks a target provision has changed for example, if it was a 

paragraph and now it’s a sub-paragraph and vice versa.  In these cases, the x-ref will be highlighted orange and be referred to as ‘promote-

demote’

15. To help you identify any invalid or promote-demote cross references in your document, the “Review” right-hand panel will identify them and when 

you click on the tile, will jump to the cross reference in your document.

16. To see where the provision is pointing to, you need to place your cursor in the cross-reference and click on the ‘Attributes’ right-hand panel.  The 

href will give you a clue on where the cross reference is pointing.

17. If you think it’s wrong, the best thing to do is to remove the x-ref by placing your cursor in the x-ref, right-clicking and selecting ‘remove x-ref’ then 

re-run ‘tag x-ref’ again or manual insert one using the structure view

18. Another shortcut useful to know when creating cross-references is copying existing references in your document and pasting them elsewhere 

into your document.  You can even paste it on top of existing x-refs and they will be replaced by the copied x-ref

Using J-refs

1. It is possible to use unique references to refer to provisions that never change, unless you manually change them and these are called J-refs

2. You can insert J-refs against regulations and schedules.  They appear in the left hand margin and can optionally be included in the PDF.

3. To insert a J-ref you must place your cursor in the regulation or schedule that you want to assign a Jref to and either use ‘Insert > Insert/update 

J-ref’ in the upper too bar, or right-click and select ‘Insert J-ref’.

4. Supply your own reference and click insert.

5. To remove a J-ref just leave the field empty.

6. To remove all J-refs, for example at the end of the drafting process, select ‘Tools > Delete all J-refs’ from the upper toolbar.

7. To view them in your generated PDF, select the “View J-refs” option under the ‘Extras’ section and your PDF will include them in the left-hand 

margin.

Summary

Numbering modes

Renumbering provisions and locked nums
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Numbering, renumbering and num locks in SI/SSIs

Numbering, renumbering and num locks in SI/Numbering, renumbering and num locks in SI/……

https://www.youtube.com/watch?v=1EnqGp16pwM
https://www.youtube.com/watch?v=1EnqGp16pwM
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Script of video

Managing SI/SSIs in Lawmaker 

This screencast includes:

1. Numbering modes

2. Renumbering provisions and locked nums

 Renumbering

1. There are 2 numbering options in Lawmaker.  

2. Auto-renumber turned on; and 

3. Auto-renumber turned off.  

4. When Auto-renumber is turned on means that provisions at paragraph level and below will automatically renumber as you insert them 

throughout your document.  Regulations and the grouping elements, such as parts and chapters will not renumber automatically due to the way 

document locking works.

5. You can toggle your numbering mode using the ‘Tools menu and selecting “Turn on/off auto-renumbering”

6. By default all new documents start with auto-renumbering turned off, but once you’ve changed it, it will stay that way until you change it.

7. To let you know what numbering mode is set in your document, whenever you open the document or change the numbering mode, a green 

toastie will appear in the top left to let you know what your document numbering mode has been set to.  It will eventually disappear after 30 

seconds.

8. Let’s see what happens when Auto-renumber is turned off

9. If I insert a new paragraph at the end of a series of paragraph, it will be numbered sequentially.  

10. If I , insert a paragraph between existing paragraphs, it will be auto-assigned a number using the amending numbering rule e.g. inserting 

between paragraph (1) and (2) will result in paragraph (1A); and inserting before paragraph (1) will result in paragraph (A1)

11. Now let’s see what happens with Auto-numbering turned on

12. IF I insert a paragraph anywhere in the sequence, all the paragraphs around it will be renumbered accordingly.

13. If I insert a new regulation however, or a new part in the middle of a series, you will see how it is assigned a number again.

 Renumbering provisions

1. To renumber your provisions if you have been drafting with auto-renumber turned off, or to renumber the regulations and grouping elements, you 

will need to use the ‘Renumber’ button available in the upper toolbar and in your right-click menus

2. You can choose to highlight a sub-set of provisions to renumber, or, if you click on ‘renumber without making a selection it will ask you if you 

want to renumber the current provision or the whole document.

3. The current provision is the regulation or schedule that your cursor is in.

4. If you select the ‘whole document’ you need to make sure nobody else is currently editing the same document as the renumber action will 

require locks on the whole document to perform. 

5. Renumbering will not affect provisions inside quoted structures (textual amendments).  You will need to renumber the quoted structure as a 

separate action using the same function.  Just place your cursor inside the quoted structure before you trigger renumber.  

Locked nums

1. You will see when you insert a quoted structure for textual amendments, that if the starting element is a numbered element, it’s num element is 

surrounded by a dotted border.  

2. This indicates that the num is locked.  

3. Locked nums will not be overwritten when you perform a renumber.  

4. As renumber works by checking the sibling provision’s number before it, you do not need to lock the nums of sibling provisions after the first 

locked num.  For example, if the locked num of a regulation is 2A, the sibling regulation will automatically be numbered 2B.  

5. To manually add or remove number locks, right-click and select ‘Add/remove number lock’.  

Summary

Project tab 
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Managing SI/SSI document versions in Lawmaker

Managing SI/SSI document versions in LawmManaging SI/SSI document versions in Lawm……

https://www.youtube.com/watch?v=zVkK_scrt8Q
https://www.youtube.com/watch?v=zVkK_scrt8Q
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Managing your SI/SSI through the different stages

Projects tab

1. The project tab allows you to perform different actions on your document versions

2. You can Share a document with another organisation.  To do this, click on the ‘Action’ drop down on the version you wish to share and select 

“Share version”.  You will need to select the organisation you wish to share with and click on ‘Share’.  This will create a significant version on the 

right-hand side of the ‘Projects’ tab which is read only and visible to you, but also visible to all users in the organisation you shared it with.  It will 

also be read only for them.

3. If someone shared a document with you, you will also see it in the right-hand side of the projects, in read only format.  To make edits to it, you 

will need to create a duplicate version.  To do this, click on the ‘Actions’ drop-down on the version you wish to Duplicate and select ‘Duplicate 

version’

4. This will create a green working version of the document that appears in the left-hand side of the ‘Projects’ tab and is only visible to you and all 

users in the same organisation as you.  The other organisation will not be able to see your working version.  Likewise, you will not be able to see 

their working versions.  Duplicate version can be used in a similar way that you might use ‘Save as’ in Word to create new versions of a 

document and gives you flexibility when managing your drafts.

5. You can rename document versions by clicking on the edit button to the right of the description in the green tile.  It has to be a unique name.

6. If you have created a version by mistake, it’s possible to delete this document by clicking on the ‘Actions’ drop down and selecting ‘Delete 

version’.  You cannot delete the last document in the project.  If you no longer needed the project, you have to delete the project from the 

dashboard

Summary

Converting a draft instrument to ‘Made’

Preparing an instrument for signing

Marking PDF version as having been signed

Downloading a ZIP file to upload to TNA’s publishing system

Marking downloaded version as having been submitted to TNA

Managing your SI SSI through the different stages

Managing your SI SSI through the different staManaging your SI SSI through the different sta……

https://www.youtube.com/watch?v=1Rq9aH6how8
https://www.youtube.com/watch?v=1Rq9aH6how8
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This screencast includes:

1. Converting a draft instrument to ‘Made’

2. Preparing an instrument for signing

3. Marking PDF version as having been signed

4. Downloading a ZIP file to upload to TNA’s publishing system

5. Marking downloaded version as having been submitted to TNA

 Converting a Draft Instrument to ‘Made’

1. To convert a Draft SI to Made, you will need to create a duplicate of the Draft version. 

2. This is done on the ‘Project’ tab by finding the appropriate document version, clicking on the ‘Actions’ drop down and selecting ‘Duplicate 

version’

3. Specify the folder you want it to be moved to, if needed and give it a unique version description. 

4. Also, click on the ‘Convert to Made’ check box before clicking on ‘Duplicate’

5. A new version of the Instrument is created which can be opened in the Editor to refine further

6. As you can see, the instrument has been updated to remove the draft procedural rubric from the top of the page, ‘Draft’ has been removed from 

the banner and the preamble has been updated as well.

Preparing an instrument for signing

1. When an Instrument is ready for signing, you will need to ensure it has the correct signatory information in it.

2. To do this, open the latest version of the document. 

3. You can either insert a new signature block by selecting ‘Insert > Insert signature block’ from the Upper Toolbar and filling in the necessary 

details in the dialogue box.

4. Or, if a signature block already exists, you can update it by right-clicking on it and selecting ‘Update signature block’

5. Don’t worry that the signature block doesn’t look correct in the Editor, when you generate the PDF, it will look correct.

6. Once the Instrument is ready for signing, you will need to generate a PDF that will be printed as the signing copy.

7. If it has just been signed, you will need to update it with the Made and signed date before sending it to TNA.

8. To do this, open the instrument in the Editor.

9. To update the date, click on the blue date area in the preface.

10. Select the ‘Made date’ from the Manage Date dialogue box.

11. Specify a date and optionally a time. Ensure that these correlate with the details in the signature block.

12. You can add other dates as required in the same way. You may need to change (or add) the Laid heading to reflect your expected laid date, if 

the instrument is a signed SI of a type that requires laying.

13. If you have been allocated an SI number in advance by TNA, you should add it to the SI now by clicking on the blue number in the preface which 

will open the ‘Document Information’ panel where you can insert the advanced SI Number and any advanced subsidiary numbers.

14. Otherwise, the SI number will be allocated and inserted by TNA’s Publishing system during the registration process.

15. When you have made the necessary updates to the SI, save your changes and close the Editor.

Marking PDF versions as having been signed

1. When you generate a PDF, a snapshot version is created which captures a read-only version of the instrument at the point it was signed.

2. You will need to mark this snapshot version as the one that was signed.

3. Mark this snapshot version as having been signed by clicking on the ‘Actions’ dropdown and selecting ‘Mark as signed’

4. This will create a significant version which appears on the right-hand side. It will be read only meaning that no one can alter it.

 Downloading a ZIP file to upload to TNA’s publishing system

1. Once your Instrument is ready to upload to TNA’s publishing system, you will need to download a ZIP file containing the XML and PDF and any 

images your SI might contain

2. This is generated using Lawmaker and is the same process for draft instruments as well as those that are Made.

3. The first step in this process is to generate a PDF.
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Updating the preface, explanatory note and signature blocks in SI/SSIs

4. Once you are happy with the PDF, you will need to select that PDF snapshot version and click on the ‘Actions’ drop down to select ‘Download 

ZIP file’

5. A zip file will be downloaded, allowing you to save it in the appropriate repository before uploading in onto TNA’s publishing system

6. Once you have uploaded the ZIP file, you should now mark this ‘downloaded’ snapshot version as having been submitted to TNA.

7. This will create a significant version which appears in the right hand side of the ‘Projects’ tab.  It is read only so that it cannot be altered

Marking a version as having been upload to TNA’s publishing system

1. Once you have uploaded the ZIP file you should now mark the downloaded snapshot version as having been uploaded to TNA.

2. Find the copy of the snapshot, called Download

3. Click on the ‘Actions’ drop down and select ‘Update document status to submitted’.

4. Click on Update

5. This will create a significant version that appears on the right-hand side.

Summary

Updating the preface

Inserting and updating an explanatory note

Inserting a signature block

Inserting and updating a commencement history table

Inserting a table of contents

Updating the preface, explanatory note, commencement histories and signature …

Updating the preface, explanatory note, commUpdating the preface, explanatory note, comm……

https://www.youtube.com/watch?v=0iBLRKggfU4
https://www.youtube.com/watch?v=0iBLRKggfU4
https://www.youtube.com/watch?v=0iBLRKggfU4
https://www.youtube.com/watch?v=0iBLRKggfU4
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This screencast includes:

1. Updating the preface

2. Inserting and updating an explanatory note

3. Inserting a signature block

4. Inserting and updating a commencement history table

5. Inserting a table of contents

Updating the preface

1. The preface is basically everything within the dotted line at the top of the document.

2. The blue highlighted text represents data that you can edit.

3. To update the SI Number and year, click on the blue text area which will open the ‘Document Information’ right hand panel, where the editable 

fields are kept

4. You would only need to add a number if you had been given an advance number, I shall put one in to show how it works No.404..  Together with 

an example subsidiary number for example (C.1)

5. You can also edit the title, year and procedure type in this panel

6. If you did change the procedure from draft to made, then you will be warned that the rubrics will get automatically updated as part of this change.

7. For changes to take effect, make sure you move your cursor out of the field that you updated and wait 5 seconds for auto-save to be triggered

8. To update the subject, click on the Subject in the preface which will open a dialogue box.

9. You can add as many subjects as you need to, they are using the SI Registrar’s approved list of subjects and corresponding sub-subjects.

10. If a subject has a sub-subject, it will appear in the sub-subject drop down.

11. You can also add an extent if required.

12. To update the dates on an Instrument, click on the dates in the preface which will open a ‘Manage dates’ dialogue box. 

13. From here it will be possible to add, update and remove dates as required for your instrument. 

14. The ‘Coming into force’ date offers some additional options based on the type of coming into force information you require

15. It’s possible to specify a time and this will be presented in the correct format in the document when saved

16. You can also insert other preface elements using the ‘Insert > Insert preface element’ option in the upper toolbar. 

17. This will open a dialogue box offering different elements, including

a. Correction rubric,

b. Resolution,

c. Approved and pre-populated text options, and

d. Laid in draft.

18. Once you have selected the element to insert into your preface, you have the option of selecting what it will be pre-populated with

Inserting and updating an explanatory note

1. To insert an Explanatory Note into your document, select ‘Insert > Insert Explanatory Note’ from the upper toolbar.  Note you might have to scroll 

to find it in the menu

2. You can add additional paragraphs to the explanatory note, or you can insert numbered lists or even bullet lists. 

3. To change the style of your bullets, right click on the bullet item in your explanatory note and select ‘Update List Style’.  You can choose between 

bullets, em dashes or no bullet marker.

4. You can insert tables into your explanatory note if you want to.

Inserting a signature block

1. To insert a signature block into your instrument, select ‘Insert >Insert signature block’ from the upper tool menu. 

2. A dialogue box will appear allowing you to specify the data you require for example name, role, date and including seals

3. You can add more than one name to a signature if needed

4. When you insert the signature block into your instrument, it won’t look as you expect in the Editor View.  However, when you generate a PDF, the 

signature block will be presented as it should.
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Managing tables and images

5. You can insert more than one signature block if required and swap the order that they appear in the Editor using the Structure view if required.  

Just repeat the process for inserting signature blocks from the ‘Insert’ menu in the upper toolbar

Inserting and updating a commencement history table

1. It is also possible to insert commencement history tables into your document if required,

2. If required, you can copy and paste a previous commencement history table from a previous commencement instrument as long as it was 

drafted in Lawmaker

3. Use the table functions in the right-click menu to update and add to your table as required.

 Inserting a table of contents

1. To insert a table of contents, you will need to select ‘Insert > Insert table of contents’ from the upper toolbar

2. A table of contents will be automatically generated and inserted into the instrument just under the date table, before the preamble.

3. It’s not possible to insert a table of contents with page numbers

4. If the provisions in your document change order or new ones are added or removed, you will need to regenerate a table of contents to reflect the 

changes.

 Managing tables and images in your SI/SSI

Managing tables and images in your SI/SSIManaging tables and images in your SI/SSI

https://www.youtube.com/watch?v=0ni63oyZ768
https://www.youtube.com/watch?v=0ni63oyZ768
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Generating a PDF of your SI/SSI

[to be added]

Summary

Generate PDF from Project Tab or Editor

Generate sub-set of provisions

Footers, J-Refs and snapshots

Generating a PDF of your SI/SSI

Generating a PDF of your SI/SSIGenerating a PDF of your SI/SSI

https://www.youtube.com/watch?v=M2lf4x-hFfw
https://www.youtube.com/watch?v=M2lf4x-hFfw
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Checking your document is valid

1. You can generate a PDF of your Instrument at any time.

2. You can generate a PDF from the ‘Project’ tab by selecting the document version you want to PDF and selecting “Generate PDF” From the 

actions drop down

3. Or you can do it from the Editor by clicking on ‘Documents > Generate PDF’ from the upper toolbar

4. The only difference between the 2 approaches is that when you generate a PDF from the Editor, it will include everything in the Editor - including 

any unsaved changes. 

5. There are a few options to select from when generating a PDF

6. The default setting is to generate a PDF of the whole document, showing any tracked changes if there were any.

7. However, you could decide to generate a PDF of a subset of provisions in your PDF by clicking on the ‘Pages/provisions to include’ drop-down 

and selecting the ones you want to include.

8. Alternatively, you might have tracked changes in your document, but prefer to show the print form with changes applied, with or without side-

lining.

9. You can optionally add footer notes for example if your document is draft

10. You can also opt to show J numbers in the margin if you have included J numbers in your Instrument.

11. Every time you generate a PDF, a snapshot version is created, capturing the version of the document when you generated the PDF.  If you do 

not want to capture a snapshot, you have the option of unselecting this check box. 

12. PDF snapshot versions are used for marking a version as having been signed, or for marking a version as having been submitted to TNA so if in 

doubt, leave this checked.

13. The PDF generated adheres to TNA’s styling and formatting rules so you should no need to make any further edits to your Instrument to make it 

look right in printed format.

Summary

Tracked changes and comments

Document checks

Attributes

Reviewing and validating your SI/SSI

https://www.youtube.com/watch?v=6JQbZMaUYYY
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Introduction to XML (slide deck)

See Introduction to XML .

 

This screencast includes:

1. Tracked changes and comments

2. Document checks

3. Attributes

Tracked changes and comments

1. Lawmaker includes tracked change mode and the ability to record comments in your documents

2. These need to be removed from your document when it is finalised

3. To turn on tracked changes, click on the binoculars button in the upper toolbar

4. When you insert or delete text or whole provisions in the Editor, changes will be marked up in standard tracked change format

5. If you click on the ‘Review’ right-hand panel, you will see these changes being recorded separately as individual change tiles.

6. If you click on a tile in the Review panel, it will jump to the affected part of the document with an arrow indicating exactly where the change 

occurred.

7. You can choose to accept or reject the change or leave a reply

8. The same accept/reject and reply options are available if you hover the mouse point over the change in the Editor.

9. It’s further possible to delete, edit or mark a comment as done.

10. At the bottom of the ‘Review’ panel, there are options to accept all or reject all changes in your document.

11. As well as capturing tracked changes, the Review panel will display comments. 

12. To create a comment, highlight some text or a whole provision by using the breadcrumb or structure view. Right-click and select “Add comment” 

or use the “REview” menu in the upper toolbar.

13. When you have recorded your comment it will appear in the ‘Review’ panel alongside the tracked change tiles and the text will be highlighted 

purple with a tooltip showing the content of the comment if you hover your mouse pointed over the text.

14. Like comments against tracked changes, you can reply, edit and delete comments using the Review panel 

Attributes

1. The last thing to mention in the right-hand panel, relating to reviewing and validating your document is “Attributes”.  You shouldn’t need to use 

this panel.  However, we left it visible as there are a few occasions where it is handy.

2. Once such occasion is checking the target provision of a cross reference. Place your cursor in a cross reference and open the ‘Attributes’ table

3. The href field will describe which provision the cross reference is pointing to.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
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Selecting the procedure applying to an SI/SSI
You can select the procedure applicable to an SI/SSI when you create the SI/SSI project or at a later point. Selecting the procedure will 

affect:

whether the instrument is a draft or made instrument, and

what rubric (if any) that the instrument has at the beginning.

Selecting the procedure when creating an SI/SSI

When creating an SI or SSI project (see Creating a new project ), use the Procedure drop-down menu to select the appropriate 

procedure.

When the blank SI/SSI is created, it will have the following rubric:

SI draft affirmative / draft 

negative

Draft Regulations laid before [Parliament] under section *** of the *** Act *** (c. ***), for approval by 

resolution of [each House of Parliament].

SSI draft affirmative / draft 

negative

Draft Regulations laid before the Scottish Parliament under section *** of the *** Act *** (asp ***), for 

approval by resolution of the Scottish Parliament.

SI Made affirmative Regulations made by ***, laid before [Parliament] under section *** of the *** Act *** (c. ***), for approval 

by resolution [of each House of Parliament].

SSI Made affirmative Regulations made by ***, laid before [Parliament] under section *** of the *** Act *** (c. ***), for approval 

by resolution of [each House of Parliament] within *** days beginning with the day on which the 

Type Procedure Rubric

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
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Changing the procedure of an existing instrument version.

You can change the procedure of an existing SI/SSI version in the Editor.

Use the Procedure drop-down menu in the Document Information right-hand panel to select a different procedure.

Selecting a different procedure will update the rubrics in the instrument and, if necessary, change the instrument from a draft instrument to a 

made instrument or vice versa.

instrument was made, subject to extension for periods of dissolution, prorogation or adjournment [of 

both Houses] for more than four days.

SI Emergency procedure Regulations made by ***, laid before [Parliament] under section *** of the *** Act *** (c. ***), for approval 

by resolution of [each House of Parliament] within *** days beginning with the day on which the 

instrument was made, subject to extension for periods of dissolution, prorogation or adjournment [of 

both Houses] for more than four days.

SI Emergency procedure Regulations made by the Scottish Ministers and laid before the Scottish Parliament under section *** of 

the *** Act *** (asp ***), for approval by resolution of the Scottish Parliament within *** days beginning 

with the day on which the Regulations were made, not taking into account periods of dissolution or 

recess for more than 4 days.
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Managing Subject, Extent and Subsubject
Subjects, extents (territorial suffix) and subsubjects in the preface can be easily updated through a dialogue box giving you the option to 

select from the approved list from the SI Registrar.

How to insert Subject, extend and subsubject

Click on the blue placeholder “Subject”

The system will open a dialogue box

To add a new subject, click on the Add Subject button

Select a subject from the drop-down list - you can type in the first few characters to find subject more easily.

Select an Extent if applicable

If there is a subsubject you want to add, click on the Add button under the label “Subsubject”

Select a subsubject from the drop-down list

Repeat step 2.c if you wish to add more subsubjects

When you have added your Subject, click Add button

If you want to add another subject, click Add Subject again

When you have finished adding/updating subject information, click on Add

Lawmaker will update the Preface with your specified Subject data

How to update Subject, extent and/or subsubject

Click on the blue placeholder “Subject”

The system will open a dialogue box

Click on the pencil button next to the Subject you wish to update

Make required changes and click on Edit button

Repeat these steps to update other Subjects

When you have finished updating the subject information, click on Add

Lawmaker will update the Preface with the changes

How to delete Subject information

Click on the blue placeholder “Subject”

The system will open a dialogue box

Click on the ‘x’ button next to the Subject you wish to remove

If necessary, repeat to remove other subjects

When you have finished updating the subject information click on Add

Lawmaker will update the Preface with the changes

If the subject you need is not listed, you can create one by typing it into the Subject box in the dialogue box.
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How to delete Subsubject information

Click on the blue placeholder “Subject”

The system will open a dialogue box

Click on the pencil button next to the Subject you wish to remove the Subsubject from

Click on the ‘x’ button next to the Subsubject you wish to remove

When you have finished updating Subsubjects click on Edit

When you have finished updating Subjects, click on Add

Lawmaker will update the Preface with the changes

Hints and tips

You can add your own custom Subject or Subsubject entries if the one you need does not already exist, by typing in the subject 

field, but this must be approved through the usual process with the SI Registrar
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Managing Dates
Introduction

You can add and update made, laid and coming-into-force dates in an SI using the Update Dates dialogue box.

How to update Dates

To add or update dates, start clicking on the dates block of the SI in the Editor. It is highlighted in blue.

That will bring up the Update Dates dialogue box:

 

How to update an existing date
1. Click on the pencil icon next to the date you wish to update.

2. Make required changes and click on Update button.

3. When you have finished updating the Date information, click on Save.

How to add a Date

To add a new date:

1. Click on the Add Date button.

2. Select a date type from the drop-down list.

3. Select a date description from the drop-down list.

4. Select a date and time (if required).



235

5. When you have added your date, click Add button.

6. When you have finished click Save.

How to delete Date information

To delete a particular date:

1. Click on the ‘x’ button next to the Date you wish to remove.

2. Click Save.

How to change a Coming into Force Date

To edit the Coming into Force date description:

1. Either edit the existing ‘Coming into Force’ option or add a new date (see above instructions)

2. Ensure the Date type is ‘Coming into Force’

3. In the Date Description select the most appropriate text and by typing in the box add the appropriate text.  Select ‘Other’, if you type in an alternative 

option.

4. Update the rest of the dialogue box if appropriate.

5. Click on Update

6. Click on Save

How to change the order

You can change the order of dates, by clicking and dragging them in the Update Dates dialogue box.

 

 

Hints and tips

Dates in your SI should always appear in Chronological Order, however if you change the dates by inserting or deleting a date, 

Lawmaker will not change this automatically.

You can overwrite the date or time in the input field if you find this easier to change than the date or time picker

Lawmaker will format the date or date and time when it is inserted into the Preface according to the approved format

The date description can be overwritten if the option you need is not in the drop-down list.
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Inserting pre-populated rubrics
You can insert five types of pre-populated rubrics into the beginning of an SI/SSI:

Correction

Resolution

Approved

Laid in draft

Royal Presence.

Depending on the type selected, Lawmaker will present further options of the text to be inserted. Once inserted, you can modify them further 

if required.

For example, here is a Laid in draft rubric after it has been inserted:

How to insert a rubric
1. From the upper tool bar, select Insert>Insert Front Matter Element.

2. The system will present a dialogue box allowing you to select the type of element.

3. Select the rubric option which most closely matches the wording you need.

4. Click Insert 

The system will insert the rubric text in the correct location in the document. If a rubric element already exists in the document, it will be 

replaced with your selected one. 

If necessary, you can update the rubric by typing into the *** placeholders. 

How to delete rubric
1. Place your cursor in the rubric.

2. Click on the rubric element in the breadcrumb and press Backspace. Depending on the type of rubric, the breadcrumb element may have different 

names, e.g. “Procedural rubric”, “Approval”, “Correct rubric”, “Laid in draft rubric”.

The system will remove the rubric element from the document.
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Citation footnotes (legislative history footnote)
SIs and SSIs often include references to other laws and regulations (such as Acts, other SIs or EU legislation). These references are 

accompanied by a footnote which provides the citation of the reference and its legislative history, showing how the referenced provision has 

been amended by other legislation over time.

These are known as ‘citation footnotes’ or ‘legislative history footnotes’.

In Lawmaker, you can automatically generate citation footnotes for any tagged external reference in an SI or SSI.

This feature uses data from Legislation.gov.uk  to generate footnotes that contain the citation of the external reference and summarised 

amendment history of the referenced provision.

How to generate a citation footnote
Before you can insert a citation footnote after a reference, you need to tag the reference (see References | How to “tag” references ) so 

Lawmaker can identify the relevant provision on legislation.gov.uk.

Then, you can trigger the generation of a citation footnote in a number of ways:

Click on the tagged reference and then select Tools menu>Insert citation footnote,

Right-click on the tagged reference in the Editor and select Insert citation footnote, or

Click on the tagged reference and use the keyboard shortcut Alt+Shift+f

Lawmaker will extract the amendment information from Legislation.gov.uk  and generate the citation footnote.

If a footnote already exists for a reference and you insert a citation footnote, the original content of the footnote is preserved: the citation 

footnote will be inserted after the existing text.

Currently, it is only possible to generate one citation footnote at a time.

Once a footnote is generated you can edit it, for example to delete or summarise parts that are not relevant.

What will a citation footnote include?
A citation footnote generated by Lawmaker will always begin with the citation of the legislative document, e.g. the SI year and number.

It will then include amending history information for the reference if the reference you are adding the footnote to refers to a specific provision 

or range of provisions. For example, if it refers to a section, regulation, article, rule (or lower level provision) such as "section 9 of the 

Companies Act 2006".

The automatic generation of citation footnotes is still in beta as there are a number of edge cases that that may need further 

refinement in future. Subsequent versions of Lawmaker will update this feature and make it more robust.

All the references generated within the citation footnote are tagged and link to Legislation.gov.uk . You can view the provision 

referred to by double-clicking on the reference and selecting Goto ref on the floating toolbar. The page will open in a new tab.

http://legislation.gov.uk/
http://legislation.gov.uk/
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522/References#How-to-%E2%80%9Ctag%E2%80%9D-references
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522/References#How-to-%E2%80%9Ctag%E2%80%9D-references
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/


238

What is included depends on information available on legislation.gov.uk. 

The structure of the footnote will be the following: citation+amended provision+amending history information 

For instance: 2016 asp 22. Section 1 was amended by paragraph 11(2) of the Schedule to the Domestic Abuse (Scotland) Act 2018.

2016 asp 22 is the citation of the reference,

Section 1 is the provision referred to which has been amended at some point,

paragraph 11(2) of the Schedule to the Domestic Abuse (Scotland) Act 2018 is the amendment history information relating to that provision.

The output of the citation footnote therefore will depend on the type of reference as shown in the summary table below

Which amendments are included in the footnote?

Lawmaker will include all amendments made to the section, regulation, rule etc. even if the reference is to a sub-provision within that section 

etc.

For example, if the external reference is "section 1(1)(a) of the Abusive Behaviour and Sexual Harm (Scotland) Act 2016" the footnote will 

present the amendment history information for section 1 (“2016 asp 22. Section 1 was amended by paragraph 11(2) of the Schedule to the 

Domestic Abuse (Scotland) Act 2018”.

How is the amending history  generated?

The amending history information is extracted from the textual amendment information available on legislation.gov.uk (also known as ‘F-

notes' or 'footnotes’). Here is an example of how that information appears on the website:

More specifically - when generating a citation footnote - Lawmaker will first request the XML of the   provision referred to from 

legislation.gov.uk, then it will extract all textual amendments from the XML, and finally it will convert each textual amendment into an 

amending statement which will be appended to the citation.

Document reference Companies Act 2006 Citation only 2006 c. 46.

Reference to a grouping 

level (e.g. to a Part, 

Chapter, Schedule, etc.)

Part 1 of the Companies 

Act 2006

Citation only 2006 c. 46.

Reference to a specific 

provision (e.g. to a section, 

regulation, article, or rule)

section 9 of the Companies 

Act 2006

Citation and amending 

history (when available)

2006 c. 46. Section 9 was 

amended by section 3(2)

(a) and (b), 72(2), 29(2), 2(

b) and (a) and 28(2) of 

the Economic Crime and 

Corporate Transparency 

Act 2023 and section 

93(3) and (2)(a) and (b) of, 

and paragraph 

4 of Schedule 3 to, 

the Small Business, 

Enterprise and 

Employment Act 2015.

Reference type Example of  reference Citation footnote output Example of citation 

footnote output

http://legislation.gov.uk/
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In order to do so, Lawmaker requires that the data provided by legislation.gov.uk follows a certain structure and format, which isn’t always 

the case. When the data deviates from the expected format, Lawmaker will consider it as unintelligible and will not be able to extract the 

information. 

In this case, it will provide the following message in brackets within the citation footnote “(<Amended provision> has amendments that 

couldn't be processed when generating this footnote)”.

This means that textual amendments were found on legislation.gov.uk but it was not possible to process them and insert them into the 

citation footnote.

"Cannot generate citation footnote” message

This feature relies on the data from Legislation.gov.uk   to generate footnotes. Sometimes, Legislation.gov.uk   might be 

unresponsive due to server errors or other issues and therefore Lawmaker will not be able to retrieve the necessary information.

In this happens, when you try to add a citation footnote, you will see the error message “Cannot generate citation footnote. Unable to 

retrieve data from Legislation.gov.uk  ” and no citation footnote will be inserted in the Editor.

These issues with legislaton.gov.uk are often temporary, so you should try to generate the citation footnote again after a short time. If the 

problem persists then contact Lawmaker support.

http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislation.gov.uk/
http://legislaton.gov.uk/
https://help.lawmaker.legislation.gov.uk/help/live/support-portal
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Managing Signatures
Introduction

Signature blocks can be inserted through a dialogue box.

How to insert a signature block

In the upper toolbar, click on ‘Insert signature’

The system will open a dialogue box

Add in the signature information in the appropriate field

When you have finished adding the signature information, click on Insert

The system will update the Signature with your specified signature information

How to delete Signatures

Click on “Signatures” from the Structure view or from the breadcrumb

Click on ‘backspace’

The system will remove the Signature from your document

 

Hints and tips

You can update signature information directly in the Editor.  If you need to add another element e.g. name or address, then you will 

need to delete the signature and reinsert another one containing the full set of elements.

If you had more than one signature in your document, you can delete them individually, but you cannot leave the ‘signatures’ 

container empty as this will cause an error with your document. It can be undone using Ctrl +z but make sure you delete using the 

‘Signatures’ container if it’s there is only one signature in your document that you want to delete.

You can insert more than one Signature block in a document – the system will keep adding them after any existing signatures

You can change the order of signature blocks in a Signatures container by using cut and paste. 

You can select between a standard or large seal or text seal if required
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Inserting Explanatory Notes
Explanatory notes appears at the end of the document.

How to insert an Explanatory Note

From the upper tool bar, select ‘Insert > Insert explanatory note’

The system will insert an explanatory note at the end of your document.

If an explanatory note already exists, a new explanatory note will be added after it

 

Hints and tips

You can add numbered paragraphs which default to the numbering format (a) but can be over-written if desired. 

You can insert nested numbered paragraphs which will default to the numbering format (i) or (aa) depending on the nesting level

You can add bullet lists to your explanatory note by selecting ‘List’

The bullet can be changed to an em-dash or nothing at all by right-clicking on any item in the bulleted list and selecting ‘Update List 

style’

You can insert headings in your explanatory notes which have been styled to look like Regulation (or article etc.) headings.

If you have two or more separate blocks of numbered paragraphs in your Explanatory Note, the system will not be able to 

distinguish between the for renumbering.  So, make sure you only highlight the block of paragraphs that you want to renumber, 

rather than selecting the whole Explanatory Note.
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Marking a document as 'Submitted'
Introduction

To keep track of which version was submitted to the National Archive’s Publishing System, it’s possible to mark the downloaded ZIP 

snapshot version as having been submitted which will create a significant version on the right-hand side, clearly flagged as having been 

submitted.

How to mark a document as being submitted

Find the Downloaded snapshot version that was used to submit the ZIP file to the National Archive’s publishing system and select  Update 

document status to ‘submitted’ from the drop down menu

The system will present a warning message, making sure you have selected the right version of the document that was submitted to the 

National Archives

Select Update button to mark the chosen snapshot version as submitted

The system will create a significant version marked as “Submitted”, containing the PDF and the document version that produced it

 

 

Hints and tips

Unlike Bills, marking a document will not make it public to all users of the system.  The permissions for the document will remain the 

same.
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Inserting Commencement Tables
Commencement tables can be added to a SI/SSI when the drafter is ready and appears at the end of the document, after the Explanatory 

Note.

How to insert a Commencement Table

1. From the upper tool bar, select ‘Insert > Insert Commencement Table’

2. The system will insert a commencement history block at the end of your document

Hints and tips

The Commencement history block will be pre-populated with the standard rubric and default table

You can add further paragraphs of text if required
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Confirming which SI/SSI document version should be published
When a SI/SSI has been through its final checks and is either Made, ready to be Made, or a Draft SI/SSI,  it may be necessary to confirm to 

processing colleagues which document version should be used for registration and publishing. 

The correct version can be highlighted in several ways:

SI/SSIs to be published
1. This section applies to final Made or Draft SI/SSIs. 

2. Ensure the document version to be published is final and error free, with no updates required for registration and publishing. 

3. Go to the SI/SSIs project tab. 

4. Go to the Actions' menu of the document version to be published and select Generate PDF

5. Close the PDF and on the Project page go to the most recent PDF listed under the required version. 

6. Select Download a zip file from the PDF’s Actions' menu. The zip file may be saved automatically to your Downloads folder. The zip should include a 

PDF and XML file of the required version. 

7. Email the zip file to the team that will submit the SI/SSI to TNA for registration and publishing. 

SI/SSIs to be Made and/or published
1. This section applies to SI/SSIs which need to be Made, in addition to Draft SI/SSIs not provided to the processing team in a zip file (see above).  

2. Go to the SI/SSIs Project tab. 

3. The document version required will saved be on the left hand side of the tab in a green rectangle or tile. The green tile will be in a top level white 

container. In the image below the white containers are labelled: Drafting, POE and Processing. 

https://lawmaker.scrollhelp.site/help/live/generating-and-viewing-a-pdf
https://lawmaker.scrollhelp.site/help/live/downloading-a-zip-file-of-a-document
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3. Go to the green tile including the version to be published. In the example above, this is in the ‘POE’ white container (POE for Pair of Eyes Check) and 

is labelled ‘1st draft’. 

4. On the left side of 1st draft green tile is a black triangle. Select the triangle and a list of grey document versions and snapshots will appear. 

5. Go to the version to be published. From its Actions' menu select Duplicate version 

6. Give the new duplicate version a name, the example above is ‘Duplicate version for processing'. 

7. Save the duplicate version in its own white container labelled ‘Processing’ or similar. When naming containers and specific document versions follow 

any naming conventions your organisation may use. 

8. The duplicated version is automatically listed under the 1st draft, labelled ‘Duplicated’

9. The duplicate labelled ‘Duplicate version for processing', in its own white container, is ready for the processing team to work on. Selecting the 

version's edit icon will open the Editor screen.  

10. Back on the SI/SSIs Project page, copy and paste the link at the top of the Project page into an email. 

Left hand side of SI/SSI Project page 

Edit icon highlighted in yellow

https://lawmaker.scrollhelp.site/help/live/duplicating-a-document-version
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11. Add the SI/SSI’s title, and the labels of the duplicate to be published (here ‘Duplicate version for processing’) and its container ('Processing') to the 

email and send to the processing team. 

12. Check with email recipients that the version to be published is clear. 

Related information 

Submitting an SI or SSI to TNA  

Processing and submitting SI/SSIs overview  

Tips for SI & SSI drafters working with processing teams  

 

 

 

 

 

 

Project page link highlighted in yellow

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448577
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448577
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/194936833
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/194936833
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/213483521
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/213483521
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Converting a Draft SI/SSI into a Made version
Introduction

SI/SSIs subject to the affirmative procedure will be initially laid in the form of a Draft SI/SSIs.  Once they have received approval through 

Parliamentary procedures they will need converting to Made.  The system will allow users to easily convert a Draft SI/SSI to a Made SI/SSI, 

automatically making all necessary updates to the document and underlying XML.

How to convert an SI/SSI to Made

1. On the Project Tab, select Duplicate version from the Actions menu on the document version you want to convert to Made.

2. Enter a version description (i.e. a name) for the new version and select the folder in which the Made version is to be created.

3. Click on the Convert to Made checkbox so it is checked.

4. Click Create.

Converting a Draft SI/SSI to Made will make the following changes:

Updates the XML so that it is now an Act document (XML version of Made)

Removes ‘Draft’ from the banner

Removes the procedural rubric above the Banner

Further information

 

The system will create a duplicate version of the document, converting it into a Made document and display it on the ‘Project’ tab, under 

the new stage heading of “Made” (unless you specified a different stage name during this duplication process).

Hints and tips

It is not possible to use ‘Convert to Made’ if the document version is already ‘Made’

Lawmaker will suggest a folder of ‘Made’ when you convert a draft SI/SSI to Made, but you can override this in the ‘Duplicate version’ modal 

if you want to put the duplicate document in a different folder.
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Marking a document as 'Signed'
To keep track of which PDF version was signed, it’s possible to mark the PDF snapshot version as having been signed which will create a 

significant version of the document and flag it as having been signed.

Marking a particular version as signed can be useful if, for example, another user is going to be responsible for submitting the document to 

TNA, to ensure they submit the correct version.

Note, however, that Lawmaker does not require a document to be marked as signed before it can be submitted.

How to mark a document as being signed
1. On the Project tab, generate a PDF of the document, if you haven’t already done so.

2. Find the PDF snapshot version that you want to mark as being signed (see Documents and folders on the Project Tab  for more about 

snapshots).

3. Select Update document status to Signed from the Actions menu next to the PDF snapshot. The system will present a warning message, making 

sure you have selected the right version of the document that was signed.

4. Click Update to mark the chosen snapshot version as signed.

The system will create a significant version of the document marked as “Signed” which will be visible on the right of the screen. Other users 

in the same organisation will be able to view that significant version.

 

 

It is a current limitation in Lawmaker that you can only mark a PDF snapshot as signed if the snapshot has the default name of PDF. 

To create a PDF snapshot with this default name, leave the Version description box in the Generate PDF dialog box empty when 

you are creating the PDF.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
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Submitting an SI or SSI to TNA

You can submit an SI/SSI to TNA from within Lawmaker.

How to submit to TNA

1. From the Project Tab, generate a PDF of the working version that you wish to submit to TNA.

2. Find the “PDF” snapshot (click on the toggle next to the version name if necessary to show snapshots) and select Actions > Submit to TNA.

3. Click Submit in the dialog box that appears.  A significant version will appear on the right of your screen.  

4. On the left-hand panel, find the snapshot version ‘Submitted to TNA’ and select Actions > Download ZIP file. 

The submission process is not yet fully automated, so there are some additional steps you need to follow to submit your SI/SSI.
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5. Click Download in the dialog box that appears.  A zip file will be created containing the PDF and XML file, and also any images included in your 

SI/SSI.

 

 

You can now upload the downloaded file into TNA’s publishing system.
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Processing and submitting SI/SSIs overview

Lawmaker introduction

Getting started 

Getting started and other introductory videos

Editing SI/SSIs 

Managing dates

Updating the preface video

Managing signatures

Inserting signature blocks video

Marking your SI/SSI as signed

Sharing documents

Sharing a document with another Lawmaker organisation 

Checking documents  

Validating your document using Document checks

Checking your document video 

Generating and viewing PDFs 

Generating a PDF video 

Submitting SI/SSIs to TNA

Creating a zip file of your SI/SSI to submit to TNA

Managing your SI/SSI through the stages video

Marking your SI/SSI as submitted

Generating Large Print (20pt Arial) PDFs

Generating and viewing PDFs  - select Large Print option 

 

 

 

This section brings together the parts of the user manual that seem most relevant to processing and submitting SI/SSIs to TNA. 

Select a link below for information on managing dates, managing signatures, sharing SI/SSIs with another Lawmaker organisation, 

marking SI/SSIs as signed, checking SI/SSIs, submitting to TNA, marking SI/SSIs as submitted, and generating Large Print PDFs.

https://lawmaker.scrollhelp.site/help/live/getting-started
https://lawmaker.scrollhelp.site/help/live/getting-started
https://lawmaker.scrollhelp.site/help/live/managing-dates
https://youtu.be/0iBLRKggfU4
https://lawmaker.scrollhelp.site/help/live/old-managing-signatures
https://youtu.be/0iBLRKggfU4
https://lawmaker.scrollhelp.site/help/live/old-marking-a-document-as-signed
https://lawmaker.scrollhelp.site/help/live/sharing-a-document-with-another-organisation
https://lawmaker.scrollhelp.site/help/live/old-document-checks-validating-your-document
https://www.youtube.com/watch?v=6JQbZMaUYYY
https://lawmaker.scrollhelp.site/help/live/generating-and-viewing-a-pdf
https://youtu.be/M2lf4x-hFfw
https://lawmaker.scrollhelp.site/help/live/submitting-an-si-or-ssi-to-tna
https://youtu.be/1Rq9aH6how8
https://lawmaker.scrollhelp.site/help/live/old-marking-a-document-as-submitted
https://lawmaker.atlassian.net/wiki/pages/resumedraft.action?draftId=194936833
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Tips for SI & SSI drafters working with processing teams
The purpose of these tips is to reduce queries just before a SI or SSI is due to be submitted, registered and published, when time can be 

very short. 

Where not already in place, it is suggested that legal teams:

give the relevant processing team plenty of notice before a Lawmaker SI/SSI needs to be processed and/or submitted for registration and publishing

resolve a Lawmaker SI/SSI’s document checks as you draft (particularly Mandatory checks) especially before the SI/SSI is passed to the processing 

team, contacting Lawmaker support if required

clarify to the processing team exactly which document version of a Lawmaker SI/SI should be Made and/or submitted for registration and publishing

support the processing team with using Lawmaker until the SI/SSI is submitted successfully

create a shared legal advisory/processing team guide on Lawmaker roles and responsibilities, and

do not expect the processing procedures for Word template SI/SSIs to apply, without first checking with the processing team.

 

 

https://support.lawmaker.legislation.gov.uk/
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UK Bills and amendments
 

As well as the pages below, you may find general help in the following sections:

Drafting and editing  

 Amendments and amendment lists  

 

Drafting UK bills

Creating and drafting a UK Private Bill

Marking 'money provisions'

Inserting UK Bill and Act front and back covers

Finance Bills and Finance Bill Resolutions

Creating a Finance Bill/Finance Resolution

Marking s.5 PCTA resolutions

Preparing bills and acts for publication

Preparing a bill for introduction

Preparing the ‘as amended’ bill version

Publishing bills

Preparing a House Bill 

Applying FrameMaker amendments to a Lawmaker Bill

Converting a UK Bill into an Act

Submitting a UK Act to TNA

Drafting UK amendments

[Commons and Lords] Inserting pre-populated amendments

[Commons and Lords] Amendments to amendments

Inserting explanatory statements

[Lords] Copying amendments from LAS to paste into Lawmaker

Tabling UK amendments (incl. 'ready for publishing')

[Lords] Cloning amendments

Managing Commons amendments and amendment papers

Adding/removing 'Gov' from Commons amendments

Inserting and deleting motions and resolutions

Converting a resolution into an Order in a Commons Marshalled List

Adding [R] to Members with Registered Interests

House of Commons amendment list logic

Managing Lords amendments and amendment papers

[Lords] Amendment Process - One-page summary

[Lords] Copying amendments from LAS

[Lords] Withdrawing amendments before debate

[Lords] Recording outcomes (incl. republishing on the website)

[Lords] Generating Official Lists

[Lords] Updating an amendment so it appears on a subsequent Daily Sheet

Ping pong

[Lords] Ping pong motion lists overview

Specific help for drafting and managing UK Bills, amendments and amendment lists, e.g. how to publish Bills at each stage, producing 

amendments lists in the House of Commons and House of Lords, publishing lists, applying amendments to a Bill, Ping Pong, drafting 

Finance Bill Resolutions.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688898
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688898
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25428280/Drafting+UK+bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/47317042/Creating+and+drafting+a+UK+Private+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339139/Marking+money+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407/Inserting+UK+Bill+and+Act+front+and+back+covers
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25657382/Finance+Bills+and+Finance+Bill+Resolutions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339005/Creating+a+Finance+Bill+Finance+Resolution
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339147/Marking+s.5+PCTA+resolutions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22511617/Preparing+bills+and+acts+for+publication
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/62816257/Preparing+a+bill+for+introduction
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473/Preparing+the+as+amended+bill+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443/Publishing+bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63406081/Preparing+a+House+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526880/Applying+FrameMaker+amendments+to+a+Lawmaker+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681/Converting+a+UK+Bill+into+an+Act
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448601/Submitting+a+UK+Act+to+TNA
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65011715/Drafting+UK+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559068/Commons+and+Lords+Inserting+pre-populated+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60653569/Commons+and+Lords+Amendments+to+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60456961/Inserting+explanatory+statements
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65929217/Lords+Copying+amendments+from+LAS+to+paste+into+Lawmaker
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674/Tabling+UK+amendments+incl.+ready+for+publishing
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/121962497/Lords+Cloning+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22347777/Managing+Commons+amendments+and+amendment+papers
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526365/Adding+removing+Gov+from+Commons+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526501/Inserting+and+deleting+motions+and+resolutions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526381/Converting+a+resolution+into+an+Order+in+a+Commons+Marshalled+List
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526357/Adding+R+to+Members+with+Registered+Interests
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/23199745/House+of+Commons+amendment+list+logic
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22446081/Managing+Lords+amendments+and+amendment+papers
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64815105/Lords+Amendment+Process+-+One-page+summary
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60555265/Lords+Copying+amendments+from+LAS
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60915739/Lords+Withdrawing+amendments+before+debate
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60784656/Lords+Recording+outcomes+incl.+republishing+on+the+website
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71696385/Lords+Generating+Official+Lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/78184449/Lords+Updating+an+amendment+so+it+appears+on+a+subsequent+Daily+Sheet
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25166191/Ping+pong
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70680577/Lords+Ping+pong+motion+lists+overview
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[Commons and Lords] Colouring a paperback for printing

[Commons and Lords] preparing and publishing Consolidated Lists of Amendments

Drafting ping pong motions (including reason motions)

Managing Lords ping pong motions and preparing lists

Managing Commons ping pong motions and preparing lists

Add a heading to an amendment within a ping pong motion

Consolidated List Overview

Publishing amendments on UK parliament's website

Publishing UK amendment lists (incl. ping pong lists)

Republishing updated UK amendments

Church measures

Drafting Church Measures

Managing a Church Measure in Parliament

Creating an Enacted version of a draft Church Measure

Commons resources page

Lords resources page

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/158203905/Commons+and+Lords+Colouring+a+paperback+for+printing
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68878416/Commons+and+Lords+preparing+and+publishing+Consolidated+Lists+of+Amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68255786/Drafting+ping+pong+motions+including+reason+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68157493/Managing+Lords+ping+pong+motions+and+preparing+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68255806/Managing+Commons+ping+pong+motions+and+preparing+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/173080584/Add+a+heading+to+an+amendment+within+a+ping+pong+motion
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70778881/Consolidated+List+Overview
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70942732/Publishing+amendments+on+UK+parliament+s+website
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60456974/Publishing+UK+amendment+lists+incl.+ping+pong+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60882968/Republishing+updated+UK+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/532905986/Church+measures
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522518529/Drafting+Church+Measures
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522616835/Managing+a+Church+Measure+in+Parliament
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256/Creating+an+Enacted+version+of+a+draft+Church+Measure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/140738561/Commons+resources+page
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71073850/Lords+resources+page


256

Drafting UK bills

Creating and drafting a UK Private Bill

Marking 'money provisions'

Inserting UK Bill and Act front and back covers

 

 

 

Specific help for drafters of UK Bills in the Commons and Lords.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/47317042/Creating+and+drafting+a+UK+Private+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339139/Marking+money+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407/Inserting+UK+Bill+and+Act+front+and+back+covers
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Creating and drafting a UK Private Bill
This page outlines how you can create a UK Private Bill and the specific features in Lawmaker to help you do that.

Creating a private Bill

You can create a private Bill project in the same way as you would create a public Bill but by selecting “UK Private Bill” as the project type - 

see Creating a new project   for general help here.

When you create a Private Bill project, an empty document based on the private Bill template will be opened in the Editor. Key features of 

the template where it differs from the public Bill template:

Front and back covers are included within the template

An empty explanatory note element is included within the front cover

The ECHR statement on the cover is the default statement for a private Bill

The preamble contains the standard private Bill text (Starting “WHEREAS-”)

The back cover has a placeholder to enter the session year and an empty promoter block

Adding content to the explanatory note and preamble

Click on the “Text” placeholder on the front cover and start typing to  add content to the explanatory note.

The explanatory note can consist of one or more paragraphs of text. To add additional paragraphs click Enter and select “Paragraph”.

To add numbered paragraphs to the preamble, place your cursor immediately after “WHEREAS-” and press Enter.  Select “Paragraph (1)” to 

insert a paragraph starting with the number (1). You can repeat this to add further numbered paragraphs.

Within those paragraphs it is possible to insert sub-paragraphs by selecting “Paragraph (a)” from the menu when you click Enter.

See Inserting provisions  for general help with inserting additional provisions.

Inserting front and back covers and table of contents.

Although the template contains the front and back covers by default, you can re-insert them in the same way  you would with a public Bill. 

You can also insert a table of contents,

Use the Insert menu in the toolbar and select Insert Front Cover, Insert Back Cover or Insert Table of Contents.

See Inserting UK Bill and Act front and back covers  for more general help with covers and Inserting table of contents  for tables of 

contents.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978762
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978762
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
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Adding promoter/sponsor details to the back cover

The details of the promoter can be added directly in the fields that exist in the default back cover. The name will appear in all caps and the 

role will be in italics.

To add an additional line to the address, click Enter and select “Location”. That will insert an additional location element and you can type 

into that.

Additional promoters/sponsors can be added by placing your cursor within an existing promoter’s details, clicking Enter and selecting 

“Promoter”. That will insert the same placeholders as exist on the default placeholder, i.e. name, address line 1, address line 2 and role.

Converting a Private Bill into a Local Act

To create an Act version of a Private Bill, follow the same approach as you would for a public Bill, using the Duplicate Version feature on 

the Project Tab.

See Converting a UK Bill into an Act .

When you convert a Private Bill to a Local Act, the following should happen:

In the Bill title, "Bill" is replaced with the word "Act".

The Act year will appear at the end of the Act title.

The front cover will show the updated short title and the chapter number will show underneath.

The Explanatory Note will be removed.

The version rubric will no longer be displayed.

The version rubric will no longer be displayed on the cover or preface.

The preface displays the act year and chapter number under the short title (Act Title).

Assent date will appear under the long title (right-aligned)  in the preface.

The back cover will be removed.

The XML root element becomes <act name="ukla"> rather than <bill name=”ukprib”>.

Generating PDFs of private Bills and Local Acts

You can generate a PDF of a Private Bill or Local Act in the same way you would for a public Bill or Act. This includes generating line 

numbering for a Bill.

See Generating and viewing a PDF  .

Publishing Private Bills and sharing Local Acts with TNA

You can publish a Private Bill in the same way that you would publish a Bill. See Publishing bills  .

You can share a Local Act with TNA in the same way that would share a UKPGA.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
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Marking 'money provisions'

You can mark provisions in UK Bills as ‘money provisions’, which are presented in italics as a result.

How to mark/unmark a provision as a ‘money provision’

1. Place the cursor in the provision that you would like to mark as a money provision and

From the upper toolbar select Tools > Mark/unmark as a money provision

Right-click on the provision, and select Mark/unmark as a money provision 

Right-click on the provision in the structure view and select Mark/unmark as a money provision  

2. The system will mark the selected provision (and all its descendant elements) as a money provision and render it in italics (PDF and Editor view).

You can mark a section/subsection/schedule paragraph/schedule sub-paragraph as a money provision

If your provision contains a table, you will need to separately update the italicisation of data inside the table using the ‘Table > Update table’ 

dialogue box

If you intend to mark a schedule paragraph as a money provision, it is easier if you select the whole schedule paragraph from the 

breadcrumb or structure view and mark it as a money provision rather than leaving your cursor in the schedule sub-paragraph as it will only 

apply the money provision mark up to the schedule sub-paragraph in that scenario.
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Inserting UK Bill and Act front and back covers

When a new project is created, the Bill does not include front and back covers.  These can be inserted at any point when drafting the 

document in the Editor.  The front cover also contains the table of contents by default.

How to insert the front cover
In the Editor, from the toolbar select Insert>Insert front cover.  

How to insert the back cover
In the Editor, from the toolbar select Insert>Insert back cover.

Deleting the front or back cover
To delete the front or back cover, select it either from the breadcrumb or using the structure view and press Backspace as you would delete 

a normal provision in the document.

 

A front cover and table of contents will be inserted at the beginning of the document. Any existing cover and table of contents will be 

replaced.

The cover inserted will depend on whether the document is a Bill or an Act.

In a Bill: the front cover will include the Note element by default.  To insert additional statements (e.g. Environmental statement) select 

Statement from the insert menu

In an Act: the image of the crest will be rendered in the PDF but does not appear in the Editor.

A back cover will be inserted at the end of the document.  Any existing cover will be replaced.

The contents of the back cover are derived from other parts of the Bill and details entered into the Document Information panel:

The Long Title is derived from the Long Title in the preface of the Bill and shouldn’t be edited directly on the back cover. The presentation 

of the Long Title in the Editor is an approximation and you should view the PDF to see it properly formatted.

By default, the back cover will include supporter information.  If there are no supporters, place the cursor in the supporter information on 

the back cover, select ‘Supporter block’ from the breadcrumb, and press Backspace to delete it cleanly from the back cover.

If no brought from date is supplied, the back cover will display presenter/supporter information and the copyright statement will only 

include one House (the ‘printed by’ House).

If brought from date is supplied, the block above the ‘Ordered to be printed’ section will display the ‘brought from’ date and the copyright 

statement will include both Houses.

Some elements of the back cover will automatically update when you change them in the Document Information panel but for others you will 

need to reinsert the back cover before the changes will be visible.

If you just want to update the table of contents, use the Insert table of contents menu option instead - see Inserting table of conte

nts

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
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Finance Bills and Finance Bill Resolutions

Creating a Finance Bill/Finance Resolution

Marking s.5 PCTA resolutions

 

 

Specific help for drafters of UK Bills, finance resolutions and amendments in the Commons and Lords.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339005/Creating+a+Finance+Bill+Finance+Resolution
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339147/Marking+s.5+PCTA+resolutions
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Creating a Finance Bill/Finance Resolution

How to create a Finance Bill project

From the dashboard, click on the + New button in the top right above the project tiles/list

The system will ask you to provide the following information:

Type - select "UK Public Bill"

Sub-type - select "Finance Bill"

Title (mandatory)

When you have added the necessary details, click on the Create button

The system will take you to the Editor, with the appropriate Finance Bill template loaded and pre-populated with known text.

How to create an empty Finance Resolution document (in an existing Finance Bill project)

From the Project tab, click on the + New FR button in the top right

The system will ask you to provide the following information:

Folder

Version description (must be unique across the whole project)

When you have added the necessary details, click on the Create button

The system will create a new Finance Resolution document version and display it as a green tile (working version - editable) in the 

appropriate folder with a "FR" green badge.

To draft finance resolutions, you must be in a project that is a Finance Bill

Hints and tips

You can insert 4 types of resolution:

Ways and means resolution

PCTA resolution

Money resolution, and

Procedure resolution

To group subsection-like elements under an italicised heading, select "Resolution group" from the insert menu.  This works the same way 

that a cross heading would work - you must use "wrap" to insert it around existing provisions and to remove it you should use "unwrap"

By default, any user in the same organisation as the user who created the Finance Bill or Finance Resolution will have read/write access to 

it.

When you create a new project, it will automatically be set as a 'favourite' 

You can insert as many resolutions in a single Finance Resolution document as you like
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Marking s.5 PCTA resolutions

Introduction

You can mark resolutions in a finance resolution document as 's.5 PCTA resolutions'.  This information is used when generating a Table of 

Contents - any resolution marked as an s.5 PCTA resolution will be listed under the s.5 PCTA statement at the beginning of the Table of 

Contents.

How to mark/unmark a resolution as a 's.5 PCTA resolution'

Place the cursor in the resolution that you would like to mark as a s.5 PCTA resolution and

From the upper toolbar, select Tools > Mark/unmark as s.5 PCTA resolution

Right-click on the resolution and select “Mark/unmark as s.5 PCTA resolution” 

In the structure view, right-click and select “Mark/unmark as s.5 PCTA resolution”

The system will mark the selected resolution as a s.5 PCTA resolution and a green 's.5 PCTA' label will appear before the resolution (visible 

in the Editor only).

Hints and tips

Hints and tips

You need to mark a resolution as s.5 PCTA resolution if you want it to appear under the s.5 PCTA statement when you generate a 

Table of Contents

The green s.5 PCTA resolution appears in the Editor only - it will not appear in the PDF as well.
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Preparing bills and acts for publication
This section covers managing and publishing UK Bills and Acts, including applying amendment to Bills.

Preparing a bill for introduction

Preparing the ‘as amended’ bill version

Publishing bills

Preparing a House Bill 

Applying FrameMaker amendments to a Lawmaker Bill

Converting a UK Bill into an Act

Submitting a UK Act to TNA

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/62816257/Preparing+a+bill+for+introduction
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473/Preparing+the+as+amended+bill+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443/Publishing+bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63406081/Preparing+a+House+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526880/Applying+FrameMaker+amendments+to+a+Lawmaker+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681/Converting+a+UK+Bill+into+an+Act
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448601/Submitting+a+UK+Act+to+TNA
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Preparing a bill for introduction
This is the business process for preparing an ‘As Introduced' or 'As brought from the Commons’ bill version.

How to prepare a bill for introduction
1. Locate the Project on the Dashboard 

2. Find the shared version on the Significant versions side 

3. Duplicate version 

4. Open in the Editor: 

a. Check document check warnings 

b. Delete all J-refs 

c. Update Document Information (session, year, bill number, version rubric, printed date (brought from date), printed by and members) 

d. Check & re-insert front & back covers/table of contents as required 

e. Generate a PDF (select line numbering) 

5. Send PDF for checking

See also Publishing bills   

https://lawmaker.atlassian.net/l/cp/AQV9SE0r
https://lawmaker.atlassian.net/l/cp/C4mWthQx
https://lawmaker.atlassian.net/l/cp/uqw01070
https://lawmaker.atlassian.net/l/cp/1bWPzJzm
https://lawmaker.atlassian.net/l/cp/SNWGEeCn
https://lawmaker.atlassian.net/l/cp/K1qXsBJM
https://lawmaker.atlassian.net/l/cp/6TrksH0K
https://lawmaker.atlassian.net/l/cp/6TrksH0K
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Preparing the ‘as amended’ bill version
This is the business process for preparing a bill after amendments at an amending stage have been agreed to.

The recommended approach to updating as amended bill versions is a 5-step process which will guide you through the necessary sequence 

of steps to produce a final version ready for publishing at the end.  This section takes each section in turn: 

Pre-flight checks
1. Before you publish a bill, always start with a clean bill  

a. You should have done this already when preparing the As Introduced version but double check there are no ‘bad’ document checks, remove all 

comments and delete any jrefs 

2. Before applying amendments, always start with a clean set of amendments 

a. To check if the amendments are clean, select them using check boxes on the ‘Amendment Manager’ tab before applying them and open them in 

the Editor (Amendment Actions > Create temporary list) 

i. Check Document Checks right-hand panel in the Editor to double check there are no mandatory checks that need addressing

ii. Remove any comments from the ‘Review’ right-hand panel 

3. [COMMONS ONLY] Update new clause and new schedule amendments with location information 

a. This is particularly useful if there are a large number of new clause and/or new schedule amendments as it will save you time when dragging 

them to the correct location in your bill after they have been applied 

b. Open the Amendment Information right-hand panel for each new clause amendment and update the ‘Location’ box with “before” or “after”; and 

update the ‘Provision’ box with the appropriate provision number in the format “sec_22” for sections (clauses) and “sch_3” for schedules.

Apply amendments & check results 
1. From the Amendment Manager, select the amendments you want auto-applied and run Amendment Actions > Apply Amendments.   

a. Consider using filters to make it easier to 'select all' amendments to apply e.g., filter by Member 

b. You can apply amendments to the same bill version in batches 

c. Large bills containing lots of amendments can sometimes take a while to auto-apply (~3 mins) 

d. Create new bill version if you have not already created an as amended version 

2. Accept all the applied amendments displayed as tracked changes  

a. If it is a large bill, use Actions > Edit portion of document  mode 

b. Click on the Accept All Amendments button at the top of Inline Amendments r-h panel 

c. Check for any new Document Check messages (ignore advisory or x-ref doc check errors for now as they will be dealt with as part of ‘Finalise 

Document’ stage) 

3. In the Editor, move to the Review r-h panel where auto-apply warning messages are posted.    

a. Some messages warn you that the amendments were applied but need checking e.g. if there was more than one paragraph being inserted by 

different amendments in the same place, the warning message is asking you to check the sort order;

Auto-application of amendments can only happen if the bill version you are applying them to has page-line information inside it.  

When creating a new version of the bill as part of the auto-application process, it will take care of this for you.  However, if you want 

to apply amendments to a version of the bill you have started updating (e.g. OPC printing points) then you MUST make sure you 

have made those changes to a version of the bill containing page-line information.  To do this duplicate the published version of 

the bill and de-select the ‘strip out page-line information’ as you need this in the bill for auto-application of amendments to work 

later.

https://lawmaker.scrollhelp.site/help/live/old-opening-amendments-in-the-editor-creating-temp
https://lawmaker.scrollhelp.site/help/live/editing-a-portion-of-document
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b. Some messages warn you that a certain amendment couldn’t be applied; in this case, open up the specified amendment in a temporary list and 

check for any obvious mistakes e.g. page-line information or whitespace at the end of the instruction if it’s inserting new provisions.  If you cannot 

fix the amendment, right-click in the quoted structure and select “Copy content of quoted structure” and manually paste it in the correct location.  

c. Delete the warnings that you’ve dealt with as you go so you can keep track of which issues you have resolved.

4. If you need to manually apply amendments: 

a. Open the PDF of the published bill to help work out location of insertions/leave outs 

b. Select the amendment(s) that could not be applied on the Amendment Manager and open them in a temporary list 

c. Display the list side-by-side with your bill (use the Windows button on your keyboard with the left arrow to divide your monitor view in half) as in 

this example below: 

d. 

e. To copy provisions inside a quoted structure:  

i. Place cursor inside the quoted structure of the amendment 

ii. Right-click and select "copy content of quoted structure" 

iii. Place cursor in the bill where you would like to paste the content and use Ctrl + V.    

iv. Check for locked nums when you do this, they may need manually removing (right-mouse-click > Lock/unlock num)  

f. To copy text from the amendment instruction:  

i. Highlight and copy the text within the quotation marks 

ii. Place cursor in the bill where you would like to paste the content and use Ctrl + V 

iii. To insert new clauses which contain grouping levels, e.g., a Part you will need to copy the content of the quoted structure and paste it directly 

into your document in the correct location. 

Finalise document 

To finalise the document, you need to close the document in the Editor and return to the ‘Project’ tab.  To minimise the number of repeating 

steps in this process, the recommended sequence is: 

1. Updating document information from project tab   (e.g., bill number, version rubric, printing dates) 

2. Finalising a document   (select what you need from the options e.g., renumber, update x-refs, reinsert front/back covers including table of 

contents) 

a. If you inserted a new front cover, you would need to open the whole bill to update the Department name on the front cover. 

Final checks
1. Open the document in the Editor 

a. Check Document Checks r-h panel 

When checking auto-applied amendments, you may need to remove the lock on newly inserted provisions.  See How to use lock

ed nums in UK amendments   for more information on why you need to remove locks on nums when amendments are applied.

https://lawmaker.scrollhelp.site/help/live/updating-document-information-from-project-tab
https://lawmaker.scrollhelp.site/help/live/updating-document-information-from-project-tab
https://lawmaker.scrollhelp.site/help/live/finalising-a-document
https://lawmaker.scrollhelp.site/help/live/finalising-a-document
https://lawmaker.scrollhelp.site/help/live/how-to-use-locked-nums-in-uk-amendments
https://lawmaker.scrollhelp.site/help/live/how-to-use-locked-nums-in-uk-amendments
https://lawmaker.scrollhelp.site/help/live/how-to-use-locked-nums-in-uk-amendments
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i. The only issues you should see here are invalid x-refs that Lawmaker was unable to resolve or benign ‘advisory’ document checks 

ii. Correct the invalid x-refs for anything obvious (or is this an OPC responsibility?) 

b. Save changes when you have dealt with all Document Check warnings 

c. Check the Table of Contents – did renumber work as expected?  Sometimes a locked num that was not dealt with in the ‘Auto-apply 

amendments’ stage can throw up unexpected results 

d. Save and close the bill 

2. From project tab: compare document versions 

a. Compare the previous version of the bill with the as amended copy you have been working on to check where changes have been made 

b. First you will need to duplicate BOTH working versions to strip out any page-line numbers (future version of Lawmaker will ignore page-line 

numbers in documents so you will not have to remember this step) 

c. Start with the as amended bill version you have just created and run Actions > Compare Version Comparing documents  to compare it with 

the duplicated previous bill version 

d. Generating a PDF might be a quicker way of skimming through the document looking for changes (and any missing printing point changes) 

3. Send the PDF for checking

At the end of the stage, repeat all the steps above for any opposition amendments that were later agreed to.  This time, when 

applying amendments in step 1, select to update an existing version (the as amended version you have been working on)

If Government bill: Sharing a document with another organisation   Share with OPC for checking & update as required .  

If it is a Private Member’s Bill that has not been drafted by OPC: checks are done in PBO & update as required

See also Publishing bills    

For time-saving measures, see:

Updating document information from project tab  

Finalising a document   

Opening and editing a portion of document   

https://lawmaker.scrollhelp.site/help/live/comparing-documents
https://lawmaker.scrollhelp.site/help/live/comparing-documents
https://lawmaker.scrollhelp.site/help/live/sharing-a-document-with-another-organisation
https://lawmaker.scrollhelp.site/help/live/sharing-a-document-with-another-organisation
https://lawmaker.scrollhelp.site/help/live/publishing-uk-bills
https://lawmaker.scrollhelp.site/help/live/publishing-uk-bills
https://lawmaker.scrollhelp.site/help/live/updating-document-information-from-project-tab
https://lawmaker.scrollhelp.site/help/live/updating-document-information-from-project-tab
https://lawmaker.scrollhelp.site/help/live/finalising-a-document
https://lawmaker.scrollhelp.site/help/live/finalising-a-document
https://lawmaker.scrollhelp.site/help/live/editing-a-portion-of-document
https://lawmaker.scrollhelp.site/help/live/editing-a-portion-of-document
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Publishing bills
Introduction

This outlines the business process for publishing a Bill in the Lords

How to publish a Bill in the Lords
1. From the ‘Project’ tab, find the approved PDF snapshot version  under the correct working version 

2. Select “Actions > Publish version” 

3. Download a ZIP file of the PDF snapshot version that you published 

4. Send it to the usual product distribution list

 

See also Preparing a bill for introduction   and Preparing the ‘as amended’ bill version  

https://lawmaker.atlassian.net/l/cp/0NmSrQG1
https://lawmaker.atlassian.net/l/cp/vSUR278m
https://lawmaker.atlassian.net/l/cp/UE3Ep8kF
https://lawmaker.atlassian.net/l/cp/UE3Ep8kF
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473
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Preparing a House Bill 
Introduction

This is the business process for preparing a PDF that will be used by the other House as the ‘House Bill’

How to prepare a House Bill
1. Duplicate the latest version of the Bill and name it “Commons Copy” or “Lords Copy”

2. Generate a PDF of the newly created document version selecting ‘Line numbering’ and ‘Generate as House Bill” 

3. Send PDF for checking

https://lawmaker.atlassian.net/l/cp/EZms5Svp
https://lawmaker.atlassian.net/l/cp/jnAABPZ8


271

Applying FrameMaker amendments to a Lawmaker Bill

Introduction

You can't copy and paste amendments from FrameMaker directly into Lawmaker because the formatting of the FrameMaker file confuses 

Lawmaker's Smart Paste function.

But you can export the FrameMaker amendment list into a different document type and then copy and paste from there more easily. You can 

either use a PDF from FrameMaker or a plain text export.

Creating a document to copy and paste from

Creating a Word document from a PDF export

1. Export a PDF of the amendment list from FrameMaker

2. Open Microsoft Word and from there open the PDF file so Word converts it into a Word document.

3. Remove the amendment numbers as they interfere with smart paste logic (see 'Removing all amendment numbers' below)

Creating a plain text version

See https://help.adobe.com/en_US/framemaker/2019/using/using-framemaker-2019/user-guide/frm_basics_ba-documents_save-as-plain-

text.html#topic_save-as-plain-text.

Applying individual amendments that insert provisions

If you need to insert a couple of provisions that do not need marking up with x-refs, it might be quicker to paste them directly into the bill (in 

'Edit portion' mode if the bill is large)

If the amendment is inserting provisions that need marking up with x-refs:

Open a LoDA

Copy the whole amendment (including the instruction) and paste into a blank amendment in the LoDA

if you encounter any issues with smart paste, see 'Smart Paste tips' to troubleshoot

no need to add Clause or Schedule number to the beginning of the instruction, unless you were planning on using 'auto-apply'

See section 'Creating x-refs' for tips on marking up any cross references

Remove the lock on the first provision inside a quoted structure (unless you do not want the provision renumbered).  You do this by placing your 

cursor in the num, right-click and select "Lock/Unlock Number".

Inserting new clauses:

If your bill contains parts, chapters or cross headings and you need to paste a new clause, open up its direct parent grouping level in 'Edit 

portion' 

If your bill is only made up of clauses and no grouping levels, then you have to open the whole bill to insert the new clause

If your amendment includes a grouping level before the new clause e.g. a cross heading, then you would need to open the parent grouping level 

of the cross heading e.g. a part of chapter in 'Edit portion'

Remove the lock on the first provision inside the quoted structure - this lock will prevent the provision from being renumbered after it has been 

inserted into the bill.

Creating x-refs

The recommendation is to update amendments inside a LoDA rather than inside the bill itself as this will help with overall performance

If you are cross-referring to a provision in the bill itself, find the provision in the structure view and copy the appropriate x-ref notation. Paste 

it into the amendment in your LoDA.

https://help.adobe.com/en_US/framemaker/2019/using/using-framemaker-2019/user-guide/frm_basics_ba-documents_save-as-plain-text.html#topic_save-as-plain-text
https://help.adobe.com/en_US/framemaker/2019/using/using-framemaker-2019/user-guide/frm_basics_ba-documents_save-as-plain-text.html#topic_save-as-plain-text
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If you are cross-referring to a provision in an amendment's quoted structure (this could be within the same amendment or to another 

amendment's quoted structure:

Expand the structure view

Find the appropriate target provision within the 'quoted structure' level

Copy the desired x-ref notation

Paste into the amendment 

If you are cross-referring to an unnumbered clause (i.e. where the heading is quoted)

Add a number to the target clause

Copy the x-ref to the newly numbered clause (or provision within it)

Paste it over the old italicised text cross-reference

In all these cases above, when you paste the amendment into the bill, the cross reference will be automatically updated to point to the 

correct target provision inside the bill.  If you paste the content of an amendment before you paste the target provision in another 

amendment, the cross reference will be inserted with grey highlight indicating that it is 'invalid'.  However, as soon as you paste the content 

of the other amendment that contains the target provision and run 'update x-ref' it will convert back to 'orange' text indicating that it is a valid 

x-ref.  This is because, as part of the 'paste' operation, it is searching the document for its target and if it can't find it, it will flag it as 'invalid' 

so you know to investigate if required.

Smart paste tips and amendments

You don't need to add Clause or Schedule numbers at the beginning of the instruction unless you're intending to use 'auto-apply 

amendments' feature)

Remove any square brackets and add them manually after pasting

Formatted text in normal paragraph text e.g. italics is not picked up by smart paste, you will need to apply formatting to text after pasting 

(note that this doesn't include italic cross headings or bold clause headings as these are handled by Lawmaker's automatic styling of 

provisions)

Check quotes - there must be a balanced number of quotes.  In some amendments, there may be missing quotes so you might have to 

manually add them in for smart paste to work logically, and then remove them after pasting

If you are copying a new clause that includes a cross heading or part or chapter before it, you will need to manually number the clause for 

smart paste to correctly identify it as a clause. 

If the quoted structure of an amendment goes over a page in the Word document, it is easier to copy the complete amendment and paste it 

into notepad before pasting into a LoDA so that you can strip out any of the page furniture and double-check any incorrect line breaks.

Removing amendment numbers in one go (if downloaded in Word document)

Put your cursor in the "instruction" line of amendment 1 (i.e. the same line as the number "1")

Click on multi-level list button in the toolbar:

Click on "Define New Multilevel List…" in the menu that appears:
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Delete "1" from "Enter formatting for number" text box so the text box is empty and then click OK:
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Converting a UK Bill into an Act

Introduction

Once a Bill has gone through all the amending phases and is ready for enactment, its content will need updating so that it becomes an Act.

Converting a UK Bill into an Act will make the following changes:

Updates the XML so that it is now an Act document type

Inserts the Act front cover (containing Short title, Chapter Number and Explanatory Notes statement)

Inserts new Table of Contents (containing Short title, Chapter Number)

The date of enactment rubric will be added after the long title and the Act Year and Chapter Number will be inserted under the Short title in the 

preface

“Bill” in the short title will be changed to “Act” and the Act Year inserted at the end

“Bill” in the long title will be changed to “Act”

The stage version rubric will be removed

The back cover will be removed (if there is one)

How to convert a UK Bill into an Act

1. On the Project Tab, select Duplicate version from the Actions menu on the document version you want to convert into an Act (see Duplicating a 

document version ).

2. The system will ask you to specify a folder and a version description.

3. When you have provided a folder and version description, select the Convert Bill to Act checkbox and click Create.

4. Open newly created document version in the Editor and do the following: 

Check the Act title  is correct;

Update the Document Information including Act year, chapter number & assent date  (see Managing document information );

Delete Explanatory Notes rubric from front cover  if not required (and any other element, e.g. the table of contents);

Save the document.

5. Generate a PDF (see Generating and viewing a PDF .

6. On the Project Tab, find the PDF snapshot of the approved PDF version and select Submit to TNA (see Submitting an Act or SI/SSI to TNA

ARCHIVED ).

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688280
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688280
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688280
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688308
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688308
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688430
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688430
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688430
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688430
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688430
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Submitting a UK Act to TNA

You can submit an Act to TNA from within Lawmaker.

How to submit to TNA

1. From the Project Tab, generate a PDF of the working version that you wish to submit to TNA.

2. Find the PDF snapshot and select Actions > Submit to TNA.

3. Click Submit in the dialog box that appears.  A significant version will appear on the right of your screen.  

4. On the significant version, select Actions > Download ZIP file. 

5. Click Download in the dialog box that appears.  A zip file will be created containing the PDF and XML file, and also any images included in your Act.

You can now use this zip file to upload into TNA’s publishing system.

 

The submission process is not yet fully automated, so there are some additional steps you need to follow to submit your Act.
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Drafting UK amendments
Specific help for drafters of UK amendments in the Commons and Lords.

[Commons and Lords] Inserting pre-populated amendments

[Commons and Lords] Amendments to amendments

Inserting explanatory statements

[Lords] Copying amendments from LAS to paste into Lawmaker

Tabling UK amendments (incl. 'ready for publishing')

[Lords] Cloning amendments

Here’s an introductory screencast explaining how to draft Commons amendments:

Drafting Commons amendments

Drafting Commons amendmentsDrafting Commons amendments

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559068/Commons+and+Lords+Inserting+pre-populated+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60653569/Commons+and+Lords+Amendments+to+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60456961/Inserting+explanatory+statements
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65929217/Lords+Copying+amendments+from+LAS+to+paste+into+Lawmaker
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674/Tabling+UK+amendments+incl.+ready+for+publishing
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/121962497/Lords+Cloning+amendments
https://youtu.be/BloaJiKGKDM
https://www.youtube.com/watch?v=BloaJiKGKDM
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[Commons and Lords] Inserting pre-populated amendments

When drafting amendments on a List of Draft Amendments (LoDA), Lawmaker provides the option of inserting standard forms of 

amendments containing prepopulated instructions.

To insert a pre-populated amendment, press Enter and select the appropriate option from the CCA.  The screenshot below is the insert 

menu from a Lords LoDA:

The table below lists the available options and what is inserted. (See Inserting provisions and other elements  for general help with the 

CCA.)

Commons pre-populated amendments

Lords pre-populated amendments

Amendment - Leave out Clause / Schedule Leave out Clause / Schedule ***

Amendment - New Clause To move the following Clause— 

 

Amendment - New Schedule To move the following Schedule— 

 

Amendment - Page-line Clause /Schedule ***, page ***, line ***, text

Amendment - Amendment to amendment As an Amendment to ***:—

Line ***,

CCA option Amendment inserted

Amendment - 

Leave out 

Clause / 

Schedule

Leave out Clause / Schedule ***

Amendment - 

Insert Clause

Before/After Clause ***, insert the following new Clause— 

 

Amendment - 

Insert Schedule

Before/After Schedule ***, insert the following new Schedule—

 

CCA option Amendment inserted

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
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Amendment - 

Page-line

Clause / Schedule ***, Page ***, line ***, text

Amendment - 

stand part motion

Proposer gives notice of his/her intention to oppose the Question that Clause *** stand part of the Bill. / that Schedule *** be the 

***th Schedule to the Bill.

Amendment - 

Amendment to 

amendment

As an amendment to the amendment in the name of Member to text, printed on sheet HL Bill ***.

Instruction
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[Commons and Lords] Amendments to amendments
Amendments to amendments are always sorted so that they appear under the target amendment they are amending (apart from in Lords 

Daily Sheets when the target amendment is not usually displayed).

The location information used by Lawmaker to sort amendments is usually gleaned from the amendment’s instruction.  However, in the case 

of amendments to amendments, the text in the italic amendment note is parsed to ascertain the location information used for sorting 

purposes.  

Creating Lords amendments to amendments 

In the List of Draft Amendments (LoDA)…

1. Click ‘Enter’ and select Amendment - Amendment to amendment option

2. The default text that appears in the italicised amendment note is As an amendment to the amendment in the name of to , printed on sheet HL Bill . 

a. Update this to point to the appropriate amendment (see example rubrics in the information panel below).  

b. If the target amendment has been numbered, rewrite this so that it reads As an amendment to amendment x

Amendments to unnumbered new clause/new schedule amendments

If the target amendment was a new Clause amendment or new Schedule amendment the amendment to amendment’s italic text should 

be phrased something like: “As an amendment to the amendment in the name of Lord Purvis of Tweed to After Clause 2 printed on sheet HL 

Bill 128(a)”.  When you save this amendment, the amendment note is parsed and Lawmaker will be able to update the ‘Provision’ attribute in 

the location table (visible in the Amendment Information right-hand panel) is correctly updated with “sec_2”.  However it does not update 

the ‘Location’ attribute which will need manual intervention:

1. Ensure your cursor is in the amendment to amendment so that you are viewing the location information for this amendment

2. Click in the empty ‘Location’ cell of the location table and  type “before” or “after” as appropriate

3. Wait for the spinner to finish spinning before saving your changes.

Creating Commons amendments to amendments

In the List of Draft Amendments (LoDA)…

1. Click ‘Enter’ and select Amendment - Amendment to amendment option

2. Add the amendment number of the target amendment and fill out the amendment as required
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Inserting explanatory statements
Amendments in the Commons and Lords can have explanatory statements after them.  They are not included by default when a new 

amendment is inserted.  To add an explanatory statement to 

How to insert an explanatory statement
1. Place your cursor in the amendment requiring an explanatory statement and click on Enter

2. Select Explanatory Statement from the insert menu

3. Your cursor should appear in the empty Text element inside the explanatory statement allowing you to start drafting or paste the content of the 

explanatory statement.

see also Managing cross references to other amendments  

https://lawmaker.atlassian.net/l/cp/jLrphFct
https://lawmaker.atlassian.net/l/cp/jLrphFct
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[Lords] Copying amendments from LAS to paste into Lawmaker
Members, including the Whip’s Offices currently use Lords Amendment System (LAS) to submit amendments to the Lords PBO for tabling.  

There is a features on LAS which allows the PBO to copy an amendment from LAS and paste it into Lawmaker using Smart Paste.  

How to copy amendments from LAS

In LAS

1. Open the amendment you want to copy into Lawmaker

2. Click on the “Copy to Clipboard” button

In Lawmaker

1. Ensure you have a List Draft Amendments (LoDA) open in the Editor for the appropriate bill and stage

2. Place your cursor in the Instruction element of an empty amendment (click ‘Enter’ and select “Amendment” to insert an empty amendment)

3. Use the paste keyboard short cut Ctrl + V to paste the copied amendment

Pasting amendments from LAS relies on Smart Paste.  See  Smart paste  for more information on how it works and also its limitations

If you find the amendment is pasted badly into Lawmaker, it could be due to a structure that isn’t currently supported by Smart Paste.  The 

page on smart paste will provide useful tips on navigating around its limitations, but it may be easier to paste the provisions in one-by-one.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339283
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339283
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Tabling UK amendments (incl. 'ready for publishing')
If you are a Parliament user, you will have access to the Amendment Status panel in the right-hand panel of the Editor where you can 

update an amendment’s status e.g. tabling or recording an outcome e.g. “Agreed to”.  

How to table amendments
1. Select one or more (submitted) amendments that you would like to update and open them in a temporary list by selecting Amendment Actions > 

Create temporary list from the dropdown menu in the top right of the Amendments tab

2. Place your cursor in the first amendment in the list and click on the “Amendment Status” panel in the right-hand panel in the Editor

To update status individually in a list

1. (From step 2 above) Select the status you would like to change your amendment to e.g. “Table” or “Reject”

2. Move to the next amendment using:

a. The Next >  or < Previous button at the top of the “Amendment Status” panel

b. Using keyboard short cuts

i. Alt + k to move to “Next” amendment, or

ii. Alt + h to move to  “Previous” amendment

3. When you have finished making changes, click on the Save button

To update statuses in one-go

1. (From step 2 above) Click on the Bulk update statuses button. Select the amendments and select Submitted to Draft from the bulk action 

dropdown and click on Update

2. When you have finished making changes, click on the Save button

Amendments must have been submitted before Parliament user can table or reject them

The changes to amendment statuses will only be applied when you click ‘Save’

To undo a selection, click on the button again to de-select it.  To undo a table action after you have saved, see Undoing an amendment s

tatus/managing lifecycle events  

Bulk update will only work on amendments that have the appropriate status e.g. “Submitted to Tabled” the amendment’s status must be 

Submitted.  If there was one or more amendment that didn’t have the status of Submitted but the rest did – only the amendments with the 

status = Submitted would be updated in this context.

Commons Amendments only

There is an additional state "Ready for Publishing" which the PPU will use once they've finished setting an amendment and it is considered 

ready for publishing.  The 'Marshalled List' logic has been updated to only populate the list if Amendments have the 'Ready for Publishing' 

status (and no longer the 'Tabled' status)

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526690
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526690
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526690
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[Lords] Cloning amendments

See Moving or copying amendments to a different stage (including ping pong motions)   for steps on how to ‘clone’ (copy) an 

amendment to a different stage

 

 

You can now copy amendments to different stages which is essentially the same things as “Clone” (a feature from Lords Amendment 

System (LAS)).

Make sure you select “Copy amendment to a different stage” as this will perform the following steps:

remove any assigned number

remove its DNumber (unique identifier e.g. HoL1) and assign a new one

leave the copied amendment assigned to its current stage/bill version

remove any proposer and supporters

remove any lifecycle events from it (e.g. if it had been submitted or tabled) so that it appears as ‘Draft’ once copied to the new stage

The difference between move and copy:

Move will simply move the amendment (and all its associated data & event history) from one stage/bill version to another, bring with the 

amendment all its history and metadata.

Copy will duplicate the amendment the amendment, creating a new version and stripping it of non-relevant data as described above.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
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Managing Commons amendments and amendment papers
Adding/removing 'Gov' from Commons amendments

Inserting and deleting motions and resolutions

Converting a resolution into an Order in a Commons Marshalled List

Adding [R] to Members with Registered Interests

House of Commons amendment list logic

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526365/Adding+removing+Gov+from+Commons+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526501/Inserting+and+deleting+motions+and+resolutions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526381/Converting+a+resolution+into+an+Order+in+a+Commons+Marshalled+List
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526357/Adding+R+to+Members+with+Registered+Interests
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/23199745/House+of+Commons+amendment+list+logic
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Adding/removing 'Gov' from Commons amendments

Introduction

The attribute "Gov" is automatically assigned to OPC submitted amendments if they check the "Mark these amendments as Government 

amendments" upon submission.  In the unlikely event they get this wrong when they submit their amendments, it is possible to update the 

submitted amendments manually.

How to add/remove 'Gov' from Amendments

From the 'Amendment Manager' tab, select the amendment(s) you wish to update and click 'Edit' (alternatively you can do this directly in the 

Marshalled List)

When they appear in the Editor, either:

place your cursor in the amendment's num (or unique reference if it hasn't been assigned a number yet) and use the left arrow to move your cursor to 

the 'Body' element (see the breadcrumb, it should look something like: "list name" > List body > Component > Amendment > Body )

show tags by:

From the upper tool bar, select 'Document > Preferences'

Select 'Full Tags' and click on 'Apply'

 Place your cursor after the "Body" tag (just before "Heading" tag)

Return to your preferred tag view by repeating steps i and ii.

Click on 'Attributes' right hand panel

To add the 'Gov' attribute: click on the 'Add Attribute' button

Type into the 'Attribute' field: ukl:memberInCharge

Type into the 'Value' field: Gov

Click on 'Add' when complete

To remove the 'Gov' attribute: click on the ukl:memberInCharge attribute in the list and click on the 'delete' (bin) button

The Gov text in the Editor will appear/disappear as appropriate

 

 

Hints and tips

This can be done when editing Marshalled Lists if that's preferred
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Inserting and deleting motions and resolutions

Introduction
You can insert motions and resolutions into a Commons Marshalled List or Proceedings in a similar way to how you insert amendments 

(using the the CCA).

How to insert a resolution or motion
1. Place cursor in the list body of a Commons Marshalled List or Commons Proceedings List and click Enter bring up the CCA. (You can also bring up 

the CCA by right-clicking and selecting Insert element… or by selecting Insert>Insert Element… from the the toolbar.)

2. Select resolution or motion from the menu that appears and click Enter. 

The selected element will be inserted in the next correct place.

How to delete a motion or resolution (or order)
1. Select the appropriate motion, resolution or order 

2. Click Delete or Backspace key.

The system will remove the selected element from the list.

You can select the motion etc. by one of the following:

Select it in the Editor by dragging your cursor across it.

Select it from the Structure View by clicking on the relevant item.

Click on 'Resolution', 'Motion' or 'Order' from the breadcrumb.

 

Hints and tips
Motions will be inserted after the element that your cursor is in

Resolutions are used for Programme Motions

You can use the insert menu (CCA) to create structure in your resolution using number format 1 or (1) and inserting paragraphs (a) 

and (i) as appropriate.  

You can also insert tables into resolutions using the upper tool bar "Tools > Insert table".  To insert another paragraph after the table, 

place your cursor after the paragraph before the table and click 'Enter' to access the insert menu.  Select the appropriate paragraph 

and it will be inserted after the table.

The first resolutions inserted into a Commons Marshalled List or Commons Proceedings, will be inserted as the first element in the 

list.  Subsequent resolutions will be inserted as siblings after the first resolution in the list.

When you use 'Update List' to refresh your list with new/updated amendments, your motions and resolutions will not be touched. 

You cannot insert motions or resolutions into Lists of Draft Amendments (LoDAs)

Orders cannot be inserted from the CCA.  First you will need to insert a resolution and then convert it into an order

You can build up the structure of a resolution by clicking in the 'text' placeholder element to insert paragraphs and tables

You can update the 'proposer' of a motion or resolution by clicking on the blue placeholder which will open an 'Update proposer' 

dialogue box allowing you to select from a list of Commons Members.

You can change the order of motions/resolutions or orders in the list by using 'drag & drop' in the Structure view
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Converting a resolution into an Order in a Commons Marshalled List

Introduction

You can convert a resolution in a Marshalled List into an order. This will adjust the formatting and move it to the back of the List.

How to convert a resolution into an Order
1. Place cursor in the selected resolution.

2. Right-click and select Convert to order.

The resolution will be removed from the list and a new order (containing the resolution content) will be inserted at the end of the amendment 

list (before the Withdrawn Amendment section).

 

 

Hints and tips

Resolutions are used for Programme Motions.

You should record the outcome against a resolution before converting it into an Order as that means you can copy the resolution 

and paste it into the Proceedings and it will have the 'proposer' element correctly inserted at the top of the resolution.

If you converted a resolution by mistake, use 'undo' to revert it back into a resolution.

Converting the resolution will additionally strip out the introductory paragraph and ending paragraph of text around the programme 

motion .

Orders cannot be inserted from the CCA, you need to create a resolution first and use 'Convert to Order'.

You can update the 'proposer' of a resolution by clicking on the blue placeholder which will open an 'Update proposer' dialogue box 

allowing you to select from a list of Commons Members.

You can change the order of motions/resolutions or orders in the list by using 'drag & drop' in the Structure view.
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Adding [R] to Members with Registered Interests

Introduction

Members with registered interests in a Commons amendment are displayed in amendment lists with the letter "R" in square brackets e.g. 

"Jo Swinson [R]".

How to add [R] to a Member's displayed name
1. Place your cursor in the name of the Member who needs updating.

2. Select Document>Edit as XML from the upper tool bar.

3. The Editor will display the amendment list in XML format.  Your cursor will be in the XML, it will likely be at the bottom of the screen.

4. Add "[R]" to the appropriate Member's name which  e.g.

5. Click Switch to Author mode in the upper tool bar.

 

1 <block name="supporters"><docProponent refersTo="amnd#person-01">Mike Freer [R]</docProponent></block>

Hints and tips

Making the changes to the display name of the Member in this way ensures that the data  continues to map to the Member in 

Members Names database in Parliament.  If you free-typed the name into the "Manage Members" dialogue box where you add 

proposers and supporters, it wouldn't match to the true Member in the Members Names database.

If you can't find the Member in the XML, either:

use Ctrl+F which will open a blue search bar at the top of the page of XML, allowing you to type the Member's name that you are wanting to 

add the "[R]" to, or

click on the magnifying glass button in the top right of the Editor which will also open the blue search bar at the top of the page of XML
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House of Commons amendment list logic

Introduction

This page sets out the detail of how Lawmaker generates and updates Commons amendment lists including:

what amendments/motions are included,

how they are sorted,

if and how they are numbered,

other rules relating to headings etc. that are automatically generated.

(Rolling) Marshalled Lists

What amendments are included?

Amendments (or ping pong motions depending on the stage) will appear in the Rolling Marshalled List if they were recorded as having been 

“Ready for Publishing” up to the date of the amendment list and and they haven’t already got an outcome recorded against them e.g. 

Withdrawn before debate, Agreed to etc..

How are they sorted?

Amendments are sorted according to a number of factors when they are inserted into a Marshalled list. The sorting algorithm currently sorts 

by the follows criteria:

1. Amendments are first sorted by the clause or schedule to which they relate. If there is an Order of Consideration then this is applied to the sort. 

Otherwise amendments will be sorted in the order the clauses and schedules appear in the Bill.

2. Amendments relating to the same clause/schedule are then sorted by their page and line numbers (and column numbers, for amendments to tables).

3. New Clause and new Schedule amendments are sorted by amendment number.

4. Amendments to amendments are sorted after the amendment to which they relate.

5. Finally, amendments that would otherwise be sorted to the same place are sorted by their user-specified sort code e.g. “M1” before “M2” etc.

Ping pong motions are sorted by the amendment they are referring to on the Consolidated List of Amendments (CLOA)

Numbering

Amendments (and ping pong motions) will not be numbered by Lawmaker when a Marshalled List is generated or updated.

Numbers should be manually assigned to amendments as part of setting the list ready for publication

You can assign simple consecutive numbers to amendments using the renumber function in the Tools menu > Renumber Amendments.

Highlighted amendments in red text

If an amendment is highlighted in red text it means that Lawmaker is unable to sort the amendment correctly. This will be because:

two or more amendments have been identified as appearing in the same page/line location OR

 there are 2 or more new Clause/new Schedule amendments and at least one of these amendments do not have a sort code for the system 

to determine the correct order. 

To resolve this, add a sort code to the highlighted amendments, save them and then update the list. The red highlighting will 

disappear at that point.
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Starred amendments

A black star will automatically appear before an amendment or ping pong motion that has never appeared on a previous rolling marshalled 

list

A white (hollow) star will automatically appear before an amendment or ping pong motion that has been published once already on a rolling 

marshalled list (converting the black star to an white star)

You can manually add or remove black and white stars by right-clicking on your selected amendment and selecting 'update star status'

Headings and rules

The system will automatically insert short rules between amendments and motions in the list

Interstitial headings can be inserted by selecting 'Interstitial heading' from the insert menu when you are editing a Marshalled List

Amendments to amendments (A2A)

Amendments to amendments (A2A)

Amendments to amendments will appear after their target amendment in the sorted list

Line numbers will appear automatically against the target amendment in the PDF (not in the Editor) when you generate a PDF of the Rolling 

Marshalled List/Daily (as long as the A2A is in the same list)

You can manually specify whether an amendment or ping pong motion should be line numbered in a PDF by right-clicking in the Editor on the 

selected amendment/motion and selecting "Update line numbering status" 

A heading will automatically appear before the amendment to amendment

If you have more than one A2A amending the same target amendment, delete the text from the subsequent A2A's headings without deleting the 

heading element and the headings then will not appear in the PDF

Withdrawn amendments

The “Withdrawn amendments” section of the marshalled list does not appear by default when you create or update a marshalled list. You 

can insert it by placing your cursor at the appropriate point, pressing Enter and selecting "Withdrawn Amendments" from the insert menu.

These will be listed at the end of the list whenever they are withdrawn before debate

Motions and resolutions and Orders

Motions and resolutions must be manually inserted into the Marshalled list by selecting 'motion' or 'resolution' from the insert menu

Orders cannot be inserted, they are created by converting a resolution into an order by right-clicking on the selected resolution and selecting 

'Convert to order'

Proceedings
It is assumed that outcomes against motions and amendments will be recorded in the appropriate Marshalled List.  Once you have finished updating 

the amendments and motions with outcomes, you can generate the Proceedings. 

If you are planning on generating a Proceedings at the end of each day, you will need to create a new Proceedings each day of the sitting. 

The system will create an empty document.  You will need to copy and paste motions and resolutions into the Proceedings from the Marshalled List.  

Amendments will be automatically inserted when you run 'Update List'.

The 'Update List' operation will not remove any amendments, motions, resolutions, interstitial headings, witness information or section/schedule 

outcomes.  This means that you can build up a running Proceedings document if you prefer - with new amendments appended to the end of the list 

and before the glossary and adjournment statement.  

An interstitial heading will be inserted before the group of inserted amendments allowing you to record the sitting day information if required.  If not, 

select the interstitial heading element from the breadcrumb or from the structure view and delete it from the list.  They can be manually inserted from 

the insert menu (CCA) if you later decide you want one.
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The system will insert any amendments that have an outcome recorded against them on or between the supplied start and end dates in the 'Update 

List' dialogue box.  This is why you should record outcomes against the amendments before generating a proceedings.

You can insert Witness List information using the insert menu - as well as clause/schedule outcome statements.  Short rules will be inserted 

automatically in the appropriate place as you build up the content of the document.

Ping Pong (Marshalled List)
As covered previously, drafting ping pong motions and amendments is the same as creating Amendments - use the 'Amendments Workspace' to 

create a List of Draft Amendments (LoDA).  To view these motions, look to the Amendment Manager – and it is here, as well as in the LoDA itself, that 

you can advance your pp motions and amendments to the submitted stage, and then to tabled, and then to Ready to Publish.  At this point, you are 

ready to create an Official List.

Official lists can be generated the same way as 'normal' amendments but you must select stage = Ping Pong

Ping Pong Proceedings
It is assumed that outcomes against ping pong motions and amendments will be recorded in the appropriate Marshalled List open in an Editor, or in 

an ephemeral list created for that purpose.  Once you have finished updating the amendments and motions with outcomes, you can generate the 

Ping Pong Proceedings! 

The system will create an empty document.   Amendments with decisions against them will be automatically inserted when you run 'Update List'.

The 'Update List' operation will not remove any amendments, motions, resolutions, interstitial headings, witness information or section/schedule 

outcomes.  This means that you can build up a running Proceedings document if you prefer - with new amendments appended to the end of the list 

and before the glossary and adjournment statement.  

The system will insert any amendments that have an outcome recorded against them on or between the supplied start and end dates in the 'Update 

List' dialogue box.  This is why you should record outcomes against the amendments before generating a proceedings.

 Explanatory statements are not typically used at pp stage, although the functionality to add them remains in the CCA. Motions, resolutions and a 

space to list withdrawn amendments at this stage are options available from the CCA.

Reasons Document
You will need some reason motions set to 'Ready for publishing' before you can generate a Reasons documents

As with all Commons lists, you need to generate the empty list first, then update it with content by selecting "Tools > Update List"
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Managing Lords  amendments and amendment papers
[Lords] Amendment Process - One-page summary

[Lords] Copying amendments from LAS

[Lords] Withdrawing amendments before debate

[Lords] Recording outcomes (incl. republishing on the website)

[Lords] Generating Official Lists

[Lords] Updating an amendment so it appears on a subsequent Daily Sheet

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64815105/Lords+Amendment+Process+-+One-page+summary
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60555265/Lords+Copying+amendments+from+LAS
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60915739/Lords+Withdrawing+amendments+before+debate
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60784656/Lords+Recording+outcomes+incl.+republishing+on+the+website
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71696385/Lords+Generating+Official+Lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/78184449/Lords+Updating+an+amendment+so+it+appears+on+a+subsequent+Daily+Sheet
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[Lords] Amendment Process - One-page summary
Overview of Amendment & Amendment List process

The one-page summary for managing amendments and lists was created in August 2022. 
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How to update this process flow

To update it, you should update the source POWERPOINT document in SharePoint.  Once you have updated that version, generate a new 

PDF to replace the existing PDF in SharePoint.  This image was created by taking a screen shot of the PDF view and pasting it directly onto 

this help page

 

 

https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EUgvbha1baBCi_-HF4SSYg4BEcXHE4DBtv1bNIqcdOGQVA?e=RzX4Y4
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[Lords] Copying amendments from LAS
How to copy amendments from LAS

In LAS

1. Open the amendment up in LAS

2. Click on the Copy to Clipboard button

In Lawmaker

1. Ensure you have a List of Draft Amendments (LoDA) document open in the Editor (see Creating new amendments on a List of Draft Amendments 

(LoDA)  )

2. Insert an empty amendment (select Amendment from the insert menu).  It should look like this:

3. Place the cursor in the Instruction empty placeholder element

4. Paste the content of the LAS amendment into the instruction using Ctrl + V

 

 

Pasting the content of a LAS amendment into the instruction uses Smart Paste logic.  

For more information on how to get the most out of smart paste, see Smart paste  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526389
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526389
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526389
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339283
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339283
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[Lords] Withdrawing amendments before debate
Sometimes, Members wish to withdraw an amendment before debate.  If this happens before a Marshalled List is produced, the 

amendment is updated and it will no longer appear on future lists.  If it appears after it has appeared on a previous Marshalled List, it will 

appear in subsequent marshalled lists with the text “[Withdrawn]” instead of showing the full amendment content.  

How to withdraw an amendment before debate
From the Amendment Manager tab: 

1. Find the amendment on the Amendment Manager you want to update 

2. Select the amendment(s) using the check box on the left hand side.   

3. Open the amendments in a temporary list by selecting Amendment Actions > Create temporary list from the drop-down menu in the top right of 

the Amendment Manager 

4. Click on the Amendment Status right-hand panel 

5. Select Withdrawn before debate button in the Amendment Status right-hand panel

6. Save your changes and close the temporary list

7. If this amendment has been published on a list already, you will need to ensure an update has been scheduled on the relevant bill

How to remove a withdrawn-before-debate amendment from appearing on subsequent 
marshalled lists
When a ‘withdrawn-before-debate’ amendment is part of a batch of amendments that have been dealt with, it should no longer appear on 

subsequent marshalled lists.  To ensure it no longer appears, you will need to remove all the published events from those amendments as 

part of recording outcomes against the other amendments on the Marshalled List.  To do this:

From the Editor, with Amendment Status open in the right-hand panel:

1. Click on the 'Manage lifecycle events' link at the bottom of this panel

2. In the dialog box that opens, delete all published events

3. Click on Update when you have finished making the changes

This will ensure the amendment with the italic ‘[Withdrawn]' note will no longer appear on subsequent amendment lists.

You can use the quick filters at the top of the page to help you find amendments on the Amendment Manager, or use the advanced 

search at the side of the amendment table. 
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[Lords] Recording outcomes (incl. republishing on the website)
After debate, the outcomes need to be recorded against each amendment.  It’s possible to do this via a temporary list or by editing the latest 

Marshalled List.  The process for recording the outcomes is the same for both approaches.  Once you have recorded outcomes, you will 

need to republish the amendments in order for the website to reflect the changes.

How to record outcomes

Option 1: recording outcomes using a marshalled list

1. Open the latest marshalled list 

2. Update the amendments with outcomes (see Recording amendment outcomes  )

3. Save and close the Editor

Option 2: recording outcomes using a temporary list

1. From the Amendment Manager, select the amendments you want to record outcomes against

2. Select Amendment Actions > Create temporary list

3. Update the amendments with outcomes (see Recording amendment outcomes  )

4. When complete, save and close the Editor

How to re-publish updated amendments

Option 1: publishing via the PDF snapshot

1. From the Official List tab, find your updated green Marshalled List and select Actions > Generate PDF 

2. Expand the same green Marshalled List view to view the snapshot versions below it

3. 

4. Find your recently created PDF snapshot and select Actions > Publish version

5. Click Publish on the publish warning message

Option 2: publishing via the Amendment Manager

1. From the Amendment Manager tab, find the amendments you just updated with outcomes

2. Select them all using the check boxes

TIME SAVING TIP

If there are a lot of amendments in the list in the Editor, it is sometimes faster to open the document up in XML view so that locks are 

acquired on all the amendments in a list which saves a little time when updating them individually.  To do this:

1. Select Document > Edit in XML

2. When the XML view appears (sometimes it can take a few seconds), click on the button in the top banner that says “Switch to Author Mode”

When the list of amendments appears again, you will see locks (pencil icons) appear against each amendment in the Structure View 

indicating you have locks on all these amendments.  You can carry on with the steps below to record outcomes.

https://lawmaker.atlassian.net/l/cp/6BSrRjw0
https://lawmaker.atlassian.net/l/cp/6BSrRjw0
https://lawmaker.atlassian.net/l/cp/6BSrRjw0
https://lawmaker.atlassian.net/l/cp/6BSrRjw0
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3. Select Amendment Actions > Publish selected amendments from the dropdown menu in the top right of the page

4. Expand the same green Marshalled List view to view the snapshot versions below it

5. Click Publish on the publish warning message

Ensure you have schedule an update in LegHub before you go home.  This can be done at any time during the day in LegHub, even before 

you have republished the updated amendments - along as the scheduled update time is late enough to run after you have finished making 

your changes.

Use keyboard shortcut Alt + K to move down or Alt + H to move back up the list of amendments

Use the filters on the ‘Amendment Manager’ tab to help you find the amendments that need updating/republishing

The green Marshalled List, when opened in the Editor, will always show the latest version of the amendments.  Which means, if an 

amendment without an outcome has changed since it was first published in a Marshalled List, republishing the Marshalled List using option 1 

above will mean the current version of the amendment is published.  You will not accidentally revert a changed amendment back to it’s 

previous state by publishing the whole amendment list using option 1.
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[Lords] Generating Official Lists
Generating a Lords Daily Sheet (incl. unnumbered supplementary sheets)

Generating a Lords Running List

Generating a Lords Marshalled List

Generating a Lords Manuscript List (used for numbered supplementary sheets)

Sorting logic used by Lords amendment lists

Preparing a Lords Next-Morning Marshalled List

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64782398/Generating+a+Lords+Daily+Sheet+incl.+unnumbered+supplementary+sheets
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65961985/Generating+a+Lords+Running+List
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65961999/Generating+a+Lords+Marshalled+List
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65994753/Generating+a+Lords+Manuscript+List+used+for+numbered+supplementary+sheets
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345/Sorting+logic+used+by+Lords+amendment+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/87228417/Preparing+a+Lords+Next-Morning+Marshalled+List
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Generating a Lords Daily Sheet (incl. unnumbered supplementary sheets)
Generating an official list will automatically populate the appropriate document template with relevant amendments, sorted and grouped 

under appropriate interstitial headings.  

How to generate a Lords Daily Sheet
1. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

2. Select Lords Daily Sheet

3. Update the relevant information in the dialog box and click on Create

4.  

5. A new tab opens with the appropriate document template, containing relevant amendments sorted and grouped under applicable interstitial headings

See Troubleshooting  if you encounter any unexpected outcomes when generating a Daily Sheet

Process and logic for auto-generating the Lords Daily Sheet

Deciding on the document template to use:

If there are no published Marshalled Lists for this bill version, then a Daily Sheet document template is used.

If there are published Marshalled Lists for this bill version, then a Supplementary Sheet document template is used.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
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Filtering which amendments to include in the list:

Amendments will appear in the Daily Sheet or unnumbered Supplementary Sheet if:

they were recorded as having been “tabled” up to the specified cut-off date/time of the amendment list,

they haven’t already got an outcome recorded against them e.g. Withdrawn before debate, Agreed to etc.., and

they haven't already been published on a previous list.

Sorting the amendments

They will be sorted in the order they appear in the bill or by the Order of Consideration, if there is one (see Sorting logic used by 

Lords amendment lists   for more information on sort logic).

Amendments to amendments will be sorted by the page/line information or the amendment number they are linked to.  This 

information is automatically captured by parsing the italic amendment note on amendments to amendments when saving.  

Populating the list

As part of populating the list with amendments, interstitial headings are automatically inserted before each amendment group e.g. 

“Clause 2”; “After Schedule 2” etc.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
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Generating a Lords Running List
Generating an official list will automatically populate the appropriate document template with relevant amendments, sorted and grouped 

under appropriate interstitial headings.  

How to generate a Lords Running List
1. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

2. Select Lords Running List

3. Update the relevant information in the dialog box and click on Create

4. A new tab opens with the appropriate document template, containing relevant amendments sorted and grouped under applicable interstitial headings, 

with black stars against any new amendments which haven’t previously been published.

See Troubleshooting  if you encounter any unexpected outcomes when generating a Running List

Process and logic for auto-generating the Lords Running List

Filtering which amendments to include in the list:

Amendments will appear in the Running List if:

they were recorded as having been “tabled” up to the specified cut-off date/time of the amendment list, and

they haven’t already got an outcome recorded against them e.g. Withdrawn before debate, Agreed to etc..

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
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Sorting the amendments

They will be sorted in the order they appear in the bill or by the Order of Consideration, if there is one (see Sorting logic used by 

Lords amendment lists   for more information on sort logic).

Amendments to amendments will be sorted by the page/line information or the amendment number they are linked to.  This 

information is automatically captured by parsing the italic amendment note on amendments to amendments when saving.  

Populating the list

As part of populating the list with amendments, interstitial headings are automatically inserted before each amendment group e.g. 

“Clause 2”; “After Schedule 2” etc.

Black stars will be added next to any amendments which have not previously been published on a list.

If there is an order of consideration, it will be included in the header of the list.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
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Generating a Lords Marshalled List
Generating an official list will automatically populate the appropriate document template with relevant amendments, sorted and grouped 

under appropriate interstitial headings.  

How to generate a Lords Marshalled List
1. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

2. Select Lords Marshalled List

3. Update the relevant information in the dialog box and click on Create

4. A new tab opens with the appropriate document template, containing relevant amendments sorted and grouped under applicable interstitial headings

See Troubleshooting  if you encounter any unexpected outcomes when generating a Marshalled List

Process and logic for auto-generating the Lords Marshalled List

Filtering which amendments to include in the list:

Amendments will appear in the Marshalled List if:

they were recorded as having been “tabled” up to the specified cut-off date/time of the amendment list, and

All withdrawn (Withdrawn before debate) will be if they have previously been published on a Marshalled List

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
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Sorting the amendments

They will be sorted in the order they appear in the bill or by the Order of Consideration, if there is one (see Sorting logic used by Lords a

mendment lists   for more information on sort logic).

Amendments to amendments will be sorted by the page/line information or the amendment number they are linked to.  This information is 

automatically captured by parsing the italic amendment note on amendments to amendments when saving.  

Populating the list

As part of populating the list with amendments, interstitial headings are automatically inserted before each amendment group e.g. “Clause 

2”; “After Schedule 2” etc.

If there was an order of consideration, it will be included in the header of the list

Amendments are numbered according to the Amendment Numbering Logic

Any amendment that has not previously been published on another list will be assigned a black star

Amendment Numbering Logic

Numbers will be assigned to amendments after they have been filtered, sorted and inserted into the list. 

Numbers will be assigned to amendments that have been recently tabled amendment and that have not been published on a Marshalled List 

or Manuscript List

The number will be inserted into the amendment's //num (overwriting any existing value) following the auto-assign numbering algorithm used 

in the Editor for numbering provisions e.g. 1A for an amendment between amendments 1 and 2, A1 for an amendment before amendment 1 

etc..  (Amendments to amendments (A2As) are treated the same as ordinary amendments)

The only amendments not to receive a number are the ones drafted at Committee stage that contain the text "intention to oppose" in the 

instruction (stand part motions).  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345


309

Generating a Lords Manuscript List (used for numbered supplementary sheets)
Use the Manuscript Amendment List for any amendments that need to be numbered which aren’t on a ‘normal’ Marshalled List e.g. 

Manuscript Amendments or numbered supplementary sheets.

How to generate a Lords Manuscript List
1. Pre-select the amendments you wish to include in the List using the checkboxes on the Amendment Manager tab

2. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

3. Select Lords Manuscript List

4. Update the relevant information in the dialog box and click on Create

5.  

6. A new tab opens with the appropriate document template, containing pre-selected amendments sorted and grouped under applicable interstitial 

headings

See Troubleshooting  if you encounter any unexpected outcomes when generating a Manuscript List

Process and logic for auto-generating the Lords Manuscript List

Filtering which amendments to include in the list:

The amendments that were pre-selected on the Amendment Manager

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
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Sorting the amendments

They will be sorted in the order they appear in the bill or by the Order of Consideration, if there is one (see Sorting logic used by Lords a

mendment lists   for more information on sort logic).

Amendments to amendments will be sorted by the page/line information or the amendment number they are linked to.  This information is 

automatically captured by parsing the italic amendment note on amendments to amendments when saving.  

Populating the list

As part of populating the list with amendments, interstitial headings are automatically inserted before each amendment group e.g. “Clause 

2”; “After Schedule 2” etc.

If there was an order of consideration, it will be included in the header of the list and can be optionally deleted if not required

Amendments are numbered according to the Amendment Numbering Logic

Any amendment that has not previously been published on another list will be assigned a black star

Amendment Numbering Logic

The logic for numbering amendments on a Manuscript List is basic at the moment and is due to be improved in a future release.  

Currently it will work out what the next number in the sequence is from previously published amendments.  It is not able to workout where 

these selected amendments sit vis-a-vis already published amendments and therefor is unable to work out amendment numbering e.g. 1A

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64651345
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Sorting logic used by Lords amendment lists
Amendments are automatically sorted as part of generating the different Lords Official Lists.  

In short, it is a combination of:

where the amendment appears in the bill (subject to an order of consideration & whether it’s an amendment to amendment),

whether it is a new clause/schedule (specifically, dealing with the ‘before’ and ‘after’ cases),

position on the page (page & line information), and finally

sort codes where used

In more detail, this looks like:

First level sort: by the provision to which the amendment relates (using the ukl:targetProvision attribute)

Sort by the order that provisions appear in the Bill, as adjusted by the Order of Consideration (Bill is published version to which the 

amendments relate).

This level involves sorting amendments against a list of provisions in Bill order that has been sorted against the order of consideration. 

 

The types of entry in the OoC and what amendments fall within them are as follows:

longTitle Clauses 2 to 5 sec_2

preamble Schedule 1 sec_3

sec_1 Clause 1 sec_4

sec_2 Clauses 6 to 9 sec_5

sec_3 Schedules 2 to 5 sch_1

sec_4 Preamble sec_1

sec_5 Long Title sec_6

sec_6  sec_7

sec_7  sec_8

sec_8  sec_9

sec_9  sch_2

sch_1  sch_3

sch_2  sch_4

sch_3  sch_5

sch_4  preamble

sch_5  longTitle

Order of Bill provisions Order of Consideration Sort amendments using this order

OoC entry amendments
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If no order of consideration then use the following order:

1. Clauses 1 to (end)

2. Schedules 1 to (end)

3. Preamble

4. Long title

If the Order of Consideration doesn't cover certain provisions (i.e. there are gaps in the specified ranges of provisions) then those provisions 

should be treated as falling at the end of the order of consideration in the order they appear in the Bill.

Amendments to amendments that have a @ukl:targetProvision="amnd_z" should appear after their target amendment (identified using the 

number expressed as "z" in the example ukl:targetProvision="amnd_z"). 

Second level sort: by whether amendment is  before the target provision, to the target provision or after it (using 
the ukl:location attribute)

Sort by values in the following order: before, (empty), after

Third level sort: by position on page (using the ukl:targetPage attribute)

1. Sort in ascending order by page (p_x), then line (ln_x), then column (col_x, if included) e.g.

2. Amendments with empty  ukl:targetPage (i.e. an amendment to leave out clause/schedule) go last

Fourth level sort (using the ukl:targetSortKey attribute)

Amendments appear in sort code order ascending - using alphanumeric values e.g. M1, M2, M3... or 20, 30, 40 or 1, 2, 3

 

 

 

Clauses x to y all amendments of ukl:type "insert", "leaveOut", "substitute", "move", 

"divide" relating to clauses with ukl:targetProvision within range of sec_x 

to sec_y

Schedules x to y all amendments of ukl:type "insert", "leaveOut", "substitute", "move", 

"divide" relating to schedules with ukl:targetProvision within range of 

sch_x to sch_y

Preamble all amendments with ukl:targetProvision "preamble"

Long title all amendments with ukl:targetProvision "longTitle"
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Preparing a Lords Next-Morning Marshalled List
This is the process for preparing a Next-Mornng Marshalled List.  

How to prepare a Next-Morning Marshalled List

Preparing the dummy Marshalled List (to be done the night before)

1. Generate a Lords Marshalled List following the usual process, ensuring the list is dated for the next day when first creating it

Producing the Next-Morning Marshalled List

1. The next morning, open the unpublished Dummy Marshalled List in the Editor by clicking on the pencil icon

2. 

3. Make all necessary changes in the Editor: delete the dealt-with amendments using multi-select in the structure view (Ctrl + left mouse click and 

‘delete’)

4. Save changes

5. Generate a PDF

6.  

7. Download the PDF, rename it (e.g. Energy Bill [HL] – HL Bill 39–I) and email it to the Amendment Product Distribution List

8. Select the PDF snapshot you just created by toggling the black triangle next to the updated Marshalled List

9. Select Actions > Publish Version

10. Click on Publish to confirm you want to publish the list and amendments

Do not publish the Marshalled List at the end of this process
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[Lords] Updating an amendment so it appears on a subsequent Daily Sheet
Sometimes, an amendment might need republishing on a subsequent Daily Sheet, for example if it has been substantively updated.  These 

steps outline what you need to do to ensure this can happen.  

How to republish an amendment on a Daily Sheet
From the ‘Amendment Manager’ tab: 

1. Find the amendment on the Amendment Manager you want to update 

2. Select the amendment(s) using the check box on the left hand side.   

3. Open the amendments in a temporary list by selecting Amendment Actions > Create temporary list from the drop-down menu in the top right of 

the Amendment Manager 

4. Click on the Amendment Status right-hand panel 

5. Click on the Manage lifecycle events link 

6. In the dialog box that opens, delete all published event (s) and click Update

7. Save your changes and close the temporary list

8. Next time a Daily Sheet is generated, this amendment will get picked up as it has no longer got a record of having been published on a list before. 

See Generating a Lords Daily Sheet (incl. unnumbered supplementary sheets)  for more information on the list generation rules

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64782398
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64782398
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Ping pong
[Lords] Ping pong motion lists overview

[Commons and Lords] Colouring a paperback for printing

[Commons and Lords] preparing and publishing Consolidated Lists of Amendments

Drafting ping pong motions (including reason motions)

Managing Lords ping pong motions and preparing lists

Managing Commons ping pong motions and preparing lists

Add a heading to an amendment within a ping pong motion

Consolidated List Overview

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70680577/Lords+Ping+pong+motion+lists+overview
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/158203905/Commons+and+Lords+Colouring+a+paperback+for+printing
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68878416/Commons+and+Lords+preparing+and+publishing+Consolidated+Lists+of+Amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68255786/Drafting+ping+pong+motions+including+reason+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68157493/Managing+Lords+ping+pong+motions+and+preparing+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/68255806/Managing+Commons+ping+pong+motions+and+preparing+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/173080584/Add+a+heading+to+an+amendment+within+a+ping+pong+motion
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70778881/Consolidated+List+Overview
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[Lords] Ping pong motion lists overview
Overview of ping pong motion papers process

The one-page summary for managing ping pong motions & amendments and the lists was created in August 2022.
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How to update this process flow

To update it, you should update the source POWERPOINT document in SharePoint. Once you have updated that version, generate a new 

PDF to replace the existing PDF in SharePoint. This image was created by taking a screen shot of the PDF view and pasting it directly onto 

this help page

 

 

https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EUgvbha1baBCi_-HF4SSYg4BEcXHE4DBtv1bNIqcdOGQVA?e=RzX4Y4
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[Commons and Lords] Colouring a paperback for printing
The following instructions explain how to edit the Consolidated List to change it’s font colour for printing.

1. Open the PDF in Adobe Acrobat pro (this process will not work in Adobe Reader).

2. In your Tools bar on the right, selected “Edit PDF” (If you can’t find the Tools bar, there should be a Tools tab next to the Home button in the top-left of 

the window)

3. On the right-hand side of the page, a panel called “Format” should have appeared.

4. Zoom out so the whole of a page is within view.

5. Use Ctrl+A to select all the text on the page

6. Select the Font Colour box in the Format panel. (The Font Colour box may have been replaced by a ? symbol in a circle – select this if it has).

7. Select the colour that you need to change the text to.

8. Repeat for each page in the document.

 

 

Things to look out for:

This process sometimes slightly alters pagination within individual text boxes. If it does, just slightly alter the affected text box (dragging to 

the left, slightly extending etc.).

Where amendment numbers appear without a letter (eg. 1 instead of 1A, or 10 instead of 10A) this process will add an underscore for some 

reason, so 1 will become 1_ and 10 will become 10_. These underscores will need removing.
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[Commons and Lords] preparing and publishing Consolidated Lists of 
Amendments

This area of the user manual includes all information related to preparing and publishing the Consolidated List of Amendments: from the first 

one containing all agreed amendments from the second House across all their amending stages; to subsequent versions that are passed 

back and forth between the Houses as ping pong progresses

Preparing the Consolidated List of Amendments

Publishing the Consolidated Lists of Amendments

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526469/Preparing+the+Consolidated+List+of+Amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526876/Publishing+the+Consolidated+Lists+of+Amendments
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Preparing the Consolidated List of Amendments
The first Consolidated List of Amendments will bring together all agreed amendments from the second House from all amending stages.  

Subsequent versions of the Consolidated List will then be updated by removing agreed amendments and including messages going back to 

the other House for amendments still in play.

How to generate the first Consolidated List of Amendments

Towards the end of the final stage, a consolidated list of amendments can be generated, pulling together all the agreed amendments from 

all stages in the 2nd House that are either agreed, or highly likely to be agreed once the final stage is completed.  It’s often generated a day 

or two early to give OPC enough time to review it before it is sent to the originating House for publishing.  This is a 2-step process:

1. First copy all the agreed (or likely to be agreed) amendments to ‘ping pong’ stage, and

2. Finally, generate the Consolidated List, updating the amendments in it as normal.

How to copy the agreed (or likely to be agreed) amendments to ‘Ping Pong’ stage

1. Start with current bill version: from the Amendment Manager select using the checkboxes all ‘agreed’ amendments (tip: use the filters here); or any 

amendments that are likely to be agreed.

2. Copy the amendments to ping pong stage by selecting Amendment Actions > Move/copy to a different stage (for more information see Movin

g or copying amendments to a different stage (including ping pong motions)  )

3. In the dialog box:

a. Select “Copy amendments to a different stage”

b. Select Ping Pong for stage

c. Bill version should be “As brought from…” version 

d. Click on Confirm button when ready

4. The amendments will be copied to ping pong stage and you will be able to view them by selecting the correct bill version filter in the top-left of the 

page (in this case, the “As brought from…” stage).  They will be ‘Draft’ status and won’t have a proposer.

5. Repeat steps 1-4 above for any other amending stage in the 2nd House if there were also agreed amendments there.

1. The selected amendments will essentially be duplicated and copied across to Ping Pong stage.  The following changes will be made to 

them:

a. The newly created amendments will be assigned new DNumbers

b. They will no longer have a number assigned to them

c. Any proposers and supporters will be removed

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
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How to generate the Consolidated List

Once all amendments have been copied across to Ping Pong, it’s possible to generate the Consolidated List:

1. Select Amendment Manager > Create Official List

2. In the dialog box that appears, select ‘Consolidated List of Amendments’

3. Fill in the options on the dialog box and click on Create button

4. In newly created list in the Editor:

a. Update the amendments in the list so that they point to the version of the Bill when it first entered the 2nd House

b. Merge, delete and move amendments around as required

i. You may notice that some amendments are at the top of the list when they should be further down. This is because LM is associating ping 

pong amendments with the As Brought from the Commons version of the Bill, and the amendments are to provisions that are beyond what 

was contained in that Bill print. You don't need to worry - these amendments can be dragged and dropped into place.

c. If you made changes to clause & schedule numbers as part of updating the amendments also check that the associated interstitial heading needs 

updating as well,

d. After you’ve finished updating the amendments, manually insert any missing interstitial headings where required (select Interstitial heading from 

the Insert Menu, making sure your cursor is in the ping pong motion before the location where the interstitial heading should be inserted)

e. Renumber the amendments so that they are now numbered 1 to n (Tools > Renumber amendments)

f. Save and close the list

5. If you need to add further amendments after you have begun work on the consolidated list (for example, there are 3rd reading amendments or 

unexpected divisions), copy those amendments to Ping Pong stage in the same way as outlined in "How to copy the agreed (or likely to be agreed) 

amendments to ‘Ping Pong’ stage" above. Open the newly duplicated amendments in a temporary list and copy and paste them into the correct 

place in your consolidated list. You can do this by right-clicking on the amendment in the structure view or by right-clicking on the 'Amendment' 

element in the breadcrumb for that amendment. Tip: Make sure to use ctrl+V when pasting into the correct place. 

6. Share the document version with the other House and let them know that it’s ready for them to prepare for publishing

d. Any events that were recorded against the original amendment (submitting, tabling, publishing etc.) will not be copied across so they will 

appear as “Draft”

2. Once the amendment tabs are changed from filtering by bill version to filtering by stage, this process will be a lot easier see what’s going on.

If you want to insert an interstitial heading before the first amendment in the Consolidated List, you will need to place you cursor in 

the 'list body' element.  To do this:

1. Put your cursor at the start of the amendment heading e.g. “COMMONS AMENDMENT 3”

2. Click on the left arrow on your keyboard and watch the breadcrumb change until you end up in 'list body'

3. Click enter now and select 'Interstitial heading' from the insert menu and type in the Clause  reference number

The interstitial heading will be inserted before the amendment heading, at the top of the list.  The reason for this manoeuvring of 

cursor location when inserting the first element in a list is because Lawmaker always inserts your selected element after the 

element that your cursor is in.  The only way to insert something as the first item in a list, is to shift the cursor so that it’s in an 

element before the element at the start of the list.  

Edit rights to the amendments belong to the House that published the latest version of the bill i.e. users in the second House.  

When you share your Consolidated List with the other House, make sure the amendments, interstitial headings and sort order is 

correct.

If you pick up a shared Consolidated List and notice there is a mistake with the amendments, you will not have edit rights to the 

amendments UNTIL YOU PUBLISH THE CONSOLIDATED LIST.  To correct the data you can either:

Contact someone in the other House who can make that change to the amendment for you

If the mistake is inside the amendment (e.g. page number wrong or message is wrong) they can update the amendment in a temporary 

list and save – when you refresh your Consolidated List – you will see their changes; or

If the mistake is in the list (e.g. a missing interstitial heading or the sort order is incorrect) they will need to update the Consolidated List 

itself and reshare the new version with you.
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How to create subsequent Consolidated List of Amendments

Once a ping pong round is complete, a revised Consolidated List of Amendments needs to be sent back to the other House so that they can 

publish the list and start the next ping pong round in their House:

1. Duplicate the last published version of the Consolidated List

2. Open the list in the Editor:

a. Update the amendments that are still in play with any new messages (messages will include message text and potentially reasons or 

amendments)

b. Delete the amendments that are no longer still in play

c. Move amendments around according to any new groupings

d. Create new interstitial headings as required

e. Save and close the list

3.Share the list with the other House and let them know that it’s ready for them to prepare for publishing

 

 

If you cannot get hold of someone in the other House in time, publish the list (to assign edit rights to you), make the change and then 

republish the list once it’s complete.  At the time of writing this: only ping pong motions will appear on the website so publishing the 

Consolidated List with a mistake on it will not make the mistakes public.  

Consolidated List of Amendments will always appear on the Official Lists tab, regardless of the bill version filter applied

Messages are children of the amendments they relate to.  If a message relates to a group of amendments, it will be the last amendment in 

that group that adopts the message and its associated message text, reasons and amendments.

Messages can be moved between amendments using drag & drop in the Structure View.  This may be necessary when an amendment in a 

group of amendments has been resolved and up until then had been the parent for the messages in that amendment group.  You can move 

these messages to the remaining amendment still in play.

It is envisaged you will copy and paste agreed ping pong amendments directly into the message rather than retype them.

House of Commons

The Lords now include the Clause/Schedule number in the amendment instruction so when editing amendments to convert them into the 

Lords format, don’t forget to add the Clause and Schedule (or Long Title) into the instruction as well.

When updating new Clause and new Schedule amendments (NCX and NSX amendments), the provision number in the location table will 

not automatically update.  You will need to update both the location field and the Provision field for each new clause/schedule amendment 

and then drag them into the correct location, inserting an interstitial heading before them as necessary.

If you change the clause or schedule number in an amendment, you will need to update the Provision field in the location table on the 

Amendment Information right-hand panel and then drag them into the correct location, inserting an interstitial heading before them as 

necessary.
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Publishing the Consolidated Lists of Amendments

Once the other House has shared with you the consolidated list of amendments, you need to top and tail the list and publish it.  

How to Publish the Consolidated List of Amendments
1. Duplicate the shared Consolidated List

2. Open the list in the Editor

a. Open the ‘Document Information’ right-hand panel:

i. add a bill number,

ii. check the House

iii. add a printed date

b. Check that the front and back covers are displaying the correct information – update if required

c. Save and close the document

3. Generate a PDF

4. Find the PDF snapshot version and select Actions > Publish version

 

The next round of Ping Pong can officially start – the bill version visible in the drop-down menu that ping pong motions will be raised against 

will be “Ping Pong – [bill number]” e.g. “Pingpong - HL Bill 23”

It is possible to draft ping pong motions before the Consolidated List has been published.  Once the Consolidated List has been published, 

you can use the Actions > Move amendments to a different stage/bill version option against the LoDA (or individual motion from the 

Amendment Manager tab) to point them to the newly published Consolidated List
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Drafting ping pong motions (including reason motions)
This area of the user manual provides all the information you need to draft and submit ping pong motions, including reason motions

Drafting ping pong motions

Drafting reason motions

Submitting ping pong motions

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526419/Drafting+ping+pong+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/69533697/Drafting+reason+motions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/69599233/Submitting+ping+pong+motions
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Drafting ping pong motions

You can draft ping pong motions and their amendments in the same way as drafting amendments on a List of Draft Amendments (LoDA) 

from the Amendment Workspace tab.  

How to draft a ping pong motion
1. From the Amendment Workspace tab, click on the + New button

2. Fill in the necessary details in the dialog box that opens and click on Create

3.  

4. The system will take you to the Editor, with an empty List of Draft Amendments template loaded and pre-populated with the affected bill short title

5. Use the Insert menu (click Enter on your keyboard) to select the appropriate ping pong motion or amendment:

6. 

 

 

The motion context is the header before the ping pong motion text and usually refers back to the amendment that the ping pong motion is 

targeting.  This information is parsed by Lawmaker when the ping pong motion is saved and used to update the location table on the 

Amendment Information right-hand panel.  The location information is used to sort the amendment lists that are automatically generated.  

The parse logic can work out phrases that include:

Lords amendments 1, 2 and 4

Lords amendments 1 to 3

Commons amendment 1

Commons amendment no. 4

Commons amendment nos. 3 to 6

When a list is auto-generated, any duplicate motion contexts are hidden and a new interstitial heading is inserted before the group of 

motions to ensure there is only ever one heading before the group.  

To check if the motion context has successfully parsed, open the Amendment Information right-hand panel and check the numbers that 

appear in the table row labelled Provision - it should list all the numbers that it has successfully parsed e.g. "amnd_2".  It can be manually 

updated if the motion context isn’t recognised by the parsing logic.
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Drafting reason motions

You can draft reason motions in the same way as drafting amendments on a List of Draft Amendments (LoDA) from the Amendment 

Workspace tab.  

How to draft a reason motion
1. From the Amendment Workspace tab, click on the + New button

2. Fill in the necessary details in the dialog box that opens and click on Create

3.  

4. The system will take you to the Editor, with an empty List of Draft Amendments template loaded and pre-populated with the affected bill short title

5. Use the Insert menu (click Enter on your keyboard) to select PP Reason Motion

 

Reason motion

The motion context is the header before the reason motion and usually refers back to the amendment that the ping pong motion is targeting.  

This information is parsed by Lawmaker when the ping pong motion is saved and used to update the location table on the Amendment 

Information right-hand panel.  The location information is used to sort the lists that are automatically generated.  The parse logic can work 

out phrases that include:

Lords amendments 1, 2 and 4

Lords amendments 1 to 3

Commons amendment 1

Commons amendment no. 4

Commons amendment nos. 3 to 6

You can add additional ‘reason’ paragraphs to the dotted box by clicking on Enter to get the insert menu and selecting Reason
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Submitting ping pong motions

Once you have finished drafting your ping pong motion(s), you can submit them for tabling to the appropriate Parliament.  This action 

changes the permissions on an amendment if you are an OPC user so that the appropriate Parliament users can now view and edit the 

submitted amendments and you will only have read only access.  

How to submit ping pong motion from the 'Amendments' tab
1. From the Amendment Manager tab, use the check boxes on the left-hand side of each amendment to select the one(s) you wish to submit

2. Select Amendment Actions > Submit Amendments  from the dropdown menu in the top right of the screen

3. The selected elements will be updated to status “Submitted” and visible to the appropriate Parliaments’ users

How to submit ping pong motions from the Editor (OPC)
1. Open the List of Draft Amendments (LoDA) in the Editor

2. Click on the Document Information right-hand panel in the Editor

3. Click on the Submit List button

4. The ping pong motions on the list will all be updated to status “Submitted” and visible to the appropriate Parliaments’ users

How to 'bulk' submit amendments from the Editor (Parliament users)
1. Open the List of Draft Amendments (LoDA) in the Editor

2. Click on the Amendment Status right-hand panel in the Editor

3. From the Bulk update statuses drop-down, select Draft to Submitted

4. Click on the Update button

5. Save your changes and all amendments in the list that are set to 'Draft' will be updated to 'Submitted'

 

If a ping pong motion contains tracked changes or comments (in the Editor) then a warning will be displayed when you select to submit 

them.  You can choose to cancel and remove them or submit them anyway.

Submitting ping pong motions from the Amendment Manager tab will only work if:

the associated bill document has been published by the appropriate Parliament,

their status is “Draft”,

there are no active locks on them, and

there isn't a flag set against them (this check only works if submitting from the Amendment Manager tab)

Submitting ping pong motions from the Document Information right hand panel in the Editor, will only work if:

the associated bill document has been published by the appropriate Parliament,

their status is “Draft”, and

there are no active locks on them.
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Managing Lords ping pong motions and preparing lists
This area of the user manual explains what the Lords PBO must do in order to prepare and publish ping pong lists.

Generating a Lords Daily Sheet at Ping Pong

Generating a Lords Marshalled List at Ping Pong

Recording outcomes against ping pong motions (incl. republishing on the website)

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/69402625/Generating+a+Lords+Daily+Sheet+at+Ping+Pong
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/69402639/Generating+a+Lords+Marshalled+List+at+Ping+Pong
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/69500929/Recording+outcomes+against+ping+pong+motions+incl.+republishing+on+the+website
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Generating a Lords Daily Sheet at Ping Pong
Generating an official list will automatically populate the appropriate document template with relevant ping pong motions, sorted and 

grouped under appropriate interstitial headings.  

How to generate a Lords Daily Sheet at Ping Pong
1. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

2. Select Lords Daily Sheet

3. Update the relevant information in the dialog box and click on Create

4.  

5. A new tab opens with the appropriate document template, containing relevant amendments sorted and grouped under applicable interstitial headings

Process and logic for auto-generating the Lords Daily Sheet at Ping Pong stage

Deciding on the document template to use:

If there are no published Marshalled Lists for this bill version, then a Daily Sheet document template is used.

If there are published Marshalled Lists for this bill version, then a Supplementary Sheet document template is used.

Filtering which ping pong motions to include in the list:

Ping pong motions will appear in the Daily Sheet or unnumbered Supplementary Sheet if:

they were recorded as having been “tabled” up to the specified cut-off date/time of the amendment list,

they haven’t already got an outcome recorded against them e.g. Agreed to etc.., and
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How to copy amendments from the consolidated list into a Lords Daily sheet

As a general rule, it’s only the Lords Marshalled List where the source amendment from the Consolidated List is displayed in the 

amendment list before the ping pong motions.  However, they can sometimes appear in Lords Daily Sheets.  This will not happen 

automatically like it does for Lords Marshalled Lists.  Instead you will need to copy and paste the amendment into your Daily Sheet.  Here’s 

how to do it:

1. Open the latest, working version (green version) of the Consolidated List (to ensure you’re copying all associated messages and ping pong 

amendments that might be linked to the source amendment)

2. Find the amendment you want to copy, place your cursor in that amendment and copy it

3. Open the Daily Sheet that you want to paste the amendment into

4. Locate the ping pong motion that you want the amendment to appear before and place your cursor in the amendment heading before it (e.g. 

“COMMONS AMENDMENT 3”)

5. Use ctrl+v to paste the source amendment into your Daily Sheet (ignore the empty ‘Proposer’ element that appears before the pasted amendment, 

this won’t appear in the PDF)

they haven't already been published on a previous list.

Sorting the ping pong motions

They will be sorted by the amendment number they are associated to (taken from the motion’s context heading)

Populating the list

As part of populating the list – the following insert logic is applied:

1. Take the first sorted ping pong motion and insert an interstitial heading containing that motion’s context (e.g. “COMMONS AMENDMENT 2”)

2. Insert the first sorted ping pong motion followed by any other ping pong motions with the same motion context (hiding their motion contexts 

so there’s only one interstitial heading before them all)

3. Repeat these steps for remaining sorted ping pong motions with different motion contexts

The ping pong motions and associated ping pong amendments are not numbered.

If you need to crop this amendment (e.g. if there is more than one ping pong motion to this amendment, which are referring to previous 

messages in the source amendment like in this real life example ping pong marshalled list 

https://bills.parliament.uk/publications/41135/documents/145) then carefully select the messages from the source amendment to delete them 

one-by-one as required using the breadcrumb or structure view.  

If you find you have deleted too much, use Ctrl+z to undo and have another go.

If you only want a ping pong amendment from the source amendment to appear (see amendment 4D under Motion B, page 4 in the linked 

Marshalled List above for an example of this scenario) then you cannot simply delete the source amendment as this will delete all its child 

messages and their child ping pong amendments.  Instead:

a. Delete the quoted structure first by selecting it from the breadcrumb

b. Use backspace to remove the text (not the element) in the amendment’s instruction and use backspace again to remove the number 

from the amendment’s num element leaving behind the empty num and empty instruction placeholders.  These will not appear in 

the PDF when it is printed, but means that the child message remains.

c. Delete the message heading element and the message text element by selecting them from the breadcrumb.  Deleting the elements in 

this case will not delete your ping pong amendment

If you’ve done these previous 3 steps correctly, it will look something like this in the Editor:

https://bills.parliament.uk/publications/41135/documents/145
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If you want to insert an interstitial heading (or any other element) before the first amendment or element in a list, you will need to 

place you cursor in the 'list body' element.  To do this:

1. Put your cursor at the start of the amendment heading or the first element in your list e.g. “COMMONS AMENDMENT 3”

2. Click on the left arrow on your keyboard and watch the breadcrumb change until you end up in 'list body'

3. Click enter now and select the appropriate element from the insert menu e.g. 'Interstitial heading' and type in the inserted element

The selected element will be inserted before the element at the top of the list. The reason for this manoeuvring of cursor location 

when inserting the first element in a list is because Lawmaker always inserts your selected element after the element that your 

cursor is in. The only way to insert something as the first item in a list, is to shift the cursor so that it’s in an element before the 

element at the start of the list.
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Generating a Lords Marshalled List at Ping Pong
Generating an official list will automatically populate the appropriate document template with relevant ping pong motions, sorted and 

grouped under appropriate interstitial headings.  

How to generate a Lords Marshalled List at ping pong (for a Commons Starter or not the first ping 
pong round for a Lords Starter)
1. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

2. Select Lords Marshalled List

3. Update the relevant information in the dialog box and click on Create

4. A new tab opens with the appropriate document template, containing relevant ping pong motions sorted and grouped under applicable interstitial 

headings

Process and logic for auto-generating the Lords Marshalled List at Ping Pong 

Filtering which amendments to include in the list:

Ping pong motions will appear in the Marshalled List if they were recorded as having been “tabled” up to the specified cut-off 

date/time of the amendment list.

Sorting the amendments

They will be sorted by the amendment number they are associated to (taken from the motion’s context heading)
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How to generate a Lords Marshalled List at ping pong for a Lords Starter when it is the first round 
of Ping Pong

There are 2 options here, depending on how many ping pong motions there are Vs how many amendments there were on the Consolidated 

List.

1. If there were more amendments on the Consolidated List than tabled ping pong motions, it might be quicker to create a Lords Marshalled List and 

copy the amendments from the Consolidated List straight  into it in one go and move the ping pong motions after the appropriate amendment using 

the structure view; or (to paste motions after the appropriate amendment, move your cursor using the arrow keys into the list body element between 

the amendments in the list)

2. If there were more tabled ping pong motions than amendments on the Consolidated List, use the automatic list generation rules for a Marshalled 

List and copy over the missing amendments from the Consolidated List.

How to copy amendments from the consolidated list into a Lords Marshalled List

If you have quoted a valid commons or lords amendment number in the ‘Amendment heading’ element for your ping pong motion, then the 

Marshalled List that is generated will automatically be populated with the source amendment and all its associated messages and ping pong 

amendments.  However, sometimes it’s necessary to carve up the source amendment and display bits of it before ping pong motions that 

may be referring back to earlier messages.  This happened in the Marshalled List here 

https://bills.parliament.uk/publications/41135/documents/145.  To recreate this list (or another one like it in future) follow these steps:

To ensure you get a ‘Motion’ heading auto-generated in the Marshalled List before each ping pong motion group:

1. Open a temporary list containing all the ping pong motions

2. Update the amendment heading for each ping pong motion with the ping pong amendment that the motion is referring to rather than the source 

amendment.   The amendment heading is the ALL CAPS heading before the motion e.g. “LORDS AMENDMENT 4” for example, in the example 

Marshalled List linked above:

a. all motions under Motion A are referring back to “Amendment 4B and 4C” so update the Amendment Heading for any motions within the Motion A 

group with “LORDS AMENDMENT 4B and 4C”

b. the motion under Motion B is referring to Amendment 4D so update the Amendment Heading for any motions grouped under Motion B with 

“LORDS AMENDMENT 4D” etc.

3. Save changes and close the temporary list

Generate the Lords Marshalled List following the instructions above

Because you added different amendment headings that Lawmaker couldn’t map directly back to a source amendment from the consolidated 

list, what you will see is a ‘MOTION’ heading before each batch of ping pong motions, but there won’t be any source amendment before 

these motion groups.

Populating the list

As part of populating the list – the following insert logic is applied (same as daily sheet with differences in red text):

a. Take the first sorted ping pong motion and insert an interstitial heading with “MOTION” before it

b. Followed by an interstitial heading containing that motion’s context (e.g. “COMMONS AMENDMENT 2”)

c. Followed by all the source amendment(s) from the Consolidated List (identified from the motion’s context)

d. Insert the first sorted ping pong motion followed by any other ping pong motions with the same motion context (hide their actual motion 

context so there’s only one interstitial heading before them all)

e. Repeat these steps for remaining sorted ping pong motions with different motion contexts

The ping pong motions are not numbered

Any ping pong motion that has not previously been published on another list will be assigned a black star.  

You can optionally choose to assign black stars to ping pong amendments if they have been added to a previously published ping pong 

motion.  Follow the same process as adding a star to a normal amendment (v13) Inserting/removing an Amendment Star   

https://bills.parliament.uk/publications/41135/documents/145
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/113967170
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/113967170
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Copy and paste the source amendment after the ‘MOTION’ heading and crop it according to your needs:

1. Open the latest, working version (green version) of the Consolidated List (to ensure you’re copying all associated messages and ping pong 

amendments that might be linked to the source amendment)

2. Find the appropriate amendment in this consolidated list that you want to copy:

a. Place your cursor in that amendment, 

b. Select ‘amendment’ from the breadcrumb to ensure you are correctly selecting the whole thing (including child messages and their child ping 

pong amendments) and 

c. Select copy (Ctrl+C or use the right-click menu or the copy button in the upper tool bar).

3. Open the Marshalled List that you want to paste the amendment into

4. Locate the ping pong motion that you want the amendment to appear before and place your cursor in the amendment heading before it (e.g. “LORDS 

AMENDMENT 4B and 4C”)

5. Use Ctrl+V to paste the source amendment into your Marshalled List

6. If you need to crop this amendment then carefully select the “Messages” from the source amendment to delete them one-by-one as required using 

the breadcrumb or structure view.  

 

If you find you have deleted too much, use Ctrl+Z to undo and have another go.

If you only want a ping pong amendment and not the source amendment to appear (see amendment 4D under Motion B, page 4 in the 

linked Marshalled List above for an example of this scenario) then you cannot simply delete the source amendment as this will delete all its 

child messages and their child ping pong amendments.  Instead:

a. Delete the quoted structure first by selecting it from the breadcrumb

b. Use backspace to remove the text (not the element) in the amendment’s instruction and use backspace again to remove the number 

from the amendment’s num element leaving behind the empty num and empty instruction placeholders.  These will not appear in 

the PDF when it is printed, but means that the child message remains.

c. Delete the message heading element and the message text element by selecting them from the breadcrumb.  Deleting the elements in 

this case will not delete your ping pong amendment

If you’ve done these previous 3 steps correctly, it will look something like this in the Editor:

 

If you want to insert an interstitial heading (or any other element) before the first amendment or element in a list, you will need to 

place you cursor in the 'list body' element.  To do this:

1. Put your cursor at the start of the amendment heading or the first element in your list e.g. “COMMONS AMENDMENT 3”

2. Click on the left arrow on your keyboard and watch the breadcrumb change until you end up in 'list body'

3. Click enter now and select the appropriate element from the insert menu e.g. 'Interstitial heading' and type in the inserted element

The selected element will be inserted before the element at the top of the list. The reason for this manoeuvring of cursor location 

when inserting the first element in a list is because Lawmaker always inserts your selected element after the element that your 

cursor is in. The only way to insert something as the first item in a list, is to shift the cursor so that it’s in an element before the 

element at the start of the list.
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Recording outcomes against ping pong motions (incl. republishing on the 
website)

After debate, the outcomes need to be recorded against each motion.  It’s possible to do this via a temporary list or by editing the latest 

Marshalled List.  The process for recording the outcomes is the same for both approaches.  Once you have recorded outcomes, you will 

need to republish the ping pong motions in order for the website to reflect the changes.

How to record outcomes against ping pong motions

Option 1: recording outcomes using a Marshalled List

1. From the Official List tab, find and open the latest marshalled list (green version)

2. Update the ping pong motions with outcomes

a. Place your cursor in the first ping pong motion

b. Open Amendment Status in the right-hand panel

c. Select the appropriate outcome from the buttons on this panel

d. Move to the next ping pong motion (Alt + K to move down through the list, or Alt+H to move back up through the list)

e. Continue for each ping pong motion

3. When complete, save and close the Editor

Option 2: recording outcomes using a temporary list

1. From the Amendment Manager, select the ping pong motions you want to record outcomes against

2. Select Amendment Actions > Create temporary list

3. In the Editor, update the ping pong motions with outcomes

a. Place your cursor in the first ping pong motion

b. Open Amendment Status in the right-hand panel

c. Select the appropriate outcome from the buttons on this panel

d. Move to the next ping pong motion (Alt + K to move down through the list, or Alt+H to move back up through the list)

e. Continue for each ping pong motion

4. When complete, save and close the Editor

How to re-publish updated ping pong motions

Option 1: publishing via the PDF snapshot

1. From the Official List tab, find your updated green Marshalled List and select Actions > Generate PDF 

2. Expand the same green Marshalled List view to view the snapshot versions below it

3. 

4. Find your recently created PDF snapshot and select Actions > Publish version

5. Click Publish on the publish warning message

Option 2: publishing via the Amendment Manager
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1. From the Amendment Manager tab, find the ping pong motions you just updated with outcomes

2. Select them all using the check boxes

3. Select Amendment Actions > Publish selected amendments from the dropdown menu in the top right of the page

4. Expand the same green Marshalled List view to view the snapshot versions below it

5. Click Publish on the publish warning message

Ensure you have schedule an update in LegHub before you go home.  This can be done at any time during the day in LegHub, even 

before you have republished the updated ping pong motions - as long as the scheduled update time is late enough to run after you 

have finished making your changes.

Use keyboard shortcut Alt + K to move down or Alt + H to move back up the list of amendments

Use the filters on the ‘Amendment Manager’ tab to help you find the ping pong motions that need updating/republishing
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Managing Commons ping pong motions and preparing lists
This area of the user manual provides information on how to prepare and publish Commons Marshalled Lists and Proceedings at ping pong 

stage.

Adding proposers and supporters to ping pong amendments

Generating the Reasons Document

Line numbering at ping pong follows a different rule for Commons ping pong motions and ping pong amendments:  the first line that 

is counted will be the motions/amendment instruction (e.g. that starts “Clause 1, page 1, line 1…”.  This is a different rule that is 

applied to Commons amendments in normal amending rounds where the first line counted is within the quoted structure (i.e. the 

provisions being inserted by the amendment)

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/73596935/Adding+proposers+and+supporters+to+ping+pong+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/151257089/Generating+the+Reasons+Document
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Adding proposers and supporters to ping pong amendments
By default, when a ping pong amendment is inserted after a ping pong motion, there will be no proposer associated to it. If the amendment 

was in a different name or set of names from the parent ping pong motion, then it’s possible to add names to the individual amendments

How to add a proposer to a ping pong amendment

In the Editor…

1. Place your cursor in the ping pong amendment that you would like to add a proposer to

2. Right-click and select Update Propopsers/Supporters

3. In the dialog box that opens, add proposers and supporters as required and click on Update

 

To remove proposers and supporters from the amendment, click on the blue proposer name and delete them from the dialog box that opens

If you delete all names from the dialog box, the proposer element is removed 
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Generating the Reasons Document
The Reasons Document is not a document that needs publishing in Lawmaker.  It is prepared for the Reasons Committee and OPC will 

need to draft the Reason Motions (in the same way they would draft ping pong motions, using the Amendment Workspace tab) and then 

submit them.  The Commons will then need to table and set them ‘Ready for Publishing’ in order for them to appear on the generated 

Commons Reasons Document

Pre-requisites
OPC have submitted the Government’s reason motion(s) in Lawmaker

Commons have tabled and set them “Ready for Publishing”

How to generate a Commons Reasons Document
1. Create a list by:

a. From the Amendment Manager tab: select Amendment Actions > Create Official List from the dropdown menu in the top right of the page

b. From the Official List tab: click on the Create List button

2. Select Commons Reasons Document

3. Update the relevant information in the dialog box (make sure you select ‘Ping Pong’ as the stage) and click on Create

4. A new tab opens with the appropriate document template loaded in the Editor with an empty List Body element

5. Select Tools > Update List from the upper tool bar to populate the document with all reason motions with a status of Ready for Publishing

6. Update the preface of the document with any necessary text

7. Generate a PDF ready for the Reasons Committee.
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Add a heading to an amendment within a ping pong motion
You can add a heading to one or more amendments within a ping pong motion in the Editor.

This is to support the creation of lists like https://publications.parliament.uk/pa/bills/lbill/2017-2019/0111/18111-I.pdf - see amendments 4C, 

4D and 44E and the headings before them.

As agreed with the Commons and the Lords, however, the headings inserted by Lawmaker appear centred and in italics.

How to add a heading
1. Place your cursor in the amendment you want to add a heading before.

2. Right click and select Add amendment heading from the menu.

3. A heading will appear above the amendment.

https://publications.parliament.uk/pa/bills/lbill/2017-2019/0111/18111-I.pdf
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Consolidated List Overview
Overview of preparing and publishing the Consolidated List

This one-page summary for managing Consolidated Lists was created in August 2022.
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How to update this process flow

To update it, you should update the source POWERPOINT document in SharePoint. Once you have updated that version, generate a new 

PDF to replace the existing PDF in SharePoint. This image was created by taking a screen shot of the PDF view and pasting it directly onto 

this help page

 

 

https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EUgvbha1baBCi_-HF4SSYg4BEcXHE4DBtv1bNIqcdOGQVA?e=RzX4Y4
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Publishing amendments on UK parliament's website
Publishing UK amendment lists (incl. ping pong lists)

Republishing updated UK amendments

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60456974/Publishing+UK+amendment+lists+incl.+ping+pong+lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60882968/Republishing+updated+UK+amendments
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Publishing UK amendment lists (incl. ping pong lists)
The amendment list should be published in Lawmaker in order for the website to display the amendments.

How to send a PDF to print services - Lords
1. When you have generated a PDF and it has been approved

2. Download the PDF

3. Rename it according to the approved naming convention: [Bill title]  – Amdts – [List number] e.g. Energy Bill [HL] – Amdts – HL Bill 39(a)

4. Attach it to the product distribution email and send it to the usual distribution list along with any other lists due out that day

How to publish an amendment list in Lawmaker
1. From the Official Lists tab: find the amendment list that you just created.  It will be a green document on the left-hand side of the screen and probably 

the top of the list if it was the most recently generated 

2. Click on the black triangle to the left of the list name which will expand the view to show all snapshot versions linked to that document 

3. Locate your PDF snapshot version  

4. Select Publish version from the Actions dropdown menu (you might have to scroll to find that option).   

5. Click on Publish on the warning message 

6. Once publishing has completed, a new grey published version will appear on the right-hand side of the screen 

If you don’t see your recently created snapshot version, click on F5 to refresh your browser.  If you still don’t see it, generate another PDF 

from the ‘Actions’ dropdown menu and be sure to leave the checkbox for “Record snapshot version” checked this time. 

Publish version only appears against snapshot versions so make sure you are selecting the correct snapshot

If you know that you are likely to be publishing amendments on a particular bill, go to LegHub and schedule an automatic update later that 

day.

see also Republishing updated UK amendments  

See also [Lords] Amendment Process - One-page summary  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60882968
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60882968
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64815105
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64815105
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Republishing updated UK amendments
If you have made changes to an amendment in a bill e.g. changed the supporters, added explanatory statements, withdrawn or recorded an 

outcome, then you will need to republish the amendments so that the website is updated with the recent changes.

This is a 2 stage process.  

The first stage is making the change in Lawmaker and republishing the updated amendments.  

The second stage (which can happen at any time that day) is to schedule an update which will run later in the evening to pick up any changes made 

that day in Lawmaker.

How to republish updated amendments
1. Find the amendment(s) on the Amendment Manager tab  

2. Select the amendment(s) using the check box on the left-hand side 

3. Select Amendment Actions > Publish selected amendments from the drop-down menu in the top-right 

4. Click Publish on the warning message

 

You can use the quick filters at the top of the page to help you or use the advanced search at the side of the amendment table
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Church measures
This section includes help on drafting and managing UK Church measures.
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Drafting Church Measures
Creating a new Church Measure project

To create a new Church Measure project, click the New button in the top-right of the Lawmaker dashboard, then select Church Measure 

from the ‘Type’ drop-down menu.

 

 

Select one of two possible Sub-types: Measure or Consolidation Measure. 

Give your project a title and click ‘Create’ to create a new Church Measure project. 

Creating working versions and using the Editor

Church Measures are extremely similar to UK Public Bills. Refer to the pages under Drafting and editing  for help with drafting the 

provisions in your Measure, creating structure, and managing working versions.

Generating a PDF of a Measure with the stage name in the footer

To indicate the stage the Measure has reached in the General Synod, you may wish to add a note to the footer of any PDFs generated from 

your Measure document. You can generate a PDF from within the Editor, by clicking the ‘Document’ menu and selecting Generate PDF, or 

from the project page (refer to Generating and viewing a PDF  for additional information on how to generate PDFs).

In the ‘Generate PDF’ modal, select ‘Insert footer note’ and specify the stage name in the text box, then click ‘Generate’ to generate a PDF 

of your Measure:

Screenshot showing the ‘New’ button on the dashboard

Screenshot showing the ‘Create new project’ modal with ‘Church Measure’ selected as the document Type

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688748
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
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Screenshot showing the ‘Generate PDF' modal with a Footer Note added and Line Numbering selected
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Managing a Church Measure in Parliament
You can manage the document information associated with a Church Measure, and insert a front cover on a Measure, using the same 

Lawmaker functions which exist for UK Bills.

Managing document information

There are two ways to manage document information: within the Editor, or from the Project page. See Managing document information  

for more general guidance on managing document information.

With a Measure open in the Editor, click on the ‘Document Information’ icon to show the Document Information pane:

 

To edit this information from the Project tab, click the ‘Actions’ menu next to a working version, then select Update Document Information. 

This will open the following modal:

Screenshot showing the Document Information 
pane

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688308
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688308
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Both methods allow you to update the following information:

Title: the title of the Measure

Sub Type: the document sub-type, either ‘Measure’ or ‘Consolidation Measure’

Session: the parliamentary session in which the draft Measure is being considered 

Year: the year in which the draft Measure is being considered

Paper number (House of Lords): the Lords paper number assigned to the draft Measure when it appears before the Ecclesiastical 

Committee. This will appear on the front cover, on the first page of the table of contents, and on the first page of the Measure proper.

Paper number (House of Commons): the Commons paper number assigned to the draft Measure when it is considered by the 

Ecclesiastical Committee. This will appear on the front cover, on the first page of the table of contents, and on the first page of the Measure 

proper.

Printed date (House of Lords/House of Commons): the date on which the draft Measure was printed. A date value is generally assigned 

for both Houses, and it’s usually the same date. This will appear on the front cover.

Adding a front cover and Table of Contents

You can add a front cover to a Draft Measure from the Insert menu in the Editor. This will add both the Front Cover and the Table of 

Contents. In the Editor, the Front cover appears like this:

Screenshot showing the ‘Update Document Information’ modal which is accessible from the project tab
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In the rendered PDF, the front cover of a Draft Measure appears like this:

Screenshot showing the front cover of a Draft Measure in the Editor

Screenshot showing the front cover of a Draft Measure in the rendered PDF



356

Creating an Enacted Measure

See the following page of the manual for information on creating the enacted version of a draft Measure: Creating an Enacted version of 

a draft Church Measure  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256
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Creating an Enacted version of a draft Church Measure
Once a Draft Measure has been approved by Parliament, you can create the enacted version of the Measure using the same method you 

would use to create the Act copy of a UK Bill. (See Converting a UK Bill into an Act  for general information about creating Act copies of 

UK Bills.)

To create the enacted version of a Measure, select ‘Duplicate’ from the Actions menu, add a folder name and version label, ensure ‘convert 

Draft Measure to enacted Measure’ is ticked, then click Create.

 

This will create a new version of the Measure with the following changes:

any existing front cover and table of contents will be removed and replaced by the enacted version of the front cover (including a table of contents);

the Measure Year value will be set to 9999; you will need to add the correct year using the Document Information pane in the Editor or the ‘Update 

Document Information’ modal on the project tab;

the Assent date value will be set to 1st January 9999; you will need to choose the correct date using the Document Information pane in the Editor or 

the ‘Update Document Information’ modal.

Submitting the enacted Measure to TNA

After converting the Draft Measure to an enacted Measure, you can then generate a PDF of the enacted version and submit this version to 

TNA. To do this, follow the same procedure as for UK Acts (see Submitting a UK Act to TNA ).

Screenshot showing the Duplicate modal and the ‘Convert to enacted Measure’ option selected.

The Long Title will remain unchanged. If this begins with the words “Draft of a Measure to….” then you will need to edit this so it 

instead reads “A Measure to…”

The Measure Number won’t be populated. You can add this using the Document Information pane in the Editor or the ‘Update 

Document Information’ modal on the project tab.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448601
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448601
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Commons resources page

 

Introduction to Lawmaker 
1. Overview of Lawmaker

2. Glossary of terms   

3. Introduction to XML  

4. Keyboard shortcuts  

5. Multi-factor authentication guide

6. Lawmaker roles & responsibilities

Quick start links 
1. Creating a new project  

2. Preparing a bill for introduction  

3. Preparing the ‘as amended’ bill version  

4. Publishing bills  

5. Drafting UK amendments  

6. Submitting amendments  

7. Tabling UK amendments (incl. 'ready for publishing')

 

How to raise an issue
1. Speak to the champion user in your area to check if you’re dealing with a known issue.

2. Check the Troubleshooting  page for any relevant info/workarounds

3. Perform a search in the online help site to see if there is additional information on the issue on 

the ‘how to’ page for the feature you’re using

4. Check the Lawmaker Support Portal (link on Lawmaker Sharepoint) to see if the issue has 

already been raised

Normal office hours

Contact the Lawmaker Superusers for any further support and advice.  They will raise the 

issue on the Lawmaker Support Portal for escalation if required.

Weekdays until 9pm

If Lawmaker appears to be unavailable or to have stopped responding (e.g. if you can’t 

open documents in the Editor) or if you encounter some other urgent issue, you should 

raise it using one of the following means:

1. Raise an Urgent system issue request type issue on the Lawmaker Support Portal which will 

immediately alert the service team, or

2. Call the service team using their escalation number One of the service team will pick up your 

call as soon as possible.

After 9pm and at weekends (and it can’t wait until normal office hours)

1. While a member of the service team may be able to assist outside core hours, there is no 

guarantee of that and you can instead escalate the issue directly to our contractor, Leidos (see 

Sharepoint for number. (monitored 24/7.)

2. If Lawmaker is unavailable, also report it to PDS helpdesk on x2001 to check whether it might 

be a wider issue affecting Parliamentary Estate rather than Lawmaker.

Training materials 

Links to Lawmaker’s sharepoint site in 

Parliament

1. Drafting Commons Amendments

2. Preparing a bill for publication

3. Using the Editor

4. Ping Pong

Other useful links

Links to Parliament’s sharepoint site

1. BCDR processes

2. Lawmaker Support Arrangements (guidance 

issued by TNA)

3. Lawmaker health check

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688893
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688893
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688881
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688881
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688736
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688736
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EZmbCHmmTflGjvhkOUfDwJcB4HqjhLNH9q8uZgazT-hgzg?e=6wfSC9
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/62816257
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/62816257
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65011715
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65011715
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://hopuk.sharepoint.com/sites/bct-LDAPP/
https://hopuk.sharepoint.com/sites/bct-LDAPP/
https://hopuk.sharepoint.com/sites/bct-LDAPP
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/ESFJEGhv9lVEqQLo8GGhgIgBUCISV-2H1pmXHywpKyPNRw?e=r2gGsv
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/ERRMuApHD3pIh4nxdKv7lbsBQOJIB2xocGVYc6nTNb8Row?e=PESP0Y
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/ESjRnnf85AZNjhFs0fDcqpMBhn6ebArgpQdY_ZQzdaak0Q?e=8USBgO
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EUPeIN8uaZ9NquIFjs2TCzUB1tR1AR68FfOWpTq46TtlgQ?e=6w9M3h
https://hopuk.sharepoint.com/sites/bct-LDAPP/Transition%20Deliverables/Forms/AllItems.aspx?newTargetListUrl=%2Fsites%2Fbct%2DLDAPP%2FTransition%20Deliverables&viewpath=%2Fsites%2Fbct%2DLDAPP%2FTransition%20Deliverables%2FForms%2FAllItems%2Easpx&id=%2Fsites%2Fbct%2DLDAPP%2FTransition%20Deliverables%2FCommons%2FBCDR&viewid=527ca904%2Db770%2D49c5%2D87f9%2Dc90bbeb14ec9
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EQvayXW4QvJPp54kZunrYksB8v4c_-aqLlWwDuQ0LuHrng?e=iaBxch
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EQvayXW4QvJPp54kZunrYksB8v4c_-aqLlWwDuQ0LuHrng?e=iaBxch
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EQvayXW4QvJPp54kZunrYksB8v4c_-aqLlWwDuQ0LuHrng?e=iaBxch
http://lawmaker.legislation.gov.uk/health
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Lords resources page

Introduction to Lawmaker 
1. Overview of Lawmaker

2. Glossary of terms   

3. Introduction to XML  

4. Keyboard shortcuts  

5. Multi-factor authentication guide  

6. Duty Clerk Notes on using Lawmaker

7. Lawmaker roles & responsibilities

One-page process summaries

Links to Lawmaker’s sharepoint site in 

Parliament

1. Lords amendment overview

2. Same day marshalled list

3. Lords bills & acts overview

4. Lords ping pong motions overview

5. Consolidated lists overview

6. How to raise an issue

7. When to update LegHub

8. Duty Clerk Summary

Quick start links
1. Creating a new project  

2. Preparing a bill for introduction  

3. Preparing the ‘as amended’ bill version  

4. Publishing bills  

5. Drafting UK amendments  

6. Submitting amendments  

7. Tabling UK amendments (incl. 'ready for 

publishing')

8. [Lords] Generating Official Lists  

9. Publishing amendments on UK parliam

ent's website  

10. Converting a UK Bill into an Act  

How to raise an issue
1. Check the Troubleshooting  page for 

any relevant info/workarounds

2. Perform a search in the online help site to 

see if there is additional information on the 

issue on the ‘how to’ page for the feature 

you’re using

3. Check the Lawmaker Support Portal to see 

if the issue has already been raised

Normal office hours

Contact the Lords Lawmaker Superuser for 

any further support and advice.  They will 

raise the issue on the Lawmaker Support 

Portal for escalation if required.

Weekdays until 9pm

If Lawmaker appears to be unavailable or 

to have stopped responding (e.g. if you 

can’t open documents in the Editor) or if 

you encounter some other urgent issue, 

you should raise it using one of the 

following means:

1. Raise an Urgent system issue request 

type issue on the Lawmaker Support Portal 

which will immediately alert the service 

team, or

2. Call the service team using their escalation 

number. One of the service team will pick 

up your call as soon as possible.

Training materials 

Links to Lawmaker’s sharepoint site in 

Parliament

1. Amendments and Amendment Lists

2. Bills and Acts

3. Using the Editor

4. Amending Bills

5. Ping Pong

Other useful links

Links to Parliament’s sharepoint site

1. LegHub notes

2. Procedural notes

3. BCDR processes

4. Lawmaker Support Arrangements 

(guidance issued by TNA)

5. Lawmaker health check

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688893
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688893
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688881
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688881
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688736
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688736
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EZjXoG7mq15MgalJYf5UEiIBXIwO6_KyPWYDLhnJpTEMLw?e=5sM82b
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EZmbCHmmTflGjvhkOUfDwJcB4HqjhLNH9q8uZgazT-hgzg?e=6wfSC9
https://hopuk.sharepoint.com/sites/bct-LDAPP
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EUgvbha1baBCi_-HF4SSYg4BEcXHE4DBtv1bNIqcdOGQVA?e=RgQLmT
https://hopuk.sharepoint.com/:b:/s/bct-LDAPP/EY2R_GqxF2NOsHeDtWJbn18B5RiRGdqj3hmX6liyuv33Xw?e=ub69l1
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EbfVNPseMPZHviq5avWCXdEB6JinBQSftqhCG1iuig8hag?e=rbUfZm
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EXBDeMi_2ERDmYg8v4KDoGABowBd8PWGi4PueoDdaUBwAw?e=bc8Xly
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EfrGNksnLnZAuEE8B5g4kJ8BJKzDqD6xPHr65mv3xP8HQA?e=VMqA2I
https://hopuk.sharepoint.com/:b:/s/bct-LDAPP/EUIPPZ38VYZJhaeAVs1NGq8B0iUI2SUgMQ4jWSMa2Cna8w?e=JpfVIJ
https://hopuk.sharepoint.com/:b:/s/bct-LDAPP/EetqY7mjuhFHmyGUAkpLqZABaMhdFLlHdVz6Od6EBpnPNg?e=B8KrOY
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EXlWtkSkiTdGjY25DC1PsiwBB9MbfHUsMueTOk9S4uZ__g?e=ZIQshI
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688709
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/62816257
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/62816257
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/63209473
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688443
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65011715
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65011715
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71696385
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71696385
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70942732
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70942732
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/70942732
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688681
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/64913464
https://hopuk.sharepoint.com/sites/bct-LDAPP
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EQ252E0GdGhJvx5ZXwOY5G4BO0d7IuDIYFhSXVjLt0-nxQ?e=PrQPUZ
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EVKMzRbQdnpIu0OXgJ5GVIkBSdgHSBBEdhsjuj3kglMz7Q?e=1m6oZo
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/ESjRnnf85AZNjhFs0fDcqpMBhn6ebArgpQdY_ZQzdaak0Q?e=8USBgO
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EXfTFgib-1JOr3PKWSiyoD8BPwT8rqmxSQpgJhbY99JqLw?e=ifoplx
https://hopuk.sharepoint.com/:p:/s/bct-LDAPP/EafUs7r0rptLsif15OXGpAQBA4a1kgLlzbomrlz3s6Nqqw?e=Tb3qDB
https://hopuk.sharepoint.com/sites/hlt-PBO/PAP/Forms/AllItems.aspx?id=%2Fsites%2Fhlt%2DPBO%2FPAP%2FPublic%20Bills%20Procedures%20and%20Guidance&viewid=e2bf3dfd%2Dd8d2%2D46cf%2D9425%2D3243aaca58e6&OR=Teams%2DHL&CT=1663839278614&clickparams=eyJBcHBOYW1lIjoiVGVhbXMtRGVza3RvcCIsIkFwcFZlcnNpb24iOiIyNy8yMjA3MzEwMTAwNSIsIkhhc0ZlZGVyYXRlZFVzZXIiOmZhbHNlfQ%3D%3D
https://hopuk.sharepoint.com/:f:/s/bct-LDAPP/EuX7-TsPhBNFpFsOCJN0U8sBK1RqcfqvYrQ6wwcDCtPiqw?e=KUhZoU
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EQvayXW4QvJPp54kZunrYksB8v4c_-aqLlWwDuQ0LuHrng?e=iaBxch
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EQvayXW4QvJPp54kZunrYksB8v4c_-aqLlWwDuQ0LuHrng?e=iaBxch
https://hopuk.sharepoint.com/:w:/s/bct-LDAPP/EQvayXW4QvJPp54kZunrYksB8v4c_-aqLlWwDuQ0LuHrng?e=iaBxch
http://lawmaker.legislation.gov.uk/health
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After 9pm and at weekends (and it 
can’t wait until normal office hours)

1. While a member of the service team may 

be able to assist outside core hours, there 

is no guarantee of that and you can instead 

escalate the issue directly to our contractor, 

Leidos (This number will be monitored 

24/7.)

2. If Lawmaker is unavailable, also report it to 

PDS helpdesk on x2001 to check whether it 

might be a wider issue affecting 

Parliamentary Estate rather than 

Lawmaker.
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Drafting Scottish Bills and amendments

For Lawmaker assistance

If you require further assistance, please contact Jonathan Brown, Fraser Gough or Nicole McIntyre.

If they are unavailable and it is urgent, please contact lawmaker@nationalarchives.gov.uk

 

Scottish Bills

Inserting Scottish Bill and Act front and back covers

Scottish Amendments

Tips for drafting amendments

Inserting pre-populated amendments - Scotland

Ensuring the right amendments are lodged

Suggestions for filtering Amendment Manager

Suggested best practice for lodging and submitting amendments

How to submit using the Amendment Manager

How to submit amendments using 'Submit List' in the editor

Scotland - quick guide to drafting Bills and amendments

Quick Guide - Managing Bills

How do I save comments?

How do I create a new document in a Bill project?

How do I create a new Bill?

Quick Guide - Managing amendments

Quick Guide - Drafting Bills

OLD -How do I split one provision into two?

OLD -How do I rearrange my provisions?

OLD -How do I create a textual amendment?

How do I change a provision I've already inserted?

Quick Guide - Drafting amendments

OLD -How do I change proposer or supporter details?

These pages are to provide specific help for drafters of Scottish Bills and amendments.

mailto:lawmaker@nationalarchives.gov.uk
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25166247/Scottish+Bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349/Inserting+Scottish+Bill+and+Act+front+and+back+covers
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25592001/Scottish+Amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108953601/Tips+for+drafting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559064/Inserting+pre-populated+amendments+-+Scotland
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108625921/Ensuring+the+right+amendments+are+lodged
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108724225/Suggestions+for+filtering+Amendment+Manager
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128778249/Suggested+best+practice+for+lodging+and+submitting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/127959049/How+to+submit+using+the+Amendment+Manager
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128647171/How+to+submit+amendments+using+Submit+List+in+the+editor
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688636/Scotland+-+quick+guide+to+drafting+Bills+and+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690125/Quick+Guide+-+Managing+Bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690157/How+do+I+save+comments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690145/How+do+I+create+a+new+document+in+a+Bill+project
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690133/How+do+I+create+a+new+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690252/Quick+Guide+-+Managing+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690176/Quick+Guide+-+Drafting+Bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690238/OLD+-How+do+I+split+one+provision+into+two
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690216/OLD+-How+do+I+rearrange+my+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690198/OLD+-How+do+I+create+a+textual+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690184/How+do+I+change+a+provision+I+ve+already+inserted
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690260/Quick+Guide+-+Drafting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690268/OLD+-How+do+I+change+proposer+or+supporter+details
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Scotland - quick guide to drafting Bills and amendments
This Quick Guide will take you through common scenarios you may encounter when drafting Bills and amendments in Lawmaker.

If the information you are looking for isn't here, you may find it elsewhere in this manual.

You can also contact your User Champions[?]:

Name here

Name here

If your User Champions are not available, please email Lawmaker@nationalarchives.gov.uk

Quick Guide contents
Quick Guide - Managing Bills

How do I save comments?

How do I create a new Bill?

How do I create a new document in a Bill project?

Quick Guide - Drafting Bills

How do I change a provision I've already inserted?

OLD -How do I create a textual amendment?

OLD -How do I rearrange my provisions?

OLD -How do I split one provision into two?

Quick Guide - Drafting amendments

OLD -How do I change proposer or supporter details?

Quick Guide - Managing amendments

 

mailto:Lawmaker@nationalarchives.gov.uk
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690125/Quick+Guide+-+Managing+Bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690157/How+do+I+save+comments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690133/How+do+I+create+a+new+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690145/How+do+I+create+a+new+document+in+a+Bill+project
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690176/Quick+Guide+-+Drafting+Bills
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690184/How+do+I+change+a+provision+I+ve+already+inserted
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690198/OLD+-How+do+I+create+a+textual+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690216/OLD+-How+do+I+rearrange+my+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690238/OLD+-How+do+I+split+one+provision+into+two
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690260/Quick+Guide+-+Drafting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690268/OLD+-How+do+I+change+proposer+or+supporter+details
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690252/Quick+Guide+-+Managing+amendments
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Quick Guide - Managing Bills
How do I save comments?

How do I create a new Bill?

How do I create a new document in a Bill project?

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690157/How+do+I+save+comments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690133/How+do+I+create+a+new+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690145/How+do+I+create+a+new+document+in+a+Bill+project
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How do I save comments?

Example scenarios

You have several comments and replies in a Bill, and you want a tidy version of the Bill but you want to save a copy of the Bill with the 

comments before you delete the comments

You want to keep a record of a comment, but the provision/text it is attached to needs to be deleted (which will also delete the comment).

To do this, you must save a read-only version of the document. This is called taking a snapshot and is available for Bills and amendments.

To save a version of the document—

(If you haven't already, save the document first and stay in the editor).

Your saved version will be listed under the main document (you may need to click on the arrow to the left of the document title to display the 

saved version). Below is an example of a saved version of "amendments 1".

For more information, see:

Saving your document  

Saving snapshots of your document

You can save a snapshot of the document you are editing at any time. This  will create a copy of the document in its current state and save 

it as a snapshot in the document’s version history without affecting the main version of the document (i.e. the one that is saved when you 

press the Save button).

To save a snapshot:

1. In the upper toolbar, select Document>Take snapshot.

2. Edit the snapshot name in the Version Label field (it is set to “Saved” by default)

3. Click OK.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339227/Saving+a+snapshot+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659
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How do I create a new Bill?

Example scenario

There is no Bill project in Lawmaker yet and you need to create it

To create a new Bill—

1. From the dashboard, click on the + New button in the top right above the project tiles/list

2. The system will ask you to provide the following information:

a. Type (mandatory)

b. Sub-type (only applicable to a subset of 'Type' options - mandatory)

c. Title (mandatory)

d. Procedure (only applicable to SI/SSIs - mandatory)

3. When you have added the necessary details, click on the Create button

4. The system will take you to the Editor, with the appropriate bill/SI/SSI template loaded and pre-populated with known text.

Note—

By default, a bill document template will consist of the Preface and Body.  You can manually insert the front cover, table of contents and

back cover depending on when/whether you need them 

For more information, see:

Creating a new document/project (S)

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979490
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How do I create a new document in a Bill project?

Example scenario

You want to have another version of the Bill, but you don't want to clone the existing version of the Bill (ie you want to start from an empty Bill 

template).

There are two or more of you drafting the Bill, and for practical reasons you want to work in your own document rather than in the same document. 

You do not want to clone the existing version of the Bill (if any), or you all want to start from an empty Bill template.

To create a new document in a Bill project—

1. From the Project tab, click on the + New button in the top right

2. The system will ask you to provide the following information:

a. Folder

b. Version description (must be unique across the whole project)

3. When you have added the necessary details, click on the Create button

4. The system will create a new document version and display it as a green tile (working version - editable) in the appropriate folder.

For more information, see:

Creating a new document/project (S).

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979490
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Quick Guide - Drafting Bills
How do I change a provision I've already inserted?

OLD -How do I create a textual amendment?

OLD -How do I rearrange my provisions?

OLD -How do I split one provision into two?

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690184/How+do+I+change+a+provision+I+ve+already+inserted
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690198/OLD+-How+do+I+create+a+textual+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690216/OLD+-How+do+I+rearrange+my+provisions
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690238/OLD+-How+do+I+split+one+provision+into+two
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How do I change a provision I've already inserted?
Example scenarios

You have inserted a section, which has automatically inserted a subsection, but you want to remove the subsection number.

You have inserted a subsection, but you want it to be a paragraph (or the reverse, assuming there are already subsections in the section).

You have inserted a sub-paragraph, but you want it to be a subsection (and there are already subsections in the section).

In certain circumstances, you can change a provision you have already inserted, even if you have already started typing, and avoids having 

to copy and paste the text. This is called promoting and demoting a provision.

You must first click on the text of the provision you want to change.

To promote a provision—

To demote a provision—

Place your cursor anywhere in the provision you wish to promote (e.g. in the num, heading or text element) and do one of the following:

use keyboard shortcut, press Alt+[ ,

from the right-click context menu in the Editor or Structure view, select Promote element, or

from the upper toolbar, select Tools>Promote element.

The selected provision will be promoted into the next valid provision.

When you promote a provision that has child elements (e.g. a paragraph containing sub-paragraphs), the child elements will also be 

promoted if it would be logical to do so (definitions and steps will stay the same).

Promoting the last in a list of paragraphs, sub-paragraphs or sub-sub-paragraphs will convert the provision into closing words as the first 

step, and then into the next provision up in the hierarchy as the second step.

Promoting the only subsection in a section or only paragraph in a Regulation or Article etc. (i.e. a provision with the number format (1)) is a 

quick way of removing the subsection/paragraph so you have an undivided section/regulation etc.

Provision types that can be promoted are: Bill subsections, SI paragraphs, paragraphs, sub-paragraphs, sub-sub-paragraphs, definitions 

and steps, and schedule sub-paragraphs. 

Place your cursor anywhere in the provision you wish to demote and;

using keyboard shortcut, click Alt+] ,

from the right-click context menu, select Demote element,

from upper toolbar, select Tools>Demote element.

The selected provision will be demoted into the next valid provision. Lawmaker uses the context of the provision to work out whether it can 

be promoted and what to - that means that the feature can’t be used at the moment on the first provision in a quoted structure because 

there is no context.

When you demote a provision that has child elements (e.g. a paragraph containing sub-paragraphs), the child elements will also be 

demoted if it would be logical to do so (definitions and steps will stay the same).

Demote works for subsections, schedule sub-paragraphs, paragraphs and sub-paragraphs as long as there is another element of the same 

kind before it to ‘adopt’ the demoted provision as its child.

You can demote section/regulation text (into subsection/paragraph (1)), paragraphs, sub-paragraphs, definitions and steps, schedule 

paragraph text and schedule sub-paragraphs
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For more information, see Promoting and demoting provisions  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
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Example scenarios

You want to insert a new discreet provision (eg a new section, subsection, paragraph etc).
You want to amend and amending provision.

In Lawmaker, textual amendments are called "quoted structure".

1. Insert a quoted structure by:
a. using keyboard shortcut Ctrl + q
b. using right-click context menu in Editor view select ‘Insert quoted structure’
c. from the upper toolbar, select ‘Insert > Insert quoted structure’

2. In the ‘insert quoted structure’ modal:
a. Select the target document you are quoting from
b. Select the starting provision
c. Specify the necessary indent level to apply to the quoted structure
d. Select whether you require a starting and ending quotation
e. Specify the text immediately following the quoted structure

And click Insert
3. The system will insert a quoted structure on a new line below the provision your cursor is in, with the selected starting element
4. Continue drafting your quoted structure

You can inserted quoted structure within quoted structure (for example, when amending an amending provision)

1. With your cursor in the provision introducing the nested quoted structure, insert a nested quoted structure by following ‘insert quoted structure’
step 1

2. The system will insert a nested quoted structure, within your existing quoted structure

If you need to change the quoted structure properties after you have inserted your quoted structure:

1. With your cursor in the quoted structure you want to update, either:
a. right-click in Editor view and Structure view and select ‘Update quoted structure properties’
b. from the upper toolbar, select ‘Insert > update quoted structure properties’

2. In the ‘insert quoted structure’ modal you can change:
a. The indent level
b. The starting and ending quotation mark
c. The following text
d. And click ‘OK’ to save your changes

3. The system will update the quoted structure according to your changes

For more information, see:

Inserting quoted structure (S)
Moved - Annex 12 - Indent levels in quoted structures

OLD -How do I create a textual amendment?

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979683/Inserting+quoted+structure+S
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979372/Moved+-+Annex+12+-+Indent+levels+in+quoted+structures
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Example scenarios

You want to rearrange subsections within a section.
You want to move a subsection to a different section.
You want to rearrange sections/cross headings/Parts.

There are two ways to rearrange your provisions. You can either:

cut and past the provisions, or
use the structure view to drag and drop provisions.

To perform either method, you may need to expand or collapse your structure view. See:

How to turn on/off the structure view
How to change from depth-limited view to full structure view (ie, how to show structure below the section level)

How to cut and paste provisions

1. Select the provision/amendment/interstitial heading you would like to cut/copy using:
a. keyboard short cuts Ctrl + C (for copy) or Ctrl + X (for cut);
b. right-click context menu > Copy or > Cut (when mouse cursor is in Editor view and Structure view)
c. from the upper toolbar, select Edit > Copy  or > Cut

2. Navigate to the part in the document that you would like to paste the cut/copied provision/amendment/interstitial heading and place the mouse
cursor at the end of the provision you would like the cut/copied provision/amendment/interstitial heading pasted after

3. Use the keyboard short cut (Ctrl + V) to paste the provision/amendment/interstitial heading
4. The system will attempt to paste the cut/copied provision/amendment/interstitial heading into the next valid location after the

provision/amendment/interstitial heading the mouse cursor is placed in.

How to move provisions using the structure view

You will need to expand or collapse your structure view to the level that you wish to rearrange. For example:

If you want to rearrange Parts, you need to collapse everything to the Part level (ie do not have any Cross headings or sections showing).
If you want to rearrange subsection within a section, collapse everything to the subsection level (ie within that one section, do not have any
paragraphs showing).
If you want to move a subsection to a different section, in both those sections collapse everything to the subsection level. It may be easier if you
also collapsed all other sections to the section level (this makes it easier to drag and drop to the right position).

Instructions:

1. Collapse the structure level down to the level of the element you are planning to move
2. Locate the provision (including table)/amendment/interstitial heading you wish to move and press and hold the left button on your mouse
3. Drag the provision/amendment/interstitial heading to the target location
4. When the surrounding provisions/amendments/interstitial headings move out of the way, drop the selected provision into its new location

For more information, see:

Using cut/copy and delete (S)
Moving provisions or amendments (using the structure view) (S)
Using the structure view (S)

OLD -How do I rearrange my provisions?

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979628/How+to+turn+on+off+the+structure+view
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979639/How+to+change+from+depth-limited+view+to+full+structure+view
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979573/Using+cut+copy+and+delete+S
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979593/Moving+provisions+or+amendments+using+the+structure+view+S
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979632/Using+the+structure+view+S
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Example scenario

You have drafted a subsection and want to split it into two subsections (without having to copy and paste).

You can only split a provision into the same type of provision (eg. split one subsection into 2 subsections). 

To split a provision:

1. Place your cursor at the point in the text where you want to split your element and;
a. using keyboard shortcut, click ALT + s 
b. from right-click context menu in Editor view, select Split element

2. The selected provision will be split at the cursor point and a new sibling element inserted immediately after it containing the rest of the text after
the cursor point.

If you wish to split a provision and then change the second provision, after splitting you may be able to do so using the promote/demote function
(see How do I change a provision I've already inserted?).

For more information, see:

Splitting provisions (S)

OLD -How do I split one provision into two?

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690184/How+do+I+change+a+provision+I+ve+already+inserted
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979715/Splitting+provisions+S
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Quick Guide - Drafting amendments
OLD -How do I change proposer or supporter details?

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25690268/OLD+-How+do+I+change+proposer+or+supporter+details
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Example scenarios

There is no proposer and you want to add the proposer details (eg when drafting handout amendments).
You want to change the proposer or supporter.
You want to add a supporter.

To add or update the proposer or supporter:

1. Either:
a. Click on the proposer's name (or placeholder element if no name has been specified yet), or
b. Right-click on the proposer (or supporter names) and select “Update Proposers/Supporters”,

2. The system will open a dialogue box
3. Add, update, re-order or delete Members' names as required.
4. When you finished, click Update button
5. The system will update the amendment with your specified proposer (and any supporters)

If you want to delete all supporters:

1. If you want to get rid of all supporters on an amendment, click on “Supporters block” on the breadcrumb,
2. The system will highlight all the “Supported by:…” text in the Editor
3. Click on ‘backspace’ to remove all supporters from the amendment
4. The system will update the amendment with the changes

For more information see:

Managing Proposers and Supporters (Amendments) (S)

OLD -How do I change proposer or supporter details?

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8979643/Managing+Proposers+and+Supporters+Amendments+S
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Quick Guide - Managing amendments
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Scottish Bills
Below are some helpful pages for PCO drafters, relating to drafting and managing Scottish Bills:

Inserting Scottish Bill and Act front and back covers

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349/Inserting+Scottish+Bill+and+Act+front+and+back+covers
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Inserting Scottish Bill and Act front and back covers
Introduction

When a new project is created, the Bill does not include front and back covers.  These can be inserted at any point when drafting the 

document in the Editor.  The front cover also contains the table of contents by default.

How to insert the front cover

In the Editor, from the toolbar select Insert>Insert front cover.

A front cover and table of contents will be inserted at the beginning of the document. Any existing cover and table of contents will be 

replaced.

The cover inserted will depend on whether the document is a Bill or an Act.

In an Act:

The image of the crest will be rendered in the PDF but does not appear in the Editor.

How to insert the back cover

In the Editor, from the toolbar select Insert>Insert back cover.

A back cover will be inserted at the end of the document. Any existing cover will be replaced.

You can only insert a back cover for a Bill.

The contents of the cover are derived from other parts of the Bill and details entered into the Document Information panel:

The Long Title is derived from the Long Title in the preface of the Bill and shouldn’t be edited directly on the cover. 

Some elements of the back cover will automatically update when you change them in the Document Information panel but for others you will need to 

reinsert the back cover before the changes will be visible.

Deleting the front or back cover

To delete the front or back cover, select it either from the breadcrumb or using the structure view and press Backspace as you would delete 

a normal provision in the document.

 

Hints and tips

If you just want to update the table of contents, use the Insert table of contents menu option instead - see Inserting table of contents .

Lawmaker will take a lock on the whole document to insert the front or back cover.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317


378

Scottish Amendments
Below are some helpful pages for PCO drafters, relating to drafting and managing amendments to Scottish Bills:

Ensuring the right amendments are lodged
How to submit amendments using 'Submit List' in the editor

How to submit using the Amendment Manager

Suggested best practice for lodging and submitting amendments

Suggestions for filtering Amendment Manager

Tips for drafting amendments
Inserting pre-populated amendments - Scotland

 

Here is a quick introductory tutorial to drafting amendments in Lawmaker:

Lawmaker training video - Drafting Scottish Amendments

Lawmaker training video - Drafting Scottish AmendmentsLawmaker training video - Drafting Scottish Amendments

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108625921/Ensuring+the+right+amendments+are+lodged
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128647171/How+to+submit+amendments+using+Submit+List+in+the+editor
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/127959049/How+to+submit+using+the+Amendment+Manager
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128778249/Suggested+best+practice+for+lodging+and+submitting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108724225/Suggestions+for+filtering+Amendment+Manager
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108953601/Tips+for+drafting+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559064/Inserting+pre-populated+amendments+-+Scotland
https://youtu.be/oB2JCnieX54
https://www.youtube.com/watch?v=oB2JCnieX54
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Ensuring the right amendments are lodged

IMPORTANT: Amendments must first be lodged via an email to the Parliamentary clerks. Once the amendments are lodged via email, 

it is best practice to submit in Lawmaker soon after.

Best way to lodge and submit amendments

Suggested best practice for lodging and submitting amendments

All the ways to submit amendments

Submitting via the Amendment Manager

Submitting via the editor using “submit list”

Suggestions for how to organise the Amendment Manager

Using filters to make Amendment Manager more useful



381

Suggestions for filtering Amendment Manager
For Bills with a lot of amendments, the Amendment Manager may become long and difficult to use. You may wish to use the filter options to 

make it more manageable and useful to you. Here are two suggestions for how to filter your Amendment Manager. There are numerous 

other ways you may wish to filter your Amendment Manager.

For more information see here.

Filtering by status

Each amendment has a status (eg, Draft, On Hold, Submitted). You may filter your Amendment Manager according to the status of each 

amendment. The steps below will show you how to filter to Draft status.

 

To filter by status:

1. You will need to set the “status” and flag the amendments as follows:

How to set amendment status to "On hold"

How to flag and unflag amendments

Government amendment Draft No

Handout amendment Draft Yes

Superseded or discarded amendment On hold No

Amendment type Status Flagged

 

For for information see here.

From the 'Amendment Manager' tab, select the draft amendments you want to put 'On hold'

Click on the 'Amendment Action' drop-down menu at the top-right of the screen and select Set 'Draft' to 'On hold'

Amendments will be updated to 'On hold'

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526453
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526650
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2. Filter your amendments to show only those with “Draft” status.

How to quickly filter amendments to Draft only

 

This means that:

your amendments manager is now more manageable,

superseded or discarded amendments will not appear on your list (and the “on hold” status means they cannot accidentally be lodged),

handout amendments will still be visible so you can keep track of your drafting (but flagging it prevents it from being accidentally lodged),

submitted amendments will not appear in your amendment manager.

 

If you wish to see all amendments, you will need to change the Quick Filter to show “All amendments”.

 

 

For more information see here.

1. Go to the Amendment Manager tab

2. Click on a  flag icon on the left-hand side of an amendment to flag it.

The selected amendment will be highlighted yellow in the list when the flag is on. To remove the flag, simply click on the flag icon again.

 

Use the quick filter option at the top-right of the Amendments Manager tab:

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526461
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Filtering by list (LoDA)

You can also filter the Amendment Manager to show the amendments in a particular LoDA (List of Draft Amendments - i.e. the name you 

have given the list in your Amendment Workspace tab).

 

To filter by list:

1. Click on the “Filter” button at the top right of your Amendment Manager tab.

2. Select the List you wish to view.

3. Click Apply.

Note that the filter will stick. To see other amendments not in the list, you will need to change the Filter settings or click “clear”.

This means that:

your amendments manager is now more manageable as other amendments no longer appear on the page,

submitted amendments still appear in your amendment manager if they occur in that list,

if all lodged amendments appear in one list, it is easier to select amendments for submission in Lawmaker.
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How to submit using the Amendment Manager

IMPORTANT: Amendments must first be lodged via an email to the Parliamentary clerks. Once the amendments are lodged via email, 

it is best practice to submit in Lawmaker soon after.

One way to submit amendments in Lawmaker is by using the Amendment Manager (another way is to submit the list from the editor).

Before you select the amendments to submit, filter your amendments to minimise any errors when selecting.

For more information on filtering amendment manager

Note, amendments that are flagged or where the status is set to “on hold” cannot be submitted. They will need to be unflagged or the status 

set back to “draft” before they can be submitted.

How to flag and unflag amendments

How to set amendment status to "Draft"

See Suggestions for filtering Amendment Manager  

Once filtered, if you cannot find the amendments you are looking for, it may be that their status is “On hold”. You will need to change the 

status back to “draft” before Lawmaker will allow you to submit it.

For more information see here.

1. Go to the Amendment Manager tab

2. Click on a  flag icon on the left-hand side of an amendment to flag it.

The selected amendment will be highlighted yellow in the list when the flag is on. To remove the flag, simply click on the flag icon again.

 

 

For more information see here.

From the 'Amendment Manager' tab, select the 'On hold' amendments you want to set back to 'Draft'

Click on the 'Amendment Action' drop-down menu at the top-right of the screen and select Set 'On hold' to 'Draft'

Amendments will be updated to 'Draft'

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108724225
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108724225
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526461
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526650
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To submit amendments in Amendment Manager:

1. Select the amendments by ticking on the check box to the left.

2. Select Amendment actions > Submit amendments
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How to submit amendments using 'Submit List' in the editor

IMPORTANT: Amendments must first be lodged via an email to the Parliamentary clerks. Once the amendments are lodged via email, 

it is best practice to submit in Lawmaker soon after.

One way to submit amendments is to use the Submit List function from the editor. This is especially useful if you have generated the PDF for 

lodging from a list in Lawmaker.

 

 

For more information see Suggested best practice for lodging and submitting amendments  

To submit amendments from the editor:

1. Open editor for the list you wish to wish to submit.

2. Open the “Document information” panel on the right.

3. Click on “Submit List”.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128778249
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128778249


387

Suggested best practice for lodging and submitting amendments

IMPORTANT: Amendments must first be lodged via an email to the Parliamentary clerks. Once the amendments are lodged via email, 

it is best practice to submit in Lawmaker soon after.

The following is a suggested work flow for lodging amendments via email and then submitting them in Lawmaker:

1. Create a list in Lawmaker that contains the amendments you wish to lodge. Give it a unique name (eg, Amendments for lodging on [date] or [Topic] 

amendments for lodging).

2. Save the list and close the editor.

3. Create a PDF of the list from the project dashboard.

4. Lodge the PDF with the Parliamentary Clerks via email. Include at the end of the email that you will submit the amendments in Lawmaker as soon as 

possible.

5. Return to the list in Lawmaker and open the editor.

6. Use the Submit List function to submit the list.

How to submit amendments using Submit List function

 

 

For more information see here.

To submit amendments from the editor:

1. Open editor for the list you wish to wish to submit.

2. Open the “Document information” panel on the right.

3. Click on “Submit List”.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/128647171
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Tips for drafting amendments
Inserting pre-populated amendments - Scotland

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559064/Inserting+pre-populated+amendments+-+Scotland
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Inserting pre-populated amendments - Scotland

When drafting amendments on a List of Draft Amendments (LoDA), Lawmaker provides the option of inserting standard forms of 

amendments containing prepopulated instructions.

To insert a pre-populated amendment, press Enter and select the appropriate option from the CCA. The table below lists the available 

options and what is inserted.

Leave out section/schedule amend Leave out section / schedule ***

Insert section amend After section ***, insert—

<num Heading

(1) Text>

Insert schedule amend After schedule ***, insert—

<SCHEDULE

Text

HEADING>

Insert section after amend After schedule ***, insert—

Amendment - Page-line In section ***, page ***, line ***, text

Amendment - Amendment to amendment As an amendment to amendment ***, line ***, text

CCA option Amendment inserted
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Managing Scottish Bills and amendments

In this section
Publishing a Scottish Bill

Converting a Scottish Bill into an Act

Submitting a Scottish Act to TNA

Scottish Amendment Lists

Using the amendment sort code in Scottish amendments

Specific help for managing Scottish Bills, e.g. how to publish Bills at each stage, and amendments, e.g. producing daily, marshalled and 

groupings lists.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688371/Publishing+a+Scottish+Bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688792/Converting+a+Scottish+Bill+into+an+Act
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/103448625/Submitting+a+Scottish+Act+to+TNA
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526872/Scottish+Amendment+Lists
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25559078/Using+the+amendment+sort+code+in+Scottish+amendments
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Publishing a Scottish Bill
This details the practical steps to publish a Scottish Bill in Lawmaker.
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Converting a Scottish Bill into an Act

Introduction

Once a Bill has gone through all the amending phases and is ready for enactment, its content will need updating so that it becomes an Act.

Converting a Scottish Bill into an Act of the Scottish Parliament will make the following changes:

Updates the XML so that it is now an Act document type

Inserts the Act front cover (containing Short title, Act Year, ASP Number and Explanatory Notes statement)

Inserts new Table of Contents (containing Short title, Act Year, Act Number)

The date of enactment rubric will be added above the long title in the preface and the Act Year and Act Number will be inserted under the Short title in 

the preface

“Bill” in the short title will be changed to “Act” and the Act Year inserted at the end

The stage version rubric will be removed, as will the Accompanying Document rubric

The back cover will be removed (if there is one).

How to convert a bill into an Act

1. On the Project Tab, select Duplicate version from the Actions menu on the document version you want to convert into an Act.

2. The system will ask you to specify a folder and a version description.

3. When you have provided a folder and version description, select the Convert Bill to Act checkbox and click Create.

The system will create a duplicate version of the document, converting it into an Act and display it on the Project tab in the folder you 

specified.

 

Hints and tips

After converting a Bill to an Act, it is possible to delete elements if they are not required e.g. Table of Contents, Explanatory Notes rubric, 

Assent date in the date of enactment rubric, Act Year and Act Number.

You can’t generate an Act version if the document is already an Act version. 

To create the Official Print and Queen’s Copy, we recommend for each one that you duplicate the Palace copy and select Convert Bill to 

Act.
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Submitting a Scottish Act to TNA

You can submit an Act to TNA from within Lawmaker.

How to submit to TNA

1. From the Project Tab, generate a PDF of the working version that you wish to submit to TNA.

2. Find the PDF snapshot and select Actions > Submit to TNA.

3. Click Submit in the dialog box that appears.  A significant version will appear on the right of your screen.  

4. On the significant version, select Actions > Download ZIP file. 

5. Click Download in the dialog box that appears.  A zip file will be created containing the PDF and XML file, and also any images included in your Act.

You can now use this zip file to upload into TNA’s publishing system.

 

The submission process is not yet fully automated, so there are some additional steps you need to follow to submit your Act.
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Scottish Amendment Lists

Daily Lists

Amendments will appear in the Daily List if they were recorded as having been “tabled” before the cut-off date and time, and they haven’t 

already been published on another list.

Sorting

Amendments will be sorted by the Order of Consideration if there is one. If there is no Order of Consideration, they will be sorted in the order 

they appear in the Bill

Amendments are also sorted by:

their Page, line and column number,

their specified sort code e.g. M1, M2

Numbering

Amendments are numbered sequentially 1 - n in the order they appear in the Daily List.  They will continue from the number of the last 

published amendment.

Headings

The system will automatically insert interstitial headings e.g. “Section 2” or “Before schedule 2A” etc between the amendments as 

appropriate

Amendments to amendments

Amendments to amendments will appear after their target amendment in the sorted list

They are numbered after their target Amendment and are appended with a letter in alphabetical order e.g. 23A, 23B, 23C according to their 

sort order if more than one was tabled on the same day.

Line numbers will appear automatically against the target amendment in the PDF (not in the Editor) when you generate a PDF of the Daily 

List or Marshalled List (including Manuscript amendments and Scripted Marshalled Lists)

Marshalled Lists

Amendments will appear in the Marshalled List if they were recorded as having been ‘tabled’ before the cut-off date and time (and not ‘Not 

Selected’ if stage 3), and they haven’t already got an outcome recorded against them e.g. Withdrawn before debate, Agreed to etc.

Sorting

Same as Daily Lists

Numbering

Same rule as Daily Lists.

In most cases, amendments will already have been numbered on Daily Lists, but it is possible to include new amendments in the Marshalled 

Lists which will automatically be numbered according to the same rule as Daily Lists.

Headings

The system will automatically insert interstitial headings e.g. “Section 2” or “Before schedule 2A” etc between the amendments as 

appropriate
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Amendments to amendments

Amendments to amendments will appear after their target amendment in the sorted list

They are numbered after their target Amendment and are appended with a letter in alphabetical order e.g. 23A, 23B, 23C according to their 

sort order if more than one was tabled on the same day.

Line numbers will appear automatically against the target amendment in the PDF (not in the Editor) when you generate a PDF of the Daily 

List or Marshalled List (including Manuscript amendments and Scripted Marshalled Lists)

Starred amendments

These will appear automatically if this is the first list that an amendment has appeared on (i.e. it is a ‘new’ amendment)

Manuscript Amendments/Supplement to the Marshalled List

You can create manuscript amendment list by pre-selecting the amendments to be inserted into the list and selecting "Manuscript List" on 

the 'Create List' dialogue box.  This will generate a Marshalled List, only containing the selected amendments.  These amendments will be 

sorted and numbered using the same rules as the Marshalled List.

You can now add a note to a Scottish Parliament Daily List, a step which then allows you to generate Manuscript Daily Lists.  You can insert 

a Note with your cursor either in the Bill Title, or in the Bill Stage.  Press 'enter' to bring up the CCA, and it will give you the option to add a 

Note.  The Note is formatted in italics.

Scripted Marshalled Lists

To create a Scripted Marshalled List, you will need to duplicate your last published Marshalled List.  First of all, insert a 'Script' element using 

the 'insert' menu in the appropriate place in the list.  You can then use the 'insert' menu to insert pre-populated scripts (based on the old 

Word template).  These pre-populated scripts will need manual modification once inserted e.g. adding a Member's name or Amendment 

numbers.  

To insert a script at the start of the amendment list, you need to get your cursor into the 'List body' element.  To do this:

1. put your cursor at the beginning of the first interstitial heading (the bold, centred headings that appear before amendments in a certain group e.g. 

"Before Section 1",

2. use the left arrow to move your cursor into the 'List body' element:

a. Check the breadcrumb that appears at the top or bottom of the Editor.  When the cursor is in the correct place, the last breadcrumb will be 'List 

body'.  

3. click 'enter' to get the insert menu.

4. select 'Script' which will insert a script box before the first interstitial heading  

To create line breaks/spacing in these boxes, insert ‘non-breaking whitespace’ into the paragraph elements using the ‘Insert special 

characters’ button in the upper toolbar.  This will ensure that the PDF retains the spacing created by these ‘empty’ paragraph elements.

Groupings Lists

To create your first Groupings List for an amending stage, generate one from the “Create List” button.  The system will load an empty 

Groupings List document in the Editor.  You will need to manually insert the different groupings (including grouping notes and timing 

information as required). You can also add ‘Notes’ for any Group as required. To add additional paragraphs to the ‘Notes’ select ‘Note’ from 

the Insert menu.  To add timing information, select ‘Timings’ from the Insert menu. When you have added all the groupings with amendment 

numbers comma separated, you will need to trigger the automatic ‘Populate Groupings List’.  If you make further changes to the amendment 

numbers, you will need to re-run the ‘Populate Groupings List’ function.

To create subsequent Groupings Lists, the easiest thing to do would be to duplicate the last published Groupings List and copy and paste 

Groupings into the ‘Groupings already debated’ to save you from keying in all the information again.  Once you have made the necessary 

changes, re-run ‘Populate Groupings List’ to update the full text versions of the amendments appearing at the back of the document.  Don’t 

forget to update the ‘Document Information’ panel with new information that will appear in the footer of the Groupings List once the PDF is 

generated.
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Using the amendment sort code in Scottish amendments

Sorting amendments that start at the same page/line position or after/before same section

At the moment the sorting algorithm is not sophisticated enough to correctly sort amendments which start on the same page and line as 

each other (or are after/before the same section).

To get amendments of that kind to sort automatically you can to add a sort code to each amendment. 

What code to use

You can use your own scheme to assign an order (amendments with a code numerically or alphabetically lower will appear first so you could 

use “1”, “2”… or “A”, “B”…)

Alternatively, you can reuse the existing scheme for the (optional) 5th (word position) and suffix (category of MSP) components of 

amendment filenames.

For the latter, here’s an extract from the existing software manual with examples of what sort code to apply.

Filenames - Element 5 (optional)

59.       This element represents the word number in the line in question.  Where the amendment refers to a word in the line (e.g. “leave 

out first <the>”), count to that word (disregarding any numbering at the beginning of the line that is part of the numbering structure of the 

Bill).

0 = “at beginning” or “leave out line”

1 = 1st word in line

2 = 2nd word in line, etc.

60.       For amendments that insert words or a block of text at the end of a line, the following numbers are used—

50 = “at end insert <words>”;

60 = “at end insert— [sub-sub-sub-paragraph]”;

70 = “at end insert— [sub-sub-paragraph]”;

80 = “at end insert— [sub-paragraph]”;

90 = “at end insert— [paragraph]”;

100 = “at end insert— [subsection]”.

Note: for the purposes of this element, “paragraph” means either a section paragraph or a schedule paragraph – and “sub-paragraph” 

etc. should be treated similarly.

61.       All the above numbers (50 to 100) are—

reduced by 1 for “inserted text” (text to be inserted into an existing Act)

reduced by 5 for “full-out” text.

Thus, for example—

79 = an inserted sub-paragraph

95 = a subsection full-out

Note that most definitions are unnumbered section paragraphs and, therefore, an amendment to insert such a new definition in such a 

list should be coded 85 (i.e. paragraph fullout level).

Filenames – category of MSP (optional)

63.       This relates to who is lodging the amendment, and when they are doing so in relation to other amendments to that place in the 

Bill.  The number begins with—

a plus sign and M for an amendment in the name of the member-in-charge of the Bill (which takes precedence)

a plus sign and N for any other amendment

The letter is followed by a number indicating whether the amendment is the first of that category to that place in the Bill.
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Before section 2, insert— [Government new section] 2.B+

M01

M01

Before section 2, insert— [2nd Government new section] 2.B+

M02

M02

In section 2, page 3, line 4, leave out <7th word> and insert <words> 2.I.3.

4.7.S

+M0

1

7+M

01

In section 2, page 3, line 18, leave out subsections (2) to (4) 2.I.3.

18.0.

L+M

01

0+M

01

In section 2, page 3, line 18, leave out subsection (2) and insert— [new subsection] 2.I.3.

18.0.

S+M

01

0+M

01

In section 2, page 3, line 18, after <3rd word> insert <his normal place of residence or> 2.I.3.

18.3.I

+M0

1

3+M

01

In section 2, page 3, line 18, leave out from <12th word> to <competence> in line 19 2.I.3.

18.12

.L+M

01

12+

M01

In section 2, page 3, leave out line 19 and insert— [new paragraph] 2.I.3.

19.0.

S+M

01

19+

M01

In section 2, page 3, line 20, at end insert— [new sub-paragraph] 2.I.3.

20.80

.I+M0

1

80+

M01

In section 2, page 3, line 20, at end insert— [new paragraph] 2.I.3.

20.90

.I+M0

1

90+

M01

In section 2, page 3, line 20, at end insert— [new subsection] 2.I.3.

20.10

0.I+M

01

100

+M0

1

Amendment Filen

ame

LDA

PP 

Sort 

cod

e
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How to add a sort code
The sort code can be added to an amendment (and changed) at any time via the “amendment information” panel at the right of the editor so 

it could be added by the drafter or a parliament user. Once the sort code has been saved, any list generated will use it to determine the 

order of amendments.

As an amendment to amendment X [i.e. the above amendment], line 2, leave out <word> and insert <words> 2.I.3.

20.10

0.I+M

01A

A

As an amendment to amendment X, line 3, leave out <words> 2.I.3.

20.10

0.I+M

01B

B

In section 2, page 3, line 20, at end insert— [second new subsection, non-gov member] 2.I.3.

20.10

0.I+N

02

100

+N0

2

In section 2, page 3, line 40, leave out from beginning to end of line 2 on page 6 2.I.3.

40.0.

L+M

01

0+M

01

In section 2, page 3, line 40, leave out from second <5th word> to <word> in line 42 and insert <words> 2.I.3.

40.5.

S+M

01

5+M

01

Leave out section 2 and insert— [Government new section] 2.S+

M01

M01

Leave out section 2 2.L n/a

Divide section 2 into two sections, the first (Title of new section) to consist of subsections (1) to (3) and the second (Title of new 

section) to consist of subsections (4) to (6)

2.D+

M01

M01

Move section 2 to after section 5 2.M+

M01

M01

After section 2, insert— [new section] 2.A+

M01

M01

At an appropriate place, insert— [new section] U+M

01

M01

In the long title, page 1, line 3, leave out from <5th word> to first <word> in line 4 T.I.1.

3.5.L

+M0

1

5+M

01
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Troubleshooting

Getting help

If you need help with an issue that isn’t listed below get in touch with Lawmaker Support by email (lawmaker@nationalarchives.gov.uk) or 

using the Lawmaker support portal. 

Troubleshooting guides

[Commons/Lords] Cannot update an amendment after Consolidated List has been published

[Lords] Amendment to Amendments not appearing in correct location for new clause/schedule amendments

[Lords] Change a page-line amendment to a new clause/new schedule amendment

[Lords] How to make an amendment re-appear on a subsequent daily sheet

[Lords] How to remove numbers from more than one Lords amendment

[Lords] Wrong number or “#” assigned to amendments in a Marshalled List

[OPC and Lords] How to create a Lords ping pong amendment to amendment

Amendment sorted in wrong location in an official list

Converting subsection into section content and vice versa

Deleting content has deleted more than I intended

Error: Couldn't find provision XXX in the published bill

Frequently Asked Questions (FAQs)

How do I format text to appear in smallcaps or dropCap

How do I update the long title in a Bill or Act?

How to add multiple quoted structures to one provision

How to create high resolution images of forms etc. from Word to insert into Lawmaker

How to insert a preamble into a public bill

How to use locked nums in UK amendments

Lawmaker reporting that you already have the document open in another tab (but you haven't)

LegHub is not showing amendments on my published list

LegHub is not showing amendments that have been withdrawn

PDF contains large white spaces on the page

Phantom locks on a fragment

Publishing bills even when no amendments were applied at a particular stage

Known issues

Resolved - LMS-326 Amendment list (LoDA or official list) is inaccessible

LM-148 Can't edit a Schedule heading or cross-heading when Block Tags is turned on

LMS-2646 Amendment list duplication not working as expected

LMS-2641 Amendments on a pre-introduction LoDA disappear from the Amendment Manager tab and are not visible to Commons/Lords users after

submission

LMS-2372 Unable to extract zip file

LMS-2018 Amendment quoted structure is not appearing in the PDF

LMS-41 Amendment numbering doesn't restart in SP and HoL amendment lists between stages

LMS-52b Amendment is being shown/sorted as if it were a new clause/section amendment when it is a clause/page/line amendment

LMS-52 Provisions in quoted structure look different from surrounding Bill or another quoted structure

Help on a range of specific issues that have cropped up in practice. Also includes notes on known issues with the current version of 

Lawmaker. 

mailto:lawmaker@nationalarchives.gov.uk
https://lawmaker.atlassian.net/servicedesk/customer/portal/1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/148504577/Commons+Lords+Cannot+update+an+amendment+after+Consolidated+List+has+been+published
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/162037761/Lords+Amendment+to+Amendments+not+appearing+in+correct+location+for+new+clause+schedule+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/138149889/Lords+Change+a+page-line+amendment+to+a+new+clause+new+schedule+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/137592833/Lords+How+to+make+an+amendment+re-appear+on+a+subsequent+daily+sheet
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/15106071/Lords+How+to+remove+numbers+from+more+than+one+Lords+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/72155137/Lords+Wrong+number+or+assigned+to+amendments+in+a+Marshalled+List
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/104464385/OPC+and+Lords+How+to+create+a+Lords+ping+pong+amendment+to+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71991297/Amendment+sorted+in+wrong+location+in+an+official+list
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65994796/Converting+subsection+into+section+content+and+vice+versa
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65437704/Deleting+content+has+deleted+more+than+I+intended
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/136314881/Error+Couldn+t+find+provision+XXX+in+the+published+bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25624577/Frequently+Asked+Questions+FAQs
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/138969089/How+do+I+format+text+to+appear+in+smallcaps+or+dropCap
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339251/How+do+I+update+the+long+title+in+a+Bill+or+Act
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/225116161/How+to+add+multiple+quoted+structures+to+one+provision
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/73662474/How+to+create+high+resolution+images+of+forms+etc.+from+Word+to+insert+into+Lawmaker
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/104038401/How+to+insert+a+preamble+into+a+public+bill
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/71925833/How+to+use+locked+nums+in+UK+amendments
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166952961/Lawmaker+reporting+that+you+already+have+the+document+open+in+another+tab+but+you+haven+t
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65699841/LegHub+is+not+showing+amendments+on+my+published+list
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65503233/LegHub+is+not+showing+amendments+that+have+been+withdrawn
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/96468993/PDF+contains+large+white+spaces+on+the+page
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65994777/Phantom+locks+on+a+fragment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/81592321/Publishing+bills+even+when+no+amendments+were+applied+at+a+particular+stage
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/88506381/Resolved+-+LMS-326+Amendment+list+LoDA+or+official+list+is+inaccessible
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/5668869/LM-148+Can+t+edit+a+Schedule+heading+or+cross-heading+when+Block+Tags+is+turned+on
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/282132485/LMS-2646+Amendment+list+duplication+not+working+as+expected
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/281509890/LMS-2641+Amendments+on+a+pre-introduction+LoDA+disappear+from+the+Amendment+Manager+tab+and+are+not+visible+to+Commons+Lords+users+after+submission
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/281509890/LMS-2641+Amendments+on+a+pre-introduction+LoDA+disappear+from+the+Amendment+Manager+tab+and+are+not+visible+to+Commons+Lords+users+after+submission
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/250085387/LMS-2372+Unable+to+extract+zip+file
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/226361345/LMS-2018+Amendment+quoted+structure+is+not+appearing+in+the+PDF
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/18087937/LMS-41+Amendment+numbering+doesn+t+restart+in+SP+and+HoL+amendment+lists+between+stages
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/15564801/LMS-52b+Amendment+is+being+shown+sorted+as+if+it+were+a+new+clause+section+amendment+when+it+is+a+clause+page+line+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/15040513/LMS-52+Provisions+in+quoted+structure+look+different+from+surrounding+Bill+or+another+quoted+structure
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Resolved - LMS-246 Dropdown menus in Create New LoDA and Official List dialogue boxes not working

(v13) LMS-689 Unable to save info in Document Information Tab

(v.13) LMS-52b Amendment is being shown/sorted as if it were a new clause/section amendment when it is a clause/page/line amendment

(v.13) LMS-326 Amendment list (LoDA or official list) is inaccessible

(v.13) LMS-52 Provisions in quoted structure look different from surrounding Bill or another quoted structure

(v.13) LMS-41 Amendment numbering doesn't restart in SP and HoL amendment lists between stages

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/12943361/Resolved+-+LMS-246+Dropdown+menus+in+Create+New+LoDA+and+Official+List+dialogue+boxes+not+working
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/127238145/v13+LMS-689+Unable+to+save+info+in+Document+Information+Tab
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/124092588/v.13+LMS-52b+Amendment+is+being+shown+sorted+as+if+it+were+a+new+clause+section+amendment+when+it+is+a+clause+page+line+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/124092420/v.13+LMS-326+Amendment+list+LoDA+or+official+list+is+inaccessible
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/123699302/v.13+LMS-52+Provisions+in+quoted+structure+look+different+from+surrounding+Bill+or+another+quoted+structure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/123568329/v.13+LMS-41+Amendment+numbering+doesn+t+restart+in+SP+and+HoL+amendment+lists+between+stages
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Frequently Asked Questions (FAQs)

Miscellaneous

How do I convert a section containing a subsection into a section that is not subdivided?

Promote the subsection into a section content element - see Promoting and demoting provisions  .

How do I stop 'tag x-ref' tagging cross references to other documents/enacted legislation?

Place your cursor in the incorrectly marked up x-ref and right-click and select "Ignore x-ref"

"Tag x-ref" relies on pattern recognition. It is a work-in-progress and as such it might incorrectly identify a cross reference which is to another 

document and attempt to find the target provision within the current document. If this has happened, the best thing to do is ask the system to 

ignore the x-ref so that it doesn't re-attempt to update it every time "Tag x-ref" and "Update x-ref" are run.

How do I correct the indent of an element in a quoted structure?

See Quoted structures  

Use "Indent level" drop-down menu to manually correct the indent of elements inside a quoted structure. You can set it when you creating a 

new quoted structure, or you can adjust it after you have inserted a quoted structure using the right-click context menu "Update quoted 

structure properties"

Inserting provisions and other elements

How do I insert an element before the first element e.g. a section before the first section in my bill?

Option 1 - Using tags to guide you:

1. From the upper tool bar, select "Document > Preferences" and select "Block tags" from the Tag Display Mode drop-down menu. 

2. Place your cursor in the element before the provision you are trying to insert your element before e.g. to insert a section before the first section in a 

bill only containing sections: place your cursor after the "body" tag. 

3. Click 'Enter' to access the Insert menu/CCA and select your desired provision. 

4. The system will insert the provision after the element that your cursor is placed after so in the section example, it will be inserted immediately after 

the "body" element and before your first "Section" element.

Option 2 - Using the breadcrumbs to guide you:

1. Place your cursor at the start of the element you want to insert an element before e.g. to insert a section before the first section in a bill only 

containing section - place your cursor in the "num" of the first section. 

2. Use the back arrow on the keyboard to move your cursor left-wards through the element tags (the element that your cursor appears in will be shown 

in the breadcrumb so in the section example, it will show Bill > body > section > Num) 

3. Click 'Enter' to access the Insert menu/CCA when you get to the correct element (using the example above, this would be when you got to 'body') 

and select your desired provision

4. The system will insert the provision after the element that your cursor is placed after so in the example above, a section would be inserted 

immediately after the "body" element and before your first "Section" element.

The reason for these 2 approaches is because the system will always attempt to insert your selected provision after the element that your 

cursor is in, which is why it is difficult to position your cursor so that the inserted provision is inserted before the first element in a list. This 

technique gets around that issue as long as you understand the hierarchical nature of XML.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
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How do I insert a subheading before my subsection/paragraph?

Option 1 - Using tags to guide you:

1. From the upper tool bar, select "Document > Preferences" and select "Block tags" from the Tag Display Mode drop-down menu. 

2. Place your cursor before the 'num' element of the provision that you want to insert a subheading before

3. Click 'Enter' to access the Insert menu/CCA and select 'Heading'. 

4. The system will insert a heading above the num, formatted in italics by default

5. Remove 'Block tags' view from your preferences to return to normal drafting

Option 2 - Using the breadcrumbs to guide you:

1. Place your cursor in the 'num' element of the element that you want to insert a subheading before. 

2. Use the back arrow on the keyboard to move your cursor leftwards through the element tags (the element that your cursor appears in will be shown 

in the breadcrumb so in the section example, it will show Bill > body > section > subsection > Num In this example, when you get to 'Subsection'

3. Click 'Enter' to access the Insert menu/CCA and select 'Heading'

4. The system will insert a heading in the correct location, formatted in italics by default.  

How do I insert 'defined terms' in paragraphs or any element which isn't a 'definition' element?

It's not currently possible to insert 'defined terms' in elements other than definitions, we will be adding this into a future release.   

How do I insert a step as a sibling of my other steps and not a child of my paragraph?

If you have a series of steps in your document and one of the steps contains paragraphs, it is not obvious how to continue inserting steps 

after inserting a paragraph.  This is because Lawmaker will insert a step as a child of your paragraph.  To get around this insertion logic, 

place your cursor in the step before your paragraph and click 'Enter' to get the insert menu.  If you select 'Step' from here, it will insert it as a 

sibling of the step that your cursor is in. 

How do I insert a second sentence in a subsection or other element?

Use SHIFT + Enter which is the keyboard shortcut to create an additional text paragraph.

How do I insert the front page, table of contents and back cover?

See Inserting Scottish Bill and Act front and back covers , Inserting UK Bill and Act front and back covers  and Inserting table of c

ontents   

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688317
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Converting subsection into section content and vice versa
By default, whenever you insert a section, it will include an empty subsection by default.  If you do not need a subsection, as the section 

hasn’t been sub-divided, you will need to promote the subsection into section content. 

How to convert a section with a single subsection into an undivided section

With your cursor in the subsection, right-click and select Promote Element...

How to change the stage of amendments

 

Don’t try to achieve the same result by deleting the subsection number or the num element as that may cause problems with the 

presentation of the section or for users of the legislative data in future.

The promote action will only work if there is one subsection in your section

If you change your mind and want to sub-divide your section into subsections, click Enter to bring up the insert menu and select Subsection 

(1) which will insert a subsection after your section content, and at the same time convert your section content into a subsection.
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Deleting content has deleted more than I intended
The safest way to delete a whole element in Lawmaker (e.g. a paragraph inside a quoted structure, a whole amendment, an explanatory 

statement etc.) is to use the breadcrumb which is usually displayed at the bottom of the Editor, unless you have deliberately moved it to 

appear at the top of the Editor view.

1. In the screenshot above, the breadcrumb is at the bottom with a red marker around it

2. The breadcrumb shows you where your cursor is currently located

3. In this example, my cursor is in paragraph (b)

4. I have clicked on ‘Paragraph’ in the breadcrumb and this highlights the paragraph that my cursor was in

5. I can now click on ‘delete’ or ‘backspace’ to safely remove the whole paragraph

6. If I wanted to delete the whole quoted structure, I would select “Quoted Structure” in the breadcrumb and use ‘delete’ or ‘backspace’ and I’d be left 

with the amendment instruction.
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1. In this example, my cursor is inside the explanatory statement.  

2. If I clicked on ‘Explanatory Statement’ in the breadcrumb, it would highlight the whole explanatory statement and I’d be able to delete it

3. If I wanted to delete the whole amendment, I would click on ‘Amendment’ in the breadcrumb.  This would highlight the whole amendment and I would 

be able to delete it

4. Deleting amendments will remove them from the list that you are looking at, but it will not remove them from the project and they will still appear in 

the ‘Amendment Manager’ tab.  In a future release, it will be possible to delete amendments from the Amendment Manager.

 

see also Inserting, modifying and deleting provisions  for more information

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688768
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688768
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Amendment sorted in wrong location in an official list
The sort logic used when generating official lists relies on the location information for each amendment which is displayed in the 

Amendment Information right-hand panel (type, location, provision, page, line & sort code).  Most of these are also visible on the 

Amendment Manager tab as well.  If an auto-generated official list is showing an amendment in the wrong position, make sure you check 

and update the location information

Instructions

With the list open in the Editor…

1. Place your cursor in the amendment that is in the wrong position

2. Open up the Amendment Information right-hand panel

3. Check and update the location information as required e.g. adding or updating a sort code or removing the location information if not relevant to the 

amendment

4. Wait for the list to update and save your changes

5. Re-generate the list by selecting Tools > Update List from the upper tool bar menus

Avoid just dragging the amendment to the correct location as that won’t fix the issue the next time a subsequent list is generated

Update List will re-run the list generation logic which should result in your updated amendment being correctly sorted.  

[Lords and Scottish Parliament only] If you had unpublished amendments whose numbers needed to change as part of this update, they will 

be renumbered as well.  Published amendment numbers do not get overwritten automatically - only users can overwrite published 

amendment’s numbers.



408

Phantom locks on a fragment
In certain cases, phantom locks can remain on fragments such as parts, sections or amendments.  They are called phantom locks as the 

lock will not be visible to the user that is purported to have that lock and so they are unable to release the lock using the normal method of 

saving or discarding their changes.

In these rare cases, users can use the Release  All Locks feature, but they should do so with caution.

How to release phantom locks

See Releasing Locks  

If you are releasing locks in a document, make sure you are not unwittingly going to release genuine locks held by other users as it will 

release all locks in the document.  

To ensure you are only releasing locks on the phantom lock, open that fragment using Opening and editing a portion of document  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339194
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339194
https://lawmaker.atlassian.net/l/cp/czcSgu6m
https://lawmaker.atlassian.net/l/cp/czcSgu6m
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How to add multiple quoted structures to one provision
Issue
There are two main cases in which you might want to add more than one quoted structure within a single provision. (For general help with 

quoted structures see Quoted structures .)

1. Constructing a complex inserted provision that starts with a lower level provisions and continues with a higher one (e.g. starts with a paragraph 

followed by a subsection).

2. Inserting multiple entries into a list where the entries are not being inserted beside one another (most commonly where they are being inserted “at the 

appropriate place”)

For case 1., see Cases where you may need to adjust the indent level of a quoted structure or use adjacent quoted structures  for 

instructions on how to use adjacent quoted structures to achieve this.

For case 2, Lawmaker currently doesn’t support this in a straightforward fashion but there is a workaround to achieve it described below. 

We’ll make this easier to do in a future release ( LMS-1724: Add multiple quoted structures within a single provision FEATURE LOGGED  ).

Workaround to insert multiple quoted structures in one provision
1. In the provision that is to contain the multiple quoted structures, insert the first quoted structure as normal. For example, if you are want the provision 

to contain a number of definitions to be inserted at the appropriate place, insert a quoted structure with a starting element of “definition”. Equally if you 

want the provision to contain a number of separate table rows, insert a quoted structure with starting element “table”.

2. In the quoted structure dialog box, set the following text to any punctuation you want to be included at the end of quoted structure.

3. Once the quoted structure has been inserted, select it by clicking on Quoted structure in the breadcrumbs.

4. Press Ctrl+c to copy the quoted structure.

5. Place the cursor after the end of the quoted structure, e.g. next to the punctuation you specified to be included in the following text.

6. Press Ctrl+v to paste the quoted structure. You should now have two quoted structures starting with the same element type one after the other.

7. To add punctuation after the additional quoted structure, right-click within the quoted structure and select Update quoted structure properties. Add 

any required punctuation into the Following text field and click Update.

8. Repeat this process to create further quoted structures as required.

9. Update the content of each quoted structure with the text etc. that you require.

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526905
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526905
https://lawmaker.atlassian.net/browse/LMS-1724
https://lawmaker.atlassian.net/browse/LMS-1724
https://lawmaker.atlassian.net/browse/LMS-1724
https://lawmaker.atlassian.net/browse/LMS-1724
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How to use locked nums in UK amendments
Locked nums are indicated by the dotted box surrounding a provision’s number. Locking a number is a way of preserving the provision’s 

number when triggering a ‘renumber’ operation. 

They are useful when drafting amendments as locking a provision will ensure it doesn’t get renumbered from the starting number e.g. 1.  

However, when the amendment is applied, the locks may no longer be required.  As part of the auto-application and checking process, locks 

should be removed as required so that when the whole document is renumbered at the end of preparing the as amended copy - the right 

provisions are being renumbered.

The following table explains what happens to locks when amendments are automatically applied to the bill:

If the num is empty (ignoring parentheses inside 

paragraph, subsection etc. nums) and the num is 

locked

The lock is ignored. Upon auto-application, the lock will be removed and a number will be 

assigned to the provision using the auto-assign numbering rule

For example: inserting a new subsection between subsections (4) and (5), when auto-

applied, it will be assigned (4A) and the num is no longer locked

When the document is renumbered, this auto-assigned number will be renumbered to (5) 

and all subsequent susbections in the clause updated as well.

If the num has been specified and the num is 

locked

The lock is preserved. Upon auto-application, the lock will remain and the number doesn’t 

change

For example: inserting a new subsection (A1) before existing subsection (1); when auto-

applied it will remain as (A1) and the lock will remain also.

When the document is renumbered, the number will not change

If the num is empty OR the num has been 

specified and the num is not locked

Upon auto-application, a number will be assigned to the provision using the auto-assign 

numbering rule

For example: inserting a new subsection between subsections (4) and (5), when auto-

applied, it will be assigned (4A)

When the document is renumbered, this auto-assigned number will be renumbered to (5) 

and all subsequent subsections in the clause updated as well.

Scenario Outcome when amendment is applied
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[Lords] Amendment to Amendments not appearing in correct location for new 
clause/schedule amendments

When you have an amendment to a new clause or new schedule amendment, and the new clause or new schedule hasn’t been assigned 

an official number yet, you will need to manually update a location attribute on the amendment’s Amendment Information r-h panel. 

Instructions
1. In the Editor, update the italic text for your amendment to amendment so that it reads e.g. “As an amendment to the amendment in the name of Lord 

Purvis of Tweed to After Clause 2 printed on sheet HL Bill 128(a)”.

2. Save your change.

3.  Open the Amendment Information right-hand panel

4. Click in the empty ‘Location’ cell of the location table and type “before” or “after” as appropriate

5. Wait for the spinner to finish spinning before saving your changes.

 

For more information, see [Commons and Lords] Amendments to amendments   

When you save, the text in the italic note is parsed by Lawmaker to workout the location information that is displayed in the 

Amendment Information right-hand panel.  It can pick up the clause or schedule that an amendment to amendment is referring to 

(e.g. Provision = “sec_2” in the example above) but it doesn’t recognise “before” or “after” in the italic note.   LMS-623 is the new 

requirement to update the parsing logic to recognise this information.  In the meantime you need to manually include this when 

drafting/updating an amendment to an amendment to ensure the amendment is sorted under the correct interstitial heading in the 

official list.

https://lawmaker.scrollhelp.site/help/live/lords-amendments-to-amendments
https://lawmaker.scrollhelp.site/help/live/lords-amendments-to-amendments
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[Lords] How to remove numbers from more than one Lords amendment
When a Lords marshalled list is generated, all amendments in that list are assigned numbers, even if the list is discarded or not published. 

However, if you need to generate a Daily sheet or Running list after you have generated the marshalled list, the amendments will need to be 

published without numbers.

There isn’t currently a straightforward action in Lawmaker to remove numbers from amendments although you can delete the numbers 

individually.

This page describes how you can use find and replace in the XML to remove all amendment numbers in a few steps.

Instructions
1. First, you need to open all the amendments that you want to remove numbers from in the Editor. You can do this by either:

a. opening an existing official list containing the amendments, or

b. creating a temporary list containing all the amendments

2. Once you have the amendments open in the Editor, select Document>Edit as XML from the toolbar. You will see something like this:

3. Copy the following text into your clipboard (select it and then press ctrl+c)

4. (Note for the following steps until step 9 you will not be able to navigate away from the Editor without resetting the search function so you may want 

to ensure you can see these instructions at the same time as the Editor window.)

Click on the search icon in the top right and select Find/Replace.

5. Paste the contents of your clipboard into the Replace: field and delete the part outside the “/” characters so you are left with the following and then 

press Enter:

6. Paste the contents of your clipboard again into the With: field and this time delete the part between the “/” characters so you are left with the 

following and then press Enter:

1 /<num ukl:dnum="(.*?)">.*?<\/num>/ <num ukl:dnum="$1"></num>

1 /<num ukl:dnum="(.*?)">.*?<\/num>/

1 <num ukl:dnum="$1"></num>
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7. Click All

8. Click Switch to Author mode and you should see that the amendments no longer have a number

9. Save the amendment list.
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[Lords] Wrong number or “#” assigned to amendments in a Marshalled List
The numbering algorithm isn’t perfect and it will struggle with particularly complicated “ZZ” scenarios.  Lawmaker will have a good guess at 

the number, but if it can’t work it out at all, it will show “#” instead.

Instructions

With the list open in the Editor…

1. Manually change the number in the num element and update any other consequentials 

2. Save your changes

You can manually change any number that is wrong.  Only when an amendment is published will the number be set.  This means it 

will not be changed by the system, but it won’t prevent users from overriding the number if necessary.
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How do I update the long title in a Bill or Act?

The long title appears in the Preface of the Bill or Act and it also appears on the back cover if there is one. In Scottish Bills, the long title is 

pre-populated by default when first created with the text “An Act of the Scottish Parliament to”.

To edit the long title, update the text in the Long title element in the Preface of the Bill or Act in the Editor. The version on the back cover will 

update automatically.

 

 

See also:

Inserting UK Bill and Act front and back covers  

Inserting Scottish Bill and Act front and back covers  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339407
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688349


416

LegHub is not showing amendments that have been withdrawn
This could be because you haven’t re-published the updated amendment in Lawmaker.

If an amendment has been withdrawn before it appears on a Marshalled List, you will need to republish it as it won’t automatically get 

included in a subsequently published list.  Re-publishing the amendment will push the update to a central repository accessible to LegHub.  

As long as you have scheduled an update for this project stage in LegHub, then you don’t need to do anything further for the amendment to 

appear updated on the website later that evening.

How to re-publish withdrawn amendments

 

see Republishing updated UK amendments  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60882968
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60882968
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LegHub  is not showing amendments on my published list
LegHub relies on the stage information when searching Lawmaker data for any amendments to publish on the website.

Lawmaker currently relies more on the bill version that the amendments are linked to.  This means that if a user has accidentally created a 

List of Draft Amendments (LoDA) using the wrong Stage, then these amendments, whilst associated to the wrong stage, will continue to 

appear on Lawmaker amendments lists as expected and the issue only becomes apparent downstream when LegHub can’t find these 

amendments to publish on the website as they are associated to an incorrect stage.

In future, Lawmaker will be updated so that the Amendment tabs will be filtered by stage rather than bill version.  This will avoid the need to 

republish bill versions after stages where no amendments were agreed.  But it also means this mistake will become obvious as you will 

notice amendments aren’t appearing because they have accidentally been created against  the wrong stage.

To check before updating the stage
1. Open the amendment in a temporary list

2. Select Document > Edit as XML (to view the XML in the Editor)

3. Search (Ctrl+F) for the stage you think it was accidentally assigned to e.g. “Committee”, “Report”, “Third”

4. You can manually change the value in the <docStage> element by typing e.g.

a. <docStage>Report stage</docStage>

b. <docStage>Committee stage</docStage>

c. <docStage>Third Reading</docStage>

d. <docStage>Ping Pong</docStage>

How to change the stage of amendments without playing with the XML:

 

See “Moving all amendments or motions on a LoDA” in Moving or copying amendments to a different stage (including ping pong 

motions)  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
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How to create high resolution images of forms etc. from Word to insert into 
Lawmaker

Sometimes you may need to include something in your Lawmaker document that you can’t create within Lawmaker, e.g. a complex form, 

notice or table.

One way round this is to create the form etc. in Microsoft Word and then insert an image of it into Lawmaker. It is important, however, that 

you create a high-resolution image so it looks okay when included in the PDF or printed.

This page details the steps to take to create a high-resolution image.

1. First, Create your form, notice or table etc. in Word (making sure it fits on page and isn’t split over two pages).

2. Save the Word doc as a PDF.

3. Open the PDF in Acrobat Reader (not in your browser).

4. In Acrobat Reader, select Edit menu>preferences...>General.

5. Make sure the box "Use fixed resolution for Snapshot tool images" is checked and enter 300 in the resolution box and click Ok.

6. Go to the Edit menu again in Acrobat and select Take a Snapshot.

7. Use the snapshot tool to draw a selection box around the form/notice/etc., staying as close to the edges of the form etc. as possible.

8. Open the Paint application on your computer.

9. Paste in snapshot from clipboard (press Ctrl+V).

10. Save the image as a jpeg.

11. Use the normal Lawmaker insert image function to insert it into your document.

See Images  for general help on working with images.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339041
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339041
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Publishing bills even when no amendments were applied at a particular stage
Amendments link to a published bill version.  If a  bill moves to a new amending stage without being amended, you should republish the bill 

in Lawmaker to provide a clean slate for new amendments in the next amending stage.  

This is particularly important for Lords and Scotland where the numbering assigned to new amendments is based on the existing published 

amendments which links to a published bill version.

Workaround

Even though an “as-amended” Bill version doesn’t need to be created, if you publish one internally in Lawmaker that will force the 

numbering to return to 1. It is best to do this immediately after the first amending stage is complete (i.e. when you know that there is no need 

to publish a real as-amended version) - this will mean that all amendments can be drafted against the new version. If it is done later, you can 

use the Move Amendments to another Stage feature to associate existing amendments with the new version.

1. Duplicate the last published version of the Bill and open in the Editor.

2. Click on the Document Information panel on the right

3. In the version rubric dropdown, select “Other…” and enter a name that will help you identify that this is a version published for the purposes of the 

subsequent stage only, e.g. “As Introduced - Report stage”

4. Wait a moment for the Bill to be updated and then save the document.

5. Generate a PDF of the Bill, making sure line numbering is on and that a snapshot will be saved.

6. Close the Editor and publish the new PDF snapshot.

7. You should now find that on the Amendment Workspace, Amendment Manager and Official List tabs, that the default version is now the custom 

version you entered in step 3 above. 
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PDF contains large white spaces on the page
The PDF generator uses a lot of ‘keep with next’ rules which can sometimes be over-zealous and over time, Lawmaker team are refining 

these so that they work as expected.  In the meantime, if you find a PDF contains a lot of unexpected whitespace, have a go inserting page 

breaks which can sometimes overrule/avoid these overzealous ‘keep with next’ rules.  Please still report the issue to the Lawmaker Support 

Portal as this will help refine these rules overtime so that you hopefully won’t need to use the page break option in future.

Workaround
1. Open the document in the Editor

2. Place cursor at the end of an element/provision and right-click and select Insert Page Break

3. Generate a PDF to check whether the page break has solved the whitespace issue

a. If not, you might need to undo the page break and try inserting it somewhere else.

 

see Inserting page breaks  for more information

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60948495
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60948495
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How to insert a preamble into a public bill
It’s very rare but nonetheless possible for a Member to table an amendment to insert a preamble into a bill.  Currently, users would have to 

draft the amendment using the traditional LoDA approach (inline amendments to preamble and long title are due for a future release).   If the 

amendment was agreed, users would need to manually insert the amendment text within the existing preamble element and before the 

words of enactment.  This section provides instructions on how to create the preamble amendment and how to insert it into the bill if it were 

agreed to.

How to create a preamble amendment
1. From the Amendment Workspace create a new List of Draft Amendments

2. Ensure you have selected type ‘Traditional’ (it will likely default to this selection)

3. Insert a blank ‘Amendment’

4. Type into the instruction: “After the Long Title, insert the following new Preamble—“

5. Insert a quoted structure 

6. Select ‘Content’ as the starting element

7. Type into the empty content element

8. Save and submit your amendment as normal

How to apply a preamble amendment
1. Open the amendment in the Editor

2. With your cursor inside the quoted structure, right click and select Copy content of quoted structure

3. Open the bill document in the Editor

4. Place cursor in the Preamble element before the words of enactment:

a. Place cursor at the start of the words of enactment ‘Be’

b. Use left arrow to move the cursor through the elements until the breadcrumb says “Bill > Preamble”

5. Click enter and insert a paragraph

6. With your cursor in the paragraph use Ctrl+V to paste the content of the quoted structure (the preamble) into the empty paragraph element.

7. Save your changes.

In a future iteration, the inline amending capability and auto-apply capability will be updated so that it’s possible to insert (and 

amend) preambles inside of public bills.  They appear by default inside of private bills.  This is a temporary workaround until this 

comes in.
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Lawmaker reporting that you already have the document open in another tab 
(but you haven't)

Lawmaker uses browser session data to determine if you already have a document open.  This is to prevent you accidentally opening 2 or 

more copies of the same document and getting into versioning issues.  On very rare occasions, this feature can create issues if your 

browser session didn’t update correctly.  If this does happen to you, you will probably only be aware of it when you attempt to open a 

document and a yellow banner appears at the top of the document in the Editor saying “Document already open in another browser tab”.   

This page shows you how to get out of this situation, but do check first to see whether you do have the document open in another tab just in 

case!

There are 2 approaches outlined below depending on your levels of confidence:

1. Using Developer Tools to update your browser session information specifically for Lawmaker.  The benefit of this targeted approach is that it 

will not impact other web applications you access in the same browser

2. Clearing cookies and other site data for all web applications (instructions for Chrome and instructions for Edge).  The drawback of this approach 

is that it will log you out of other websites you might be using in the same browser.

How to use Developer Tools to update your browser session information

Edge & Chrome

1. Close down the Editor tab reporting that the document is already open.

2. Make sure focus is on the browser tab that has Lawmaker open and press F12 to open ‘DevTools’ (if it is the first time you’ve accessed Developer 

Tools, you might need to confirm that you wish to open Developer Tools at this point).

3. Select ‘Application’ from the upper tool bar if it’s not already selected:

a.  

4. Look for opendocuments in the ‘Key’ column

5. Double click on the content in the ‘Value’ column to select it all and over-type with “[]“ (an open and close square bracket) so that it looks like this:

a.  

6. Move your cursor out of this field and try opening the document again.  You should find that the document opens in the Editor without the yellow 

banner.  

7. You can close the Dev Tools window by clicking on the X in the top right hand corner:

a.  
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How to clear cookies and other site data in Chrome
1. On your computer, open Chrome

2. At the top right, click More Settings (three dots stacked vertically)

3. Select More tools… 

4. Select Clear browser data

5. In the pop-up dialog box, select Cookies and other site data

6. Click on Clear data button

Now you will have to re-logon to Lawmaker.  Try opening the document again.  You should find that the yellow banner has now disappeared.  

How to clear cookies and other site data in Edge
1. On your computer, open Edge

2. At the top right, click More Settings (three dots displayed horizontally)

3. Select Settings

The screenshots above have been taken from Edge.  Chrome looks more or less the same but there may be minor presentational 

differences from the screenshots that you are looking at above.  The steps are all the same though.

Keyboard short cut which works in Chrome as well as Edge is Ctrl+Shift+Del which will open the dialog box that you see in the 

screenshots and is a quicker way to access this option.
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4. Select Privacy, search and services (from the left hand navigation)

5. Within the Clear browsing data section, within the  Clear browsing data now option, click on Choose what to clear

6. In the pop-up dialog box, make sure you only select Cookies and other site data and then click on Clear now button

Now you will have to re-logon to Lawmaker.  Try opening the document again.  You should find that the yellow banner has now disappeared.  
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[OPC and Lords] How to create a Lords ping pong amendment to amendment
When creating amendments to amendments for a Lords-starting bill, you need to create a single amendment to amendment for each of the 

Member’s requested amendments, rather than grouping them all under a single ‘amendment to amendment' element in Lawmaker.  This will 

ensure the Marshalled List is formatted correctly when the list is generated. 

How to create a Lords ping pong amendment to amendment
1. From the Amendment Workspace create a new List of Draft Amendments

2. Ensure you have selected “Ping pong” as the stage

3. Insert a PP Motion - amendment to amendment

4. Provide the Member’s name

5. Insert the amendment instruction and any associated quoted structure if required 

6. For any subsequent amendments to amendments in the same Member’s name, insert a new PP Motion - amendment to amendment for each 

rather than inserting from the ‘Amendment - xxx’ options in the insert menu.
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Error: Couldn't find provision XXX in the published bill
When generating an official list or updating an existing one, you might encounter an error code along the lines of:

This error is reporting an issue with the Order of Consideration.  Whilst attempting to sort the amendments in your official list using the order 

of consideration, Lawmaker is unable to find Schedule 1 in the published bill.  In this case, it was the published bill was a 1 schedule bill and 

the schedule is known as “The Schedule” rather than Schedule 1.  In this case, to fix the error, the user had to remove “1” from the to and 

from fields.  Leaving them empty allowed the sorting function to work correctly.

If you encounter an issue when generating a new list that looks similar to this, or if updating a list doesn’t work, double check the Order of 

Consideration.

 

For more information on how to use the Order of Consideration, see Creating an Order of Consideration   

https://lawmaker.scrollhelp.site/help/live/old-creating-an-order-of-consideration
https://lawmaker.scrollhelp.site/help/live/old-creating-an-order-of-consideration
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[Lords] How to make an amendment re-appear on a subsequent daily sheet
Sometimes an amendment should appear again on a Daily Sheet if it has been substantively updated.  The list generation rules for a Daily 

Sheet is to only display amendments that haven’t yet been published on a previous list.

To workaround this rule, you will need to remove the published events from the amendment  to trick Lawmaker into displaying it again on a 

subsequent Daily Sheet.

Instructions
1. Select the amendment on the Amendment Manager tab and open it in the Editor by selecting Amendment Actions > Open in temporary list

2. Open the Amendment Status right-hand panel

3. Click on the ‘Manage lifecycle events’ link that is at the bottom of this panel

4. Find all the ‘published’ events after ‘Tabled’ and delete them

5. Click on Update to close the dialog box and save your changes in the temporary list when you’re finished.

6. When you next generate a Daily Sheet, the amendment will appear
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[Lords] Change a page-line amendment to a new clause/new schedule 
amendment

If you change a ‘page-line’ amendment into a ‘new clause’ or ‘new schedule’ amendment, you will need to manually update the location 

table on the Amendment Information right-hand panel by removing the old references to page and line number.

Instructions
1. Start with Amendment Information open in the right-hand panel so you can view the location information for each amendment

2. In the Editor View, click on the amendment that you wish to update so that you can see the location information for that amendment.

3. To remove page and line numbers, place your cursor in the page and line cell of the location table and delete the content

4. Wait for the spinner to signal the update has been made and save your changes
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How do I format text to appear in smallcaps or dropCap

On rare occasions, you may need to format some text so that it has special formatting styles applied e.g. smallCaps or dropCap.  It is not 

currently possible to do this using the Editor, the only way to do it is to edit the XML. 

Instructions
1. Open the document you wish to edit in the Editor

2. Select Document > Edit in XML

3. Find the text that you with to format and insert the following start and end tags around the specific text that needs formatting:

a. DropCaps:

i. 

b. SmallCaps:

i. 

4. When you have finished editing the XML directly, select Switch to Author mode in the banner at the top

1 <p><inline name="dropCap">B</inline>e it enacted by the King’s most Excellent Majesty, by and with the 

advice and consent of the Lords Spiritual and Temporal, and Commons, in this present Parliament 

assembled, and by the authority of the same, as follows:—</p>

1 <p><inline name="smallCaps">Be it enacted</inline> by the King’s most Excellent Majesty, by and with 

the advice and consent of the Lords Spiritual and Temporal, and Commons, in this present Parliament 

assembled, and by the authority of the same, as follows:—</p>

Note how the start tag looks like this: <inline name=”smallCaps”> or <inline name=”dropCap”> and the end tag includes the 

backslash without the name attribute i.e. </inline>

If you have done it wrong, you will get an error message appear.  If you are unsure or do not want to play around with the XML, 

contact the National Archives team who can assist you.,
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[Commons/Lords] Cannot update an amendment after Consolidated List has 
been published

The Commons reported an issue in LMS-929 whereby the PPU were unable to update a Report Stage amendment with its outcome in order 

to generate a Proceedings.  

After further investigation, it appeared the Report Stage amendment had been mistakenly copied into the Consolidated List rather than 

using the ‘Ping Pong’ version of the amendment.  The Consolidated List had since been published by the Lords which meant that the House 

of Lords now had this amendment locked to them as ownership of all the amendments in that list pass to the House that publishes the list.  It 

only affected this single amendment in the list as it was an unexpected amendment that was agreed last minute, after the candidate 

Consolidated List had been generated and shared with OPC for review.  The quickest way to get this extra amendment into the 

Consolidated List was just to copy and paste it into the correct location.   Unfortunately, in this case, the wrong version of the amendment 

had been copied.

How to fix this whilst maintaining downstream data on Parliament’s website

Amendments that move through to Ping Pong are not republished on the website in HTML format - only the motions to these amendments 

are published in HTML format.   This meant that the safest thing to do would be to replace the amendment on the Consolidated List of 

Amendments so that the Commons could get back control of the original Report Stage version and update it so that these updates could 

peculate through to the website and update the same amendment on Parliament’s website with its outcome.  

To do this, log on as a user from the House that published the Consolidated List.  

1. Follow these steps to create a copied version of the Report Stage amendment, ready to copy into the Consolidated List:

a. Find the amendment on the Amendment Manager under the appropriate bill version filter

b. Select it using the check box and select Amendment Actions > Move/copy to a different stage

c. Select ‘Ping Pong’ stage and you can leave it pointing to the bill version that the amendment was amending - bill version in this context is not that 

important.  This will create a copy of the Report Stage amendment that has been stripped of its events, no longer has a proposer and no longer 

has an assigned number.

2. Duplicate the published of the Consolidated List so that you can open it to edit it:

a. Open the duplicated list in the Editor

b. Select the the Report Stage amendment and delete it (this only removes it from the list, it won’t delete the amendment)

c. Select the amendment on Amendment Manager and use Amendment Actions > Create temporary list to open it in the Editor

d. Select the whole amendment and use copy (Ctrl+C)

e. Place your cursor in the Consolidated list at the point where you want the amendment pasted after and use paste (Ctrl+V).  The Proposer and 

explanatory statement information will automatically be suppressed in the Consolidated List so you won’t see them even if they existed in the 

temporary list.

f. Save your revised Consolidated List

3. Generate a PDF and republish this Consolidated List.  The only reason you need to republish the edited Consolidated List is to make sure the person 

who is responsible for producing the revised Consolidated List to send back to the other House is using the most up to date version. 

Lastly, and most important: notify the National Archives using the support portal and ask them to switch permissions on the Report Stage 

amendment so that the House that needs to access it can.  Please use the ‘Report an urgent system issue’ so that TNA know to get this 

actioned by their supplier (who are based in Australia) overnight.  There is an alternative way to get permissions back to the other House if 

you can’t wait a day:

1. As a user in the House that doesn’t have permission to edit the amendment, Duplicate the published version of the Consolidated List

2. Delete all the amendments from it apart from the one you want to get permissions for

3. Save, PDF and publish the Consolidated List containing this single amendment.  Publishing the list will move ownership of the amendments to the 

House that published the list.  You will be able to edit the amendment now.  
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MAKE SURE YOU WORK TOGETHER WITH THE OTHER HOUSE IN THIS PROCESS SO THAT EVERYONE IS AWARE OF THE ISSUE 

AND THE STEPS TO RESOLVE THEM ARE CONTROLLED.

Future improvement

In future, a new Document Check warning will be added to check that all amendments in a Consolidated List are correctly assigned to ‘Ping 

Pong'.  If any amendment was not at ping pong stage, a warning would be displayed and this would have been triggered in this particular 

circumstance.
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General help

Getting started

Keyboard shortcuts

Release notes

Support and Lawmaker support portal

Passwords and multi-factor authentication

User Administration

Lawmaker Acceptable Use Policy

Known Issues

PDF version of user manual

Updating this manual

Pages under development

 

General help with and information about Lawmaker including user management, release notes, known issues and help with the API.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688599/Getting+started
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688736/Keyboard+shortcuts
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688878/Release+notes
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/266567686/Support+and+Lawmaker+support+portal
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688888/Passwords+and+multi-factor+authentication
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243/User+Administration
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/350355457/Lawmaker+Acceptable+Use+Policy
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688742/Known+Issues
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25428206/PDF+version+of+user+manual
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/31457281/Updating+this+manual
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/162136068/Pages+under+development
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Getting started
 

 Overview

For a general overview of Lawmaker see the Overview of Lawmaker .

 Glossary of terms

See the Glossary of terms  for explanations of common terms used in Lawmaker and this manual.

 Introduction to Lawmaker

You can watch this brief demo to get an idea of what Lawmaker is about.

Resources to help you get started using Lawmaker including a general overview of Lawmaker, a glossary of terms used in Lawmaker and 

legislation, and a guide to keyboard shortcuts.

Lawmaker Demo February 2022

Lawmaker Demo February 2022Lawmaker Demo February 2022

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688893
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688893
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688881
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688881
https://youtu.be/WBmwiHY4Q-Q
https://www.youtube.com/watch?v=WBmwiHY4Q-Q
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Introduction to XML

We’ve produced a short set of slides giving you a very basic introduction to XML and how it relates to Lawmaker. See Introduction to XM

L  .

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
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Overview of Lawmaker

Login

This is the first page you’ll see when you visit the Lawmaker website unless you’ve already logged in recently.

When an account is created for you on Lawmaker you will be notified of your username. Note this is not your email address and is case 

sensitive.

If you’ve forgotten your password click Forgot password? to reset it.

Lawmaker uses mutli-factor authentication so you may be required to enter further credentials after this screen.

Dashboard

This is the first screen you will see after you log in. It shows all the projects that you have access to and also enables you to create new 

projects.

See Projects and documents  for more about working with projects.

A brief overview of the different screens and functions that make up Lawmaker.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688727
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688727
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Project tab

The Project Tab shows the working documents contained within a project that you have access to and also significant document versions 

that have been shared, published or otherwise marked as significant.  You can view and edit documents from here and carry out a range of 

other tasks including generating PDFs, comparing different document versions and managing permissions.

See Documents and folders on the Project Tab  for more about working with documents.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
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Amendment Workspace

For Bill projects, the Amendment Workspace shows draft amendments being worked on by you and others in your organisation. 

Amendments being worked on are contained in a List of Draft Amendments (or LoDA for short). A LoDA can either contain one or more 

“traditional” amendments in the page/line format, e.g. “Clause 5, page 6, line 2, leave out…” or it can be an “inline LoDA” where the 

amendments are represented as tracked changes in a copy of the Bill.

The Amendment Workspace shows all the LoDAs that you have access to, enables you to carry out various actions on those LoDAs (e.g. to 

generate a PDF of them) and to create a new LoDA.

Amendment Manager

For Bill projects, the Amendment Manager gives you a view of all the individual amendments you have access to, either because they were 

drafted in your organisation or, if you are a user with Parliament or the Scottish Parliament, because they have been submitted to your 

organisation.

The Amendment Manager can be used to carry out a range of tasks in relation to one or more amendments, including editing them in a 

temporary list, submitting them, and putting them on hold. If you are a parliament user, you can use this page to generate an official 

amendment list and also to control the Order of Consideration.
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Official Lists

For Bill projects, the Official Lists tab shows all the official lists (e.g. marshalled lists) that have been generated in the project. If you are a 

parliament user, you can generate new lists from this page either from the Create List button or by duplicating an existing list.  Users in other 

organisations can only view lists that have been published or shared with them.
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Glossary of terms
A list of terms that are used in Lawmaker, the help documentation or in drafting and managing legislation with explanations of what they 

mean. Includes a guide to amendment terminology.

ToDo: add in grouping element, breadcrumb, toastie, placeholder

AKN Schema The set of rules that define whether an XML document is 

structured in accordance with the Akoma Ntoso standard 

for legislation (referred to as “AKN”). In the Document 

Checks panel to the right of the Editor, you can select 

whether to show errors relating to this or not - see Do

cument checks - validating your document  

Attribute Part of an XML element (see below) which provides 

further information about that element but is not text 

within the XML document. See Introduction to XML  

Closing words Where a provision is subdivided into paragraphs, any text 

after the last paragraph. Sometimes referred to as the 

“full-out text”.

Content Completion Assistant (CCA) The element insert menu that pops up when you press 

Enter. See Inserting provisions and other elements . 

Demote Changing an element into the next logical element further 

down in the hierarchy, e.g. you can demote a paragraph 

to a sub-paragraph. See Promoting and demoting pro

visions . 

Element The main building block of XML documents. Each 

provision in a Lawmaker document is represented by an 

element. An element has a start and end tag and may 

have attributes and contain text and other elements. See 

Introduction to XML  

LDAPP Legislative Drafting, Amending, and Publishing 

Programme. The project responsible for the initial 

development of Lawmaker.

Lawmaker The name of the application and the service.

Modal Another term for “dialogue box”. Used in software 

development and descriptions of the user interface.

Opening words Where a provision is sub-divided into paragraphs, the text 

before the first paragraph. Sometimes referred to as the 

“lead-in” text.

Promote Changing an element into the next logical element higher 

up in the hierarchy, e.g. you can promote a sub-

paragraph to a paragraph. See Promoting and demoti

ng provisions . 

Abbreviation or term Description

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339341
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339341
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339341
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339171
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Amendment terminology

Here is a guide to the language used to describe the different parts of a parliamentary amendment:

Quoted structure The element used to contain a textual amendment in a 

Bill or Act, or to contain provisions being inserted as part 

of a parliamentary amendment. See Quoted structure

s .

Significant version A read-only version of a document that has been created 

by Lawmaker as a result of a document being published, 

marked as signed, submitted to TNA or shared with 

another organisation. See Documents and folders on 

the Project Tab . 

Snapshot version A read-only snapshot of a working version that has been 

created by the user or automatically by Lawmaker. See 

Documents and folders on the Project Tab . 

Structure View The outline view of the document in the left-hand panel. 

See Using the structure view . 

Unwrap Removing a grouping level element e.g. Part or Chapter 

which will remove the start and end tags that are 

‘wrapping’ the child provisions within them e.g. sections. 

See Wrapping and unwrapping provisions . 

Working version An unpublished version of a document that you can view 

and edit. See Documents and folders on the Project T

ab . 

Wrap The term given when inserting a grouping element e.g. 

Part or Chapter.  In XML terms, the child provisions are 

encapsulated within the start and end tags of the 

grouping element which is where the notion of ‘wrap’ 

comes from. See Wrapping and unwrapping provision

s .

XML eXtensible Markup Language. See Introduction to XM

L  .

X-ref A Cross reference to another provision. See References. 

MFA Multi-Factor Authentication. See Multi-factor authentic

ation guide  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339075
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339303
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688786
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339357
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688800
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
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Introduction to XML
This slide deck embedded below contains a brief introduction to XML (eXtensible Markup Language) and how it is used in Lawmaker. You can also view the slides directly using this link: Lawmaker - 

introduction to XML slidedeck. 

 

 

 

 

Google Slides1

https://docs.google.com/presentation/d/1cpAYakAaHvxiDPYYzlR_LrWFDpKf8FZZDu6jJaZQLO0/edit
https://docs.google.com/presentation/d/1cpAYakAaHvxiDPYYzlR_LrWFDpKf8FZZDu6jJaZQLO0/edit
https://docs.google.com/presentation/d/1cpAYakAaHvxiDPYYzlR_LrWFDpKf8FZZDu6jJaZQLO0/edit
https://docs.google.com/presentation/?usp=slides_web
https://docs.google.com/presentation/?usp=slides_web
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Keyboard shortcuts

Special characters

Inserting provisions and paragraphs

Standard Editor shortcuts

Text formatting

Useful keyboard shortcuts when working the the Editor. Including: inserting special characters, inserting provisions, navigating around the 

document and accessing functions.

-- (dash dash) creates an em-dash (–) 

Type in Summary

Enter Brings up the Content Completion Assistant (CCA) which will contain a list of valid elements that can be 

insertable according to the element/provision you are currently in (see ‘Valid elements’ for explanation of what 

has been implemented).  The Editor will insert your selected provision/element at the next correct place 

making sure the XML is correctly structured

Ctrl + Enter Inserts the next default provision from the CCA (same as pressing Enter + Enter)

Shift + Enter Inserts an extra text element within the current provision

Keyboard shortcut Summary

Ctrl + z Undo a change

Ctrl + y Redo a change

Ctrl + c Copy

Ctrl + x Cut

Ctrl + v Paste

Ctrl + f Find (and replace)

Ctrl + s Save document

Keyboard shortcut Summary

Ctrl + b Bold

Ctrl + i Italic

Ctrl + u Underline

Ctrl + Shift + + Superscript

Keyboard shortcut Summary
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Lawmaker-specific shortcuts

Structure view

Amendments

Ctrl + Shift + - Subscript

Alt + [ Promote provision

Alt + ] Demote provision

Alt + u Update x-refs

Alt + n Renumber

Alt + l Lock/unlock number

Alt + w Wrap selected provision(s)

Alt + e Unwrap selected provision

Alt + t Tag x-refs in current provision

Alt + s Split current provision into two similar provisions

Alt + r Refreshes your document if another user has saved changes since you've had the document open

Alt + j Insert or update  j-ref in current provision

Ctrl + q Insert a quoted structure (textual amendment)

Tab Skip to the next element in the Editor

Shift + tab Skip to the previous element in the Editor

Keyboard shortcut Summary

Ctrl + mouse click Multi-select using the Structure View

mouse right click Shows context menu for provision

Keyboard shortcut Summary

Alt + k Move to next amendment in the list in the Editor

Alt + h Move to previous amendment in the list in the Editor

Keyboard shortcut Summary
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Release notes

What's new in v.17.1?

What's new in version 17?

What's new in version 16.2?

What's new in version 16.1?

What's new in version 16?

What's new in version 15.3.1?

What's new in version 15.3?

What's new in version 15.2?

What's new in version 15.1?

What's new in version 15.0?

What's new in version 14.2?

What's new in version 14.1?

What's new in version 14?

What's new in version 13.3.2?

What's new in version 13.3?

What's new in versions 13.2.1 and 13.2.2?

What's new in version 13.2?

What's new in version 13.1.1?

What's new in version 13.1?

What's new in version 13?

What's new in version 12.2.2?

What's new in version 12.2?

What's new in version 12.1?

What's new in version 12.0.1?

What's new in version 12?

What's new in version 11.7?

What's new in version 11.6?

What's new in version 11.5.1?

What's new in version 11.5?

What's new in version 11.4?

What's new in version 11.3?

What's new in version 11.2?

What's new in version 11?

What's new in version 10?

What's new in version 9?

 

This section contains release notes for minor and significant releases.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/548962305/What+s+new+in+v.17.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/317390851/What+s+new+in+version+17
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/442335233/What+s+new+in+version+16.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/418086916/What+s+new+in+version+16.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/293175298/What+s+new+in+version+16
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/299859970/What+s+new+in+version+15.3.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/258506754/What+s+new+in+version+15.3
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/222724097/What+s+new+in+version+15.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/215384065/What+s+new+in+version+15.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/202211329/What+s+new+in+version+15.0
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/192643073/What+s+new+in+version+14.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/187793409/What+s+new+in+version+14.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/168591380/What+s+new+in+version+14
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/180060161/What+s+new+in+version+13.3.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/157089793/What+s+new+in+version+13.3
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/154763265/What+s+new+in+versions+13.2.1+and+13.2.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/145096705/What+s+new+in+version+13.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/147095564/What+s+new+in+version+13.1.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/133660673/What+s+new+in+version+13.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/111116289/What+s+new+in+version+13
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/110395393/What+s+new+in+version+12.2.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/105119747/What+s+new+in+version+12.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/79167489/What+s+new+in+version+12.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/77692929/What+s+new+in+version+12.0.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/13336610/What+s+new+in+version+12
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/38600705/What+s+new+in+version+11.7
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/35356673/What+s+new+in+version+11.6
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/30474241/What+s+new+in+version+11.5.1
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/13336577/What+s+new+in+version+11.5
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9535489/What+s+new+in+version+11.4
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/5996559/What+s+new+in+version+11.3
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688765/What+s+new+in+version+11.2
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688771/What+s+new+in+version+11
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/5537817/What+s+new+in+version+10
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/6356993/What+s+new+in+version+9
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What's new in v.17.1?
Version 17.1.0 is a minor release contains some bug fixes and minor feature improvements.

It was released on 25 September 2024.

References

(LDAPP-4498, LDAPP-4497)

References within a document (both internal and external references) are now locked to prevent direct editing of them in the Editor (as 

trailed at the time of the release of v.17.0)

To change the reference text, you can double click on the reference and select Edit ref to bring up a dialog allowing references to be edited.  

Editing the reference text field will not now change the status of the reference - only editing one of the other fields will do that. That means 

that editing the reference text field will not prevent the Update references operation updating the edited reference in future.

See References  .

Running lists

(LDAPP-4462)

The list generation and updating logic for Lords Running lists has been updated to automatically assign black stars to new amendments in 

the same way as presently happens with marshalled lists.

See Generating a Lords Running List  .

List of bug fixes

PDFs

Amendments

SPT-1730 Fixed an issue where insufficient space was left between the end of a section and a cross-

heading in a Scottish Bill.

SPT-1733 Fixed an issue where unwanted asterisks would appear in an SI date block next to an entry 

“Coming into force in accordance with…”.

Issue key Summary

SPT-1720 Fixed an issued with auto-applying certain substitution amendments which prevented the 

amendments from being accepted.

SPT-1541 Improved handling of locking and auto-saves of traditional amendments relating to an inline 

LoDA.

SPT-810 Fixed an issue where duplicate values of eId attribute would be created in inline LoDAs where 

the amendment proposer was the same as the member introducing the Bill.

Issue key Summary

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65961985
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/65961985
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Editor

SPT-1721 Fixed an issue where disabled buttons could still be triggered by pressing Enter on keyboard.

SPT-1719 Renumbering whole document resets list style in Ex Note

SPT-1717 Fixed the order of the CCA where quoted text exists in provision so that correct provision 

appears at the top of CCA as default rather than quoted text.

SPT-1716 Fixed a bug preventing the updating of existing provisions using push/pull.

SPT-1715 Fixed an issue with inserting a table in a quoted structure which could result in the table being 

inserted in the incorrect place.

SPT-1712 Fixed an issue where quoted structures in documents imported from legislation.gov.uk were 

marked up incorrectly.

SPT-1710 Fixed an issue where content from the structure view could be dragged into the editor.

Issue key Summary

http://legislation.gov.uk/
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What's new in version 17?
This is a major release containing a range of new features, significant enhancements to the referencing functionality, a new beta feature to 

generate citation footnotes in SIs and some bug fixes.

It was released on 21 August 2024.

References to other provisions and documents

Reference tagging (including external references)

The referencing functionality in Lawmaker has been significantly improved and expanded in v.17. 

The most significant change is that the Tag References function will now tag external references (i.e. references to other enacted legislation 

like Acts, SIs or EU legislation) as well as internal references (i.e. references to provisions within the same document).

Other improvements include:

The tag references function is much better able to distinguish between internal and external references.

References that rely on other reference for their full context (e.g. where there is a reference in the opening words of a provision which qualifies every 

reference in the child provisions) are now handled correctly in most cases.

The tag references function now updates and, where necessary, retags existing references at the same time.

The colour of internal links has been updated to make it more accessible and external references have been given a different colour.

To tag external references, Lawmaker uses the data behind Legislation.gov.uk   to lookup and identify the appropriate legislative 

documents.

In addition, the tag references function now includes support for:

References that refer back to a previously mentioned Act or SI etc., e.g. “section 7 of that Act”

References that are external due to their context but don’t directly include the title of the Act or SI etc., e.g. references in provisions following a 

statement like “Section 32 of the Criminal Justice Act 2000 is amended as follows.”

References that rely on defined names for an Act or SI rather than its proper name, e.g. “Regulation 17 of the 2009 Regulations”, so long as the 

name is defined in the same document somewhere.

See References   and Guide to x-ref changes in version 17  .

Referencing toolbar

The new referencing toolbar (accessible by double clicking on a reference) makes it easy to complete a number of actions directly in the 

Editor.

You can jump directly to any referenced provision, whether it is internal or external. In the latter case, the referenced provision will open up 

in Legislation.gov.uk   in a separate tab.

The text of a reference can still be directly edited in the Editor but you can also use the Edit reference option in the toolbar to update the text 

and metadata fields if necessary (the ability to edit the reference text directly will be removed in the next release).

You can also trigger an update of the reference, mark it to be ignored or remove the reference mark-up from the toolbar.

See References .

Creating internal references from provisions in the Editor (rather than the structure view)

By right-clicking on a provision in the Editor and selecting Copy reference to provision you can choose a reference to that provision to be 

copied to the clipboard which can then be pasted elsewhere.

http://legislation.gov.uk/
http://legislation.gov.uk/
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/499843076
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/499843076
http://legislation.gov.uk/
http://legislation.gov.uk/
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522


449

This replicates the functionality that was previously only available from the structure view.

See References .

Generating citation footnotes in SIs

Lawmaker v.17 includes a new beta feature to automatically generate legislative history footnotes for external references in an SI or SSI. 

This feature relies on the data from legislation.gov.uk to generate footnotes that contain summarised amendment history of the referenced 

provision.

See Citation footnotes (legislative history footnote)   for more on this.

Church Measures

Lawmaker can now be used to create and manage Church Measures. 

Church Measure is a new document type available from the Create New Project dialog box. Broadly speaking the functionality and 

presentation for Church Measures is the same as for UK Bills. However, there is no ability to create amendments or amendment lists.

See Drafting Church Measures , Managing a Church Measure in Parliament  and Creating an Enacted version of a draft Church 

Measure  .

Quoted text

When drafting a textual amendment to another enactment that only involves a word or phrase rather than a whole provision, you can insert 

a Quoted Text element to represent the text that is being left out, inserted or substituted.

The new “Quoted text” element can be inserted from the Content Completion Assistant by pressing Enter and selecting Quoted text.

Quote marks automatically appear but can be removed or altered if necessary.

See Quoted Text . 

Sorting amendments by marshalled order on the Amendment Manager Tab

A new option on the Amendment Manager (via the Sort by marshalled order button) allows you to sort all the visible amendments by the 

order that they would appear in a marshalled list, including reflecting any Order of Consideration. This feature uses the same logic for 

generating a marshalled list that is already present in Lawmaker.

The previous “OoC sort” function has been removed.

See Sorting amendments on the Amendment Manager Tab . 

Scripted marshalled list improvements

Some limited improvements to the functionality for generating Scripted Marshalled Lists in the Scottish Parliament have been implemented.

These are:

new CCA options to add script boxes with or without headings;

new CCA options to add script boxes before or after the currently selected amendment;

CCA option to add the pre-populated ‘Question on amendment’ box directly from anywhere in the list, without having to create a blank script box first.

Submitting amendments from a LoDA

When amendments are submitted directly from a list of draft amendments, the receiving organisation (e.g. the Commons or Scottish 

Parliament) will also receive a copy of the list (accessible from the Amendment Workspace tab) so they can see the order in which they 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/500203522
http://legislation.gov.uk/
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/521404417
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/521404417
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522518529
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522518529
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522616835
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522616835
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/523829256
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522059778
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/522059778
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/524550160
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/524550160
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appeared on that list and to help them manage the amendment checking and tabling process.

See Submitting amendments . 

Uploading amendment list XML to create new amendments

A new option on the Amendment Workspace tab allows you to upload amendment list XML in order to create new Draft amendments 

against a specific bill version. 

Amendment list XML can be downloaded by selecting ‘Download ZIP file’ from the Actions menu next to any amendment list on the 

Amendment Workspace or Official Lists tabs. The ZIP file contains XML which can then be uploaded to any other bill project to recreate the 

amendments from that list as new draft amendments.

See Uploading amendment lists to create new amendments . 

Editing fragments of a schedule

Schedules in Bills and SIs are now fragmented at the grouping level (e.g. Part, Chapter, cross-heading) as well  as at the schedule level.

This means that more than one user can edit provisions in the same schedule at the same time. It also means that the Edit Portion function 

can be used to open up a portion of a schedule rather than only the whole schedule.

In consequence of this change, the structure view now shows the grouping levels within a schedule by default.

See Opening and editing a portion of document  and Locking document fragments/multi-user editing .

SI improvements and changes
Dates in the date block that are left empty now automatically show as three asterisks “***”.

If all the paragraphs within a regulation or article are deleted other than one, the remaining paragraph is automatically unwrapped so an undivided 

regulation or article is left.

The banner is now locked in the Editor to prevent accidental changes. It will still update automatically if the procedure is changed.

The content of the subject, title and number blocks at the beginning of an SI are now locked in the main Editor window to prevent accidental changes. 

You can still update the subject by clicking on it and selecting the appropriate subjects in the dialog box. The title and number can still be updated via 

the Document Information panel on the right.

The list of available subjects in the Subjects dialog box has been updated.

OFGEM and OFCOM have been added as new Lawmaker organisations.

Bug fixes

SI/SSIs

Schedules created in documents before this version is released will not immediately be fragmented in the new way - they will remain 

as single fragments that can only be edited and locked at that level. However, as soon as the document is saved again after this 

release, all schedules in the document will be fragmented at the grouping level.

SPT-1703 Fixed a problem that occurred when copying an SI document to another 

project if the document didn’t have enacting text

 

SPT-1700 Fixed a bug where pasting text consisting of SI regulations or articles into 

Lawmaker resulted in the full stop being deleted from the regulation number if 

auto-renumber was switched on

 

Issue key Summary User support 

ticket 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526666
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/525795329
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/525795329
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526913
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526913
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Editor

SPT-1695 Updated the list of subject headings available in Lawmaker  

SPT-1689 Fixed an issue with the spacing of SI paragraphs when there are first provision 

within a quoted structure

 

SPT-1679 Fixed an issue where certain wordings of SI/SSI dates would result in the date 

being split over two lines

 

SPT-1676 Fixed an issue resulting in the procedure of SI not updating on the Project tab 

or Dashboard

 

SPT-1671 Two new organisations added to Lawmaker: OFGEM and OFCOM  

SPT-1713 Fixed an issue that could sometimes cause the Editor, and the CCA in 

particular, to behave incorrectly (due to Oxygen failing to use the correct 

document filter - LDAPPDocumentFilter)

 

SPT-1711 Fixed an issue where Oxygen would sometimes fail to retrieve the XML from 

the server for operations like auto-save, save and structure view updates

 

SPT-1706 Fixed an issue where lots of spelling errors in a document could cause the "A 

problem has occurred" error to appears. (Included in patch release 16.2.2.)

 

SPT-1702 Fixed a performance issue in Editor (getElementByGuid Oxygen client-side 

code). (Included in patch release 16.2.1)

 

SPT-1701 Fixed an issue in the Editor which cause the screen to jump to a different 

location when the paste operation was triggered.

 

SPT-1699 Fixed a performance issue in the Editor when copying a reasonable number of 

provisions at one time. (Included in patch release 16.2.1.)

 

SPT-1683 Fixed an issue with the Mark as done toggle in the Review panel not working 

in certain cases.

 

SPT-1672 Fixed an issue which occurred when rejecting "surround" tracked changes 

which was introduced with Oxygen v.25.1 upgrade.

 

SPT-1653 Fixed an issue that could cause a document to get corrupted if the user tries to 

edit a document while the renumber operation is progressing.

 

SPT-1656 Fixed an issue with Promote/Demote of closing words where it would unwrap 

inline formatting and footnotes.

 

SPT-1631 Fixed an issue with the Copy Provisions to another document feature where 

provisions selected in a certain order would not be pushed correctly.

 

SPT-1616 Fixed an issue that prevented schedules being moved in the structure view in 

some cases.

LMS-2739

SPT-1611 Fixed an issue that caused “A problem has occurred” message to appear in 

some cases when the user accepted tracked changes. (Included in patch 

release 16.2.1)

LMS-2083

SPT-1609 Fixed an issue which affected Cross-references inside tracked change 

deletions if the references in the provision were updated.

LMS-2796

Issue key Summary User support 

ticket 

https://lawmaker.atlassian.net/browse/LMS-2739
https://lawmaker.atlassian.net/browse/LMS-2803
https://lawmaker.atlassian.net/browse/LMS-2796
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PDFs

Amendments

Document management (Project tab, comparison, permissions etc.)

SPT-1696 Quoted structure in change track have incorrect indent  

SPT-1693 Text in ukpga quoted structure //section/intro is not justified in PDF  

SPT-1692 Page numbering broken from page 10 onwards in Scottish Parliamentary 

Amendment lists

 

SPT-1691 Empty paragraph element wrongly aligned in PDF  

SPT-1682 Long hyperlinks (URLs) that are split across multiple lines have line spacing 

issues in the PDF and CSS issues in footnotes in the editor

 

SPT-1558 Resolve PDF rendering issues caused by missing attributes on 

quotedStructures (ukl:docName and ukl:indent)

 

Issue key Summary User support 

ticket 

SPT-1690 Wrong placement of material dragged into containers in amendment QSs

SPT-1651 Auto-apply: amendments which leave out words after a Defined term can't be 

applied if the quotation marks on the defined term are included in the 

amendment instruction

https://lawmaker.a

tlassian.net/brows

e/LMS-2740

SPT-1646 Extra spaces appear in certain substituting amendments when auto-applied to 

a bill version

 

SPT-1633 Auto-applying amendments to rref elements sometimes results in too much 

text being included in the rref; original rref's href attributes also persist

https://lawmaker.a

tlassian.net/brows

e/LMS-668

SPT-1632 Auto-applied amendment which inserts text beginning with punctuation after a 

<ref> element adds the text inside the <ref> when accepted

https://lawmaker.a

tlassian.net/brows

e/LMS-668

SPT-1266 Side-lining on auto-applied insert section amendment goes down too far https://lawmaker.a

tlassian.net/brows

e/LMS-76

SPT-1608 Moving an amendment in a LoDA using the Structure View with tracked 

changes turned on results in the amendment being duplicated

https://lawmaker.a

tlassian.net/brows

e/LMS-2785

SPT-1541 Auto-saved traditional amendments in an inline LoDA cannot be restored into 

the working version

 

Issue key Summary User support 

ticket 

Issue key Summary User support 

ticket 

https://lawmaker.atlassian.net/browse/LMS-2740
https://lawmaker.atlassian.net/browse/LMS-2740
https://lawmaker.atlassian.net/browse/LMS-2740
https://lawmaker.atlassian.net/browse/LMS-668
https://lawmaker.atlassian.net/browse/LMS-668
https://lawmaker.atlassian.net/browse/LMS-668
https://lawmaker.atlassian.net/browse/LMS-668
https://lawmaker.atlassian.net/browse/LMS-668
https://lawmaker.atlassian.net/browse/LMS-668
https://lawmaker.atlassian.net/browse/LMS-76
https://lawmaker.atlassian.net/browse/LMS-76
https://lawmaker.atlassian.net/browse/LMS-76
https://lawmaker.atlassian.net/browse/LMS-2785
https://lawmaker.atlassian.net/browse/LMS-2785
https://lawmaker.atlassian.net/browse/LMS-2785
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API and misc

Known issues

This section of the release note highlights any minor issues identified with the release that will be corrected in a future release:

Order of provisions in CCA is incorrect after a quoted text element is inserted: Normally, if your cursor is in a provision such as a subsection, 

when you press Enter, the item at the top of the list will be the most common sibling provision to the one you are in. So, if you are in a subsection 

then “Subsection” will be at the top of the list. This means that pressing Enter twice, or pressing ctrl+Enter originally, will insert the common sibling 

element. However, in version 17, if you have inserted a quoted text element into a provision and you subsequently press Enter when your cursor is 

not in the quoted text element, then “Quoted text” will appear at the top of the CCA instead leading to incorrect behaviour in relation to pressing Enter 

twice or pressing ctrl+Enter.

SPT-1662 Duplicating an 'Auto backup' snapshot results in the wrong XML content being 

retrieved - later changes are included in the duplicate 

 

SPT-1218 User who first created document still has read-only access when their 

permissions are removed

 

SPT-1677 ALL CAPS text is displayed with additional spacing in the Edit Portion 

dropdown

 

SPT-1648 Opening an Edit portion document in parallel with others causes issues  

SPT-1645 When logging out with two Editor tabs open (one containing a portion of a 

version), it's not possible to 'Save all changes' in the 'Unsaved changes' modal

 

SPT-1665 Comparison output moves opening words into the wrong position on Scottish 

Bill

 

SPT-1657 XML comparison functionality doesn't handle processing instructions 

appropriately

 

SPT-1627 Incorrect comparison result when an x-ref has been updated within a <mod> https://lawmaker.a

tlassian.net/brows

e/LMS-2836

SPT-993 Updated authentication to the API to prevent api accounts being unnecessarily 

disabled

 

Issue key Summary User support 

ticket 

https://lawmaker.atlassian.net/browse/LMS-2836
https://lawmaker.atlassian.net/browse/LMS-2836
https://lawmaker.atlassian.net/browse/LMS-2836
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What's new in version 16.2?
Version 16.2 of Lawmaker is a minor release containing a number of security and bug fixes.

It was released on 6 June 2024.

Document check updates

A number of changes to the document checks have been included in v.16.2:

New rules

1. Regulation and article numbers in SIs and SSIs should end with a full stop.

2. Unnumbered paragraphs shouldn’t start with a quote mark - this suggests that the unnumbered paragraph has incorrectly been used to create a 

definition or a textual amendment.

3. Highlight cases where the "Other Date" option has been used when setting the dates in an SI/SSI to ensure the user double-checks that the correct 

option has been selected.

4. Highlight cases where a quoted structure containing a partial element has been imported from Legislation.gov.uk  (e.g. a quoted structure 

containing only a heading) so it can be altered to work correctly with Lawmaker.

5.  Step elements should have a number in the form “Step x”.

6. Identify nested <mod> elements and provide a quick option to delete them.

7. Chapter numbers in citations in footnotes should have a space between “c.” and the number, e.g. “c. 13”

8. SI and SSI citations in footnotes should be formatted correctly, e.g. “S.I. 2024/34” or “S.S.I. 2023/1234”.

Updates to existing rules

1. The rule that identifies missing quotation marks at end of quoted structure is now mandatory rather than advisory. 

2. The rule that identifies leading and trailing spaces has been extended to include “figure spaces” which are created by the autocorrect feature when a 

user types in two spaces in a row.

List of issues

SI/SSIs

Amendments

SPT-1684 Fixed a bug where the date picker on the Update Document Information modal for 

Acts appeared below rather than above the date field

 

SPT-1669 Fixed a bug where adding too many subjects to an SI/SSI caused the save/cancel 

buttons to disappear

 

SPT-1583 Fixed a bug where the ‘Copy to another Project’ action always stripped out the 

Procedural rubric in SIs

LMS-2657 

SPT-1601 Fixed a bug which caused the ‘Copy to Another Project’ action to fail when copying 

SIs where the procedure had been changed

LMS-2722 

Issue key Summary User support 

ticket

http://legislation.gov.uk/
http://legislation.gov.uk/
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2657
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2722
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Editor

SPT-1681 Fixed a bug which caused draft amendments to be pulled into Groupings lists  

SPT-1630 Fixed a bug where Auto-apply appears to succeed for a simple "leave out" 

amendment but the amendment is not applied and disappears in the editor

LMS-2741 

SPT-1625 Fixed a bug where auto-applying a "leave out and insert" amendment which 

leaves out the end of the last line in a Quoted Structure caused the new text to be 

inserted in the "following text" after the Quoted Structure

LMS-2732 

SPT-1622 Fixed a bug which caused new amendments in a LoDA to become locked for 

editing after 5 minutes

 

SPT-1613 Fixed a bug which caused amendment text inside Quoted Structures to overlap or 

render incorrectly in the Amendment Preview window

LMS-2702 

SPT-1610 Fixed a bug which caused duplicate IDs to be generated for the date block in a 

Lords Running list when using the Document Information panel to update the list 

date

LMS-2794 

SPT-1342 Fixed a bug which caused a ‘null values’ error message to appear when creating 

an Official List

LMS-1356 

SPT-1306 Fixed a bug which prevented Dnums being assigned to Inline amendments  

Issue key Summary User support 

ticket

SPT-1675 Fixed an issue which made it difficult to select a Quoted Structure’s Following Text 

with the mouse after cutting a provision in the document

 

SPT-1666 Fixed a bug which caused the document to become locked when Saving if there 

were ‘Surround’ tracked changes 

 

SPT-1643 Improved importing from http://legislation.gov.uk so that imported formulae no 

longer contain unexpected XML attributes (“altimg”)

LMS-2865

SPT-1652 Improved importing from http://legislation.gov.uk  so that imported formulae no 

longer contain unexpected XML attributes (“overflow”)

 

SPT-1636 Fixed a bug where restoring from an auto-save does not restore changes made to 

the Preface or Preamble of an SI

 

SPT-1607 Improved renumbering to take account of tracked changes: deleting sections in 

the main Body of a document with change tracking enabled and then renumbering 

no longer deletes the content of all subsequent <Num> elements and instead 

renumbers correctly

 

SPT-1606 Improved renumbering to take account of tracked changes: deleting paragraphs in 

Schedules with change tracking enabled and then renumbering no longer causes 

numbering to restart from 1 after the next Schedule Part following the deleted 

paragraph

LMS-2770 

SPT-1599 Fixed a bug where using the undo function in the Editor sometimes resulted in 

auto-save versions not being restored correctly

LMS-2755 

SPT-1443 Fixed a bug which caused comments to be lost when splitting a provision LMS-1742 

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2741
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2732
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2702
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2794
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1356
http://legislation.gov.uk/
https://lawmaker.atlassian.net/browse/LMS-2865
http://legislation.gov.uk/
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2770
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2755
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1742
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Accessibility and misc

PDFs

Security

SPT-1318 Fixed a minor bug which caused extra XML tag indicators to appear in unexpected 

locations in the Editor (visible with ‘partial tag’ mode enabled)

 

SPT-388 Fixed several recurring exceptions/log messages which were related to the 

functioning of the Editor

 

SPT-1574 Fixed an issue with the handling of single and double spaces in tracked changes 

mode.

 

SPT-1620 Fixed an issue where the Copy Provisions dialog box wouldn’t list provisions if 

there were unexpected newline characters in the XML

 

SPT-1621 Accessibility improvements: made it possible to use the keyboard to select and 

navigate between radio buttons in several menus using the arrow keys

 

SPT-1550 Fixed an issue which prevented extraction of ZIP files downloaded from Lawmaker 

where the version name contained a special character

LMS-2472 

SPT-1537 Increased the character limit for drop-down menus throughout Lawmaker  

Issue key Summary User support 

ticket

SPT-1594 Fixed a bug where the presence of some forms of tracked changes caused PDF 

generation to fail

LMS-2703 

SPT-1639 Corrected the margins on first page of the House Bill PDF of a UK Private Bill LMS-2957 

SPT-1549 Fixed a bug which caused incorrect rendering of tables and footnotes when 

footnotes appeared on text inside long table cells

LMS-2479 

SPT-571 Corrected minor formatting errors in Lords Amendment List PDFs  

SPT-1655 Fixed a bug where the Explanatory Notes statement at the start of a UK Public Act 

was pushed onto the second page of the PDF if the Act title is long

 

SPT-1626 Fixed a bug which caused line numbering to stop when generating a 'changes 

applied' PDF of an amended version of a bill

LMS-2832 

Issue key Summary User support 

ticket

SPT-1659 ITHC 16 - Session Token in URL  

SPT-1661 ITHC 21 - Vulnerability Within Third-Party Library  

SPT-1660 ITHC 19 - Deprecated HTTP Security Header  

SPT-1658 ITHC 15 - Raw Database Query  

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2472
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2703
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2957
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2479
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2832


457

What's new in version 16.1?
Version 16.1.0 is a minor release containing a number of bug fixes and minor improvements.

It was released on 13 May 2024.

List of issues fixed

SI/SSIs

Auto-application of amendments and inline amendments

SPT-1604 Fixed a bug where running Finalise on an SI or SSI removes the Table of 

Content if there is an x-ref in any of the provision headings.

LMS-2552 

SPT-1533 Fixed a bug where copying a Part containing a Regulation, Article or Rule from 

Word and pasting it into Lawmaker can create incorrect structure.

LMS-2392 

SPT-1530 Fixed a bug where the Made and Laid dates at the start of an SI or SSI span 2 

lines if the time/date is too long.

LMS-2361 

SPT-1553 Fixed a bug where hyperlinks and email addresses included in Explanatory 

Notes can cause text to overlap.

 

SPT-1549 Fixed a bug where the presence of footnotes in long table cells caused large 

gaps and unexpected page breaks to appear in the PDF output.

LMS-2479 

SPT-1544 Fixed a bug where editing the Subjects in an SI or SSI using the Edit Subjects 

modal causes the editor page to attempt to reload.

 

SPT-1423 Fixed a bug where customised border styles on commencement tables did not 

appear in the generated PDF.

 

Issue key Summary User support 

ticket

SPT-1640 Fixed a bug where the Create button in the Apply Amendments modal could 

be clicked even though there was no published Bill version.

 

SPT-1638 Fixed a bug which made it possible to create two Bill working versions with the 

same version label by creating new versions from the Apply Amendments 

modal.

 

SPT-1593 Fixed a bug where the Accept All amendments button didn’t work (due to 

incorrect amendment mark-up in the Editor) and no error message was 

displayed.

LMS-2686 

SPT-1267 Fixed a bug where applying an amendment which changed text spanning 

across the beginning of quoted structures could create bad XML.

LMS-305 

SPT-1551 Fixed a bug where applying an amendment which changed text spanning 

across the beginning of quoted structures within other quoted structures could 

create bad XML.

 

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2552
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2392
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2361
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2479
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2686
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-305
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Amendments and amendment lists

Editor

SPT-1538 Fixed a bug where performing certain actions in an Inline LoDA caused an error 

message to appear in the Editor.

 

SPT-1605 Fixed a bug where whitespace characters were being added to Consolidated 

Lists of Amendments and Ping Pong LoDAs, causing unnecessary document 

check errors.

 

SPT-1578 Fixed a bug where using the Duplicate function on a LoDA which was previously 

Moved between published Bill versions would cause the duplicated version to 

revert to being associated with the original Bill version.

 

SPT-1566 Improved the Create new LoDA modal to make it possible to add a custom 

Stage name when creating a new LoDA.

 

SPT-1420 Fixed a bug where using the Update Proposer/Supporter modal (accessible 

from the right-click menu) can cause an endless loading spinner to appear.

 

Issue key Summary User support 

ticket

SPT-1572 Fixed an issue where, if your Lawmaker session timed out while editing a 

portion of a document in the Editor, the whole document would be reloaded 

instead of the portion when you logged back in.

 

SPT-1634 Fixed a bug where changes to the Following Text after a quoted structure were 

not marked up as changes despite change-tracking being enabled.

 

SPT-1586 Fixed a bug that could cause performance issues due to an infinite loop in the 

code which powers the Editor.

 

SPT-1557 Fixed an issue where it was possible to create multiple Body elements in a 

single document.

 

SPT-1528 Fixed a bug where pressing Ctrl+C to copy text sometimes caused your Editor 

window to scroll up, losing your position in the document.

 

SPT-1505 Fixed a bug causing numerous “duplicate unique value” document check errors 

to appear in Financial Resolution and Schedules after renumbering certain 

provisions.

LMS-989 

SPT-1491 Fixed an issue where manually selecting the text of a section’s <num> and 

typing over it with another number would create bad XML.

 

SPT-1489 Fixed a bug which prevented the reordering of schedules using the Structure 

view.

LMS-1933 

SPT-1387 Fixed a bug where copying and pasting part of a line of text formatted in bold, 

italic, or underline would cause the whole string to be pasted rather than the 

selected text.

LMS-1442 

SPT-1314 Fixed a bug where the number of table columns was incorrectly calculated 

when using the right-click menu to merge the first row’s cells.

 

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-989
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1933
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1442
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Compare documents

PDF generation

SPT-1271 Fixed a bug which caused duplicate IDs and document check errors to appear 

when pasting elements containing footnotes.

LMS-420 

SPT-1227 Fixed a bug where updating proposer and supporter information in an 

amendment list sometimes caused the cursor position to be moved to an invalid 

location, preventing further editing until a valid position was clicked.

 

SPT-1208 Fixed a bug which caused undesirable nesting of comments and duplication of 

provisions when pushing or pulling provisions between working versions and 

choosing to include comments.

LMS-860 

LDAPP-4421 Fixed a bug which prevented opening the right-click menu on Schedules and 

Parts of Schedules in the Structure View.

 

SPT-1465 Fixed a bug where using the Finalise Document function from the Project tab 

created occurrence count errors in a working version.

LMS-1624 

SPT-1628 Fixed a bug which created false-positive comparison results when x-refs inside 

provision headings had been updated, even if the text of those x-refs hadn't 

changed at all.

 

SPT-1584 Fixed a bug which caused comparison to fail with an 'operation timed out' error, 

due to an XML parsing problem.

LMS-2576 

SPT-1255 Fixed a bug which prevented comparison of document versions if a comment 

had been added in an unusual location.

LMS-967 

SPT-825 Implemented further refinements to the comparison output when comparing 

quoted structures.

 

Issue key Summary User support 

ticket

SPT-1590 Fixed a bug where the running headers in a Bill would sometimes overlap with 

main content if the short-title and Part titles were long.

LMS-2548 

SPT-1527 Fixed a bug where the running header at the start of a Bill would overlap with 

the Table of Contents if the Bill’s title was long.

 

SPT-1589 Fixed a bug which caused change-tracking mark-up to be rendered incorrectly 

in quoted structures.

LMS-2655 

SPT-1576 Fixed a bug which caused a New Section amendment to be incorrectly aligned 

in the PDF of a Scottish Bill.

LMS-2445 

SPT-1536 Improved line numbering so that images now contribute to the count of line 

numbers on a page.

LMS-2377 

SPT-1539 Fixed a bug which added extra space to a PDF when a quoted structure 

containing cross-heading was followed by a cross-heading.

LMS-2429 

SPT-1148 Fixed a bug where the PDF output would not display new rows added to a table 

if those rows had been added with change-tracking turned on.

 

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-420
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-860
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1624
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2576
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-967
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2548
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2655
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2445
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2377
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2429
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Accessibility

SPT-950 Further refinements to the display of tracked changes in PDF output, to prevent 

overlapping text.

 

SPT-1624 Fixed a bug where the wrong version content would be copied when duplicating 

an 'Auto backup' snapshot of a working version.

LMS-2872

 

SPT-1619 Fixed a bug where using the keyboard to select Save in the Insert/Update J-

ref modal caused an unnecessary warning banner to appear in the Editor.

 

SPT-1612 Fixed an issue where the selection pane in the Edit portion of a document 

modal would disappear when zoomed in.

LMS-2810 

SPT-1603 Fixed a bug which made it impossible to close the Auto-save version 

detected modal using the keyboard.

 

SPT-1555 Fixed a bug which would cause keyboard focus to be lost in the Generate PDF 

modal.

 

SPT-1504 Improved navigation and selection of radio buttons in various modals 

throughout Lawmaker.

 

SPT-1503 Improved keyboard navigation and selection of confirm/cancel in various other 

modals throughout Lawmaker.

 

SPT-1496 Improved keyboard navigation of the Structure View in the Editor.  

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/browse/LMS-2872
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2810
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What's new in version 16?
Version 16.0.0 of Lawmaker introduces some new features, updates the look and feel of the Editor and includes some bug fixes.

It was released on 23 March 2024.

New features and improvements

Large print PDFs

There is now an option when generating a PDF of a document (e.g. Bill, SI, amendment list) to produce a large print version. That will 

produce a PDF where all the text is 20pt Arial to aid readability. This is a general features designed to work across all document types but 

there may still be some edge cases where the output isn’t perfect (e.g. numbers may overlap with text in certain circumstances and text in 

tables may overlap between cells) and we’ll be improving this feature in future versions based on additional feedback.

See Generating and viewing a PDF  .

 

Generation of PDFs and publishing documents in the background

Rather than having to wait until the operation is complete, you can now continue to work when doing the following:

Generating a PDF (from the Project tab or within the Editor)

Publishing a document

Importing a document from legislation.gov.uk

A notification will appear at the bottom of the screen indicating that the operation is in progress. When the operation is finished, you’ll see 

another notification pop up at the bottom of the screen. In the case of PDFs, you can click on the notification to open the PDF.

New version of Oxygen Web Author

The Editor in Lawmaker is now based on Oxygen Web Author version 25.1.

Sample large print PDF output

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197


462

This brings a number of minor improvements and fixes but also changes the look and feel of some aspects of the Editor. Specific things to 

note:

the design of the panels at the right hand side  (e.g. Document Checks and Document Information) has changed so icons are used instead of names.

Find and replace (ctrl+F) now appears as a panel on the right hand side rather than as a dialog box.  makes it easier to see both the search panel 

and the document with results highlighted. Moreover, it makes it possible to see all search results at a glance without having to scroll through the 

document.

A Tags Display Mode switcher was added directly in the breadcrumb bar to make it easier to change the amount of Tags that are displayed when 

exploring the document structure.  

Upgrading the version of Oxygen also resolves some security flaws present in earlier versions.

 

UK and Scottish Bills - Order of Consideration validation

When you save changes to an Order of Consideration (accessed on the Amendment Manager Tab), Lawmaker will now validate that every 

clause/section/schedule mentioned in the updated Order exists in the published version of the Bill. This enables you to fix the issue before it 

results in issues when you try and generate an amendment list based on the Order.

Cancelling Save operation

You can now cancel a save operation mid-way through and be able to continue working on the document or retry saving it.

To cancel the save, click on the banner at the bottom of the screen. The banner will change when the save operation gets to a point when it 

can no longer be cancelled.

When you cancel a save: you will be taken back to the Editor, your document will be as it was before the save, and you will be able to make 

further changes to it. The save button should be activated allowing you to  restart the save operation.

This is particularly to help in the situation reported by users in some organisations that the save operation gets stuck at 0% or later but it 

may also be useful where you have triggered a save on a large document by accident and don’t want to wait until it is complete.
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As part of these changes, we’ve also improved the robustness of the save operation generally so that the progress bar will be skipped if it is 

likely to cause problems (due its reliance on Websocket technology which can be blocked in some networks).

See Saving your document  

Auto-application of amendments - checking for page/line information

Before attempting to apply any amendments to a Bill, Lawmaker now checks that the Bill version you are applying amendments to contains 

the necessary page and line information. This is to prevent the case where all amendments fail to apply due to the Bill version not having 

page and line information embedded within it.

Improved sorting of ping pong motions in the Lords - amendments to amendments

When generating a Lords daily sheet or marshalled list etc. of motions and amendments during ping pong, the sorting algorithm now takes 

account of any line number mentioned in amendments to amendments to sort them in the correct order if there is more than one relating to 

the same amendment.

Changes to XML mark-up for tables

To aid standard compliance and accessibility, the XML mark-up used to represent tables (which is based on the XHTML standard) has been 

updated to use <th> elements for cells in a header row rather than <td> elements. There is no different from a presentation perspective, in 

the Editor or in PDFs.

Document check improvements

A number of improvements have been made to Document checks. These include fixes to existing checks and new rules:

New rules

1. Any manual page breaks that have been inserted in the document will now show up in the document check panel to make it easier to find and delete 

them when no longer needed - LMS-913: Add a document check for page breaks in a document DONE .

2. A warning will appear if a table cell in a Bill contains complex content such as a quoted structure or a nested table because it may affect line 

numbering.

3. Definitions that contain two separate text paragraphs will be highlighted as it is likely that these were intended to be two separate definitions. This can 

sometimes happen when a user copies and pastes the content of a definition or uses shift+Enter to insert an additional paragraph.

4. Empty definition elements, where everything has been deleted other than the definition element itself, are now highlighted and a quickfix option to 

delete the empty element is provided (LEGDEV-6125).

5. Placeholders that contain text when they should be empty are highlighted. This happens when attempts are made to overwrite the content of 

placeholders in a document that show key document info (e.g. the document title). It can also occur when the placeholders in templates that should 

disappear when you type into them don’t disappear for some reason. Quickfix options are provided to resolve the issue (by either deleting deleting 

the text or deleting the placeholder element, depending on the specific issue).

6. Provisions containing opening words but no child provisions (e.g. a subsection with no child paragraphs) are highlighted with an option to convert the 

opening words back to normal content. Usually Lawmaker will do this automatically but the document check provides an additional way to pick up 

any cases left behind. (LMS-1642)

7. Any provisions that contain two number elements rather than just one are highlighted and a quickfix provided to delete the second number element (

LMS-2019: Companies (Registered Office Address) Regulations 2024 RESOLVED ). All provisions should have a maximum of one number 

element but sometimes by copying and pasting a provision can end up with more than one.

8. Highlight cases where an unnumbered paragraph has been used to create something looking like a numbered paragraph when a numbered 

provision type (e.g. a “paragraph (a)” or “subsection (1)”) should have been inserted instead (LEGDEV-6090).

Fixes and updates to existing rules

1. The check for correct numbering format now works correctly in relation to paragraphs within EU articles( LMS-2295: Improve handling of EU para

graphs in quoted structures FEATURE LOGGED  )

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659
https://lawmaker.atlassian.net/browse/LMS-913
https://lawmaker.atlassian.net/browse/LMS-913
https://lawmaker.atlassian.net/browse/LMS-913
https://lawmaker.atlassian.net/browse/LMS-913
https://lawmaker.atlassian.net/browse/LMS-2019
https://lawmaker.atlassian.net/browse/LMS-2019
https://lawmaker.atlassian.net/browse/LMS-2019
https://lawmaker.atlassian.net/browse/LMS-2019
https://lawmaker.atlassian.net/browse/LMS-2295
https://lawmaker.atlassian.net/browse/LMS-2295
https://lawmaker.atlassian.net/browse/LMS-2295
https://lawmaker.atlassian.net/browse/LMS-2295
https://lawmaker.atlassian.net/browse/LMS-2295
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2. Schedule numbers are now allowed to be in the format of "Appendix x" as well as "Schedule x"  ( LMS-1807: Sometimes we use Appendices rath

er than Schedules RESOLVED  )

3. Fixed the issue causing false positives where amendment's stage doesn't match the Consolidated List stage because of the addition of the Bill 

number to the list stage version.

4. Fixed an issue causing false positives in relation to two lists back-to-back in an SI’s explanatory note ( [LMS-2302] Explanatory notes and an error 

message - Jira Service Management (atlassian.net))  

5. Errors like “"Advisory: There is only one schedule so its number should be "Schedule" not "Schedule 3" no longer show when opening a single 

schedule with Edit portion of document feature. 

New organisations

The following organisations have been added to Lawmaker:

The Church of England (SPT-1556)

The Attorney Generals Office (SPT-1440)

Bug fixes

SPT-1579 Fixed an issue where UK amendments created before an "as introduced" bill 

is published cannot be viewed in the Amendment Manager tab and therefore 

can’t be submitted

LMS-2351 

SPT-1559 Fixed an issue that could stop line numbering appearing in a PDF of a Bill if it 

contained a table with a heading row somewhere other than the top of the 

table.

 

SPT-1547 Fixed an issue in Scottish Bills that caused line numbering to stop in the PDF 

if the document contained a quoted structure with an indent set to  “indent -1” 

LMS-2471 

SPT-1545 Fixed an intermittent issue that could cause submission of a amendment list 

containing a large number of amendments to stop part-way through. The fix 

should also improve performance when submitting a large number of 

amendments.

LMS-2351 

SPT-1520 Fixed an issue that led to the auto-apply amendments feature failing entirely 

in certain cases where the XML markup of the amendment or  Bill provision 

was complex.

LMS-2288 

SPT-1494 Fixed an issue where individual whitespaces inserted in tracked changes 

mode didn’t shown in the PDF of SI as being a tracked change.

LMS-1835 

SPT-1460 Fixed an issue with Following text after a quoted structure which was 

misplaced in the PDF in the case of a Schedule inserted within a quoted 

structure in a Schedule.

LMS-1834 

SPT-1340 Fixed an issue preventing users from updating an amendment to “on hold” 

because the system has retained a lock on the amendment despite it being 

deleted from all amendment lists.

LMS-1334 

SPT-1267 Prevented amendments which span a quoted srtucture from being auto-

applied because it leads to corrupt XML. (This is a temporary fix until a way 

is found to make amendments of this type auto-apply correctly.)

LMS-305 

SPT-678 Fixed an issue that prevented different images with the same filename being 

inserted into documents in different projects

 

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/browse/LMS-1807
https://lawmaker.atlassian.net/browse/LMS-1807
https://lawmaker.atlassian.net/browse/LMS-1807
https://lawmaker.atlassian.net/browse/LMS-1807
https://lawmaker.atlassian.net/browse/LMS-1807
https://lawmaker.atlassian.net/browse/LMS-2302
https://lawmaker.atlassian.net/browse/LMS-2302
https://lawmaker.atlassian.net/browse/LMS-2302
https://lawmaker.atlassian.net/browse/LMS-2351
https://lawmaker.atlassian.net/browse/LMS-2471
https://lawmaker.atlassian.net/browse/LMS-2351
https://lawmaker.atlassian.net/browse/LMS-2288
https://lawmaker.atlassian.net/browse/LMS-1835
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1334
https://lawmaker.atlassian.net/browse/LMS-305
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What's new in version 15.3.1?
Version 15.3.1 is a patch release to address an issue where PDF generation fails if the document contains a quoted structure, the last 

provisions of which contain tracked change mark-up, e.g. because they have been inserted with tracked changes mode on. The issue 

occurred in particular when generating comparison versions of documents (SPT-1580, LMS-2655).

(The issue was introduced by another fix in v.15.3.0 (SPT-1535) relating to formulas in quoted structures.)

Version 13.3.1 was released on 30 January 2024.

 

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2655
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What's new in version 15.3?
Version 15.3.0 is a minor release containing a number of bug fixes.

It was released on 16 January 2023.

List of issues resolved

Amendments

PDFs

SPT-1529 Fixed a bug where amendments could be moved or copied 

between Stages without a Bill Version being assigned, 

resulting in amendments disappearing from the Amendment 

Manager tab

LMS-2351 

SPT-1472 Fixed a bug where certain text characters become wrongly 

encoded and display strangely in a saved snapshot version

 

SPT-1427 Fixed a bug which caused a validation error to occur whenever 

a new provision was pasted into an Inline amendment 

document

 

SPT-1413 Fixed a bug which caused textual amendments containing x-

ref tagging to be incompletely applied to the bill text when 

using the auto-apply function

LMS-1087 

SPT-1316 Fixed a bug where the ‘Save as’ function on a temporary 

amendment list would fail if the user pressed Enter to confirm 

the creation of the new list rather than clicking the button in the 

modal

LMS-1226 

SPT-1278 Improved the paste function to allow users to paste ping pong 

motions after component amendments in a Marshalled List

LMS-1004 

Issue key Summary User support ticket

SPT-1492 Last row of a table is pushed onto the next page with the 

Explanatory Note

LMS-1947: Problem with ta

ble formatting RESOLVED  

SPT-1485 PDF Rendering Issue and Duplicate Name Display in Manage 

Members

 

SPT-1477 Line Numbering Stops when footnotes are enabled  

SPT-1461 Blank page between last schedule and Explanatory Note LMS-1834: FW: 20230907- 

ERRORS - The Armed Forces 

Pensions (Remediable Servic

e) Regulations 2023

RESOLVED  

Issue key Summary User support ticket

https://lawmaker.atlassian.net/browse/LMS-2351
https://lawmaker.atlassian.net/browse/LMS-1087
https://lawmaker.atlassian.net/browse/LMS-1226
https://lawmaker.atlassian.net/browse/LMS-1004
https://lawmaker.atlassian.net/browse/LMS-1947
https://lawmaker.atlassian.net/browse/LMS-1947
https://lawmaker.atlassian.net/browse/LMS-1947
https://lawmaker.atlassian.net/browse/LMS-1947
https://lawmaker.atlassian.net/browse/LMS-1947
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
https://lawmaker.atlassian.net/browse/LMS-1834
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Editor

Misc

SPT-1396 Partial selection when generating PDF, selects additional 

elements

LMS-1478: Partial selection 

when printing RESOLVED  

SPT-1395 Large Brackets not rendering in the PDF LMS-1501: Brackets missin

g from maths formula in pdf

RESOLVED  

SPT-1192 Some Characters not rendering in PDF  

SPT-1189 Characters fail to render in formulas  

SPT-906 ToC included when selecting multiple provisions to PDF.  

SPT-1484 Fixed a bug that caused all changes to a document to be undone when 

clicking Save if the Undo function had been used on first opening the 

document

LMS-1922 

SPT-1480 Fixed a bug where changing the Document Type of a Quoted Structure 

caused the DocName XML attribute to be cleared, resulting in incorrect 

formatting in the PDF

LMS-1898 

SPT-1464 Fixed a bug where leading whitespaces were inserted in the preface of SIs 

and SSIs whenever changes were made using the Document Information 

panel in the editor

LMS-1817 

SPT-1436 Fixed a potential Oxygen infinite loop bug which could cause high CPU 

usage on the server

 

SPT-1394 Fixed a bug that caused the Department field on the ‘Insert Signature 

Block’ and ‘Update Signature Block’ modals to show ‘null’ if a custom value 

was typed in

 

SPT-1245 Accessibility: improved keyboard navigation of drop-down menus which 

contain checkboxes, for example in the ‘Generate PDF’ and ‘Bulk update 

statuses’ modals 

 

Issue key Summary User support 

ticket

SPT-1473 Removed the ‘Delete’ option from the menu that appears against published 

versions of Official Lists, since these versions cannot be deleted

 

SPT-1159 API updated for consistency so no endpoints require “accept-

application/xml” header (previously some did and some did not) 

LMS-455  

Issue key Summary User support 

ticket

https://lawmaker.atlassian.net/browse/LMS-1478
https://lawmaker.atlassian.net/browse/LMS-1478
https://lawmaker.atlassian.net/browse/LMS-1478
https://lawmaker.atlassian.net/browse/LMS-1478
https://lawmaker.atlassian.net/browse/LMS-1478
https://lawmaker.atlassian.net/browse/LMS-1501
https://lawmaker.atlassian.net/browse/LMS-1501
https://lawmaker.atlassian.net/browse/LMS-1501
https://lawmaker.atlassian.net/browse/LMS-1501
https://lawmaker.atlassian.net/browse/LMS-1501
https://lawmaker.atlassian.net/browse/LMS-1501
https://lawmaker.atlassian.net/browse/LMS-1922
https://lawmaker.atlassian.net/browse/LMS-1898
https://lawmaker.atlassian.net/browse/LMS-1817
https://lawmaker.atlassian.net/browse/LMS-455
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What's new in version 15.2?
Version 15.2 is a minor release containing a number of bug fixes.

It was released on 29 November 2023.

List of issues fixed

Amendments and amendment lists

PDF generation

SPT-1515 Fixed a bug that resulted in LoDAs that were created by saving an 

ephemeral list not behaving correctly (deployed initially as a patch 

release in v.15.1.1)

LMS-2269 

Issue key Summary User support ticket link

SPT-1497 Fixed a bug that resulted in the footnotes near the bottom of a 

page being sequenced and numbered incorrectly.

LMS-2003 

SPT-1478 Fixed a bug that resulted in the starting quotes of a quoted 

structure containing a table being missing if the first cell in the 

table is empty.

LMS-1864 

SPT-1459 Fixed a bug that led to hyperlinks not working in the PDF when 

the hyperlink was followed by certain characters.

LMS-1834 

SPT-1453 Fixed a bug that meant that multiple paragraphs on different 

lines(created using shift+enter) were rendered as one paragraph 

in the PDF if they appeared in a Scottish Bill or SI/'SSI.

LMS-1797 

SPT-1449 Fixed a PDF bug where the heading in table of commencement 

orders read “Orders” in the Editor but showed as “Order” in the 

PDF

LMS-1794  

SPT-1444 Fixed a PDF formatting issue LMS-1716 

SPT-1442 Last formatted character in a definition causes the end-quote to 

take on the same properties.

LMS-1744: Closing quotes i

n a defined term in subscript

RESOLVED  

SPT-1438 Tracked change markup causing PDF generation to fail (Oxygen)
LMS-1725: Pdf rendering keeps failing

COMPLETED  

SPT-1437 Tracked change markup causing PDF generation to fail (RenderX)
LMS-1725: Pdf rendering keeps failing

COMPLETED  

SPT-1434 Quoted Structure ending in Footnote not rendering in PDF correctly

SPT-1509 Footnotes in same row of table displayed in wrong order LMS-1891: Footnote order

RESOLVED  

SPT-1261 Render PDF modal - amendments dropdown misformatted text content

Issue key Summary User support ticket link

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2269
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-2003
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1864
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1834
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1797
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1794
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1716
https://lawmaker.atlassian.net/browse/LMS-1744
https://lawmaker.atlassian.net/browse/LMS-1744
https://lawmaker.atlassian.net/browse/LMS-1744
https://lawmaker.atlassian.net/browse/LMS-1744
https://lawmaker.atlassian.net/browse/LMS-1744
https://lawmaker.atlassian.net/browse/LMS-1744
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1725
https://lawmaker.atlassian.net/browse/LMS-1891
https://lawmaker.atlassian.net/browse/LMS-1891
https://lawmaker.atlassian.net/browse/LMS-1891
https://lawmaker.atlassian.net/browse/LMS-1891
https://lawmaker.atlassian.net/browse/LMS-1891
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Editor

Accessibility

Misc

SPT-1499 Update X-refs is changing Schedule wording LMS-2002: Updating Xrefs

RESOLVED  

SPT-1474 Quick fix in the Document Check panel not working when the Oxygen editor is first opened

Issue key Summary User support ticket link

SPT-1233 Navigating between amendments in Amendment Preview modal doesn't announce DNum

SPT-1172 Accessibility issues with the Update Document Information modal

SPT-1108 Accessibility issues with the Move/Copy Amendments modal  

SPT-663 Accessibility - update ARIA roles in the top-right dropdown on Dashboard

SPT-635 Accessibility - modals - adaptable content  

SPT-634 Accessibility - modals - error messages  

Issue key Summary User support ticket link

SPT-1431 Improve exception handling for missing doc version records  

SPT-1356 LMAR090-UTN - Investigate automatic mounting of credentials for the default service account in 

each namespace

SPT-1320 Project and Folder visible to users who shouldn't be able to see it. LMS-1225: Restricted proje

ct is now showing despite restri

ctions RESOLVED  

SPT-747 Pen Test Issue - Cookie Without Secure Flag  

SPT-743 Pen Test Issue - Default Pages Present  

SPT-1166 Address unauthenticated document access vulnerability  

SPT-1223 Remove OPC's old IP range from Prod Whitelist LMS-898: MFA being requir

ed for each login RESOLVED  

Issue key Summary User support ticket link

https://lawmaker.atlassian.net/browse/LMS-2002
https://lawmaker.atlassian.net/browse/LMS-2002
https://lawmaker.atlassian.net/browse/LMS-2002
https://lawmaker.atlassian.net/browse/LMS-2002
https://lawmaker.atlassian.net/browse/LMS-2002
https://lawmaker.atlassian.net/browse/LMS-1225
https://lawmaker.atlassian.net/browse/LMS-1225
https://lawmaker.atlassian.net/browse/LMS-1225
https://lawmaker.atlassian.net/browse/LMS-1225
https://lawmaker.atlassian.net/browse/LMS-1225
https://lawmaker.atlassian.net/browse/LMS-1225
https://lawmaker.atlassian.net/browse/LMS-898
https://lawmaker.atlassian.net/browse/LMS-898
https://lawmaker.atlassian.net/browse/LMS-898
https://lawmaker.atlassian.net/browse/LMS-898
https://lawmaker.atlassian.net/browse/LMS-898


470

What's new in version 15.1?
Version 15.1 is a minor release containing a number of bug fixes.

It was released on 11 October 2023.

Removing leading and trailing whitespace

In addition to the bug fixes, v.15.1 also includes a new feature to delete all leading and trailing spaces in a document in one go.

To access the new feature in the Editor, from the toolbar use Tools menu>Remove all leading and trailing spaces. You will need to the 

save the document afterwards so that the removal is permanent.

List of issues addressed

SPT-1466 Fixed a bug relating to the locking of provisions in the Editor that may 

have been causing intermittent performance issues.

LMS-1870: LM generally a 

bit sluggish

 

SPT-1463 Fixed an issue where clicking on the save button multiple times (or 

pressing ctrl+s) could result in the Editor becoming unresponsive.

 

SPT-1454 Fixed an issue that was preventing the duplication of consolidated lists 

of amendments and other amendment lists (this was originally 

deployed in v.15.0.3)

LMS-1814: Unable to 

duplicate consolidated list   

SPT-1450 Added  a new feature to enable users to delete all leading and trailing 

spaces in a document with one click, in particular to help resolve an 

issue with older documents containing spaces at the beginning of 

quoted structures.

LMS-1781: Space at the 

beginning of the text   

SPT-1448 Fixed an issue that could potentially have allowed users with document 

administrators to access amendments from other organisations (this 

was originally deployed in v.15.0.2)

 

SPT-1446 Improved error handling when generating consolidated lists of 

amendments (and other amendment lists) so users are properly 

notified when there isn’t a relevant version of the published Bill or there 

is a problem with the XML.

LMS-1769: Can't create 

consolidated list 

SPT-1445 Fixed a regression bug so that generating an amendment list when 

there is an order of consideration works correctly when the Bill has a 

single schedule.

LMS-1759: Unable to 

create a daily sheet  

SPT-1441 Fixed an issue in PDFs of UK Bills where certain headings and 

numbers were being indented too far to the right when they appeared 

in the first line of a quoted structure.

 

SPT-1348 Updated the version of NodeJS used in authentication component to 

address security recommendation LMAR090-6KX

 

SPT-1338 Fixed the behaviour of amendment auto-apply so that spaces between 

words are correctly preserved when there is bold or italic formatting on 

 

Issue key Summary Related user support 

ticket 

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1870
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1870
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1870
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1814
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1814
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1814
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1781
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1781
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1781
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1769
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1769
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1769
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1759
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1759
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1759
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some of the text.

SPT-1317 Fixed an issue in the DMS that resulted in auto-save snapshots 

sometimes being left behind after a full save

LMS-961: Autosaves not 

deleting on save 

SPT-1265 Improved error handling when the publishing of an amendment list fails 

and more logging added to allow root cause to be investigated in 

future.

LMS-1082: Problems with 

publishing an official list

SPT-1191 Fixed an issue causing “ Cannot read properties of undefined 

(reading 'Value') " type errors to appear occasionally when trying 

to create a LoDA or official amendment list.

LMS-657: Null (reading 

'focus') error when 

creating new LoDA 

SPT-1180 The name of the amendment proposer has been restored to the cards 

that appear in the Inline Amendments Panel in the Editor. (The names 

disappeared as a side effect of a previous bug fix and performance 

improvement.)

LMS-281: Auto-applied 

version of bill: clicking on 

an inline amendment is 

slow in big documents 

SPT-1149 Some minor performance improvements when populating a Scottish 

Groupings List.

LMS-624: Groupings 

performing too slowly  

SPT-502 Fixed an issue causing heavily-used user accounts to become disabled 

unexpectedly (only appeared to affect test accounts in practice) 

 

https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-961
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-961
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-961
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1082
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1082
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-1082
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-657
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-657
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-657
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-657
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-657
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-281
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-624
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-624
https://lawmaker.atlassian.net/servicedesk/customer/portal/1/LMS-624
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What's new in version 15.0?
Version 15 introduces a range of new features and improvements together with further bug fixes.

It was released on 30 August 2023.

New features and improvements

Amendments and ping pong

Better number allocation for Lords amendment lists - several improvements have been made here with the result that:

the numbering algorithm used is now the same as that in the Editor for assigning numbers to new provisions so can better cope with complex 

numbers like 4ZABB; and

number allocation to new amendments (in a marshalled or manuscript list) now takes account of all published amendments, not just the amendments 

in a specific list with the result that the numbers automatically allocated should be correct in a much greater range of cases.

There are still limitations in the numbering algorithm that exist in the Editor as well and we’ll look to improve that further in the future. (LMS-

680, LMS-118)

Distinguishing between Commons and Lords versions and stages - some significant changes have been made to how Lawmaker 

manages published versions of Bills to avoid an issue that arose previously where Bills published by the different Houses were treated as 

being the same Bill causing severe problems around amendment management. Now, whenever a Bill is published by the Commons or 

Lords, an additional “Commons” or “Lords” label is added to the version, enabling both Lawmaker and users to clearly distinguish the 

versions even if the version rubric (e.g. “As amended in Committee”) is the same. (LMS-1397)

Sorting ping pong motions by sort code - you can now add a sort code to ping pong motions, as you already can with ordinary 

amendments, to control the order of motions in an amendment list where the motions would otherwise be sorted to the same place in the 

list. This will be particularly useful for amendments to amendments. (LMS-390)

Opening dialog boxes from the Amendment actions menu on the Amendment Manager tab - dialog boxes for Submit amendments 

and other actions now open quicker when working on Bills with a large number of amendments.

Editor - folding

Simplified and improved folding of provisions - “Folding” is the name given to the feature in Lawmaker that allows you to hide provisions 

in the Editor so you can only see the title or number. This can made it easier to navigate around the document and also improves 

performance.

Following feedback from users, we’ve reworked this feature substantially so that:

it only operates at one level, rather than nested levels, so that you can quickly expand and collapse provisions without multiple clicks and so that, 

even when everything is collapses, the overall document structure remains more apparent.

the functionality has been extended across Bills, SIs and amendment lists in a consistent way. It now applies to:

Sections/Clauses, and schedule paragraphs, of a Bill;

Regulations/articles/rules, and schedule paragraphs, of an SI/SSI;

the quoted structure (i.e. the provisions being inserted) by an amendment.

the toolbar in the Editor now has two buttons so you can quickly and easily access the functionality to expand all provisions or collapse all provisions 

(other than the one your cursor is in).

All provisions in a Bill etc. will be open by default when the document is first opened. (You can use the button the toolbar to quickly collapse them if 

needed.)

https://lawmaker.atlassian.net/browse/LMS-680
https://lawmaker.atlassian.net/browse/LMS-680
https://lawmaker.atlassian.net/browse/LMS-118
https://lawmaker.atlassian.net/browse/LMS-1397
https://lawmaker.atlassian.net/browse/LMS-390
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See Folding provisions .

Editor - Validation, document checks and data quality

Improvements to document checks (Schematron) - there were a few updates to the document check validation:

Checks for correct number format will now accept “legal numbering” style (e.g. 3.13B or 1.2);

A new check has been added to highlight where two lists have been inserted back to back (usually occurring within SI explanatory notes - in most 

cases the user intended for there only to be one list) (LPS-92);

A check has been added to identify schedule paragraph numbers in SI quoted structures that are missing a full stop after the number;

A new check highlights any locked numbers that are not within a quoted structure - this helps users manage locks created elsewhere while using the 

Edit Portion feature or the auto-application of amendments feature that may get in the way of subsequent actions (e.g. renumber) (LMS-949, LMS-

1078);

Various rules have been tweaked to remove false positives (LMS-1460, LMS-1452, LMS-1466) include some errors relating to numbering that would 

show when using the Edit Portion feature and errors relating to cross-references within amendments.

Changing quoted structure type - You can now change the document type of an existing quoted structure. This is mainly to allow for the 

correction of cases where the type was set to a UK Act when you want it to be a Scottish Act instead. (Changing the type more substantially, 

e.g. from an Act to an SI, will not convert the provisions within quoted structure.)

XML Data quality improvements - we’ve fixed various issues with unnecessary whitespace being created by the Editor in the XML which 

can cause problems downstream in the publishing workflow, including:

whitespace being added to the preface when converting a Bill into an Act;

whitespace being added when a quoted structure is inserted into a Bill or SI;

unnecessary whitespace in the template for Commons resolutions.

Editor Performance

Some significant changes have been implemented in relation to how locking is managed in the Editor to improve the performance of the 

Editor and make it less dependent on the performance of the back-end servers. This should have an impact particularly when the system is 

under load (i.e. when lots of users are using it at the same time).

Edit portion functionality

This functionality hasn’t changed but a number of issues and edge cases have been resolved, following a thorough review of the existing 

code with the result that the feature should now be more robust. 

Importing legislation from www.legislation.gov.uk

Version 15 introduces a significant new feature, that enables you to import a document or portion of a document from www.legislation.gov.uk 

into Lawmaker. As part of importing the document, you can convert it from primary to secondary and you can also convert retained EU 

legislation. More information on the new feature can be found here: Import legislation from www.legislation.gov.uk .

SI/SSI improvements

Editor formatting of regulations/articles that are divided into paragraphs - we’ve improved the way the Editor handles the presentation 

of regulations containing paragraphs so that there isn’t any overlap between the regulation number, the em-dash that follows it and the 

paragraph number (1) - this was particularly a problem when the regulation number was longer than usual or appeared within a quoted 

structure.

The import feature is still in beta as there are a number of edge cases that may need further refinement in future and some of the 

infrastructure used to support this feature is temporary while we await some important updates to Legislation.gov.uk  . 

Subsequent versions of Lawmaker will update this feature and make it more robust.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339033
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339033
https://lawmaker.atlassian.net/jira/servicedesk/projects/LPS/queues/custom/50/LPS-92
https://lawmaker.atlassian.net/browse/LMS-949
https://lawmaker.atlassian.net/browse/LMS-1078
https://lawmaker.atlassian.net/browse/LMS-1078
https://lawmaker.atlassian.net/browse/LMS-1452
http://www.legislation.gov.uk/
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/186941441
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/186941441
http://legislation.gov.uk/
http://legislation.gov.uk/
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Legal numbering - limited support has been added for legal numbering (i.e. numbering which consists of numbers separated by a full stop, 

e.g. 1.1, 1.2, 3.4A, etc. in regulation/article/rule numbers. In particular, the renumbering and cross-referencing features will now behave 

correctly in relation to them (although some numbers will need to be manually locked). See Legal Numbering  for how to use this number 

format. (LMS-810)

List of support fixes

Editor and misc.

Amendments

PDF generation

SI/SSI

SPT-1424 Incorrect Bill stage version in Information panel  

SPT-1345 Auto-correct for (r) changes it to the trade mark symbol LMS-1371 

SPT-1328 Lawmaker thinks document is already open when it isn't  

SPT-1281 Progress bar stuck on 20% with specific UTF-8 characters  

SPT-1196 Document permissions are being applied to subsequent documents  

Issue key Summary User support ticket

SPT-1424 Incorrect Bill stage version in Information panel  

SPT-1415 Some Lords Members missing from Lawmaker LMS-1634 

SPT-1409 Amendments get assigned to the wrong house when submitted in Oxygen  

SPT-1389 Significant Versions of Official Lists are no longer appearing in the right order LMS-1455 

SPT-1377 Pasting string of text from an amendment's explanatory statement to another results in the editor 

displaying xml

LMS-1415 

SPT-1319 Problems with italic text in Amendments LMS-1258 

SPT-1268 X-refs in amendments are part-duplicated when auto-applied to a bill. LMS-1083 

Issue key Summary User support ticket

SPT-1312 Unusual character in amendment list results in PDF failing to render LMS-1212 

SPT-1406 Cross heading in quoted structure not rendering correctly in the PDF LMS-1588 

SPT-1300 Line numbering stops after a table cell with a schedule paragraph  

SPT-1205 Hyperlinks cut off on line breaks in PDFs LMS-522 

Issue key Summary User support ticket

SPT-1344 Unable to change column width in SI Commencement Tables LMS-1358 

Issue key Summary User support ticket

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/200704012
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/200704012
https://lawmaker.atlassian.net/browse/LMS-810
https://lawmaker.atlassian.net/browse/LMS-1371
https://lawmaker.atlassian.net/browse/LMS-1634
https://lawmaker.atlassian.net/browse/LMS-1455
https://lawmaker.atlassian.net/browse/LMS-1415
https://lawmaker.atlassian.net/browse/LMS-1258
https://lawmaker.atlassian.net/browse/LMS-1083
https://lawmaker.atlassian.net/browse/LMS-1212
https://lawmaker.atlassian.net/browse/LMS-1588
https://lawmaker.atlassian.net/browse/LMS-522
https://lawmaker.atlassian.net/browse/LMS-1358
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SPT-1321 User lost changes when saving SI LMS-1286 

https://lawmaker.atlassian.net/browse/LMS-1286


476

What's new in version 14.2?
Version 14.2.0 is a minor release containing a number of bug fixes.

It was released on 24 July 2023.

List of issues resolved

Amendments   

SPT-1376 Oxygen Error while working on Amendments (already deployed in 14.1.1 patch) LMS-1418 

SPT-1375 Change Members Names Updates to Daily  

SPT-1339 Occurrence counters in Bill XML cause amendment list to sort incorrectly LMS-1337 

SPT-1329 eId attributes in tables within amendments are losing their "akn:" prefix LMS-1291 

SPT-1225 Update x-ref no longer appears to update amendment cross references LMS-899 

SPT-1391 Cannot Create LoDA for Lord Thurlow LMS-1465 

PDF generation   

SPT-1327 Placeholders in commencement history section of SI not being rendered in PDF LMS-1315 

SPT-1323 Paragraph numbers in UK Bills indented incorrectly in PDF when inside a quoted 

structure

LMS-1298 

SPT-1341 Line numbering going wrong when formula at top of page LMS-1331 

SPT-1283 SI/SSI Closing words format incorrect in PDF after Paragraphs LMS-1123 

SPT-1273 SI/SSI Number appears in the PDF of a table with sub-schedule Paragraphs LMS-1069 

LDAPP-4225 Fix line numbering issue between Ping Pong documents affecting the Lords LMS-1351 

SPT-1220 Track Changes in Section Heading and Schedule Cross Heading, PDF shows whole 

section as Tracked

LMS-463 

Editor   

SPT-1217 Tag x-ref fails for certain provisions when section has occurrence counter LMS-863 

SPT-1198 First Schedule in Scottish Bill not numbered  

Issue key Summary User support ticket link

https://lawmaker.atlassian.net/browse/LMS-1418
https://lawmaker.atlassian.net/browse/LMS-1337
https://lawmaker.atlassian.net/browse/LMS-1291
https://lawmaker.atlassian.net/browse/LMS-899
https://lawmaker.atlassian.net/browse/LMS-1465
https://lawmaker.atlassian.net/browse/LMS-1315
https://lawmaker.atlassian.net/browse/LMS-1298
https://lawmaker.atlassian.net/browse/LMS-1331
https://lawmaker.atlassian.net/browse/LMS-1123
https://lawmaker.atlassian.net/browse/LMS-1069
https://lawmaker.atlassian.net/browse/LMS-1351
https://lawmaker.atlassian.net/browse/LMS-463
https://lawmaker.atlassian.net/browse/LMS-863
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What's new in version 14.1?
Version 14.1 of Lawmaker is a minor release containing a number of bug fixes.

It was released on 21 June 2023.

List of issues fixed

SPT-1335 Add 2 new SI organisations  

SPT-1331 Problems accessing the PDR api LMS-1326 

SPT-1330 Published Bill version assigned wrong URI causing amendments to "disappear" LMS-1321 

SPT-1315 SP Dnum spacing regression  

SPT-1309 X-refs to schedules in Scottish bills & SSIs are capitalised after Update X-ref 

operation

LMS-1006 

SPT-1303 X-refs to schedules in Scottish bills and SSIs are capitalised when should be 

lower case

LMS-1006 

SPT-1297 Security - Update base DBS Docker image to remove unused Java files 

(LMAR090-9TU)

 

SPT-1296 Security - //img tags in rendered PDFs vulnerable to SSRF and XXE issues 

(LMAR090-PKE & LMAR090-HMV)

 

SPT-1295 Superscript/subscripts in a table cell cause incorrect line-numbering  

SPT-1274 Order of consideration is applying to all versions of the Bill published from same 

working version

LMS-1109 

SPT-1270 Inline amendment generating incorrect traditional amendment  

SPT-1263 Interstitial headings in Commons Ping Pong Proceedings are being given 

duplicate eIds

LMS-627 

SPT-1250 Hybrid insert amendment involving adjacent quoted structure doesn't work  

SPT-1238 Certain paragraph and sub-paragraph nums in SP Bills cause content to indent 

unnecessarily

 

SPT-1228 Can't publish amendment list when it contains certain amendments LMS-921

SPT-1221 Auto-apply whitespace issues LMS-878 

SPT-1087 Partial Tags are no longer displayed LMS-329

Issue key Summary User support ticket

https://lawmaker.atlassian.net/browse/LMS-1326
https://lawmaker.atlassian.net/browse/LMS-1321
https://lawmaker.atlassian.net/browse/LMS-1006
https://lawmaker.atlassian.net/browse/LMS-1006
https://lawmaker.atlassian.net/browse/LMS-1109
https://lawmaker.atlassian.net/browse/LMS-627
https://lawmaker.atlassian.net/browse/LMS-921
https://lawmaker.atlassian.net/browse/LMS-878
https://lawmaker.atlassian.net/browse/LMS-329
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What's new in version 14?
Version 14.0 contains a number of new features, a new interface for managing users, some performance improvements and a range of fixes 

to support issues that have been raised.

It was released on 24 May 2023.

General features and improvements

Draft watermark on PDFs

When generating a PDF of any document, including SIs and SSIs, you can select to include a “Draft” watermark on every page. See Ge

nerating and viewing a PDF .

Validation improvements

A number of enhancements to the automatic document validation have been included (these show in the Document Checks panel at the 

right of the Editor)

1. A new check identifies sections and schedules in Bills (and regulations/articles etc. in SIs) that have IDs which include an “occurrence counter” 

component. This component indicates that the provision number duplicated another number at some point but the ID should be resolved before doc 

is published or shared.

2. A new check identifies amendments that belong to a different stage from the amendment list that contains them.

3. The existing check on the correct formatting of paragraph numbers, e.g. (a), (b) etc., has been updated to allow for numbers after “z” i.e. (z1), (z2) 

etc.

4. A new check for empty “defined term” elements in definitions in amended Bills.

5. A new check for amendments that appear to be missing a closing quote mark at the end of the amendment instruction.

6. A new check highlighting table cells in Bills that have been vertically merged (because this will cause problems for line numbering in the PDF of the 

Bill).

User management interface

Users who have user administration privileges can create and manage users within their organisation via a new User Administration page. 

See User Administration  . 

Amendment features

Restricting permissions on amendments

You can now restrict permissions on draft lists of amendments (and the amendments in those lists) in the same way that you can restrict Bill 

and SI documents.

See Managing amendment permissions  

Bulk status update of amendments

The existing limited bulk status update feature in the Editor has been replaced with a new feature that enables you to select all or some 

amendments in a list and then apply any valid status transition to the selected amendments. See Updating the status of amendments wit

hin the Editor  .

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/170229761
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/170229761
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60817409
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60817409
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60817409
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Commons Programme motions etc.

Functionality in Lawmaker for handling motions and orders in Commons amendment lists has been improved, particularly in relation to 

programme motions.

Proposers and supporters can be added to a programme motion.

As well as resolutions, it’s now possible to insert a “Motion to amend order” at the beginning of a Commons Marshalled list, to support the format of 

motions that amend existing orders.

It’s now possible to insert an Order directly at the end of a Commons Marshalled list (rather than having to create it a a resolution first at the 

beginning of the list and then convert it to an Order).

Ping pong - add additional headings before amendments within motions and amendments to amendments

Within Ping pong motions, you can now add headings (centred and italic) before individual amendments.  (This is to support the creation of 

lists like https://publications.parliament.uk/pa/bills/lbill/2017-2019/0111/18111-I.pdf).

See Add a heading to an amendment within a ping pong motion  

Ping pong - structure view improvement

Structure view behaviour in the Editor has been improved so that amendments within a ping pong motion as  shown in the structure view 

with the amendment’s instruction text (instead of just “amendment”).

Statutory instruments

SI Subject and Department list updates

The subject list for SIs and SSIs has been updated to correct some errors and add additional subject headings.

The department list used when inserting signature blocks into SIs and SSIs has been updated to reflect recent changes in government.

Extending Finalise Document feature to SIs and SSIs

The Finalise Document feature (accessible from the Actions menu on the Project tab) now works for SIs as well as Bills and enables the 

user to carry out several tasks on the whole document (e.g. updating cross-references and renumbering) with one click.

List of support tickets that have been fixed

SPT-1294 Stability Fix issues where document content can be lost due to duplicate seriesId values  

SPT-1243 Stability Investigate issue with multiple HTTP requests being sent to the server  

SPT-959 Stability Investigate and possibly address the 'sharedExclusive' lock bug in Lawmaker  

SPT-500 Stability Fix the race condition when multiple users save at the same time  

SPT-1293 Editor Moving paragraphs/subparagraphs in quoted structure amendments using Structure View 

is not working as expected

LMS-644 

SPT-1286 Editor Cannot move an amendment using Structure View LMS-1140 

SPT-1254 Compare Comparing paragraphs with definitions results in Error -1 LMS-991 

SPT-1247 Editor Track changes - deleted tracked section displayed as XML in the Editor LMS-875 

Issue key Category Summary User support 

ticket link

https://publications.parliament.uk/pa/bills/lbill/2017-2019/0111/18111-I.pdf
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/173080584
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/173080584
https://lawmaker.atlassian.net/browse/LMS-644
https://lawmaker.atlassian.net/browse/LMS-1140
https://lawmaker.atlassian.net/browse/LMS-991
https://lawmaker.atlassian.net/browse/LMS-875
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SPT-1190 Editor Cannot paste string of text containing a % (Progress Bar stops at 10%) LMS-803 

SPT-1216 Amendments Amendment Preview - quoted structure numbers incorrectly displayed LMS-872 

SPT-1160 Amendments Additional problem with Amendment Filter LMS-821 

SPT-1224 Inline amendments 

and Auto-apply

Inline amendments creating one substitute amendments instead of 2 separates ones LMS-900 

SPT-1202 Inline amendments 

and Auto-apply

Auto-apply: same location amendments failed to apply LMS-732 

SPT-1201 Inline amendments 

and Auto-apply

Auto-apply cards in 'Review' r-h panel sometimes quote DNum and sometimes assigned 

num

LMS-663 

SPT-1200 Inline amendments 

and Auto-apply

If an "insert" type long title amendment fails to apply, it's not reported as not being applied 

in 'Review' rh panel (auto-apply)

LMS-666 

SPT-1194 Inline amendments 

and Auto-apply

Auto-apply mis-counting how many amendments were successfully applied to a bill LMS-811 

SPT-1175 Ping pong Cannot select 'withdrawn before debate' for Lords Ping Pong motions LMS-472 

SPT-1177 PDF Long amendment numbers not rendering correctly in PDF LMS-687 

SPT-1284 PDF In the PDF of a Quoted Structure in an SI/SSIs has extra space when starting with a 

Schedule Paragraph

LMS-1123 

SPT-1144 Session 

management

Application Error when logging out  

SPT-1239 Session 

management

Browser not returned to login page on session timeout if there have been changes in the 

Editor

 

https://lawmaker.atlassian.net/browse/LMS-803
https://lawmaker.atlassian.net/browse/LMS-872
https://lawmaker.atlassian.net/browse/LMS-821
https://lawmaker.atlassian.net/browse/LMS-900
https://lawmaker.atlassian.net/browse/LMS-732
https://lawmaker.atlassian.net/browse/LMS-663
https://lawmaker.atlassian.net/browse/LMS-666
https://lawmaker.atlassian.net/browse/LMS-811
https://lawmaker.atlassian.net/browse/LMS-472
https://lawmaker.atlassian.net/browse/LMS-687
https://lawmaker.atlassian.net/browse/LMS-1123
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What's new in version 13.3.2?
Version 13.3.2 is a patch release to address a specific issue with the line numbering of tables in PDFs. 

The patch makes a small change to the formatting of structured content within table cells. It removes additional spacing between certain 

elements in order to preserve consistent line alignment across cells in the same table row. This should result in consistent line numbering.

The release was deployed on 12 May 2023.
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What's new in version 13.3?
Version 13.3.0 is a minor release delivering various performance improvements to amendment handling and a range of bug fixes.

It was released on 3 April 2023.

Amendment performance
Version 13.3 contains improvements to the following aspects of amendment handling:

Publishing amendments - publishing a large number of amendments should now be significantly faster.

Submitting amendments - submitting amendments from a draft list of amendments (using the “Submit list” option) performs significantly faster and 

can handle large numbers of amendments (e.g. up to 400 amendments) without difficulty.

Amendment manager tab - The time taken to generate the Amendment Manager tab when there are a lot of amendments should be significantly 

reduced and should be much less affected by the size of the Bill to which the amendments relate.

Amendment Workspace and Official Lists tab - performance improvements have been made here too to reduce the time taken to generate the 

page. Caching has also been introduced which means that switching between the tabs (including amendment manager) will be significantly quicker 

once they have loaded once.

Backup configuration change
Version 13.3 will also see a change in the configuration of Lawmaker’s incremental backup system. Data backup will now be triggered every 

two minutes (rather than immediately on every update to the content servers). This will reduce load on the system and may improve 

performance.

Support issues fixed

SPT-1246 Significant issues with amendments on evening of Friday 3 March 2023

(Already deployed in patch release v.13.2.2)

LMS-964 

SPT-1235 Schedules of Bill lost when using edit portion and renumber

(Already deployed in patch release v.13.2.1)

LMS-932 

SPT-1212 Parsing of amendments is adding space characters into some ukl attributes LMS-853 

SPT-1204 Submitted Amendments on Bill assigned to wrong organisation LMS-840 

SPT-1199 Motion instruction overlapping Proposers in Commons Proceedings list  

SPT-1197 Order of consideration doesn't work where provisions have occurrence counters LMS-825 

SPT-1195 Incorrectly splitting word over a line break in SIs LMS-796 

SPT-1187 No spacing between last element and Signature Block in SI/SSIs PDF LMS-758 

SPT-1179 Selecting and overwriting from structure view causes editor functionality issues  

SPT-1162 Inline amendments generating incorrect traditional amendments  

SPT-1156 Moving paragraphs/subparagraphs in quoted structure amendments using Structure 

View is not working as expected

LMS-644 

SPT-1135 Update x-refs function doesn't take account of need to refresh document  

Issue key Summary User support ticket

https://lawmaker.atlassian.net/browse/LMS-964
https://lawmaker.atlassian.net/jira/servicedesk/projects/LMS/queues/custom/13/LMS-932
https://lawmaker.atlassian.net/browse/LMS-853
https://lawmaker.atlassian.net/browse/LMS-840
https://lawmaker.atlassian.net/browse/LMS-825
https://lawmaker.atlassian.net/browse/LMS-796
https://lawmaker.atlassian.net/browse/LMS-758
https://lawmaker.atlassian.net/browse/LMS-644
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SPT-1130 Tracked Changes in Explanatory Notes not appearing in PDFs LMS-548 

SPT-1117 Manage Lifecycle Events - endless spinning circle when clicking on 'Cancel' and re-

opening modal

 

SPT-1107 Accessibility issues with Preview modal  

SPT-1043 Resolve potential CSS performance issues introduced by tickets including the "first-

child" CSS selector

 

SPT-655 Editor's 'convert to/from schedule' doesn't always work if provision selected  

https://lawmaker.atlassian.net/browse/LMS-548
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What's new in versions 13.2.1 and 13.2.2?
Versions 13.2.1 and 13.2.2 were patch releases to fix specific issues.

Version 13.2.1

This fixed an issue (LMS-932, SPT-1235) which resulted in schedules in a document being removed when a renumber of the whole 

document was triggered in Edit Portion mode. 

This was deployed on 23 February 2023.

Version 13.2.2

This fixed an issue (LMS-964, SPT-1246) where the Copy amendments to another stage feature could misbehave in certain circumstances 

and leave the copied amendment linked to the original amendment.

This was deployed on 8 March 2023.
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What's new in version 13.2?
Version 13.2.0 is a patch release to deploy some urgently requested updates to the preview amendment feature. It also contains some 

performance improvements and bug fixes.

This version was released on 20 February 2023.

Preview amendments

The following improvements have been made to the preview amendment feature:

When you preview an amendment, the comment shown will be the most up-to-date version of that comment, rather than the comment as visible on 

the amendment manager tab.

If someone else updates a comment to an amendment while you are updating it, you will be prevented from saving your changes to avoid overwriting 

the other person’s changes.

Refreshing the amendment preview will now also refresh the amendment comment.

Performance when closing the amendment preview modal has been significantly improved when there are lots of amendments showing on the 

Amendment Manager.

Performance improvements

The release contains a couple of further performance improvements to the renumber function in the Editor and also fixes an issue where 

different users triggering a save or renumber at the same time sometimes led to slow performance or progress bars getting stuck at 0%.

Support issues

The following issues have been fixed:

SPT-1188 Provision selector in PDF modal not working for some users LMS-774 , LMS-767 

SPT-1163 Auto-apply of subsection to undivided section leads to duplicate GUIDs LMS-676 

SPT-1152 Bold/Italic in a Table Cell disrupts line numbering LMS-603 

Issue key Summary User support ticket

https://lawmaker.atlassian.net/browse/LMS-774
https://lawmaker.atlassian.net/browse/LMS-767
https://lawmaker.atlassian.net/browse/LMS-676
https://lawmaker.atlassian.net/browse/LMS-603
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What's new in version 13.1.1?
This is a patch release to fix an issue that caused documents in certain circumstances to fail to save properly and to experience other issues 

such as it not being possible to duplicate them. (The Jira reference is SPT-1215.)

This version was released on Wednesday 15 February 2023.
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What's new in version 13.1?
Summary

Version 13.1.0 contains a number of general improvements to the performance of various underlying aspects of the service which should 

result in the system being more robust and stable and in performance improvements to some specific actions/operations within Lawmaker. 

In addition, v.13.1 includes a number of fixes and improvements in relation to support issues that have been raised. 

Version 13.1.0 was released on 6 February 2023.

Performance improvements

In particular, the performance of the following has been improved:

renumbering large documents in the Editor

Using the Finalise Document feature to renumber, update x-refs and insert a table of contents into a Bill

Typing in large documents

Updating an amendment number in a large amendment list

Pasting provisions into large documents

Updating x-refs in large documents in the Editor

Inserting a table of contents into a large document in the Editor

Performance in other areas should have improved as well.

List of support issues fixed

SPT-1164 Can't get a lock on //meta when the preface explanatory notes statement is missing LMS-689

SPT-1157 Amendment Manager sorting not working correctly after using Amendment Manager 

Preview or Refresh List button

LMS-662 

SPT-1151 Backcover updating with wrong Proposer and Supporters  

SPT-1147 Closing words line repeated in the PDF of Scottish Bill LMS-621 

SPT-1145 Changes lost when locked amendment set to On-Hold  

SPT-1143 Replacing angled brackets in Scottish Amendment with 'gt' LMS-597 

SPT-1136 Auto-apply amendments is converting curly quotes into straight quotes LMS-573 

SPT-1132 Apostrophes in Comments on SI/SSIs are not rendered correctly in the PDF LMS-546 

SPT-1112 Long section numbers in quoted structure not rendering correctly in PDF LMS-486 

SPT-1099 Accessibility - focus trap for the new "Amendment Preview" Modal  

SPT-1032 Amendment with Quoted Structure not aligned correctly. LMS-288 

SPT-1026 Saving document getting stuck on 0% and not saving LMS-292 

SPT-1023 Tagging x-refs incorrectly picks up numbers later in same provision  

SPT-958 Address error handling for the ephemeral list creation LMS-71 

SPT-894 Switch over to using the Wiris MathType plugin to render MathML formulas  

Issue key Summary User support ticket link

https://lawmaker.atlassian.net/browse/LMS-689
https://lawmaker.atlassian.net/browse/LMS-662
https://lawmaker.atlassian.net/browse/LMS-621
https://lawmaker.atlassian.net/browse/LMS-597
https://lawmaker.atlassian.net/browse/LMS-573
https://lawmaker.atlassian.net/browse/LMS-546
https://lawmaker.atlassian.net/browse/LMS-486
https://lawmaker.atlassian.net/browse/LMS-288
https://lawmaker.atlassian.net/browse/LMS-292
https://lawmaker.atlassian.net/browse/LMS-71
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SPT-823 Error appears when deleting to the beginning of a cross heading after a save  

SPT-801 Improve how long provision numbers are handled in PDFs for UK and Scottish Bills  

SPT-528 Screen resolution issue when using Amendment List Filter LMS-250 

LDAPP-3627 Losing locks when refreshing document (SPT-1133)  

LDAPP-3626 Issues with duplicating and recording snapshots on working versions (SPT-1104) LMS-473 

SPT-1116 Cursor doesn’t go into num in SP amendments  

SPT-653 Inconsistent render of J-refs in PDFs  

https://lawmaker.atlassian.net/browse/LMS-250
https://lawmaker.atlassian.net/browse/LMS-473
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What's new in version 13?
Summary
Version 13 introduces a range of new features and improvements, particularly around amendments, as well as additional bug fixes since the 

last release (v.12.2).

This version was released on 12 December 2022.

New features and improvements

In the Editor

Tag and update x-refs when editing a portion of the document - when you are editing a portion of a document (see Opening and editing a por

tion of document ) if you tag references or update existing references in the portion, Lawmaker can now use the whole of the document, not just the 

portion, to determine whether the reference is valid and to update it as necessary. See Cross-references (x-refs) ARCHIVED . 

Copying provisions between documents - now handles correctly copying schedules between documents whether or not there is already a 

schedule in the target document. An issue with updating x-refs when pushing provisions into another document has also been resolved. See Cop

ying provisions between documents - push/pull .

“Select x-ref to copy” menu in the Structure View - the minor issue where this menu wouldn’t automatically close after you’d selected something 

has been fixed. See Cross-references (x-refs) ARCHIVED  .

Ping Pong

Generating consolidated list of amendments - a new approach for generating consolidated lists of amendments has been implemented. Users will 

now need to copy amendments to a “ping pong” stage before they will be included but this means they can work on the consolidated list version while 

any prior parliamentary stage is ongoing.

Adding stars to ping pong motions - stars can now be added to a ping pong motion or to any individual amendment within a motion. As part of this 

change, the automatic application of stars to motions and amendments on a Commons Marshalled list has been removed.

Line numbering of Commons ping pong motions - the rule for where line numbering should start on Commons ping pong motions and 

amendments within those motions has been updated.

Additional content on Lords amendment lists - when generating Lords Daily sheets, Marshalled list and Manuscript lists during the ping pong 

stage, content from a consolidated list of amendments (and any messages etc. that have accumulated) can be added to the amendment list with a 

greater degree of flexibility and any changes you make to that content on the list won’t be reflected back in the original version (so won’t, for example, 

affect the next iteration of the consolidated list of amendments).

Amendments

Amendment manager tab - a number of different improvements have been made here: the layout of the table of amendments has been modified so 

the columns are better sized according to their content; the filter button, enabling you to filter the amendments, by member, location etc. has been 

moved above the table to make it more prominent ( see Filtering amendments ); the message shown when you have a temporary list open has 

been clarified; the table of amendments will no longer automatically refresh so long as you stay on the tab so you can rely on its content remaining 

static; and a separate refresh button has been added so you can manually trigger a refresh of the table when it suit you.

Preview and comment on amendments - Individual amendments can be quickly previewed from the Amendment Manager tab without opening the 

Editor. You can add or edit a comment on the amendment at the same time including adding a “quick comment”, a short phrase or sequence of 

letters, that you use repeatedly (e.g. to indicate approval). See Preview and comment on amendments .

Bulk update of proposers and supporters - the proposer and supporters on all or some amendments in an amendment list (whether draft or 

official) can be updated in a single action from the Editor. See Bulk update of proposers and supporters .

Copy amendments between stages - Selected amendments in the Amendment Manager Tab can now be copied from one stage to another, 

including being copied to ping pong. See Moving or copying amendments to a different stage (including ping pong motions) .

Confirmation that amendments have been auto-applied - when you apply amendments to a Bill version, the message confirming the action is 

complete now specifies how many of the amendments were applied rather than just reporting successful completion. See Auto-application of am

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688223
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338989
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338989
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9338989
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688776
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526453
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526453
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115343371
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115343371
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115277837
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115277837
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526854
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526854
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endments to a Bill version .

Sorting Commons amendments by topic - Using the Order of Consideration, you can add headings to generated marshalled lists and proceedings 

and select which amendments are grouped under each heading. See Creating an Order of Consideration .

Legend in Lords Daily sheet - you can now add a legend to the preface of a Lords Daily sheet.

Title of Scottish Parliament Marshalled Lists - when a marshalled list is generated at Stage 3, the title is adjusted automatically to “Marshalled List 

of Amendments selected for Stage 3”.

SI/SSIs

Procedural rubrics for made affirmative and emergency procedure - the rubrics automatically inserted when you create an SI/SSI or change its 

procedure have been updated to the approved forms. See Selecting the procedure applying to an SI/SSI .

Placement of signature block in PDF - the orphan control on the signature block has been removed to allow the text of the SI/SSI to flow more 

naturally. (Manual page breaks can still be inserted if a different pagination is required.)

Other changes

User manual and support portal links - the new user manual and support portal can now be accessed from the menu that appears at the top right 

of the screen and shows your username.

Page titles - we’ve updated page titles across the system to use “Lawmaker” rather than “Legislative drafting, amending and publishing programme” 

and made some other tweaks to make the titles more consistent and accessible.

System health checks - some additional automated checks are now active in relation to the Editor and the  PDF generation component.  (You can 

check on overall system health here: Lawmaker health check .)

List of support issues fixed

SPT-1121 Cannot renumber or update x-ref, when provisions are selected. LMS-520 

SPT-1081 Missing table cell causes delete and other operations to fail elsewhere in document  

SPT-795 Preface not showing lock in structure view when long title edited  

Ping pong   

SPT-1089 Interstitial headings in Commons Ping Pong marshalled list are being given duplicate eIds LMS-274 

SPT-1080 Duplicate unique value' document check error when the same member appears more than once 

in pp amendments

LMS-359 

SPT-790 Incorrect CCA options for Lords ping pong motions  

SPT-1072 Line Break Issues on Ping Pong Marshalled List LMS-385 

SPT-1051 Ping pong: copying Commons amendments into Lords Daily Sheet can cause list to freeze LMS-330 

Amendments   

SPT-1070 Lords Numbering Logic for new amendments at beginning of list has regressed LMS-396 

SPT-1029 Summary: Auto-apply amendments incorrectly matching characters instead of words LMS-279 

SPT-1014 Cutting amendments before and after Interstitial heading deletes all amendments LMS-226 

SPT-943 Auto-apply amendments - NC amendment has been applied, but is reported as NOT having been 

applied

LMS-94

SPT-869 Cannot save pasted inline amendments in a LoDA when there is more than 1  

SPT-1106 Amendments actions dropdown menu not closing after action  

Editor   

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526854
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526399
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526399
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115277992
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/115277992
https://lawmaker.dev.legislation.gov.uk/health
https://lawmaker.atlassian.net/browse/LMS-520
https://lawmaker.atlassian.net/browse/LMS-274
https://lawmaker.atlassian.net/browse/LMS-359
https://lawmaker.atlassian.net/browse/LMS-385
https://lawmaker.atlassian.net/browse/LMS-330
https://lawmaker.atlassian.net/browse/LMS-396
https://lawmaker.atlassian.net/browse/LMS-279
https://lawmaker.atlassian.net/browse/LMS-226
https://lawmaker.atlassian.net/browse/LMS-94
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SI/SSIs   

SPT-1115 SI/SSI Users (and others) unable to download zip file from significant versions  
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What's new in version 12.2.2?
Summary

This is a minor patch release to fix a few high priority issues.

It was released on Wednesday 23 November 2022.

List of issues fixed

Bugs

Validation update

In addition to these fixes, the validation rules in the Editor were updated to include an additional rule on x-refs.

The new rule will identify cross-references where the text of the cross-reference (e.g. “section 13”) doesn’t match what Lawmaker is 

expecting, based on the ID of the target provision stored in the XML. A mismatch like this is a sign that the Update X-refs function hasn’t, or 

may not, work as expected on this cross-reference and so the reference should be checked for accuracy and potentially re-inserted. (The 

underlying reason for the mismatch may be due to a user having manually updated the text of the reference at some point after it was made 

or it may be due to the reference having been affected by an issue that is fixed by SPT-1102 mentioned above or a similar issue fixed in 

v.12.2.)

 

LMS-361/LMS-504/LMS-532 (SPT-1056/SPT-

893)

changes lost when saving document This fixes issues with save and auto-save 

where the provisions locked by a user were not 

contiguous. When that was the case, in some 

circumstances not all the changes would be 

saved.

LMS-567 (SPT-1102) cross-references not updating when there 

is a processing instruction in the middle or 

end of reference

This fixes an issue where page-line processing 

instructions within cross-reference (these are 

only present where the Bill version has been 

created using the auto-apply amendments 

feature) cause some cross-reference to update 

incorrectly. A similar issue was fixed in v.12.2 

but didn’t cover all possible occurrences of the 

issue.

LMS-536 (SPT-1126) system performance issues due to infinite 

code loop

A system performance issue on 10 November 

was traced to code that, in very infrequent 

circumstances, could get stuck in an infinite 

loop. This prevents such loops in future.

Reference Description Note
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What's new in version 12.2?
This is a minor release which:

implements a new session timeout mechanism for logging users out after 30 minutes of inactivity (LDAPP-3526 and LDAPP-3525),

contains a number of accessibility fixes and improvements to elements of the user interface (SPT-995 and SPT-846), and

fixes a number of bugs.

It was released on Monday 7 November 2022.

List of issues fixed

 

SPT-1071 Performance/locking problems with SP Marshalled list (high Oxygen Memory utilisation)  

SPT-1057 Page Breaks not working after Amendment Explanatory Notes  

SPT-1050 Line numbers incorrectly aligned in Lords ping pong motions LMS-317

SPT-1046 Errors showing on Amendment Workspace and LoDA inaccessible LMS-326 

SPT-1045 Official list becoming unresponsive in Editor when user attempts to update title LMS-315 

SPT-1041 Provide manual trigger (REST API endpoint/page) for BCDR environment failover  

SPT-1038 Ping Pong: consolidated List sort logic incorrect LMS-272 

SPT-1037 Provision number (in the 'Amendment Information' panel) not updated in Consolidated List LMS-256 

SPT-1031 SI/SSI Schedule Headings incorrectly aligned (PDF) LMS-352 

SPT-1030 Trailing whitespace in amendment instruction caused auto-apply to fail LMS-259 

SPT-1015 Long URLs not rendering in PDFs for SIs  

SPT-868 Handle occurrence counters on all provisions for auto-apply amendments  

SPT-761 Space between schedules in UK Bill is larger when quoted structure at end  

LDAPP-3537 Update to validation rules (schematron)  

SPT-1093 X-refs not automatically updating when containing page/line processing instructions  

ID Summary Support portal ticket

https://lawmaker.atlassian.net/browse/LMS-317
https://lawmaker.atlassian.net/browse/LMS-326
https://lawmaker.atlassian.net/browse/LMS-315
https://lawmaker.atlassian.net/browse/LMS-272
https://lawmaker.atlassian.net/browse/LMS-256
https://lawmaker.atlassian.net/browse/LMS-352
https://lawmaker.atlassian.net/browse/LMS-259
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What's new in version 12.1?
Summary

This is a minor release containing further bug fixes.

It was released on Monday 26 September 2022.

List of issues fixed

 Amendments - Scotland  

SPT-736 Indent of quoted structure in SP Amendment wrong for Subsections & Sch. Sub-paras  

 Amendments - Lords  

SPT-973 Stand part amendments not italic when inline elements are present in front  

SPT-997 Lords Marshalled List and Stand Part amendments - issue with number and black stars LMS-134 

SPT-671 Update x-refs in the context of an amendment list is checking the interstitial headings  

LDAPP-3518 Ping Pong amendment instruction appearing bold in Lords Marshalled list (CSS)  

LDAPP-3514 Proposer not visible in Lords ping pong amendment to amendment  

SPT-1016 Lords Marshalled Ping Pong List PDF - Headings too close LMS-143 

LDAPP-3519 Update XML for Lords ping pong amendment to amendment to move proposer  

SPT-996 Lords Running List applying cut-off times LMS-177 

SPT-1019 varListNo. is pre-populated in Lords Manuscript List LMS-194 

 Amendments - Commons  

SPT-812 Paste issue with //p into Commons Marshalled List's 'Legend' (preface)  

SPT-1004 Copying a motion in HC Marshalled List results in duplicate eId LMS-198 

SPT-1006 Red highlighting of amendments with same location not working correctly LMS-209 

 Amendments - General  

SPT-1011 Hybrid Insert amendment causes a space between words to be removed  

SPT-974 Amendments generated from In-line incorrectly take account of other in-line amendments LMS-130 

SPT-1010 Clicking outside the 'Order of Consideration' modal closes the modal, losing all inputted data LMS-210 

SPT-986 Deleting amendments when selecting from bottom up in Structure View  

SPT-803 Publishing amendment list - modal doesn't close  

SPT-1001 Official List Tab - does not display lists for 10-15 seconds LMS-205 

SPT-975 Amendments inaccessible on API after Consolidated list of Amendments is published LMS-153 

SPT-1012 Hybrid Insert amendment causes Dnums to be displayed over text when applied to a Bill  

ID Description Support portal ticket

https://lawmaker.atlassian.net/browse/LMS-134
https://lawmaker.atlassian.net/browse/LMS-143
https://lawmaker.atlassian.net/browse/LMS-177
https://lawmaker.atlassian.net/browse/LMS-194
https://lawmaker.atlassian.net/browse/LMS-98
https://lawmaker.atlassian.net/browse/LMS-209
https://lawmaker.atlassian.net/browse/LMS-130
https://lawmaker.atlassian.net/browse/LMS-210
https://lawmaker.atlassian.net/browse/LMS-205
https://lawmaker.atlassian.net/browse/LMS-153
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SPT-1027 Ping pong: messages not saved in revised consolidated lists LMS-297 

SPT-1020 docType not set correctly on amendment lists at ping pong stage LMS-277 

SPT-1021 House not set correctly on amendment lists at ping pong stage LMS-277 

SPT-977 Ping pong motions showing incorrect href values in /amendments api endpoint LMS-153 

SPT-1052 Infinite loop issue when editing the proposers and supporters for an amendment with the 

"Withdrawn before debate" outcome

 

 Drafting/editing  

SPT-1013 Wrong quote marks in PDF for Quoted Structure containing a table  

LDAPP-3516 UK Private Bill - Can't select Front cover in structure view  

LDAPP-3517 UK Private Bill - explanatory memorandum cut off in PDF after first page  

SPT-1005 Promoting/demoting an element above a provision that has been deleted in TC mode  

SPT-827 PDF line numbering stops when there are horizonal cell merges LMS-36 

SPT-720 Line numbering in PDF stops when encountering a ligature character LMS-110 

SPT-981 Long URLs (in SI/SSIs) in footnotes not rendering correctly in PDF LMS-176 

SPT-971 Copy Document to Another Project function not updating projectID component of URIs LMS-150 

SPT-1047 Work disappeared from SP Bill LMS-332 

LDAPP-3510 'Update Dates' feature in SIs and SSIs not working properly  

 General  

SPT-890/LDAPP-

3493

Resolve Cognito Token Handling issues ("white screen" issue) LMS-72 

SPT-394 Fix recurring login attempt bug  

SPT-1008 Add Department for Levelling Up, Housing and Communities and Cabinet Office as new SI 

organisations

LMS-222 

LDAPP-3532 Update Templates etc. following the death of Her Majesty Queen Elizabeth II LMS-335 

https://lawmaker.atlassian.net/browse/LMS-297
https://lawmaker.atlassian.net/browse/LMS-277
https://lawmaker.atlassian.net/browse/LMS-277
https://lawmaker.atlassian.net/browse/LMS-153
https://lawmaker.atlassian.net/browse/LMS-36
https://lawmaker.atlassian.net/browse/LMS-110
https://lawmaker.atlassian.net/browse/LMS-176
https://lawmaker.atlassian.net/browse/LMS-150
https://lawmaker.atlassian.net/browse/LMS-332
https://lawmaker.atlassian.net/browse/LMS-72
https://lawmaker.atlassian.net/browse/LMS-222
https://lawmaker.atlassian.net/browse/LMS-335
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What's new in version 12.0.1?
Summary
Version 12.0.1 removes the progress bar functionality that was added in v.12 to the Save function in the Lawmaker Editor. It has been 

removed because it was identified as the source of a serious memory issue and will be reintroduced in a future release once the issue as 

been resolved.

It is otherwise the same as version 12.0.0.

Version 12.0.1 was released on 5 September 2022.

(See What's new in version 12?  for a full list of features in v.12.)

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/13336610
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/13336610
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What's new in version 12?
Summary
Version 12 introduces a number of new features and improvements across Lawmaker. In particular, it adds functionality to allow UK Private 

Bills to be drafted and managed, it refines ping pong functionality to address some remaining issues and includes a number of 

improvements to the Editor and PDFs.

Version 12 was released on 26 August 2022.

Detail of new features and improvements

UK Private Bills

You can now:

Create a Private Bill which has a custom template including the Explanatory note on the cover and the preamble.

Add content to the explanatory note and preamble including numbered paragraphs (1), (2) etc.

Insert front and back pages in a Private Bill (some issues with these features for Hybrid Bills have also been resolved).

Add details of promoters/sponsors to the back cover.

Convert a Private Bill into a Local Act.

Generate PDFs of Private Bills and Local Acts.

Publish Private Bills and share Local Acts with TNA.

See Creating and drafting a UK Private Bill  in the user manual.

Ping pong and amendments

Move amendments between stages - you can now update selected amendments or a whole LoDA so that they relate to a different stage 

or Bill version. This means, for example, that you can draft amendments before a particular stage has started or Bill version has been 

published and then update the amendments later to point to the correct stage/Bill version. That can be done before or after amendments are 

submitted and applies to normal parliamentary stages and ping pong. See Moving or copying amendments to a different stage (including 

ping pong motions)  

Logic when pasting and saving amendments - The logic applied when pasting an amendment into another amendment list has been 

modified so that the original will be pasted even if the amendment’s stage doesn’t match the stage of the list you are pasting into. Equally, 

the amendment’s stage will no longer be updated when the list is saved if it doesn’t match the list stage. This is mainly to better handle 

various scenarios during Ping Pong.

Interstitial headings - minor improvements to the handling of interstitial headings in amendment lists

Commons Amendment list templates - we’ve adjusted the Commons Marshalled List and Proceedings templates in light of some change 

requests.

Performance - the performance of Lawmaker when publishing amendments has been significantly improved.

Ping pong - entries in the CCA have been updated to make them easier to understand and use; other various changes to templates and 

CCA configuration in light of user feedback and testing.

PDFs

Selecting PDF options - The dialogue box for generating PDFs has been reworked to make it easier to follow. 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/47317042
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/47317042
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526551
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Hyperlinks - When you create a PDF, all entries in the contents page and all internal cross-references are now automatically converted into 

hyperlinks, i.e. clicking on them will take you to the target provision elsewhere in the PDF.

Including comments - We’ve also added an option to include any comments in the document in the PDF. The comments appear inline and 

indicate who the author of the comment was. Replies to comments are also included.

See Generating and viewing a PDF .

SI/SSIs

Subjects - The SI/SSI subject list has been updated and ordered alphabetically. See Managing Subject, Extent and Subsubject .

Templates - The templates for SIs and SSIs have been updated to include placeholders that can be tabbed into and easily be overwritten.

Date fields - When you’re specify a date in a date field (e.g. the made/laid dates or a signature date), you can now specify a simple year 

rather than a full day/month/year. See Managing Dates  and Managing Signatures .

Editor formatting - the spacing of provisions in Editor has been improved to be closer to the printed version.

Working with documents on the Project tab

Project tab view - The default behaviour of the project tab has been tweaked so that, where there is only one folder visible, the folder will 

be expanded automatically to show the working versions it contains.

Updating document information - For UK Bills and Acts and Scottish Bills and Acts, you can now update the document information from 

the project tab (using Actions>Update Document Information). This gives you access to the same fields as are present in the Document 

information panel in the Editor. See Updating document information from project tab  .

Editor improvements

Auto-renumber schedule paragraphs - when you have auto-renumber turned on, schedule paragraphs will  be renumbered as well as the 

existing provisions. See Renumbering provisions .

Save progress bar - whenever you save a document, e.g. a Bill or amendment list, a progress bar (like the one that is shown when you 

open a document) will be displayed. See Saving your document . 

Page breaks - you can now insert page breaks into documents that will affect how the PDF is paginated. A page break can be inserted after 

most provisions forcing the text after the break to start on a new page. See Inserting page breaks  .

Superscript/subscript formatting - in the same way as you can format text as bold or italic you can now format selected text as 

superscript or subscript. See Adding formatting to text (bold, italic, superscript etc.) .

Font size in tables - you can now adjust the font size (using the table properties dialog box) for all text in a particular table. You can make 

the text larger or smaller. See Inserting and managing tables .

Cursor placement - the cursor placement logic has been improved in some specific case including when you insert closing words. See I

nserting provisions and other elements . 

Performance - some miscellaneous performance improvements to the Editor have been implemented.

Support tickets included in release

SPT-937 Jrefs shown as part of xrefs are no longer italicised in PDFs

SPT-622 Long section numbers causing issue with headings inside quoted structure

SPT-808 Additional paragraph inserted into table cell (Shift enter) missing namespace attribute

Ticket Description of bug

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688197
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121966
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121966
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121950
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121950
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121958
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/16121958
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60915747
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60915747
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339202
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9371659
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60948495
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60948495
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339259
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339259
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339057
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/9339065
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SPT-907 Steps are not aligned correctly in PDFs

SPT-881 SI/SSI Procedure drop down in Create New Project model not behaving correctly
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What's new in version 11.7?
Summary

This is a minor release containing further support fixes and some performance improvements.

It was released on Tuesday, 19 July 2022.

Detail of support issues fixed

 

 

 

LDAPP-3479 Correct the format of Leave Out amendments in the Commons (Generate from Inline Amendments) Commons 

(LMS-106)

LDAPP-3480 Correct the format of Leave Out amendments in the Commons (Auto Apply) Commons

(LMS-106)

LDAPP-3469 Strip out Page/Line processing instructions as part of cut/copy/paste UKP, OPC 

(LMS-83)

LDAPP-3473 Proposers and supporters for a Lords amendment do not split over page in amendment list PDF Lords (LMS-73)

LDAPP-3475 Add sort code column to Amendment Manager tab Lords (LMS-127)

LDAPP-3477 Prevent users selecting proposers or supporters that don't exist in the data obtained from parliament UKP (LMS-66)

LDAPP-3476 Change Commons amendment sort logic to ignore amendment numbers Commons 

(LMS-105)

LDAPP-3481 Update Lawmaker to handle 'correct' format of Leave Out amendments in the Commons (Sorting) Commons 

(LMS-106)

LDAPP-3494 Investigate and improve performance issues with deleting a large number of amendments from a HoL 

Marshalled List

Lords (LMS-138)

SPT-939 Schedule stand part amendments are not italicised in Editor or PDF Lords (LMS-85)

SPT-956 Smart paste defaults to "asp" when pasting into HoL or HoC amendments UKP (LMS-122)

SPT-957 Processing instructions containing line/number elements stop update x-refs working Lords (LMS-116)

SPT-930 Address performance bottleneck caused by some actions only being executed sequentially. Lords (LMS-13)

SPT-953 “New” button on dashboard not accessible if Browser window too narrow  

SPT-926 Incorrectly formatted footnotes  

Reference Description Raised by

https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3479
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3480
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3469
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3473
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3475
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3477
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3476
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3481
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3494
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-939
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-956
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-957
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-930
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-953
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-926
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What's new in version 11.6?
Summary

This is a minor release containing further support fixes and some performance improvements.

It was released on Friday 8 July 2022.

Detail of support issues fixed

SPT-922  Save button not enabled after the document is updated

SPT-925  Wrong list of stages presented when creating a new Official List of Amendments

SPT-756  Deleted whole provisions always show in partial PDFs

SPT-809  Folder naming issue when duplicating documents

SPT-651  New Working Version - Version Description should be empty

SPT-652  Can’t change case of characters in Document Version Label 

SPT-752  Logic to update project details doesn't seem to be applied when users convert bill to act

SPT-938  Schedule stand part amendments are being numbered when they should be unnumbered

SPT-947  Improve the performance of the document information panel in large documents

SPT-935  Continuation headings in Lords amendment lists appearing unnecessarily

SPT-842  SI paragraphs (Prov2) with Track Changes display incorrectly in PDF

SPT-921  J-Refs not displaying in PDF against x-refs marked as invalid

SPT-936  Location and number columns are being sorted alphabetically rather than alphanumerically

SPT-923  Performance very slow when users editing scripted SP Marshalled List

SPT-901  Performance issues in production

SPT-952  Lords numbering rule not working for clause stand part motions when there are already published amendments

SPT-967 Disappearing clauses and lost changes in big bill

 

 

 

   

   

   

https://legi-project.teratext.leidos.com.au/jira/browse/SPT-922
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-925
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-756
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-809
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-651
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-652
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-752
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-938
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-947
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-935
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-842
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-921
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-936
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-923
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-901
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-952
https://legi-project.teratext.leidos.com.au/jira/browse/LDAPP-3492
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What's new in version 11.5.1?
Summary

This is a minor release containing a few high priority support fixes.

It was released on Wednesday 15 June 2022.

Detail of support issues fixed

 

 

LMS-79 SPT-932 Commons white stars being applied incorrectly

 SPT-918 Attempting to renumber preamble results in Editor becoming unresponsive

LMS-82 SPT-940 Lawmaker temporarily unresponsive followed by application error

LMS-100 SPT-946 Line numbering incorrect in UK Bills

 SPT-700 UK Private Member's Bill assigned incorrect Doc sub type

LMS-80 SPT-948 Update schematron validation to prevent highlighting of large portions of documents

Support ref Ticket Description of bug/change

https://lawmaker-support.atlassian.net/browse/LMS-79
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-932
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-918
https://lawmaker-support.atlassian.net/browse/LMS-82
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-940
https://lawmaker-support.atlassian.net/browse/LMS-100
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-946
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-700
https://lawmaker-support.atlassian.net/browse/LMS-80
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-948
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What's new in version 11.5?
Summary

This is a minor release containing a number of support fixes.

This version was released on 1 June 2022.

Detail of support issues fixed

 

 

 SPT-856, SPT-

911, SPT-567

Auto-application of amendments not working reliably (and other issues) due to line breaks and whitespace 

being added to XML

 SPT-900 "Update List" for Lords Marshalled List is renumbering amendments incorrectly

 SPT-899 Lords amendments numbered incorrectly (stand part and/or running list issue)

 SPT-902 Not possible to generate any amendment list in specific SP Bill project

 SPT-883 Amendments generated from Inline textual amendments incorrectly taking account of other inline 

amendments on same line

 SPT-876 Document validation causing performance issues

 SPT-908 Can't insert footnote in text before a quoted structure (i.e. within a //mod element)

 SPT-564 Withdrawn amendments being shown incorrectly in SP Amendment List PDFs

 SPT-855 Long section numbers causes headings in PDF to appear above the number

 SPT-915 Blank cover page created on all UK Bill PDFs

 SPT-532 Poor performance when tagging invalid x-refs

 SPT-896 Deleting preamble causes sections to be lost when editing portion of Bill

Support ref Ticket Description of bug/change

https://legi-project.teratext.leidos.com.au/jira/browse/SPT-856
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-900
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-899
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-902
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-883
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-876
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-908
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-564
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-855
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-915
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-532
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-896
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What's new in version 11.4?
Summary

This is a minor release containing a number of support fixes.

This version was released on 12 May 2022.

Detail of support issues fixed

SPT-632* Accessibility - issues with keyboard and focus in modals

SPT-811* changing @eIds causing inappropriate locking

SPT-877* Proposer/Support Member IDs missing from XML/API

SPT-532 Poor performance tagging invalid x-refs

SPT-799 Can't publish amendments derived from copy & paste

SPT-847 Individual provisions sometimes not displayed in Generate PDF modal

SPT-835 Unable to duplicate compare document versions

SPT-798 Lords amendment numbering logic not working correctly

SPT-814 Applied amendments are inserted as flat XML

SPT-874 Users sometimes losing changes on Save and phantom locks created

SPT-880 Saving portion of document is removing num locks from all provisions in portion

SPT-843 Copying content from amendment quoted structure includes extraneous XML

SPT-721 Pasting quoted structures into amendments not behaving as expected

SPT-711 Incorrect IDs assigned in metadata when proposers/supporters updated on unsaved amendment

SPT-867 Schematron validation messages not showing for for made SI/SSIs

SPT-852 Auto-renumber not working when merging provisions

SPT-840 Cannot submit an amendment after cancelling submission

SPT-543 "Fragment has been deleted” message appears when using Track Changes

SPT-805 Smart Paste not working correctly in Preamble and SI Explanatory note contexts

SPT-762 Copy pasting text that begins with cross-reference results in ref XML element being turned into text

SPT-870 Line spacing of multi-line amendment instructions in Commons & Lords incorrect

SPT-750 Date algorithm not working for certain dates in the PDF

SPT-712 -1 indent level on quoted structures not showing correctly in PDFs

SPT-863 "Where-" paragraph in math formula displayed before image in SI PDF

SPT-865 Removing explanatory note statement from UK Acts prevents front page appearing in PDF

Ticket Description of bug/change

https://legi-project.teratext.leidos.com.au/jira/browse/SPT-877
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-532
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-799
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-847
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-835
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-798
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-814
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-874
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-880
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-843
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-721
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-711
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-867
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-852
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-840
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-543
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-805
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-762
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-870
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-750
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-712
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-863
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-865
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*These fixes were patched directly into Production as part of patch release v.11.3.1

 

SPT-733 Text in tables cells in Scottish Bills are being justified in PDF regardless of settings

SPT-708 Table inside a definition is not rendering correctly in PDF

SPT-892 Compare function causing system performance issues

https://legi-project.teratext.leidos.com.au/jira/browse/SPT-733
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-708
https://legi-project.teratext.leidos.com.au/jira/browse/SPT-892


506

What's new in version 11.3?
Summary

This is a minor release containing a number of support fixes.

In addition it includes some updates to the API to help with integration with UK Parliament’s systems.

This version was released on 1 April 2022.

Detail of support issues fixed

API updates

The API was updated to:

add paging to endpoints that might deliver lots of results (/ids and /amendments)

adjust the /amendments endpoint to be more consistent with the /all documents endpoint

use URIs that are relevant to the environment rather than absolute.

SPT-716 Consolidated List of Amendments being sorted incorrectly Raised by HoL

SPT-429 Automatic timeout not behaving correctly Raised by various

SPT-797 Scottish Parliament PDFs: spacing issue with cross heading in quoted structure Raised by SP

SPT-841 Body elements appear in CCA/insert menu Raised by project team

SPT-813 Can’t apply amendments when the eId of the clause/section has an occurrence counter Raised by project team

SPT-837 Can’t generate PDFs (environment issue) Raised by HoL

SPT-632 / 

SPT-834

Various issues with accessibility Ongoing accessibility work

SPT-859 Add DCMS, BEIS and DfT as organisations Raised by TNA

SPT-833 Amendment being applied to bill when the line number was incorrect Raised by HoL

SPT-866 Inserting covers when in 'Edit portion' mode deletes data Raised by OPC

SPT-763 Pushing provisions into another document introduces spaces between //ref elements Raised by PCO

SPT-844 Disaster recovery health checks not performing correctly Support management work

SPT-862 Page number not appearing on last page of SI PDFs Raised via TNA

Ticket Description of bug/change Lawmaker feedback log 

reference/Raised by
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What's new in version 11.2?
Summary

v.11.2.0 includes features allowing users to create amendments inline and apply selected amendments to the bill. While early versions of 

these features were available in previous releases, this is the first release to contain  versions of the features which are comprehensive and 

fairly stable. They are however, still in beta because further extensions are planned and user feedback from live use is required to refine 

them further.

The release also includes a number of bug fixes.

This version was released on 16 February 2022.

Inline amendments

One of the biggest and most eagerly awaited new features being brought in by Lawmaker is the ability to create amendments through inline 

changes to the bill text.  Lawmaker will convert these changes into traditionally formatted amendments which can then be managed on the 

'Amendment Manager' tab in the same way that traditionally generated amendments are currently - including their submission to the 

relevant Parliament for tabling/lodging.  

The core 'leave out', 'insert' and 'substitute' type amendments for all jurisdictions have been implemented, although there are edge cases 

where manual intervention may be required.  To find out more about how to use these features, please consult "Creating an inline 

amendment" in the user manual.

When you save changes to your inline document, the traditional versions of the amendments are automatically generated.  To view them, 

open the 'Inline Amendment Tools' right-hand panel and click on the 'View traditional amendments' button.  This will open a new tab 

displaying all the inline amendments in traditional format (and enabling you to make manual adjustments to the traditional amendments if 

required).

Auto-application of amendments

In conjunction with inline amendments, this release also enables the auto-application of selected amendments.  This can be used for 

amendments at any state and whether or not they originated from inline amendments or were drafted in the traditional manner. This feature 

is available to all users. 

To use it, select the amendments you want to apply to a copy of the bill from the 'Amendment Manager' tab, and select the action "Apply 

amendments".  You can choose to create a new bill version with your selected amendments applied; or apply them to an existing version of 

the bill (this can be useful if you are updating 'Agreed' amendments at the end of a multi-sitting amending stage).  All applied amendments 

will be visible as tracked changes in the document and listed on the 'Inline Amendments' right-hand panel.  If any amendments couldn't be 

applied (e.g. the instruction wasn't recognised, or they overlapped with another amendment), a note will appear in the 'Review' right-hand 

panel so you can clearly see what wasn't applied.  

Once you are happy with the application of amendments (including removing any amendments you no longer want applied, and 

incorporating any necessary non-substantive printing changes required) you can use the 'Accept all' button at the top of the 'Inline 

Amendments' right-hand panel to remove the tracked changes and produce a clean version of the Bill.

To find out more about how to use these features, please consult "05 Auto-Application of Amendments" in the user manual.

Other

A number of bugs and issues have been resolved in this release:

https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978643
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978643
https://lawmaker.atlassian.net/wiki/spaces/UM/pages/8978643
https://legi-project.teratext.leidos.com.au/confluence/display/UM/05+Auto-Application+of+Amendments
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 Refactored Save function and Edit portion of document feature  to cope with very large 

documents and resolve other issues

OPC

 Smart paste not handling phrases beginning with a number properly, e.g. "1984 Act" Lords

SPT-566 / SPT-734 FRBR document check errors no longer appearing N/A

SPT-569 "Manage lifecycle events" - 'Update' button not clickable Scottish Parliament

SPT-583 XML in quoted structures going wrong after PDF generation Parliament Digital Services 

development team

SPT-645 SI PDF - display of commenceDate SI drafters

SPT-646 SI PDF - sub-paragraph nums in quoted structures look squished. SI drafters

SPT-654 Insert table - cannot insert a table with greater than 10 rows SI drafters

SPT-660 Pasting schedule into bill no longer being wrapped in 'schedules' container OPC

SPT-687 Smart quotes not operating in the Long Title Parliament Digital Services 

development team

SPT-693 House Bill page 1 starts at different place on page from normal Bill Lords

SPT-694 Seal image @src attributes don't match actual image in zip file TNA

SPT-703 Space-before UK Bill Schedules should be 36 pt Lawmaker feedback LPM195 

raised by Lords

SPT-717 Pushing schedules into another document that already contains schedules doesn't 

work properly

OPC

SPT-731 Copy/paste paragraphs creating nested //p elements SI drafters

SPT-751 red highlighting no longer appearing for overlapping amendments in amendment lists Lawmaker feedback LPM198 

raised by Lords

SPT-753 UK Bill's long title is being converted (upper case changed to lower case) when 

enacted

Lawmaker feedback LPM199 

raised by Lords

SPT-754 PDF - Line spacing in SP Amendment Lists for bill title Scottish Parliament

SPT-759 / SPT-757 Issues with PDF bookmarks PCO

SPT-765 Amendment Manager' doesn't display anything if a single amendment has XML issues Lawmaker feedback LPM201 

raised by Scottish Parliament

SPT-773 Update x-ref behaving incorrectly in the presence of tracked changes Lawmaker feedback LPM202 

raised by PCO

SPT-775 SP Manuscript amendment list no longer renumbering published amendment lists Lawmaker feedback LPM201 

raised by Scottish Parliament

SPT-778 Can't update table to have 1 row (Remove restriction on minimum of 2 rows) Lawmaker feedback LPM208 

raised by Commons

SPT-780 Unable to Renumber Building Safety Bill Lawmaker feedback LPM189 

raised by Commons

SPT-782 Nums dropping down a line due to line numbering Lawmaker feedback LPM206 

raised by Commons

Ticket Description of bug/change Lawmaker feedback log 

reference/Raised by
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SPT-782 Manuscript lists are renumbering previously published amendments Lawmaker feedback LPM205 

raised by Scottish Parliament

SPT-788 PDFs generated from Project tab are different from those generated from Editor Lawmaker feedback LPM207 

raised by Lords

SPT-789 Line numbering out by 1 line on 5 pages Lawmaker feedback LPM207 

raised by Lords

SPT-792 Comparison failing when document contains formula Lawmaker feedback LPM210 

raised by OPC

SPT-793 Compare documents - "change" attribute showing up in PDFs Lawmaker feedback LPM211 

raised by OPC

SPT-796 Inserted SI text is formatted incorrectly and throwing out line numbering Lawmaker feedback LPM213 

raised by Lords

SPT-802 / SPT-804 A fix to the issue whereby a document couldn't be seen on the 'Project' tab by some 

users

Raised by OPC

SPT-820 Auto-opening of dropdown menus on the 'Create new project' and 'share version' 

dialogue boxes

N/A
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What's new in version 11?

Release Date:  3 December 2021

Summary

v.11.0.0 is a release that brings more productivity and generic editor enhancements; features allowing Finance Resolutions to be drafted 

and managed in Lawmaker; document permissions so you can restrict access to documents (and consequently the projects they are in); 

and further enhancements to amendments, including ping pong.  We've continued working on inline amendment creation and auto-apply of 

amendments, but these features won't be ready for use until a later release planned for the end of this year.

Productivity and generic editor enhancements
1. Finalise documents - a quicker way to renumber, update x-refs and insert front and back covers into bill documents without opening the editor.  

2. Copy document to another project - an easy way to move documents of the same type between projects.

3. Rename folders - an easy way to manage your documents on the Project tab and implement your preferred folder naming convention.

4. Sort working versions of documents alphabetically on the 'Project' and 'Amendment Workspace' tabs

5. Insert equations - you can create complex mathematical equations using the new equation editor.  When inserted, it will include the "Where " 

statement that often accompanies math equations.

6. Copy provisions from multiple documents - allows you to merge different documents in the same project into a single document. 

7. Insert origin information - you can now capture origin information against provisions in a bill which will be used to construct the tables of 

origins/destinations for a consolidation Bill.

8. Improved the 'Document Check' error/advisory messages - we are continually improving these document check messages.  We've included some 

extra ones with this iteration, including checking the number format of different provisions and identifying leading spaces which can mess up the PDF 

presentation (these are often introduced when copying and pasting from external sources (not through smart paste))

9. Convert subsection-like elements (e.g. Paragraphs in SIs or subsections in Bills) to Schedule sub-paragraphs and vice versa using cut,copy and 

paste

10. Table enhancements including unmerge cells, insert numbered provisions inside table cells and adjust individual column widths.

Finance Resolution features

It is now possible to create and manage Finance Resolution documents inside Finance Bill projects.  These documents can contain one or 

many Resolutions which can be drafted using the same Editor features as Bills.  

You can merge the content of one or more Resolution Documents into a single document using the 'copy provisions from multiple 

documents' feature or merge specific resolutions using the "Copy provisions from another document" feature.  Resolution text is auto-

converted into subsections or schedule sub-paragraph text when pasted into Bill documents (and vice versa).

You can move Finance Resolution documents between projects using the newly implemented 'copy document to another project' feature.

Cover pages and contents can be inserted into the Finance Resolution documents in the same way that you insert front covers and tables of 

contents into Bills.  A s.5 PCTA Resolution statement is automatically included if you have marked any Resolutions in the document as being 

an s.5 PCTA Resolution.

The document permissions will allow you to control access to these documents as they are drafted. 

Finance resolution documents can be published to the API to enable integration with other systems/organisations.

Document permissions

By default, a document's permissions are set so that users in the same organisation as the creator will have read/write access.  You can 

now restrict access to a working version so that only named users will be able to see and edit the document.  (You can only restrict access 
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to users within the same organisation as you.)  This can be done at the point of creating the project to restrict access to the first working 

version or when creating a new document in a project (by uploading a document or creating a new blank document). Permissions on 

individual working versions can also be updated at any later point.  As the project inherits its permissions from the documents within it, your 

project will only be visible to a user with access to at least one document within it.  

There is also a new 'Document Administrator' role that has come in with document permissions.  This role can be assigned to a user in your 

organisation giving them the ability to see all restricted documents in your organisation and to edit their permissions, but not to edit the 

documents themselves in the Editor.  If this role is assigned, then the user could update the permissions of a document if, for example, all 

those with access to it are unavailable but the document was required urgently - otherwise the same can be achieved by raising a support 

request with the Lawmaker team.

Enhancements to amendments including ping pong
1. A warning is presented if any amendments being submitted contain tracked changes or comments

2. A setting in the Editor allows you to turn on/off line numbering of ping pong amendments and motions in PDFs

3. Individual amendments can be selected and published to Lawmaker's API/Public Document Repository (PDR) and are published automatically when 

an amendment list is published

4. Lords ping pong 'amendments to amendments' and 'consequential amendments' can be created

5. Reason Motions can be drafted and submitted to House of Commons

6. Commons users can generate Reasons documents, containing all  submitted Reason motions

Other

Various support fixes, including improved compliance with accessibility guidelines.
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What's new in version 10?

Release Date: 21 October 2021

Summary

v.10.0.0 brings a lot of exciting new features and productivity enhancements.  For more information on the key changes, see the following 

sections.

Productivity enhancements
1. You can now additionally filter the dashboard by project type and session, and the selection is sticky so that whenever you return to the dashboard, 

the settings are saved.

2. 'Convert to/from schedule' has been updated so that it can now be triggered from structure view as well as the Editor view.

3. We've improved default cursor placement when inserting new elements in the Editor which will minimise the need to take your hands off the 

keyboard as you draft.

4. Edit portion of document allows you to open smaller portions of the document in the Editor; particularly handy if you are dealing with a large 

document as it brings performance improvements.

5. Smart paste allows users to paste text from unstructured documents outside Lawmaker, into the Editor. This works for bills, SIs and also amendment 

instructions (including any quoted structures). See this page for more on how to use this function.

6. UK Parliament users now have the ability to print a bill with the House Bill front cover.

Inline amendments and auto-application of amendments

You can create amendments inline.  We have started with 'leave out' and 'insert' type amendments.  The 'Inline Amendment Tools' right-

hand panel provides extra tools to help with inline amendment drafting including:

1. Help text explaining how to create the different types of amendment,

2. 'View Traditional Amendments' button which will open a separate read-only tab listing all traditional format amendments, and

3. 'Leave out' and 'Insert' buttons to assist in the creation of inline amendments

As you create inline amendments, they will appear on the 'Inline Amendments' right-hand panel.  This panel allows you to view all inline 

amendments in your document as well as other features such as:

1. a button that will allow you to remove inline amendments from your document 

2. a filter at the top of the list which allows you to filter the list of amendments by amendment type (e.g. leave out, insert)

You can select one or more amendments to apply to a bill.  This could be a newly created bill version or you can apply them to an 

existing working version. Any user can use this auto-application feature; amendments do not have to be derived from an inline amendment 

and they can be at any state. Lawmaker will list which amendments were successfully applied (on the 'Inline Amendments' right hand 

panel), but also any that couldn't be applied for any reason (on the 'Review' right hand panel).

Please note that inline and and auto-application of amendments are still a work-in-progress.  See Work in progress features for more 

information on known issues and limitations on these new features.

Miscellaneous updates
1. Warning messages about duplicate IDs when pasting provisions and amendments.

2. Further refinements to Document Compare to improve its robustness.

3. You can now merge table cells vertically and horizontally

4. The DNumber assignment algorithm has been revised so DNumbers are specific to your organisation and are shorter in length e.g. OPC1, HoC1, 

SP1

https://legi-project.teratext.leidos.com.au/confluence/display/UM/Using+smart+paste
https://legi-project.teratext.leidos.com.au/confluence/display/UM/Work+in+progress+features
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5. Lists can now be inserted into quoted structures as well as elsewhere in the document (particularly useful to SI drafters quoting EU legislation that 

can often start with lists)

Support fixes

Various support fixes, including improved compliance with accessibility guidelines.
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What's new in version 9?
Release Date:  2 July 2021

Summary

v.9.0.0 is a release that brings more ping pong functionality; new generic Editor features which have the added benefit of improving the 

management and drafting of big bills; changes to amendments based on early Amendment feedback; and other miscellaneous updates 

including new SP bill types, API updates and new Lawmaker branding.   We have also included some work-in-progress features (Document 

Compare and Inline Amending) which are stable enough to play with but shouldn't be used for critical business processes.

For more information on the key changes, see the following sections.

Ping pong functionality

We have now delivered all the core amendment lists produced by the Commons and Lords during Ping Pong (Commons Marshalled Lists, 

Commons Proceedings, Lords Daily Sheets and Marshalled Lists).  It is possible to record outcomes against all ping pong motions are their 

amendments and generate PDFs for all lists.  There are still some refinements required which we will address in the next release alongside 

any prioritised feedback coming from testing what has been delivered so far (mainly through the Fantasy Parliament exercise).

New Editor features
1. The "Copy Provisions to another document" function has been deployed and this will allow SI or bill drafters to push/pull provisions into/from other 

documents in the same project, replacing any duplicate provisions.

2. Progress bars now appear whenever users perform the following actions, which should help provide users with confidence if an action takes a 

particularly long time to complete:

a. Opening a document in the Editor

b. Inserting table of contents

c. Paste (which includes drag & drop)

d. Renumber

e. Tag x-refs

f. Update x-refs

g. Delete all j-refs

3. The "Converting to/from schedule" function will allow SI and bill drafters to select one or more sections and convert them into a schedule; and vice 

versa, schedules can be converted into main provisions (sections or e.g. regulations) in the other direction.

4. Merge elements now allows SI or bill drafters to merge one or more sibling provisions into a single element which complements 'split' that was 

introduced a few releases ago.

5. List elements can now be inserted into SI and Bills.  They default to a bullet list, but the bullet style can be changed to an em-dash list or no bullet 

style (essentially an unnumbered list)

Changes to amendments

Based on feedback from users we have implemented the following changes:

1. We have renamed the amendment tabs in a project to make them more intuitive

2. The Commons now have a new status, "Ready for Publishing" to support the separation of roles between PBO and PPU

3. The Commons now have the ability to show/hide supporters in amendments as their supporter lists can get quite unwieldy at times

4. The 'Location' column on the 'Amendment Manager' tab now contains page and line information (where appropriate) to provide more context on an 

amendment in the list

5. The 'Amendment Manager' tab now has a 'quick filter' option to filter by submitted, tabled, ready for publishing and draft amendments
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6. The buttons on the 'Amendment Manager' have now been moved to an 'Amendment Actions' drop-down list in the same place

7. You can you set amendments to 'on hold' and use the filters to 'hide' them from lists when drafting

8. UK amendments now have inline placeholders in their pre-populated amendments and ping pong motions which should hopefully make it quicker 

and easier to update instruction information

Miscellaneous updates
1. Scottish users can now create SP private, hybrid, committee and budget bills which will now load the correct templates with the appropriate pre-

populated rubrics. 

2. Some API enhancements for UK Parliament.

3. A warning message will appear when pasting duplicate provisions or amendments in documents so that it is clear to the user what is happening.

Work-in-progress features
1. Compare documents will allow users to compare two different document versions from the same project in order to see (via tracked changes) how 

the document has changed.  It's mostly delivered now, however we have identified some areas for refinement.

2. Inline amendments: we have started with 'leave out' amendments for Commons, Lords  and Scottish Parliament.  The functionality built so far will 

allow you to create an inline documents; highlight text and structures that are to be left out; and save these changes to generate traditionally 

formatted amendments visible on the 'Amendment Manager' tab.  Not all 'leave out' scenarios have been catered for but there is enough there to 

have a play with.

See Work in progress features for more information on known issues and limitations on these new features.

Support fixes
1. pasting over provisions - the paste warning message will no longer appear in this scenario and the provision will replace the existing provision rather 

than being inserted at a random place;

2. the space-bar issue has been resolved.  When typing into input fields in various dialogue boxes, users found the space bar would only work with 

every other key press;

3. the handling of j-refs when displayed in cross references; 

4. ability to cut/copy & paste elements within amendments (making it easier to copy supporter blocks from one amendment to another);  

5. use of ampersands in bill & SI titles; 

6. a fix for the snapshot issue which was preventing generation of pdfs & duplicating document versions amongst other actions; 

7. line numbering issue in PDFs affecting tables (first identified in Scottish Budget Bill);

8. running header of enacted primary legislation incorrectly display the ASP/Chapter number on the wrong line;

9. section content wasn't being formatted as 'justified' in the PDF for UK bills; and

10. line numbering starting in the wrong place for Commons amendments.

https://lawmaker.atlassian.net/wiki/pages/createpage.action?spaceKey=UM&title=Work%20in%20progress%20features&linkCreation=true&fromPageId=2195748
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Support and Lawmaker support portal
This page contains help and guidance on using the Lawmaker support portal. You can access the portal at 

support.lawmaker.legislation.gov.uk.

When is support available?

The portal is always available for you to log an issue but the support team will only respond and work on issues during our support hours. 

Those hours are:

8am-6pm, Monday to Friday for all issues and requests,

24hrs a day, Monday to Friday for critical issues that require an urgent resolution.

(Support is available at weekends by prior arrangement only.)

As well as raising raising issues via the portal, urgent issues can also be raised by phone on 0333 456 4786. 

Finding your way around the portal

Use this to search across the portal. It will return known issue pages and open tickets that relate to you search term. It will also show 

relevant request forms (for example search for “new user” and you’ll get the the form to request a new user account).

Checking whether your issue has already been raised by someone else or addressed on a Known Issue page before raising a new ticket 

can help resolve things quicker.

Use this if something isn’t working properly or if you think you’ve come across a bug. For example, if you get an error when you try and 

generate a PDF, use this form to report the issue. See below for some further guidance on including screenshots, PDFs and other 

information to include to help us resolve the issue quickly.

When you raise an issue, it is helpful if you can assign it an Urgency level so we can prioritise a response appropriately. The four possible 

levels are:

High: use this for issues that you can’t work around and which need to be resolved the same day, e.g. if you are working on an SI which needs to be 

issued for signing that day but you can’t generate a PDF or if you have problems publishing an amendment list which needs to be published that day.

Medium: use this for issues that cause significant disruption to your work but that you could wait up to a week to resolve, e.g. because you’ve found 

a way to work around the issue or because the deadline for the document affected is a couple of weeks away.

Low: use this for issues that you’re able to wait a couple of weeks for a resolution on, e.g. because you have an easy way to workaround the issue.

Standard: use this for something you’ve spotted that isn’t quite right but doesn’t impact on your work in any meaningful way.

http://support.lawmaker.legislation.gov.uk/
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This section contains a range of forms for different circumstances, including:

Use this if you require assistance or guidance from the Lawmaker team, e.g. advice on how to achieve a particular format or structure of provision 

using Lawmaker, or how to resolve a document check error (Advice and Guidance).

If you’re having problems logging in (e.g. because you no longer have access to the device that you setup MFA on), use this to request a reset of 

your account (Reset Lawmaker Account).

It is also possible in this section to request the creation of new user accounts in this section. Note that only authorised requests will be actioned (New 

User).

If you would like to suggest a new feature for Lawmaker or an improvement to an existing feature, you can do so here (Feature Requests and 

Improvements).

Help with reporting issues

How to take screenshots and add them to a portal ticket

It is often useful to include a screenshot to illustrate the problem you are experiencing.

A quick way to grab a screenshot of a portion of your screen is to do the following:

1. Press Shift+windows key+s. This will bring up the Snip + Sketch tool and you should see a little toolbar at the top.

 

2. If not already selected, click on the first icon on the toolbar.

3. Hold the left mouse button down and drag a rectangle over the part of the screen you want to grab. As soon as you let go, the selection will be copied 

to the clipboard. (Or use the fourth icon to copy the whole screen in one go.)

4. In the Detailed description field of the form, place your cursor inside it and paste the screenshot by pressing ctrl+v:

How to add PDFs of Lawmaker documents to a portal ticket

If the problem you are having relates to the format or content of a PDF, including the PDF in the ticket is generally useful.

To include a PDF in a ticket: 

1. Open the PDF in Lawmaker (either generate a new one or view an existing PDF snapshot).

2. Save the PDF to your computer by clicking on the disk icon.

3. On the form in the portal, click on the Add attachments button at the bottom of the page:
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4. Upload the saved PDF.

Copying links to Lawmaker projects and documents

If the issue you’re raising relates to a specific Lawmaker project or document within that project, if you include a link to that 

project/document, it can help the support team investigate the issue and resolve it.

To include a link to the whole project:

1. From the dashboard, open the project you want to link to (it will open on the project tab).

2. Copy the URL from the browser address bar, using ctrl+c to copy it to the clipboard:

3. Paste the copied link into the Detailed description field on the support portal form.

To include a link to a specific document:

1. From the dashboard, open the project you want to link to.

2. Open the document you want to link to in the Editor (from the project tab or an amendment tab).

3. Copy the URL from the browser address bar for the tab containing the document, using ctrl+c to copy it to the clipboard:

4. Paste the copied link into the Detailed description field on the support portal form.

Note that the link will only work for users who can already access the project or document so sharing the link does not introduce the 

risk of unauthorised access. 
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Passwords and multi-factor authentication
Changing your password

Reset your password if you've forgotten it

Multi-factor authentication guide

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526943/Changing+your+password
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526951/Reset+your+password+if+you+ve+forgotten+it
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959/Multi-factor+authentication+guide
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Changing your password

Introduction

You can change your password in the application whenever you like.

How to change your password
1. Click on your name in the top right of the banner to show the drop down menu.

2. Select Change password

3. The system will present a dialogue box.

4. Add your current password and type in your new password twice.

5. Click Change password.

6. So long as your new password meets the system’s password requirements, your stored password will be updated. Otherwise you will be asked to 

provide a different password.
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Reset your password if you've forgotten it

Introduction

If you forget your password when logging in, it's possible to reset it without having to get an administrator to help you.

How to reset your password
1. Click on the 'Forgot your password' link at the bottom of the login screen.

2. In the dialogue box that appears, add your username and click Send Code.

3. The system will send an email containing a code to the address associated with that username.

4. Enter the code you receive together with your new password and click Submit.
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Multi-factor authentication guide

Introduction

Lawmaker uses multi-factor authentication to make the application more secure. 

The first time you sign in after your account has been created (or reset)

After you’ve updated your password, you’ll be asked to set up MFA.

To do this you will need to install an authenticator app on your mobile phone if you don't already have one. There are a range of 

authenticator apps for Android phones and iPhones. We recommend using Google Authenticator or Microsoft Authenticator - make sure you 

download the official app from a trusted source (see below).

More on fake Multifactor Authentication (MFA) scams

Lawmaker will display a QR code on the screen. Open your authenticator app and click on the plus sign to add a new account.  Follow the 

instructions in the app to scan the code on your computer’s screen. This will link your Lawmaker user account with the authenticator app 

and the app will start producing codes that can be used for signing in to Lawmaker.

Type in the code that is currently showing on the app and click Verify Security Token.

When you sign in for a second or subsequent time

Whenever you login in future you will first be asked for your username and password. You may then be asked to also provide a code from 

your authenticator app to provide additional assurance of your identity.

You will never be asked to pay any money when signing up to activate your Lawmaker account. If you are asked to subscribe or 

make a payment by the authenticator app, stop immediately and remove the app from your phone as this is likely to be an 

attempted scam.

There are fake authenticator apps which will look very similar to the genuine apps but may ask you to pay an annual or monthly 

subscription fee to use the app.  The genuine apps will never ask for payment. Some fake apps may also attempt to steal data from 

your phone including personal data, passwords and MFA tokens which could put Lawmaker, other corporate systems and potentially 

your own digital identity at risk.  

To avoid downloading a fake authenticator app, ensure you are downloading the app from a reliable source such as Google Play store 

or Microsoft’s store.  The genuine app may not always be the first on the list within the store if you search for an authenticator app.

Other things you can check for:

Check that the publisher of the app is who you would expect, for Google it will be Google LLC and for Microsoft it be Microsoft Corporation 

(check the spelling carefully as fake apps may have just one wrong letter). 

Look for grammar mistakes in the description which may indicate that it is not a real app.

Check the reviews - a lack of reviews or suspicious content may suggest the app is fake.

https://play.google.com/store/apps/details?id=com.google.android.apps.authenticator2&hl=en_GB
https://www.microsoft.com/en-gb/security/mobile-authenticator-app
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If the dialogue box above appears then open up your authentication app on your phone. Type the code showing on the phone into the 

dialogue box and click Continue.

What happens if I get a new phone or lose my phone?

If you get a new phone then the authenticator app will enable you to transfer your MFA keys from the old phone to the new phone (e.g. the 

old phone will generate a QR code which can be scanned into the new phone). Some authenticator apps also enable you to do a secure 

backup of your keys as another way of retrieving them on a new phone.

If you lost your phone and so were unable to transfer your keys to a new device then contact Lawmaker support to get your account reset.

More information about MFA

What is "multi-factor authentication"?

Multi-factor authentication means a user is only granted access to a system if they provide two or more different kinds of evidence as to their 

identity.

A password is one piece of evidence (it is something only the user should know). Further evidence can be something the user has in their 

possession (such as a card or USB stick) or an inherent characteristic of the user (e.g. a fingerprint).

For Lawmaker, in addition to providing a password, you will sometimes be asked to provide evidence that you have something in your 

possession (a mobile phone or tablet). The evidence will be a code generated by an app on your phone.

MFA makes Lawmaker more secure because, while it is conceivable that someone could find out your password or get hold of your phone, it 

would be difficult for someone to manage both at the same time.

How does it work in Lawmaker?

When you set up MFA and scan the QR code with your authenticator app, that code contains a unique key produced by Lawmaker (the key 

is essentially a very long and unique password).

The key gets stored in the authenticator app.

The authenticator app then uses a cryptographic algorithm to generate a six-digit code derived from the key plus the current time (hence 

why it changes all the time). The cryptography is needed so no-one intercepting your six-digit code can work out what the original key was.

Since Lawmaker knows what the key is, it can use the same algorithm to check that the code you type is valid. And since only your phone 

and Lawmaker should know what the key is (it is a shared “secret”) typing in a correct code is evidence that you have access to your phone 

and hence you are likely to be who you say you are.

What information about me or my Lawmaker account is stored on my phone?

The only thing stored on your phone is the key, i.e. the long code generated when you set up MFA. It is stored securely within the 

authenticator app. The code in itself does not contain any information about you or the Lawmaker application (it is essentially just a unique, 

random number). Equally, the Lawmaker application does not store any information about you or your phone as a result of setting up MFA.
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User Administration
User accounts within an organisation can be created and managed by admin users within that organisation. This is done from the user 

management screen which also enables admin users to view all users in their organisation and their status.

If you have permissions to create new users, etc you must do so in accordance with your responsibilities set out in the Security Operating 

procedures, which will have been provided to you. See also the Lawmaker Acceptable Use Policy . 

As an admin user you can:

create a new account for a user in your organisation,

reset an account, forcing the user to setup a new password and to setup multi-factor authentication (MFA) again,

disable and delete accounts,

grant and remove administrative permissions.

How to access the user management screen

From Lawmakers Dashboard or Project tab, Click on the dropdown menu in the top-right of the screen that shows your username and select 

User Management.

If you cannot see this option, then you do not have the necessary user administration permissions.

You can navigate back to the project dashboard at any time by clicking on the Home icon in the top left of the screen:

The user management screen will display a list of all the users in your organisation, together with their username, email address and 

whether their account is active or disabled.

You can filter and sort the list shown:

To filter the list, enter a username or email address in the text box above the list of users.

To sort the list, click on the relevant column heading.

More information on managing users can be found on the following pages:

Setting up the first admin user in an organisation

If no-one in your organisation already has administrative permissions, a User Champion, Super user or link lawyer can request that 

a user be granted user admin permissions by raising a request with the Lawmaker Service Team via the Support Portal.

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/350355457
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/350355457
https://lawmaker.atlassian.net/servicedesk/customer/portal/1
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Create a new user  

Reset an account  

Disabling and deleting an account  

Assigning admin or document permissions to a user  

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165445635
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165445635
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166428674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166428674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166232072
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166232072
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166133785
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166133785
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Create a new user
You can create a new user in your organisation if you have user admin permissions.  This is done from the user management screen - see 

User Administration .

How to create a new user 

1. Click on the Create User button on the right of the screen.

2. Enter a username for the new user.

3. Enter the user’s e-mail address.

4. Click on Create.

A message will pop up confirming the new user has been created and an email will be sent to the new user.

The email will provide the user with a temporary password which must be used within 48 hours to active the account. Otherwise the account 

will become disabled and will need reset before it can be used. 

It may be worth contacting the user after the account is set up to remind them to activate their account.

Further information on setting up multi-factor authentication can be found in the Multi-factor authentication guide  .

Tips for selecting a user name

A simple approach is use the first part of the user’s email address (i.e. the part before the @ symbol) or to use their full name with a full stop 

between each name.

You can include full stops and other punctuation in usernames but not spaces.

Usernames are not case sensitive.

Lawmaker usernames must be unique across every organisation that uses Lawmaker. If you receive an error when setting up a new user, try 

making the name more unique by adding an organisation identifier (e.g. “.opc”) at the end or a number.

If a new user does not receive the notification email

Check the email address is correct. If it is wrong then delete the account and create a new account.

Ask the user to check the email has not gone into their spam or junk folders.

Try resetting the account - see Reset an account  .

Contact the Lawmaker Service Team.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166428674
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/166428674
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Reset an account
An existing user account can be reset from the User Administration screen. When an account is reset, the user will need to set a new 

password and setup multi-factor authentication again before they can access Lawmaker.

Resetting an account can be useful where:

The user has not activated their account within the time limit (usually 48hr).

The user has forgotten their password or it has been compromised and they haven’t managed to reset it themselves in Lawmaker.

The user no longer has access to the device they were using for multi-factor authentication, e.g. they have replaced their mobile phone without 

transferring the authentication details to the new phone.

When an account is reset, the process is the same as when the account is initially created:

the user will receive an email with a temporary password.

The user must use that password to activate their account within 48hr.

They will be asked to change the password and set up multi-factor authentication when they log in with the temporary password.

How to reset an account
1. First go to the User Administration screen - see User Administration .

2. Identify the user whose account is to be reset. You can use the filter box, top-left, to find the account by typing in the first few letters of the account 

name or e-mail address

3. Click on the Actions menu on the account that it to reset.

4. Click Reset account in the menu.

 

 

 

 

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
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Disabling and deleting an account
User accounts can be disabled which will prevent the user from accessing Lawmaker. A disabled account can be subsequently deleted. 

Both of these actions can be done on the User Management screen.

You may wish to disable an account if, for example, the user is on extended leave or on secondment but you expect the user to return.  The 

account can then be re-enabled when they come back.

Accounts should also be disabled if they have been dormant for a significant length of time, e.g. 3 months.

Accounts should be deleted where the user has left the post that required access to Lawmaker (even if they have transferred to another 

organisation who also uses Lawmaker). Accounts should also be deleted if they have been dormant for an extended period, e.g. 1 year, or if 

they haven’t been activated when initially set up.

How to disable an account
1. From the User Management screen (see User Administration ), find the user you want to disable. You can use the filter above the list of users to 

help find the account by entering some of the account name or e-mail address.

2. Click on the Actions menu for the user you want to disable and select Disable User.

A message will appear confirming the account has been disabled. The account status will also change to Inactive.

The user will no longer have access to Lawmaker. If they try and log in they will receive an ‘Invalid username or password’ message.  

How to re-activate a disabled account

Disabled accounts can be reactivated by following the same steps as used to disable the account.

1. Find the user you want to re-activate on the User Management screen.

2. Click on the Actions menu for the user you want to re-activate and select Activate User.

Once activated, the user will be able to log in to Lawmaker again using their previous credentials.

How to delete an account

1. Find the user you want to delete on the User Management screen.

2. Click on the Actions menu for the user you want to delete and select Delete User.

A message will be displayed confirming the account has been deleted.

 

 

 

You can only delete an account if you have disabled it first.

Account deletion cannot be undone. If the user subsequently requires access then a new account will need to be created.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/165642243
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Assigning admin or document permissions to a user
Users can be assigned additional roles which give them enhanced permissions beyond the default permissions granted when an account is 

created.

Currently, users can be assigned the following additional roles:

User admin - this gives the user access to the user management screen and means the user can view and manage user accounts within their 

organisation.

Document admin - this means the user can view restricted documents within their organisation and update the document’s permissions. This role 

can be useful, for example, where a document has been restricted to a user who has left the organisation or otherwise unavailable - a document 

admin user can update the permissions on the document so another user can access it. (For more about restricted permissions see Managing do

cument permissions  and Managing amendment permissions .) 

A user’s roles can be managed by an admin user from the User Management screen.

How to do I assign (or remove) permissions from a user

1. From the User Management screen, find the user whose permissions you want to update.

2. Click on Actions and Update Admin Roles.

3. Use the checkboxes to assign or remove roles.

 

Before assigning either the User Admin or Doc Admin role to a user, ensure that you have the appropriate authorisation to do from 

within your organisation.

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/688286
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/170229761
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/170229761
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Lawmaker Acceptable Use Policy
This document sets out your responsibility, as a user of Lawmaker, to use the application in an appropriate way. This will help protect you, 

other users and partner organisations by reducing the risk of things like an accidental data breach or a successful cyber-attack.

This policy is in addition to, and does not over-ride, your organisation’s IT policies, which also apply to your use of Lawmaker. 

What is Lawmaker?

Lawmaker is an online application supporting the drafting and amending of legislation, both primary legislation (Bills and Acts) and 

secondary legislation (SIs and SSIs).  It is used across the UK Government and Parliament and the Scottish Government and Parliament.

Accessing Lawmaker

Devices

You should access Lawmaker from a device (e.g. a laptop) provided by your organisation wherever possible.  If you need to access 

Lawmaker from an alternative device, e.g. because your corporate network isn’t available, only use a device and an internet connection you 

trust and ensure you sign out of Lawmaker as soon as you have finished. Do not access Lawmaker from a public device, such as a 

computer in an Internet café.

Browsers

You should access Lawmaker using either Google Chrome or a version of Microsoft Edge which uses the Chromium engine (v.79 onwards); 

Lawmaker will not work with Internet Explorer or older versions of Edge.  For help upgrading your browser, click here.

Accounts, login and passwords

When your account is created, follow the instructions you receive by email as soon as possible to complete the setup.

You should create a secure password following best practice guidance. You will also need to use an authentication application (such as 

Google Authenticator or Microsoft Authenticator) on a phone or tablet to complete setup and to login in future - you can find more 

information in the Multi-factor authentication guide .

Keep login details secure and do not share them with anyone else.  Don’t login to Lawmaker using another user’s credentials.

Protecting information

Lawmaker can be used to create and store OFFICIAL, including OFFICIAL-SENSITIVE, documents.  It should not be used to store 

legislation above this classification.  For further information on document classifications, see the Government Security Classifications.

Lawmaker is designed as a collaborative tool allowing multiple users to work on the same documents and for documents and information to 

be shared among different organizations. It is therefore particularly important you act responsibly and professionally in handling and 

protecting information. This includes:

Ensuring all information in Lawmaker is created, used, shared and disposed of in line with business need and in compliance your organisation’s 

Information Management Policy,

Only accessing documents that you have a valid business reason to access,

Not deleting, amending, sharing or downloading documents unless authorised to do so,

Not attempting to gain unauthorized access to information on Lawmaker or doing anything that might prevent legitimate access to it,

Being careful not to be overlooked in public areas when using Lawmaker.

https://www.gov.uk/help/browsers
https://www.ncsc.gov.uk/blog-post/three-random-words-or-thinkrandom-0
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/25526959
https://www.gov.uk/government/publications/government-security-classifications
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Compliance

Any actual or suspected breach of this policy should be reported as soon as possible to your Line Manager and to the Lawmaker Service 

Team. You may also follow an appropriate whistleblowing procedure if you believe someone is misusing Lawmaker or the information it 

holds.

Note that breaching this policy may result in suspension of user accounts and/or disciplinary procedures (including criminal prosecution) 

which could lead to dismissal.

 

 Note: All activity on Lawmaker is audited and logs are available to authorised persons for examination.

Version: v1.0 - March 2024
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Known Issues

Getting help

If you need help with an issue that isn’t listed below or an existing issue, get in touch with Lawmaker Support by email: 

lawmaker@nationalarchives.gov.uk

List of issues

LM-148 Can't edit a Schedule heading or cross-heading when Block Tags is turned on

LMS-110 Ligature Characters not rendering in PDF

LMS-1260 Unable to publish amendment list

LMS-1315 Words missing from text before commencement history table

LMS-1356 Unable to create Official Lists due to a "Can’t read properties of null" error

LMS-2018 Amendment quoted structure is not appearing in the PDF

LMS-2269 LoDA created from temporary list doesn't behave correctly

LMS-2372 Unable to extract zip file

LMS-2641 Amendments on a pre-introduction LoDA disappear from the Amendment Manager tab and are not visible to Commons/Lords users after

submission

LMS-2646 Amendment list duplication not working as expected

LMS-349 White screen when attempting to login into Lawmaker

LMS-41 Amendment numbering doesn't restart in SP and HoL amendment lists between stages

LMS-52b Amendment is being shown/sorted as if it were a new clause/section amendment when it is a clause/page/line amendment

LMS-52 Provisions in quoted structure look different from surrounding Bill or another quoted structure

LMS-579 Can't generate PDF, duplicate, download or share working version

LMS-581 Can't insert text following footnotes

LMS-689 Unable to save info in Document Information Tab

Resolved issues

 

This is a list of bugs and issues raised by users that have yet to be fixed.

Details of any possible workaround to the issues are also included.

mailto:lawmaker@nationalarchives.gov.uk
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/5668869/LM-148+Can+t+edit+a+Schedule+heading+or+cross-heading+when+Block+Tags+is+turned+on
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/46563329/LMS-110+Ligature+Characters+not+rendering+in+PDF
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/180256770/LMS-1260+Unable+to+publish+amendment+list
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/184713217/LMS-1315+Words+missing+from+text+before+commencement+history+table
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/420708355/LMS-1356+Unable+to+create+Official+Lists+due+to+a+Can+t+read+properties+of+null+error
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/226361345/LMS-2018+Amendment+quoted+structure+is+not+appearing+in+the+PDF
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/222199809/LMS-2269+LoDA+created+from+temporary+list+doesn+t+behave+correctly
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/250085387/LMS-2372+Unable+to+extract+zip+file
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/281509890/LMS-2641+Amendments+on+a+pre-introduction+LoDA+disappear+from+the+Amendment+Manager+tab+and+are+not+visible+to+Commons+Lords+users+after+submission
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/281509890/LMS-2641+Amendments+on+a+pre-introduction+LoDA+disappear+from+the+Amendment+Manager+tab+and+are+not+visible+to+Commons+Lords+users+after+submission
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/282132485/LMS-2646+Amendment+list+duplication+not+working+as+expected
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/85164033/LMS-349+White+screen+when+attempting+to+login+into+Lawmaker
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/18087937/LMS-41+Amendment+numbering+doesn+t+restart+in+SP+and+HoL+amendment+lists+between+stages
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/15564801/LMS-52b+Amendment+is+being+shown+sorted+as+if+it+were+a+new+clause+section+amendment+when+it+is+a+clause+page+line+amendment
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/15040513/LMS-52+Provisions+in+quoted+structure+look+different+from+surrounding+Bill+or+another+quoted+structure
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/108593183/LMS-579+Can+t+generate+PDF+duplicate+download+or+share+working+version
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/111214593/LMS-581+Can+t+insert+text+following+footnotes
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/129138703/LMS-689+Unable+to+save+info+in+Document+Information+Tab
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/60489755/Resolved+issues
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LMS-41 Amendment numbering doesn't restart in SP and HoL amendment lists 
between stages

Issue description

When you generate a Scottish Parliament amendment list or a House of Lords amendment list, the numbering assigned to new 

amendments is based on the existing published amendments. The numbering logic applies to all amendments relating to a particular Bill 

version.

If there are no amendments agreed to at a particular stage then the Bill will not be republished after that stage and amendments at a 

subsequent stage will be against the original Bill version. 

As a result, currently Lawmaker will assign numbers in subsequent stage that continue on from the numbering at the previous stage when 

amendments should restart at 1 for each stage.

Workaround

Even though an “as-amended” Bill version doesn’t need to be created, if you publish one internally in Lawmaker that will force the 

numbering to return to 1. It is best to do this immediately after the first amending stage is complete (i.e. when you know that there is no need 

to publish a real as-amended version) - this will mean that all amendments can be drafted against the new version. If it is done later, you can 

use the Move Amendments to another Stage feature to associate existing amendments with the new version.

1. Open the last published version of the Bill in the Editor.

2. Click on the Document Information panel on the right

3. In the version rubric dropdown, select “Other…” and enter a name that will help you identify that this is a version published for the purposes of the 

subsequent stage only, e.g. “As Introduced - Report stage”

4. Wait 5 seconds for the Bill to be updated and then save the document.

5. Generate a PDF of the Bill, making sure line numbering is on and that a snapshot will be saved.

6. Close the Editor and publish the new PDF snapshot.

You should now find that on the Amendment Workspace, Amendment Manager and Official List tabs, that the default version is now the 

custom version you entered in step 3 above. 

LMS-41 HoL, SP v11.4 ? OPEN  

ID Raised by Affects version Related Jira tickets Status
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LMS-52 Provisions in quoted structure look different from surrounding Bill or 
another quoted structure

Issue description

Sometimes provisions (e.g. subsections) in a quoted structure are formatted slightly differently from provisions elsewhere in the Bill or in 

another quoted structure (e.g. in another amendment). For example:

 

This is caused by the quoted structure being set as a different document type from the main document or the other quoted structure. Quoted 

structures have a docName attribute which helps the PDF renderer present the content of the quoted structure appropriately. It is mainly 

used to allow SI/SSI provisions to be rendered correctly in a Bill and vice versa. But it means that UK Bill/Act provisions will be presented 

slightly differently from Scottish Bill/Act provisions as well.

Workaround

You can manually edit the document type of a quoted structure in the Editor using the attributes panel.

1. Place your cursor within the quoted structure

2. Click on the Quoted Structure breadcrumb

3. Click on the Attributes panel on the right of the screen

LMS-52 HoL, OPC v11.4 ? OPEN  

ID Raised by Affects version Related Jira tickets Status



537

4. Click on the ukl:docName field to edit it:

if the provisions should be presented like UK provisions enter “ukpga”

if the provisions should be presented like Scottish provisions enter “asp”

5. Click Accept.

There may be no visible difference in the Editor but you should find when you generate a PDF that the formatting has changed.
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LMS-52b Amendment is being shown/sorted as if it were a new clause/section 
amendment when it is a clause/page/line amendment

Issue description

If you create an amendment as a new clause/section amendment (or new schedule amendment) and then edit the amendment so it amends 

an existing clause/section/schedule instead, then the amendment may continue to appear in the Amendment manager and to be sorted in 

amendment lists as if it were a new clause amendment.

This is a result of how Lawmaker parses amendments:

1. When the amendment is first created and saved, it is parsed and key information is stored in attributes to help Lawmaker sort it correctly. In particular, 

the clause number, page and line numbers are all stored. For new clause amendments, whether the clause is being inserted “before” or “after” is also 

stored.

2. When the amendment is edited so it is no longer a new clause amendment and saved, it is parsed again and the page and line information is 

updated. However, even though it no longer refers to inserting before or after the clause, the attribute that stores that information is not being 

updated.

Workaround

If an amendment appears in the Amendment Manager including “After” or “Before” in the location column when it isn’t a new 

clause/schedule amendment, you can manually edit the amendment information to remove the erroneous attribute.

1. On the Amendment Manager tab, open the amendment in an temporary list (Amendment Actions>Create temporary list)

2. In the editor, place your cursor in the amendment.

3. Click on the Amendment Information panel on the right

4. Delete the text “After” or “Before” that appears in the Location field (do not use space bar to delete the text as this will leave a whitespace)

5. Wait 5 seconds or so until the amendment is updated

6. Save the amendment.

 

 

LMS-52 HoL v11.4 ? OPEN  

ID Raised by Affects version Related Jira tickets Status
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LMS-110 Ligature Characters not rendering in PDF

Issue description

Some ligature characters (see list below) are not rendered properly in PDFs (they may appear as empty boxes instead). One ligature in 

particular, �,  will stop the PDF from rendering at all.

Ligatures usually end up in Lawmaker documents because text has been copied and pasted from another source such as FrameMaker or 

InDesign where the ligature may have been created automatically when the user entered the individual characters.

Workaround

In the Editor delete the ligature character and insert the corresponding normal characters.

List of ligatures and whether they appear in the PDF

LMS-110 HoC v12 LBB-281 Open

ID Raised by Affects version Jira/Trello reference(s) Status

Ꜳ U+A732 No

ꜳ U+A733 No

Æ U+00C6 Yes

æ U+00E6 Yes

Ꜵ U+A734 No

ꜵ U+A735 No

Ꜷ U+A736 No

 ꜷ U+A737 No

Ꜹ U+A738 No

 ꜹ U+A739 No

Ꜻ U+A73A No

ꜻ U+A73B No

Ꜽ U+A73C No

ꜽ U+A73D No

� U+1F670 internal server error

ff U+FB00 No

ffi U+FB03 No

ffl U+FB04 No

Ligature Unicode Character Displayed?



540

 U+FB01 Yes

 U+FB02 Yes

Ƕ U+01F6 Yes

ƕ U+0195 Yes

℔ U+2114 No

Ỻ U+1EFA No

ỻ U+1EFB No

Œ U+0152 Yes

œ U+0153 Yes

Ꝏ U+A74E No

ꝏ U+A74F No

� U+AB62 No

ẞ U+1E9E Yes

ß U+00DF Yes

st U+FB06 No

st U+FB05 No

Ꜩ U+A728 No

ꜩ U+A729 No

ᵫ U+1D6B Yes

� U+AB63 No

W U+0057 Yes

w U+0078 Yes

� U+A760 No

� U+A761 No

ĳ  U+0132 Yes

Ĳ U+0133 Yes
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LM-148 Can't edit a Schedule heading or cross-heading when Block Tags is 
turned on

Issue description

It isn’t possible to edit a Schedule heading or cross-heading when Block Tags is turned on.

Workaround

Turn off tag display:

1. In the editor, select Document menu > Preferences… in the toolbar.

2. In the Preferences dialog, set Tags display mode to No tags.

3. Click Apply.

 

 

LM-148 OPC ? SPT-477 OPEN  

ID Raised by Affects version Jira/Trello reference(s) Status
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LMS-349 White screen when attempting to login into Lawmaker
Issue description

When you try to login into Lawmaker, instead of reaching the dashboard you get a blank page, sometimes with a small red ‘Log in’ box in the 

top right corner. Refreshing the page results in the same white screen and you are unable to access Lawmaker.

Workaround

Clearing the browser cache or local storage will solve the issue.

Clearing the local storage rather than all of the cache has the advantage that only Lawmaker will be affected.

How to clear the local storage (instructions for Microsoft Edge and Chrome)

1. On the white page, press F12 to open the Developer Tools. Alternatively, right-click on the white page and select Inspect.

2. Select Application from the top bar of developer tools (you may have to click on the double right arrow to see it).

3. Under the Storage tab, click Local Storage to expand the list.

4. Right-click on https://lawmaker.legislation.gov.uk  and click Clear.



543

5. Close developer tools and refresh the page.

How to clear the cache

In Microsoft Edge:

1. Select Menu (3 dots icon on top right corner of the browser) > Settings > Privacy, search & services

2. Under Clear browsing data, select Choose what to clear.

3. Select the desired time range and check "Cached images and files" and "Cookies and other site data" 

4. Select “Clear now”.

In Chrome:

1. Select Menu (3 dots icon on top right corner of the browser) > More tools> Clear browsing data

2. Select the desired time range and check "Cached images and files" and "Cookies and other site data" 

3. Select “Clear data”.
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LMS-579 Can't generate PDF, duplicate, download or share working version
Issue

This issue occasionally affects working versions of Bills or SIs. If a document is affected by this issue:

generating a PDF will fail;

attempts to duplicate the working version will fail with an error “Can not checkin a document to a non-primary Version Series without the 'Branched 

From Version Description' property set.”;

attempts to do any other action which generates a snapshot will also fail, e.g. download Zip file, Share, Publish.

To ascertain if this specific issue is affecting a document you are working on, trying duplicating it. If you get the error message described 

above then follow the workarounds described below until this issue is resolved by our developers.

Workaround

To generate a PDF

In the Generate PDF dialog box, uncheck the option to Record snapshot.

Click Generate and the PDF should display as normal.

To create a new working version that isn’t affected by the problem

1. First make sure the version is saved.

2. On the project tab, click on the toggle next to the affected working version so you can see all the snapshot versions. You should be able to see an 

“Auto-backup” snapshot which will be the document as last saved.

3. In the Actions menu for that snapshot, select Download zip file.

4. Uncheck the “Resolve dates in XML” option and click Download.

5. Extract the XML file from the zip file and then use the Upload Document option on the Project tab to reimport it into your project.
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LMS-581 Can't insert text following footnotes
Issue

It is difficult to go back and insert text following a footnote.  Typing immediately after insert a footnote (Alt F) works fine.  However, if you try 

and click after an existing footnote which is at the end of a paragraph, the cursor is placed inside the footnote element where text isn’t 

allowed so when you type an error is displayed.

Workaround

There are a number of ways to get round this issue:

1. if the footnote is hidden, click just to the right of the footnote then press the right arrow key twice (the “Text” breadcrumb should then be highlighted); 

2. if the footnote is expanded, place your cursor at the very end of any text in the footnote and again press the right arrow key twice.

3. Select Documents menu>Preferences. Select Full Tags from the Tags display mode menu. Click Apply.

Find the footnote. place your cursor between the Footnote tag and Text tag and type your text.  

To turn off Full Tags, follow the steps above and select No Tags (or your preferred setting).
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LMS-689 Unable to save info in Document Information Tab
Issue
In a UK or Scottish Bill, if an element within the Preface is deleted (e.g. the explanatory notes statement in a Scottish Bill) , selecting a 

different option in version rubric menu in the Document Information Panel will result in an error and the change won’t be saved.

 

Workaround
Until this issue is fixed, the missing elements need to be reinserted into the preface before you can change the version rubric. To do this:

1. Go to the Project Tab of the project containing the document.

2. Click on +new and create a blank document (folder and name are unimportant).

3. Open the blank document in the Editor.

4. Select the preface element by placing the cursor within the preface (e.g. click on the title in a Scottish Bill) and then clicking on the Preface 

breadcrumb to select all of the preface

5. Press Ctrl+c to copy the preface.

6. In the document that caused the issue, select the preface by  placing the cursor within the preface (e.g. click on the title in a Scottish Bill) and then 

clicking on the Preface breadcrumb.

7. Press Ctrl+v to paste the copied preface thus restoring the original elements.

8. You will then be able to update the version rubric again in the Document information panel.

9. Once you have updated the rubric, you can delete any elements from the preface that you don’t want.
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LMS-1260 Unable to publish amendment list
Issue

When trying to publish an amendment list, the publishing action fails and a error is shown as follows:

The publish action failed.

java.lang.NullPointerException

The issue is caused by a bug that is triggered whenever an amendment contains a table which two or more cells which have been merged 

vertically. This triggers a problem with the algorithm which assigns Ids to elements within the amendment which, in turn, triggers the 

publishing action to fail because as part of publishing amendments, the Ids within each amendment are updated.

This issue should be resolved in version 14.1 of Lawmaker.

Workaround

If this issue occurs when trying to publish a list, you can work around it by following the steps below:

1. Open up the list that won’t publish in the Editor.

2. Find the amendment (or amendments) which contain tables and identify any that have cells that have been merged vertically.

3. Put your cursor within that amendment and then select the amendment body by clicking on Amendment Body in the breadcrumbs.

4. Open the Attributes panel on the right side of the Editor.

5. Edit the eId attribute by deleting the underscore and press Enter.

6. Save the amendment list and close the document.

7. Try publishing the list again.
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LMS-1315 Words missing from text before commencement history table
Issue

If you insert a commencement history table into an SI  (using Insert menu > Insert Commencement Table), when you generate a PDF of 

the SI, some of the words in the text before the table may be missing.

In the Editor you will see:

But in the PDF you see:

 

The missing words are automatically generated placeholders which contain the type of SI (e.g. “Regulations” or “Order”). For some reason, 

those placeholders aren’t currently showing in the PDF if they are contained within the commencement table section of the document.

Workaround

To avoid this problem until it is fixed, the best solution is to delete the placeholder and manually type in the text.

To delete the placeholders:

1. In the paragraph before the commencement history table click on the highlighted text that says "Regulations" (or “Order” etc. if the SI is a different 

type).

2. In the breadcrumbs (at the bottom or top of your screen depending on how you have it set up), click on "Subtype" 

3. Press the Backspace key on your keyboard and the highlighted text should disappear.

4. Place your cursor back where the text was and type it in manually.

5. Repeat for the second occurrence of “Regulations”.

6. Generate a new PDF.
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LMS-1356 Unable to create Official Lists due to a "Can’t read properties of 
null" error

Issue description

An error message sometimes appears when trying to create an amendment list from the Official List tab. The error message is “Can’t read 

properties of null (reading focus)”. This can also happen when trying to create a new list on the Amendment Workspace tab.

 

You may find that the list has actually been created, despite the error: closing the modal and refreshing the page sometimes shows the list 

has been generated.

LMS-1356 HoL 14 SPT-1342 OPEN

ID Raised by Affects version Jira reference(s) Status
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Workaround

This error message appears to be caused (or at least exacerbated) by browser settings related to allowing or blocking pop-up windows. The 

following steps should help to resolve the issue:

In Chrome:

1. Open Chrome Settings: Click on the three dots in the top-right corner of the Chrome browser window to open the menu. From the dropdown, select 

"Settings."

2. Navigate to Privacy and Security: In the Settings menu, scroll down and click on "Privacy and Security" in the left-hand sidebar.

3. Access Site Settings: Within the Privacy and Security section, locate and click on "Site Settings".

4. Manage Pop-ups and Redirects: Under the Permissions section, find and click on "Pop-ups and redirects".

5. Allow Pop-ups from Lawmaker: In the Pop-ups and Redirects settings, locate the "Allow" section. Click on "Add" next to "Allow," and enter the URL 

for Lawmaker's website (e.g., https://lawmaker.legislation.gov.uk/, https://lawmaker.staging.legislation.gov.uk/, 

https://lawmaker.dev.legislation.gov.uk/). This will whitelist Lawmaker and prevent Chrome blocking its pop-ups.

In Edge:

1. Open Edge Settings: Click on the three dots in the top-right corner of the Edge browser window to open the menu. From the dropdown, select 

"Settings."

2. Navigate to Cookies and Site Permissions: In the Settings menu, scroll down and click on "Cookies and Site Permissions" in the left-hand sidebar.

3. Open Pop-ups and Redirects: Within the "Cookies and Site Permissions" section, locate and click on "Pop-ups and Redirects".

4. Allow Pop-ups from Lawmaker: In the Pop-ups and Redirects settings, locate the "Allow" section. Click on "Add" next to "Allow," and enter the URL 

for Lawmaker's website (e.g., https://lawmaker.legislation.gov.uk/, Lawmaker  , https://lawmaker.dev.legislation.gov.uk/). This will whitelist 

Lawmaker and prevent Edge blocking its pop-ups.

https://lawmaker.legislation.gov.uk/
https://lawmaker.staging.legislation.gov.uk/
https://lawmaker.dev.legislation.gov.uk/login
https://lawmaker.legislation.gov.uk/
https://lawmaker.staging.legislation.gov.uk/
https://lawmaker.staging.legislation.gov.uk/
https://lawmaker.dev.legislation.gov.uk/login
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LMS-2018 Amendment quoted structure is not appearing in the PDF

Issue description

In Scottish Amendment lists, when the quoted structure is updated it is no longer displayed in the PDF.

Workaround
1. In the Editor, place your cursor inside the Quoted Structure

2. In the Breadcrumb (which may be at the top or bottom of the editor), click on Quoted Structure 

3. Select Attributes from the right-hand panel

4. Click on the box next to ukl:docName 

5. Enter the following:  ukpga

6. Click on Accept

 

 

LM-2018 PCO v15.X SPT-1506 OPEN  

ID Raised by Affects version Jira/Trello 

reference(s)

Status
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LMS-2269 LoDA created from temporary list doesn't behave correctly
Issue

An issue has been identified when you create a list of draft amendments (a LoDA) by saving a temporary list, i.e. when you:

1. Select some amendments from the Amendment Manager tab

2. From the Actions menu, select Create Temporary List

3. From the Document menu, select Save as… to create a LoDA from that list.

Several aspects of working with this kind of list will not operate correctly, e.g.

New amendments created on the list will not appear on the Amendment Manager.

Dragging and dropping amendments to change the order will result in new amendments being created rather than the original amendment being 

moved.

Likewise, pasting in an amendment from another list will result in a new amendment being created rather than the original amendment.

Trying to duplicate the list will result in an error.

The root cause of the issue is a missed consequential from changes that were made in version 15 to better handle Bill versions for UK Bills.

To determine whether an existing LoDA is affected by this issue, try duplicating it (On the project tab, select Actions>Duplicate version in 

relation to the relevant LoDA). If duplicating fails then the LoDA is affected by the issue - a new LoDA should be created using the approach 

described in the workaround (copying the amendments from the affected list rather than a new temporary list).

Workaround

Since the issue affects the list, not the amendments, the best workaround is to create a separate list and copy the amendments into it rather 

than using the Save as… feature. So:

1. Select amendments from the Amendment Manager tab.

2. From the Actions menu, select Create Temporary List.

3. Copy all of the amendments in the list (use ctrl+click to select multiple amendments in the structure view).

4. Go back to the Amendment Workspace tab and create a new LoDA from there.

5. Place you cursor in the empty amendment in the new LoDA and paste all the amendments from the temporary list.

6. Delete the empty amendment at the beginning of the LoDA

7. Save the new LoDA and close the temporary list.
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LMS-2372 Unable to extract zip file

Issue description

Error message when trying to extract a zip file downloaded from Lawmaker.

The issue is caused by unicode character in the project name, potentially copied and pasted from outside Lawmaker (eg: Word).  In the 

case reported this was an apostrophe.

Workaround

The work around is to delete the character from the project name and then download the zip again.

1. Open a working version in the Editor

2. Expand the Document Information panel on the right of the Editor

3. Delete any non-letter characters and re-insert them.

4. Save the Document

5. Close the Editor

6. Retry downloading the zip file.

LMS-2372 HMT 15.2 SPT-1550 OPEN  

ID Raised by Affects version Jira reference(s) Status
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LMS-2641 Amendments on a pre-introduction LoDA disappear from the 
Amendment Manager tab and are not visible to Commons/Lords users after 
submission

Issue Description

In a UK Bill project, if a List of Draft Amendments has been created during the pre-introduction stage, and an ‘As Introduced’ version is 

subsequently published (either by the Commons or the Lords), the amendments in the pre-introduction LoDA will disappear from the 

Amendment Manager tab. (The LoDA itself will still be visible on the Amendment Workspace tab, however.)

As a result of this bug, any amendments which are Submitted from the pre-introduction LoDA will not be visible to Commons or Lords users.

Additionally, amendments which were drafted in pre-introduction LoDAs and then copied and pasted into new LoDAs will continue to exhibit 

this problem, even if a published ‘As Introduced’ version of the bill existed when the new LoDA was created.

Please also note that any new amendments drafted in a pre-introduction LoDA, or a duplicated version of a pre-introduction LoDA, will 

continue to exhibit this problem, even if a published ‘As Introduced’ version of the bill exists when the new amendments are drafted.

Workaround

Note that this workaround should be performed before submitting your amendments from the LoDA, otherwise it won’t work. As soon as you 

submit your amendments they become locked for editing, so attempting to move or update the LoDA after that point will fail and a warning 

will appear, such as this:

Workaround Steps:

If you notice that amendments in a LoDA are not visible on the Amendment Manager tab, or if you know that amendments were drafted in a 

LoDA created at pre-introduction stage, you can use the following steps to Move the List and update all the amendments' metadata so they 

become associated with the published ‘As Introduced’ version.

1. On the Amendment Workspace tab, click the Actions menu next to your LoDA and select Move to a different stage

2. A modal will appear asking you to select a Stage and Bill version. Select the correct Stage and the ‘As Introduced (Commons)’ or ‘As Introduced 

(Lords)’ Bill version. Click Confirm. 

LMS-2641 OPC v15.X SPT-1577 OPEN

ID Raised by Affects version Jira reference(s) Status
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LMS-2646 Amendment list duplication not working as expected

Issue Description

When using the Duplicate function from the Actions menu on a List of Draft Amendments, the duplicated list may sometimes appear 

against an earlier Bill version on the Amendment Workspace tab. For example, when duplicating a LoDA which is associated with the ‘As 

amended in Committee’ version of a Bill, the duplicate copy may appear against the ‘As Introduced’ version.

This bug affects LoDAs which were created against a particular version of a Bill and then moved (using the Move to a different stage 

function). On duplication, the new copy reverts to being associated with the bill version that the LoDA was first created against.

Workaround

After using the Duplicate function, locate the new copy of the LoDA by changing the top-left filter on the Amendment Workspace tab:

From the Actions menu next to the duplicated list, select Move to a different stage

In the modal, pick the correct Stage and the correct Bill version and click Update.

This will move the LoDA to the correct Bill version.

LMS-2646 OPC v15.X SPT-1577 OPEN

ID Raised by Affects version Jira/Trello 

reference(s)

Status
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Resolved issues
This section contains previously known issues that have now been resolved.

Resolved - LMS-20 Can't format characters as superscript or subscript

Resolved - LMS-66 Member's name on UK Parliament Website isn't the same as that in Lawmaker

Resolved - LMS-79 White stars are being applied to amendments incorrectly

Resolved - LMP248 Can't insert footnotes in text before quoted structure (i.e. within mod element)

Resolved - LMS-326 Amendment list (LoDA or official list) is inaccessible

Resolved - LMS-246 Dropdown menus in Create New LoDA and Official List dialogue boxes not working

https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/7274497/Resolved+-+LMS-20+Can+t+format+characters+as+superscript+or+subscript
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/21233665/Resolved+-+LMS-66+Member+s+name+on+UK+Parliament+Website+isn+t+the+same+as+that+in+Lawmaker
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/22020099/Resolved+-+LMS-79+White+stars+are+being+applied+to+amendments+incorrectly
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/11010049/Resolved+-+LMP248+Can+t+insert+footnotes+in+text+before+quoted+structure+i.e.+within+mod+element
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/88506381/Resolved+-+LMS-326+Amendment+list+LoDA+or+official+list+is+inaccessible
https://lawmaker.atlassian.net/wiki/spaces/USERMANUAL/pages/12943361/Resolved+-+LMS-246+Dropdown+menus+in+Create+New+LoDA+and+Official+List+dialogue+boxes+not+working
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Resolved - LMS-20 Can't format characters as superscript or subscript

Issue description

It isn’t possible to format characters as superscript or subscript in the editor. This is needed, for example, when expressing chemical 

formulas or areas.

Workaround

The Editor and the PDF generator do actually support subscript and superscript characters but at the moment there is no way through the 

toolbar or menus to add the necessary XML elements to your document.

To get around this, you need to edit the XML of your document directly.

1. In the Editor, place your cursor at the text you want to format.

2. Select Document menu > Edit as XML. (Note: you can only do this if no other users have locks on any part of your document.)

3. The XML view of your document will open. The text you want to format (and your cursor) will be just off the bottom of your screen. Scroll down to view 

it.

4. Before the first character you want to format, type in “<sup>” or “<sub>” depending on whether you want superscript or subscript.

5. After the last character you want to format, type in “</sup>” or “</sub>” depending on the element you inserted in step 4.

6. The result should look something like this:

7. Click Switch to author mode to take you back to the normal Editor view. It should look like this:

 

 

LMS-20 OPC, HoC v11.4 LDAPP-3450 Awaiting Deployment 

ID Raised by Affects version Jira/Trello reference(s) Status
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Resolved - LMS-66 Member's name on UK Parliament Website isn't the same 
as that in Lawmaker

Issue description

Amendments published on Lawmaker are sometimes appearing on Parliament’s website with an incorrect proposer or supporter name, i.e. 

the name showing in Lawmaker is different from that shown on the website.

This is caused by not selecting the Member's name from the auto-suggestions in the ‘Proposer/Supporter' dialogue box and instead just 

typing the name in and pressing Enter. In that case Lawmaker will assume you are creating a custom (new) name that doesn’t exist on the 

list supplied by Parliament and will assign it a temporary ID.  

The temporary ID assigned happens to correspond to an ID for a previous Member in Parliament’s Members Names Information System 

(MNIS) which is why the website is displaying the wrong name.

This issue can also arise if you  paste a copied name and click Enter.  

A feature improvement request has been created to improve the usability of this feature and to change the temporary ID assigned.  In the 

meantime, follow the workaround below.

Workaround

When typing into the ‘Proposer/Supporter’ dialogue box, always select the suggested name in the drop-down menu by clicking on it (even if 

it is the same as what you have just typed).

 

LMS-66 HoL v.11.4  OPEN  

ID Raised by Affects version Related Jira tickets Status
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Resolved - LMS-79 White stars are being applied to amendments incorrectly

Issue description

The white star assignment rule has been implemented incorrectly so that if an amendment has a published date that matches the supplied 

white star date, a white star is assigned to it.  The rule should have been applied so that white stars are only assigned if the amendment's 

FIRST published date matched the white star date.

There are 2 workarounds, depending on numbers of amendments involved:

Workarounds

Option 1: Continue to use the "white star" date in the 'Update List' dialogue box and remove white stars from amendments that shouldn't 

have them by:

1. using the 'Update star status' in the right-click menu OR

2. updating the Attributes right-hand panel one-by-one

a. clicking on 'Component' in the breadcrumb of the selected amendment

b. Opening 'Attributes' right-hand panel

c. Deleting the white star in the  ukl:statusIndicator field and selecting 'Accept'

 

Option 2: Don't use the "white star" date in the 'Update List' dialogue box (so no white stars are assigned) and add white stars manually 

onto the amendments that should have them (might be fewer to update with this approach depending on the day)

1. using the 'Update star status' in the right-click menu OR

2. updating the Attributes right-hand panel one-by-one by:

a. clicking on 'Component' in the breadcrumb of the selected amendment

b. Opening 'Attributes' right-hand panel

c. pasting ☆ into the  ukl:statusIndicator  into the input field and selecting 'Accept'

LMS-79 HoL v11.5 SPT-932 OPEN  

ID Raised by Affects version Related Jira tickets Status
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Resolved - LMP248 Can't insert footnotes in text before quoted structure (i.e. 
within mod element)

Issue description

It isn’t possible to insert a footnote within the text before a quoted structure because that text is wrapped in a <mod> element. 

Workaround

Footnotes are allowed within <mod> elements but currently the context rules mean that the insert option isn’t showing in the relevant menus 

when the cursor is within a <mod> element.

To get around this, you need to create the footnote somewhere else and then cut and paste it into the correct location.

1. Place your cursor within text that is not text before a quoted structure.

2. Insert a footnote (e.g. use the ALT+F shortcut or use the right-click menu option “Insert Footnote”)

3. Click on the footnote to expand it.

4. Click on the “Footnote” breadcrumb which will either be at the top or bottom of the Editor pane depending on your settings

5. Cut the footnote by pressing CTRL+X.

6. Place your cursor where you actually want the footnote to be.

7. Paste in the footnote by pressing CTRL+V.

 

 

LMP248 PCO v11.3 SPT-908 OPEN  

ID Raised by Affects version Jira/Trello reference(s) Status
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Resolved - LMS-326 Amendment list (LoDA or official list) is inaccessible
Issue

An amendment list can become inaccessible and can’t be opened in the Editor. This may affect a list of draft amendments (on the 

Amendment Workspace Tab) or an official list (on the Official Lists tab).

If a list is affected by this issue, when you click the Edit button for the list on the relevant tab, a new tab is opened and the progress bar 

begins but an error appears behind it instead of the Editor loading.

You may also see a “Failed to fetch” error pop up on the Amendment Workspace Tab or the Official Lists Tab:

Cause

The issue is being caused by data corruption in an index used by Lawmaker to assemble all the amendments within the list. It does not 

mean there is a problem with the amendments or the other content of the list but it prevents Lawmaker from making the compiled list 

available in the Editor.

We’re currently working on a fix that will avoid this being an issue in future.

Workaround

There are only limited workarounds to this issue because intervention from Leidos is required to properly fix the document in question.

We therefore recommend you take one of the following approaches:

If the affected list is a list of draft amendments (LoDA) then you can recreate the list by

a. On the Amendment Manager Tab, select the amendments that were in the LoDA.

b. In the Actions menu, select Create temporary list.

c. Once the list has opened in the Editor, in the toolbar select Document>Save as… to create a new LoDA.

If the affected list is an official list that doesn’t contain much content other than the amendments themselves (e.g. a Scottish daily list or a Lords daily 

sheet) then generating a new list may the easiest way to resolve the issue.

If the affected list is an official list that does contain more non-amendment content (e.g. a Commons Marshalled list) then duplicating an older version 

of the list and updating it may be possible if there haven’t been many changes made.

If you can wait for a resolution until the next working day, log a support request and we’ll get the list fixed overnight by Leidos.
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If the matter is urgent and none of the approaches above will work for you, then request support directly from Leidos by using the phone number we 

have supplied. Their out-of-hours team should be able to fix the document in question fairly quickly.

Even if you work around the issue by taking an approach above, it would still be helpful if, at some point after, you can log a support request 

notifying us of the document that was affected so we are aware the issue has occurred and can investigate.
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Resolved - LMS-246 Dropdown menus in Create New LoDA and Official List 
dialogue boxes not working

Issue description

Clicking on the down arrow next on the Bill Version, House and Stage dropdown menus in the dialogue boxes for creating a new LoDA or 

Official list doesn’t bring up the list of options or only does so erratically.

Workaround

Instead of clicking on the arrow, click on the white space between the text showing the dropdown (e.g. “Please select…”) and the down 

arrow.

 

 

LMP250 OPC v11.3 SPT-846 OPEN  

ID Raised by Affects version Jira/Trello reference(s) Status


